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CHAPTER 1: STRUCTURE PROJECT START UP

1.1. Creating an Architectural Underlay

1. Set the location for Default template files in Option

Options

General

User Interface
Graphics
Hardware

File Locations

Rendering

Check Spelling
SteeringWheels
ViewCube

Macros

Project template files: The first five project templates will appear as links on the
Recent Files page.

1E Name Path

Construction Tem... | C:\ProgramData\Autodesk\RVT 2018\ Tem...
= Architectural Temp.... C:\ProgramData\Autodesk\RVT 2018\ Tem...
b Structural Template :C:\ProgramData\Autodesk\RVT 2018\ Tem...
Mechanical Templ... [C:\ProgramData\Autodesk\RVT 2018\Templal...

Default path for user files:
[C:\Users’huangbocumems | Browse... l

Default path for family template files:
[C:\DrogramData\Aubodesk‘lRVT 2018'\Family Templates\English | \ Browse. ., I

Root path for point douds: » .
[C:VJsers%\uang\Domnents‘PointClouds | l Browse... ‘

’ Places...
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R Browse for Template File

Lookin: | USMetric
Name 2 Date modified Type
Construction-DefaultMetric.rte 6/30/2017 7:43 AM  Autodesk Revi
Construction-DefaultUS-Canada.rte 6/30/2017 7:49 AM  Autodesk Revi
DefaultMetric.rte 6/30/2017 T:49 AM  Autodesk Revi
DefaultUS-Canada.rte 6/30/2017 7:49 AM  Autodesk Revi
Electrical-Default_Metric.rte 1/18/2017 4:26 PM  Autodesk Revi
Mechanical-Default_Metric.rte 1/18/2017 4:26 PM Autodesk Revi
Plumbing-Default_Metric.rte 1/18/2017 427PM  Autodesk Revi
'Structural Analysis-DefaultMetric.rte 6/30/2017 T:49 AM  Autodesk Revi
Structural Analysis-DefaultMetric-Up.rte 6/30/2017 7:49 AM  Autodesk Revi
Structural Analysis-DefaultUS-Canada.rte 6/30/2017 7:49 AM  Autodesk Revi
Systems-Default_Metric.rte 1/18/2017 426 PM  Autodesk Revi
>
v
o
-
3. Link Architecture Model by Click Link Revit
File Archntecture Structure Insert  Annotate  Analyze

Select = Link

4. Choose Positioning

Modify| Link Link Link DWF  Decal
Revit IFC CAD Markup N Cloud

? X

vi@@}xgi Views v

’

s | B9 Eﬂ' @JQ @ o

Point Coordinaticn Manage |

Model Links
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| sample 2018 u\‘ & B X B Vews v
- g s Preview
Name Date modified Type Size
rac_advanced_sample_project.rvt 1/21/2017 426 AM  Autodesk Revit Pr.., 15,096 KB
rme_advanced_sample_project.rvt 1/21/2017 426 AM  Autodesk Revit Pr... 32,956 KB

rst_advanced_sample_project.rvt 1/21/2017 426 AM  Autodesk Revit Pr... 13,016 KB

File name: |rac_advanced_sample _project.rvt R |
Fies of type: |RVT Files (%.rv) v
Positioning: | Auto - Project Base Point to Project Base Point s
Auto - Center to Center \ Ok | ;i l el 1

Auto - Origin to Origin L= il
Auto - By Shared Coordinates

Auto - Project Base Point to Project Base Point
Manual - Origin

Manual - Base Point

Manual - Center

5. Reload or Unload Links by Manage Links

Manage Links

Revit | [FC CAD Formats  DWF Markups  Point Clouds

-

Link Mame Status Ref_?;;:;ce onots::r;; Saved Path Path Type Local Alias

rac_advanced sample_proj

SaveFositons ReloadFrom... ||  Reload Urioad Add.. || Remove

Manage Warks=ts

ok || Caeel || A | mep |
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6. Set the Visibility of Linked Models

Visibility/Graphic Overrides for Structural Plan: Level 1 x

Model Categaories  Annotation Categories  Analytical Model Categories  Imported Categories  Filters  Revit Links

Visibility Halftone Underlay Display Settings

rac_advanced_sample_project.nit By Host View

SectAl | SelectMone | | InvertSelection

[ oc [ cancel || el | e |

The Revit Links tab in the Visibility/Graphics dialog contains the following
columns:

« Visibility: Select the check box to show the linked model in the view, or clear the
check box to hide the linked model.

o Halftone: Select the check box to draw the linked model in halftone.

e Underlay: Select the check box to display the linked model as an underlay in the
project. The geometry will display in halftone and will not obscure new lines and
edges you draw in the project.

o Note: Elements in a model set as an underlay are not eligible for tagging.
Optionally, in the Visibility/Graphic Overrides dialog, specify the model as
"Halftone" instead of "Underlay" to display the model in halftone and allow
tagging of model elements.

« Display Settings: Options to override additional settings for each linked model
in the current host view. The button displays the current display setting state
(By Host View, By Linked View, or Custom).
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7. Copy/ Monitor Levels and Grids

Analyze  Massing & Site  Collaborate ~ View Manage Add-

(Structure) — Revit 2018

S| = o
» P ® 0 & b F5 % 8 %9 ¢ X

’“m!}“-llf Co;fx:;'o"' Cogz":a;s'o" R:‘f;;}f‘:e '"tz';::: - | Modify Options|Copy Monitor Coordination Batch = Finish Cancel

T i Coordinate Seﬁmgs Copy
Q e ClnrenkRroect Select « Tools Copy/Monitor
&s&m Link Copy/Monitor | CIMultiple  Finish | Cancel ‘ Y

Copy/Monitor Options X
Levels Grids Columns Walls Floors
Categories and Types to copy:
Original type New type Parapet g™
1/4" Head 8mm Head *'x 5000 \d “' Roof
8mm Head 8mm Head — == 1 1W "_114W®
03 - Floor— 03 - FIW
7600 - 7600
02 - Floor_ =02 - Floor__‘ﬁi
N 3800 - 3800
Additional Copy Parameters:
Parameter Value

Offset Level 0.0
Reuse Levels with the same name  ([/]
Reuse matching Levels Don't reuse 01 - Entry Level 01 Entry Level
Add suffix to Level Name - ) ‘ 0 G
Add prefix to Level Name 1
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I I I I
SR NNV NSNS USRI WN—
' | I | I |

Edit Link Model

To update linked models without closing the current project, you can reload the linked
models. Unload linked models to temporarily remove them from the project.

Click Manage tab > Manage Project panel > (Manage Links).

In the Manage Links dialog, click the relevant tab.

Select the linked model.

To unload the selected model, click Unload. Click Yes to confirm.

Note: It is not required that you unload a linked model before reloading.
To reload the selected model, click Reload.

iAW =

Reference Type

Reference Type has two types: Overlay and Attachment.

When you import a model that contains linked models, the nested links display
according to the Reference Type setting in their parent model.
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Reference type for Project B
set to Overlay

If you change the Reference Type setting for Project B to Attachment, when you
import Project B into Project C, the nested link (Project A) displays.

Reference type for Project B
set to Attachment

1.2 Importing and Linking CAD files

1. Import Floor plan CAD for Level 1
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R Link CAD Formats ? X
Lookin: | 1Starting Structural Projects v| & B X B vews ~
Prévi
Qg% A | Name % Date modified Type 2ln
5 ElevationEast.dwg 2/7/2013 5:34 PM DWG File
ElevationNorth.dwg 2/7/2013 5:34 PM DWG File
: ElevationSouth,dwg 2/7/2013 5:34 PM DWG File
r% ElevationWest.dwg 2/7/2013 5:34 PM DWG File
FS FloorplanLevel01.dwg 2/7/20135:34PM  DWGFile
FloorplanLevel02.dwg 2/7/2013 5:34 PM DWG File
—_— FloorplanLevel03.dwg 2/7/20135:34PM  DWG File
My Campniter FloorplanRoof.dwg 2/7/2013 5:34 PM DWG File
N
< | >
File name: |F|oorplanLeve101.dwg vl
v | Files of type: [DWG Files (*.dwg) = I
[ current view only Colors: |Black and White Positioning: Imw-mwmm&r VI

Layers/Levels: Place at: |Leve|‘1 V‘

Import units: |Auto-Detect | 1.000000 [ orient to View
Tools - [CJCorrect lines that are slightly off axis I Open l I Cancel

2. ~ Add Grids Line
Extensions  Modify | Place Grid

ot Al - i

o
1| Level Grid '.Multi-Segment
Datum Draw j

3. Import Floorplan Level02 and Align to LevelO1

4 Go to the North Elevation
5 Set the Grid A as Work Plane
6. Link ElevationNorth.dwg
7. Align Grid and Level
8. Go to the East Elevation
9. Align CAD to Grid A
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Work Plane X

Current Work Plane
Name:
<none:>

[ Show \ Dissociate

Specify a new Work Plane
(® Name Grid : A v

(O Pick a plane
(D) Pick a line and use the work plane it was sketched in

Importing / Linking Drawing Files

Importing / Linking Drawing Files are essential when a project is not 100% in Revit by
all disciplines. It is also the normal industry practice that deliverables by some
professional services are still in CAD format, such as Topographic Survey Plan. Due to
some limitation in Revit for the drawing import/link, users always find difficulties in
the process. Here, steps for the Importing / Linking are explained. Also, some
tricks/hints are given to make Importing /  Linkin easy.
e : oo S | ——— B

£3 ot
‘_m U T I — A
— l-q-u.ap sl Landm o pradt e Bien s
‘. e e ” lomty o=a
-ud&—bvy B

To make it simple, first of all, Importing and Linking are basically doing the same thing,
i.e. to Import a CAD drawing into Revit to use. The only difference for Linking is that
Revit keeps the path of the CAD file such that when the Revit Model is loaded, the
CAD file is re-loaded. However, Revit do store the content of the CAD drawing in the
Revit Model. In case if the CAD file is not found while it is re-loaded, the CAD drawing
can still be seen in the Revit Model.

The benefit of Linking is that Links can be managed. That means, the CAD file can be
Reloaded, Unloaded or Removed. The path can also be changed by using Reload
From. This is in particular good when users want to remove old imported drawings
but forget which view the drawing is added. The CAD drawing can be removed in
Manage Links.
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In some cases, users may find it frustrated once the linked file is not found when Revit
Model is opened. A warning message comes out to ask if Manage Link is opened to
correct or it is ignored. Although it can just be ignored and the drawing can still be
used, new users may think there is some problems with the Revit Model or they have
done something wrong.

Since Importing and Linking are doing the same thing except the “path”, the
description below will only use Importing as reference. Users may do the same for
Linking if it is needed.

CAD Formats

Revit accepts different types of CAD formats including “.dwg”, “.dxf", “.dgn”, “.sat",
".skp”. Some of these are CAD are in 3D and some are in 2D. Basically, the import for
CAD for different CAD formats are same.
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2D /3D

CAD can be imported as 3D which is similar to Model objects in Revit and can be seen
in different views. CAD can also be imported as 2D which is view related. The
advantage of importing to 3D is that the drawings can be presented in more than 1
View. It can also be seen in 3D Isometric Views or Camera Perspective Views. The
disadvantage of importing to 3D is that it would slow down the operation. The CAD
will need to be re-generated when the View is re-generated even if the CAD is out of
the View Range.

When the CAD is imported as 2D, the Z-dimension in the CAD will be ignored. That
means, even if the CAD is drawn in 3D, it will become real 2D in Revit. For example, if
a Topographic Plan with 3D Contour is imported as 2D, the 3D properties will lose.

Hints: Most of the drawings should be imported as 2D (Current view only) unless real
3D CAD or Topographic Plan with 3D Contour that will be used for modelling purpose.
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Colors

Colors are colours of the drawings and layers after the CAD is imported. 3 Options
are available (Invert, Preserve and Black and White). Invert means the colour will be
changed such as Colour 1 (Red) becomes Colour 4 (Cyan). Preserve maintains the
same colour in CAD. Black and White will set all colours to black.

There is no standard about which colour setting should be used. In normal practice,
layer colours will be overridden in View Visibility or Object Style. So, it is not having
much difference in the colour selection.

T R e
s ) ol X S Yo v
e Qote sl ed Type S
Y met 200001050 AM  AuteCAD Dvawing “
3 Line Cotour WAV ZZIM  ActoCAD Drawng T
Lo NARMIM  MeteC2D Depwiny “w
[
Tl e -
Pies of Drow: ,m__ o-}_a' - .
=2 Forteres ‘@___pu--hu - |
iveser e T T -
Inpart ity | ] 1000000 V. Orgrt o Veew
o3 Loom. ] cwes ]
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- : Invert Preserve Black and White

o » o tm MG

Oaty ot LM e sy, (T 00, O ey & B N v oo . e ] [Jhenstny Vo

Layers

The CAD can be imported with All, Visible or Specify layers. In case if only some layers
are needed from the CAD, Visible and Specify should be chosen to reduce the size of
imported CAD. Otherwise, normally All layers are imported. On and off of layers can
be controlled in Visibility.

Crmdos L WN PP
ock iy || et D o X Yo
L =
Neme Oote moddied Type S
Wiment JON0A 10N AM  AseCAD Drpming @
N e Cotour WA M AtoCAD Drawng T
Wiwe VUXMIIAM  MacCAD Dipwing “w
1
Vi tme -
Fhes of e |OWE P (" e} w)
ot v L - towterwy A - Canter e Carer -
Hrr ot Lol & -
et e 200000 ¥ Orgrt s Veew
e s - f
[ Lom || Cmes |

Import units

Import Units is used to define the scale of import for the CAD. The default value is
Auto-Detect which reads the value of variables in the CAD file.
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taskips [ | Ingont A0 : ; o 9 BB X ) Yo -
Naa : Oote bl ast Type Sean
i [ NOLIONAM  AuseCAD Drawing “wa
3 Lne Color WANSOEIIM  AutoCAD Drawng O
B NAPMAM  MseCAD Drwweng “wa

Pies of e O e : .
Gacmetw towterwey A - Conter 1 Corter -
S - -
e coing U Pgew ot ievel ) d
! oot 1500000 7 Orgd e Ve

[T [ o | oms |

Say, for example, when AutoCAD drawing is imported, the settings in Units will be
read. If the Insertion Scale is “Inches”, the CAD will be imported with a scale that 1
unit in CAD is 1 inch in Revit Model. If Insertion Scale is “Unitless”, “feet” is assumed.
There is also an option of “Custom factor:" in the Import Units such that user can input
a preferred scale. So, if the drawing scale is known, it is highly recommended to select

the right scale instead of just leaving it with “"Auto-Detect”.

Positioning
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The CAD drawings can be automatically placed to “Centre to Centre” or “Origin to
Origin” when it is imported. “Centre to Centre” means the "Centre” of CAD drawing is
placed at the "Centre” of the Model on plan. Since the “Centre” of Model counts all
3D objects like Reference Plane, it may not be easily control the coordinates of the
CAD in relation to the Model. However, the CAD can be easily found after it is
imported.

“Origin to Origin” means the Origin (0, 0, 0) in CAD is placed at the Origin of the Revit
Model. Users may note that it may not be easy to locate the Origin of a Revit Model.
Also, there is a practice of using True Coordinates in CAD. So, the origin in CAD may
be far away from the drawing content

The CAD can also be positioned manually using Origin, Base Point and Centre. Base
Point is the value of variable “Insbase” in AutoCAD drawing. With these selections, the
CAD will follow the cursor before the insertion point is picked

Place at

Place at is a choice of placing the CAD at the current view of the lowest level in the
Revit Model. That means the “Z=0" in CAD is placed at the selected level. In case if
the CAD is imported to Elevation or Section, only the lowest level can be selected.
After the CAD is imported, the drawing can be moved vertically in Elevation or Section.
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Orient to View

When Orient to View is ticked, the CAD X-Y plane will be oriented to the View. For
example, if the CAD is imported to a Plan View, the X-Y plane is the CAD is oriented
to the X-Y plane of the Model. If the CAD is imported to an Elevation, the Y-direction
in the CAD is oriented to Z in the model. If this is un-ticked, X-Y plane in CAD will

always be imported to X-Y plane in the Model.
N e GOt i — i et

Lok [‘hultb

] R X S pee -
e

Dute modbad

Type Son

0001052 AM. AuteCAD Deamwg
LAMROZ M AoCAD Drawng
RS MM AtoCAD Desmng

tang
L)

Dovtorwg | Adie - Cander 1o Canter
Mgt Lol

LJE

[ oo || ome |}

Tricks / Hints
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In the older version of Revit, there is a limitation of 2 miles for the CAD import. This
limitation is relaxed in 2011 version. Only a message will appear when the CAD extent
is over 33km to re- confirm whether it should be continued. People may say it is quite
rare that the CAD drawing covers an extent of over 33km. However, it did happen
when the CAD is defined in True Coordinate (and even in mm). The coordinates in
Hong Kong will therefore over 800km. Of course, if there are no objects near the
origin, the coordinate system will not cause trouble to the drawing extent. However,
in most of the case, Block, Hatch or XRef in CAD may be mistakenly imported with
some definitions remained near the origin. This will then result with a large extent.

Difference between Link & Import

Linking CAD means the CAD file has a relative relationship with Revit project,
when CAD drawing is updated, the linked CAD drawing in Revit can be updated
simultaneously.

Importing CAD file means the CAD drawing was pasted it directly into the Revit
model, you can define the visibility of CAD file of its layers. And you can set the
visibility of CAD drawing in different Revit views. In order to maintain the CAD
drawing even when the Revit model was relocated, import tool is suggested.
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CHAPTER 2 - STRUCTURAL COLUMNS

Structural columns are loadable families in Revit. Create/Customize structural column family will be
taught later in the course. In this section, you will learn

e How to add columns (vertical and slanted).

e Adjust location of a column using temporary dimensions.

e Options

e How to create column type by duplicating existing type.

in column placement.

o How to modify mechanical properties of a column.

2.1

To add structural columns in Revit,

Adding Columns with default settings

1 Open from the course folder the “Columns.rvt” file.

2 Click Structural Tab > > Column in Structure panel.

ReHG-%-2-8

Architecture ~ Structure  Systems

aco

8- FAO0A G- oEEB-~

Insert  Annotate

Analyze  Massing & Site

[y Q) wall = [ Truss
¥ 2]
Modify| Beam

Lo Floor = ([ B

Select ~ Structure

Properties

Structural Plan

Structural Column (CL)

Adds a vertical load-bearing element ta the building model.

Open a plan view or a 3D view to add structural columns. You can

place each column manually, or use the At Grids tool to add
columns to selected grid intersections,

Structural columns can join to structural elements, such as beams,

braces, and isolated foundations.

& P20

Columns - Structural Plan: Level 2 »
Collaborate  View  Manage
## Area [P Fabric Sheet
o3 Path Cover

| Fabric Area 1 Rebar Coupler

Reinforcement ~

Add-Ins

Type @ keyword or phrase

Maodify

)

Component

[l
£) Model Text
I, Model Line
[@) Model Group -
Model

88 5 & Rsgnin

P ale = wal

= 3jE

} )
Ay Vertical
By Shaft e

Face

Opening

Structural Plan: Level 2 v @ " 2
Graphics | —T = i

View Scale e ] —_— i
Scale Value 1 100 o _»;_@ |
Display Model  Normal i
Detail Level Medium :
Parts Visibilty  Show Original i o :
Visibiity/Graphics..| | Edit. — 5% |
Graphic Display O.. dit . :
Orientation Project North  Lpress F1 for more help :
Wall Join Display  Clean all wall joins :

Discipline Structural o jll .
I

Show Hidden Lines By Discipline
Color Scheme Loc... Background
Color Scheme
System Color Sch..| Edit.
Detault Analysis .. None

Sun Path O

Properties help

Apply

¢

1:10 Bk GBRMEHP 0 RMAHIE <

e R S C)

W @ -&x

gH Grid  Set

Work Plane

BB

I~ Dormer

Datum

= 7 5% ~ Project Browser - Columns. x

=110, Views (all)
= Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
= 3D Views
Analytical Model
Elevations (Building Elevation)
East
North
South
West
) Legends
I Schedules/Quantities (all)
[ Sheets (all)
i B0 Families
& [@] Groups
© Revit Links

Click to select, TAB for altenates, CTRL adds, SHIFT unselects. i/

& 0 [ |Main Model

TN O T

3 Inthe Properties Palette, select “600 x 750mm” type from Concrete-Rectangular-Column.
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Columns - Structural Plan: Level 2

T LR

W ® -&x

File Architecture  Structure  Systems  Inseit  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-lns  Modify | Place Structural Column =-
* e oo = —
Al =T o= Wil H I @
M~ = I - - .
‘ Y - == L ® . T Load |Vertical| Slanted At At Tag on
- ¥ Gen- AT ‘ im =1 =y Family [Column Column  Grids Columns Placement
Select * Properties  Clipboard Geometry Modify View  Measure  Create Mode  Placement Multiple Tag
Madify | Place Structural Column [JRotate after placemen  Depth: ~ Level 1 v 25000 [“] Room Bounding
o x Q = 7 5% ~ Project Browser - Columns. x
operties 5 =10, Views (all)
Concrete-Rectangular-Column -l ‘\.;,' £ Structural Plans.
600 x 750mm 200000 - Level 1
o y Level 1 - Analytical
[search F o Level 2
¢ © © o ® ot oy
Cireular Hollow Sections-Column | ‘ i i i Site
! ' = 3D Views
CHS21.3x3.2 1 Y S IR
- -+ i 1 ﬂ Jr Analytical Model
CHS193.7x12.5 | | | ! | = Elevations (Building Elevation)
CHS508x12.5 | ] I | i East
Concrete-Rectangular-Column | | I | | North
i ‘ ‘ i | South
300 x 450mm Ow - ———— e — e ——- ———— O West
450% 600 ! ‘ ‘ l l 59 Logends
*ofbmm | | | | | 3 Schedules/Quantities (al)
600 x 750mm i i i i i Sheets (all)
I UB-Universal Beams-Column | | | | | & B Familes
& 1 : . . t-[@] Groups
UB127x76x13 + N 1 ﬂ Jr 8 Revit Links
| |
UB305x102x25 : ! !
UB457x191x82
UB1016x305x249
Most Recently Used Types 1:100 FEA QME P 0 MBIE < >
Concrete-Rectangular-Column : 600 x 750mm |cyele the placer ot ] E M| Main Model W ﬁ '%k m& % o Yo

4 Keep all options unchanged.

qi
5 Select “At Grids” from the ribbon to place columns at grids.

6 Select Grids 1-5 and A-B.

Columns - Structural Plan: Level 2

RzEHG -&-@-82-F0A G oEHaB

 zr— Y

W ® -&x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Madify =~
L\\. g Q wall - [ Truss % & 9 Ve, B ## Area [ Fabric Sheet . £ Model Text R aleg o wal 1)
alEe @+ e
B Brace 3 Path ] cover I\, Model Line e Ay Vertical )73
Modi Beam Connection  Isolated Wall Slab  Rebar Component By Shaft Grid Set
¢ Floor = [[[] Beam System - B Fabric Area & Rebar Coupler - [ Model Group = Face I Dormer B
Select ¥ Structure ¥ Connection ~ ¥ Foundation Reinforcement ~ Model Opening Datum  Wark Plane
Properties x o = (3 5% ~ Project Browser - Columns x
- =10, Views (all)
éﬂlﬁl Structural Plan - (=18 b=Struchural Flans
. Level 1
Level 1 - Analytical
Structural Plan: Level 2 ~ H Edit Type ® ® ® . . a Level 2
Graphics H A e i _ == Selection window - Level 2 - Analytical
View Scale | o S I E— - - placed from right st
Scale Value 1: 100 ‘ I = 3D Views
Display Model  Narmal 1 toleft. Analytical Model
Detail Lovel Nediurm : 1 £ Hlevations (Building Elevation)
Parts Visibility  Show Original 1 East
Visibility/Graphics... Edit.. o G T O 20":
Graphic Display O... Edit .. - L ‘:ult
es
Orientation Project North i B Legends
Wall Join Display | Clean all wall joins | = Schedules/Quantities (]
Disciplin‘e ‘ Slruc.tural- | o _ I BB sheets (al)
Show Hidden Lines By Discipline i i | & B Families
Color Scheme Loc... Background T ] Groups
Color Scheme <nones> &3 Revit Links
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20 = Bl main Model

il g

7 Click “Finish” J and “esc” a few times to complete placing the columns.
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8 Place column type “UB1016x305x249” at intersections of Grids 1-5 and A.

9 Click id to view the columns placed in 3D.
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2.2 Options in Column Placement

There are many options available to help you to place columns in Revit. Many of the options are self-
explanatory. You can hover over the option and see its description and press F1 for more help. Under
the contextual ribbon tab, the options for column placement are:

e Vertical Column / Slanted Column.
e Multiple “At Grids” / “At (Architectural) Column”.
e Tagon Placement
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e Rotate after placement.
e Depth / Height and (Connected to) Specific level / Unconnected.

R EHE-R-7- Q- FTO0OA @-QF B+ Columns - Structural Plan: Level 2 >|Typeakeyworaorphmse |m 8% ,Q Sign In

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage Add-Ins  Modify | Place Structural Column =~

b Kom B0 R @ Bl Dy + = 5 9-¢ = [3][¢ E’ﬂ:& H I O

Modify| [ 3 Z_%\ ® Load | Vertical | Slanted At At Tagon |
= o o) = . ™
= M &% Gioin [N ||T 2 Family! [ Column| Column  Grids Columns  Placemend
Select ¥ Properties  Clipboard Geometry Modify View Measure Create Mode™ ~PlRcémént — TMulfiple T T Tag -
L

_________________ 1
Wodify | Place Structural Calumn 1 ‘ [ Rotate after placemen Height: ~ Unconn ~ | 2500.0 1

For vertical column, if you have checked the option “Rotate after placement”, then you can either pick
the angle on screen or enter it directly after you picked the column location.

Rotate after placemen | Height: ¥ Unconn ~ | 2500.0
X

2.3Adding Slanted Columns

A Slanted Column is a column that is not vertical. To add slanted columns in Revit,

1 Open from the course folder the “Slanted Column.rvt” file.

2 Click Structural Tab » Column in Structural panel.

3 Click Slanted Column 0 on the contextual ribbon.

4 Change the offset of the 1st Click to -200 (mm) and that of the 2nd Click to 500 (mm).

5 Pick the intersection of Grids 6 and A. This is the 1°* point of the slanted column and defines its
base point.

6 Pick the intersection of Grids 7 and A. This is the 2™ point of the slanted column and defines its top
point.

7 Add similar slanted columns at intersection of Grids 6 and B, and Grids 6 and C.
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Level 2 S
3000

Level 1 S

|
|
|
Offset fl’om Level 1 0

Notes (from Autodesk Knowledge Network):
The following general rules apply to the procedures for placing slanted columns.

e When placing slanted columns, the top of the column will always have a higher elevation
than its base. When you place the column, the endpoint at the higher elevation is the top,
and the lower elevation is the base. Once defined, the top may not be set below the base.

e When placed in a 3D view, your 1st Click and 2nd Click settings define the associated levels
and offset of the column. When placed in an elevation or cross section, the endpoints
associate with their nearest level. The distance between the endpoint and the elevation are
the offset by default.

e If 3D Snapping is disabled, snap references for elements on the current work plane display,
as well as typical temporary dimensions. When you place columns with 3D snapping
enabled, the 1st Click and 2nd Click level settings are used if a snap reference is not found
or utilized.

e Slanted columns do not appear in graphical column schedules. Columns in a slanted state
will not display element properties related to graphical column schedules, such as Column
Location Mark.

e The Copy/Monitor tool does not apply to slanted columns.

2.4Adjust Location of Columns using Temporary Dimensions

There are many ways to adjust the location of a column. One way is to change its temporary dimension
value.

1 Select the column at Grid 1-C.

2 Click on the temporary dimension “6000” and change it to “3000”. Press “enter” and “esc”.
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2.5Create a New Column Type “600 x 1200mm” by Duplicating an Existing Type

You can manage/modify the properties of a column from its Properties Palette.
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1 Select the column at Grid 1-B.

2 Click “Edit Type” from the Properties Palette.

3 Click “Duplicate” and change the “Name” to “600 x 1200mm”. Click OK.

ReBG-S-7-82-FA0A @-0% &M+ SontedCoumns - Sudunal Par Lev.. # [Tpeakgmovorprase |88 8 ¢x L signin W @ - & Xx

Architecture ~ Structure  Systems

Insert  Annotate  Analyze

Massing & Site  Collaborate  View  Manage Add-Ins  Modify | Structural Columns @~

il ) ‘ { Type Properties
L N 0" =0 |
= g . '3 * "‘ ([ Family: Conarete-Rectangular-Column - L

Select ¥ Properties  Clipboard Geometry M Type: 600 x 750mm

Moy | Structural Columns | [ Moves With Grid:
Properties x x

Type Parameters
Concrete-Rectangular-Column (P Parameter n
600 x 750mm

ctroctaral Colimns 0] ! Section Shape [Not Defined

Base Level ®—-—--

Base Offset 0.0 J N J

Top Level Level 2 | il

| . '

Top Offset 00 J |

Column Style Vertical ' Keynote | Name X |

Moves With Grids | Model el | | n)
T BT - L i
Materials and Finishes B - L ~| [Section Name Key - - ————— - - | |

Structural Material Concrete, Cast-i... J | IType Comments [ J
e : === % ] o | ,

Enable Analytical ... ‘ L | URL T _E

Rebar Cover - To... Rebar Cover 1 <25... | Description j

Rebar Cover - Bot... Rebar Cover 1 <25... ' |Assembly Code

Rebar Cover - Ot.. Rebar Cover 1 <25.. | Cost .
Dimensions & O—-—- 1 P PSR

Volume 1.350 m? K
Identity Data : I << Preview | oK Cancel Apply
-~ (I -
Properties help Apply 1100 EIE Ok IR D 0 RABIE < N W
Ready i o0 @™ vain Model PED R OT

4 Change the Value of “h” to 1200. Click OK.
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Type Parameters

Parameter ‘

Value

Section Shape

éNot Defined

o

600.0

=

1200

5 Now select the column at Grid 5-B. Select Type “600 x 1200mm” from the Type Selector and press
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2.6 Modify the Mechanical Properties of a Column
1 Select the column at Grid 1-B.

2 To bring up the Material Browser, click on the builder button in structural material from its
properties palette.

S

Materials and Finishes
Structural Material Concrete, Cast—in-l@%‘j X I

2 Select the “Physical tab” and change the Density to 1 kg/m3. Click OK and press “esc”.

You have just changed the density of the material “Concrete, Cast-in-Place gray” and it will be the
same for all columns having this material in the same project.

You can also duplicate the material by right click at it in the Material Browser and give it a new name
to avoid overwriting the original material.
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2.7 Detail Description of Structural Column Instance Properties

(source: Autodesk Knowledge Network)

https://knowledge.autodesk.com/support/revit-products/learn-
explore/caas/CloudHelp/cloudhelp/2018/ENU/Revit-Model/files/GUID-5EBA5016-4E9C-4131-BD5B-
36FC99A92846-htm.html

Name Description

Constraints

Column Location Mark The coordinate location of a vertical column on the project grid.

Base Level

'Constraining level of the column base.
'Base Offset Offset of base from base level. '
'Top Level 'Constraining level of the column top. '
'Top Offset Offset of top from top level. '

'Moves With Grids 'Changes the vertical column constraint to the grid. See Lock Columns to a Grid.

‘Move Top With Grids 'Constrains the top endpoint of the slanted column to the grid.

'Move Base With Grids'Constrains the base endpoint of the slanted column to the grid.
Top Cut Style

Either Perpendicular, Horizontal, or Vertical. Specifies the cut style at the top of the
column when unattached to a reference or element.

Top Extension Offset of the top of the column when unattached to a reference or element.

'Base Cut Style

Either Perpendicular, Horizontal, or Vertical. Specifies the cut style at the base of the
column when unattached to a reference or element.

'Base Extension 'Offset of the base of the column when unattached to a reference or element.

'Either Vertical, Slanted - End Point Driven, or Slanted - Angle Driven. Specifies the slant'
style of the column which enables type specific modification tools. See Slanted Column
Manual Adjustment Tools.

'Column Style

'Base Geometry'Either Location Line, Top of beam, Bottom of Beam, or Center of Beam. Specifies
Alignment the working point along an attached beam to which the centerline of a slanted column

adjusts at its base.
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Name Description
Top Geometry Either Location Line, Top of beam, Bottom of Beam, or Center of Beam. Specifies
Alignment the working point along an attached beam to which the centerline of a slanted column

adjusts at its top.

'Base is Attached 'Read-only parameter specifying that the base of the column is mid-joined to a beam or'
attached to a structural floor or roof.

'Attachment 'Either Minimum Intersection, Intersect Column Midline, Maximum Intersection, or'
Justification At Base  Tangent. Specifies the degree of cutback or tangential justification at the base of the
column at the join.

Offset From Offset of the base of the column from the mid-joined beam or attached elements.
Attachment At Base
Top is Attached Read-only parameter specifying that the top of the column is mid-joined to a beam or

attached to a structural floor or roof.

'Attachment 'Either Minimum Intersection, Intersect Column Midline, Maximum Intersection, or'
Justification At Top Tangent. Specifies the degree of cutback or tangential justification at the top of the
column at the join.

Offset From Offset of the top of the column from the mid-joined beam or attached elements.
Attachment At Top
Room Bounding Changes column constraint to room-bounding conditions.

'Materials and Finishes

Structural Material For more information, see Change the Physical Properties of a Material.

Structural

Top Connection Applies to steel columns only. Turns on the visibility of a moment or shear connection
symbol. The symbols are visible only in elevations and cuts parallel to the main axis of
the column in coarse view.

Base Connection Applies to steel columns only. Turns on the visibility of the base plate symbol. The
symbols are visible only in elevations and cuts parallel to the main axis of the column
in coarse view.

Enable Analytical Displays the analytical model and includes it in analytical calculations. Selected by

Model default. See Disable an Analytical Model.

'Top Attachment Type 'Either Distance or Ratio. Determines if the top join of a slanted column is measured as
a distance or a ratio of the length of the beam.

'Top Attachment Distance from the referenced end of the top attached beam to the join location on the
Distance slanted column.

'Top Attachment Ratio The ratio of distance from the referenced end of the attached beam to the top join'
location on the slanted column to the total length of the beam.

'Top Attachment Either Start or End. Specifies the end of the top attached beam from which to calculate’
Reference End distance or ratio.

Base Attachment Either Distance or Ratio. Determines if the base join of a slanted column is measured

Type as a distance or a ratio of the length of the beam.

Base Attachment Distance from the referenced end of the base attached beam to the join location on the

Distance slanted column.

Base Attachment The ratio of distance from the referenced end of the attached beam to the base join

Ratio location on the slanted column to the total length of the beam.

IBase Attachmentl Either Start or End. Specifies the end of the base attached beam from which to calculatel
Reference End distance or ratio.

Rebar Cover - Top Applies to concrete columns only. Sets the rebar cover distance from the column top
Face face.

Rebar Cover - Bottom Applies to concrete columns only. Sets the rebar cover distance from the column bottom
Face face.

Rebar Cover - Other Applies to concrete columns only. Sets the rebar cover distance from the column to
Faces other element faces.
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Name Description
Estimated Specifies the estimated reinforcement volume of the selected element. This is a read-
Reinforcement only parameter that only displays when rebar has been placed.
Volume
Dimensions
Volume Volume of the selected column. A read-only value.

'Identity Data

Comments User comments.

Mark A label created for the column. Possible use: shop mark. This value must be unique for
each element in a project. Revit warns you if the number is already used but allows you
to continue using it. You can see the warning using the Review Warnings tool. For more
information, see Review Warning Messages.

'Phasing

Phase Created Indicates in which phase the column component was created. For more information,
see Project Phasing.

Phase Demolished Indicates in which phase the column component was demolished. For more information,

see Project Phasing.
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CHAPTER 3 - STRUCTURAL WALLS

Structural walls are loadable families in Revit. You can Create/Customize structural wall family for
special use (not to be covered in this course). In this section, you will learn

e How to add structural walls.
e Options in wall placement.
e How to add layers to a wall type.

3.1 Adding Walls with default settings
To add structural walls in Revit,
1 Open from the course folder the “Walls.rvt” file.

2 Click Structural Tab » Wall in Structure panel. (The default option is Wall: Structural.)
ReBG-4-2-8/2-FA0A|[G-9% G- MsisSentedCoumns-Strudural Pa. b [1pearewoaorpnae |8 5 # L signin e @ -8 Xx

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =~

N <Z -] s % & Q ) # Area B Fabric Sheet g £ Model Text 5 i 2 wall £
l + "
E I Wall; Structural E frace Connection  lsolated Wall  Slab  Rebar I e Component Rolz) U By Shaft e oH Gid  Set 7
- B, Fabric Area €0 Rebar Coupler - [@) Model Group = Face I Dormer =
st Stc sl - Foundation Reinforcement ~ Model Opening Datum  Work Plane
Creates a load-bearing or shear wall in the building model.
To change the structural function of the wall, use the Structural — (3 5% ~ Project Browser - MS1-Slanted Columns X
Wall parameter in the wall’s element properties @ @ @ 0] @ [0lG} = 0, Views @)
i i ! Hl 1) = Structural Plans
\ \ \ | [ - Level 1
! ! . : ' Lo Level 1 - Analytical
O — B o
i i ‘ | | | | Level 2 - Analytical
| | J Site
‘ \ | | | | ] = 3D Views
| | ‘ | Analytical Model
\ \ \ | [ 0]
1 | I ! H . = Elevations (Building Elevation)
S S
Press F1 for more help | | | | || | North
Orientation Project North I | | | | L South
§ | | \ | [ West
Wall Join Display Clean all wall joins ) i ] | ) Legends
Discipline Structural | | | | | || I Schedules/Quantities (all)
Show Hidden Lines By Discipline i i i | ' Sheets (all)
Color Scheme Loca... Background ‘ ‘ ‘ | | || 5 O Eamilies
Color Scheme <none> O—-—+-—1—J——--] F—-—- +-— -———— @] Groups
System Color Sche... Edit.. 1 ! ! ' ' ' 8 Revit Links
Default Analysis Di.. None ‘ I I | | [
Sun Path m]
o 3 & v
Properties help Apply 1:100 PPk AME P ¢ RBIE < >
Click to select, TAB for altemates, CTRL adds, SHIFT unselects. /7 0 B Main Model 5 S [ M O Fo

3 Inthe Properties Palette, select “Generic —300mm” type from Basic Wall types.
4 Keep all options unchanged.
5 Pick the start point of the wall at Grid-2 and 3000mm up from Grid-B.

6 Continue to pick points B and C as shown below. Press “esc” a few times to complete adding the
walls.
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ReBG-R-@-8la-l0A6-0EaD - Walls - Structural Plan: Level 2 W[1ype a veywora or phrase
Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify (O

‘/* |-—-| (%, Radial A Spot Elevation Detail Line £} Revision Cloud = A Text @ I]@j k] fLT(l) b= ] a I 4
) & Diameter 2R n 1
Aligned Linear Angular

M 5 vy Asignin W @ - &x

A Spot Coordinate [T} Region ~ [ta] Detail Group = %5 Check Spelling

. Tagby Tag Keynote . Symbol
{7 Arc Length 71 Spot Slope 5] component ~ } Insulation G Find/ Replace  Caregory Al B B ¥~ . = &= [
Select = Dimension ~ Detail Text u Tag ¥ Color Fill symbol
Properties x 1 2 3 4 (i 53 ~ Project Browser - Walls x
£ 10 Views (all)
- Level 1
= Level 1 - Analytical
Structural Plan: Level 2 ~ E8 Edit Type ‘ | fq Level 2

g Level 2 - Analytical

Graphics ~ l
View Scale Site
Scale Value 1 200 - 7 []7 7[} - - = 3D Views
Display Model Normal Analytical Model
I

Detail Level Fine 30}

Parts Visibility Show Original \ | | = Elevations (Building Elevation)
Visibility/Graphics .. B c East

Grophic Display Op..__ Edit. | ‘ ‘ ;“:u'::

Orientation Project North i 8 8 West

Wal Join Display _ Clean all wall joins =1 = ) Logands

Discipline Structural | ™ Schedules/Quantities (all)

I
Show Hidden Lines By Discipline ) Sheets (all)
o o

Color Scheme Loca... Background =1 = B Families
Color Scheme <nane> | & @ i [@] Groups
System Color Sche... Edit... _ _ i 1! — — —] @ Revit Links
Default Analysis Di.. Mone
Sun Path | | | | |

T v , ) . , v

Properties help Apply 1:20 EEI G AME P 0 aIE < ’

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 77 £ :0 3 M Main Model WA N OTo

7 Click id to view the walls placed in 3D.
ReBG &-a-8l=-FO0AG > EGD ~ Wall - 30 View: (30} T | N0 L =R ER

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =-

[ Q wall - [ Truss % é]; @ P, # Area gj £ Model Text =R ale o wal @ &
i
- o [} column [ Brace 3 Path [ cover [T Model Line 23 E gy Vertical
odif eam

Connection Isolated Wall Slab  Rebar Component By Shaft Set

¢~ Floor = [[[] Beam System B Fabric Area &3 Rebar Coupler [ Model Group = Face I Dormer B
Select + Structure ¥ Connection = ¥ Foundation Reinforcement ~ Model Opening Datum  Work Plane
Properties x . (3 53 ~ Project Browser - Walls x

=1 10 Views (all)
@ 3D View - & Structural Plans
Level 1

Level 1 - Analytical
3D View: (3D} | Edit Type = | s
Graphics 2 A ' i . Level 2 - Analytical

View Scale 1:100 Site
Scale Value 1:  |100 | @) 3D Views
Detail Level Fine > Analytical Model
Parts Visibility Show Original X (30}
Visibility/Graphics .. Edit. B = Elevations (Building Elevation)
Graphic Display Op... Edit.. ' fast
Discipline Structural i 2‘;}:::
Show Hidden Lines By Discipline et
Default Analysis Di.. None ) Legends
Sun Path O I ' 5 Schedules/Quantities (all)
Extents : [ Sheets (al)
Crop View ] | I # B Families
Crop Region Visible [ i [@) Groups
Annotation Crop |[_] @8 Revit Links
Far Clip Active O
Far Clip Offset 3048000
e P — o v
Eroperties help Apply 10 EAHGGGHHER A GE < >
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. &7 2 0 [E B Main Model PG OFo

3.2 Options in Wall Placement

There are many options available to help you to place walls in Revit. Many of the options are self-
explanatory. You can hover over the option and see its description and press F1 for more help. Under
the contextual ribbon tab, the options for wall creation and placement are:

e Draw by: Line / Rectangle / Inscribed Polygon / Circumscribed Polygon / Circle / Start-End-
Radius Arc / Center-ends Arc / Tangent End Arc / Fillet Arc / Pick Lines / Pick Faces.

e Depth / Height and (Connected to) Specific Level / Unconnected.

e Location Line: Wall Centerline / Core Centerline / Finish Face: Exterior / Finish Face: Interior /
Core Face: Exterior / Core Face: Interior.
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e Chair / Offset / Radius
e Join Status: Allow / Disallow

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View ~ Manage  Add-Ins _M_odEyLPIa_ceilru_thaIWall =~
: Ko 28 P hpess i = [ @=ese.,
vodiy [T Slan - & - o5, 0 = BERl® /= ] o :_.'_/j{"(‘ K-
C oy g ke 90O T aax ) @‘,ﬂ -
Select ¥ Properties  Clipboard Geometry Modify View Measure Create L. Daw_ _ _ ,

Notes:
e The Location Line option will affect how the wall is drawn.

e For examples: Wall drawn from Grid-1 to Grid-2 along Grid-A, with Location Line set as
“Wall Centerline” will look like

Location Line

e And wall drawn from Grid-1 to Grid-2 along Grid-A, with Location Line set as “Core Face:
Exterior” will look like

Location Line

e Once the wall has been created, changing the Location Line option in the Properties Palette
will change the location of the Location Line but not the position of the wall.

Properties x
:I Basic Wall -
Generic - 300mm
Walls (1) ~ (B Edit Type
Tt = = — = = — = = = g
1 Location Line i
LBase Constraint — devel? — — — — =
Base Offset -3000.0 |
Base is Attached
Base Extension Dist...|0.0
Top Constraint Up to level: Level 2
Unconnected Height|3000.0
Top Offset 0.0

3.3Adding (Non-structural) Layers to a Wall Type

To add layers to a wall type,
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1 Open from the course folder the “Wall Layer.rvt” file.

2 Select the horizontal wall.

3 Click “Edit Type” from the Properties Palette.

4

Click “Duplicate” and change the “Name” to “Generic 300mm + 100 Exterior Fill”. Click OK.

ReBG - S-7-82-20A @ 0% M@ WilyesCompleted - Stuctural PL. b [ipearemosorpmoe |8 5 ¢ L signin e @ - @ X
Architecture ~ Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate View Manage Add-ins  Modify |Walls @«
= i i . :
Type
Properties  Clipboard Geom “la Family: System Family: Basic Wall ~ Load... it
= -
Mocdify | Wells b ] - Generic - 300mm v Dupliate. :
= 4 : [ i = | =
Pt R L
:I Basic Wall | - Type Parameters
Generic - 300mm 2
- == Parameter Value =~
Wl (1) I+ B Edit Type
© === Structure | Edit... ]
Location Line [Core Face: Exterior Wrapping at Inserts Do not wrap
Base Constraint Level 2 None
Base Offset -3000.0 d

Base is Attached

13000
{Exterior

Base Extension Dist..[0.0 ation)
Top Constraint Uptolevellevel2 | =0 |/} & e e e e e e ==
Unconnected Height 30000 ]
Top Offset 00 _]
Top is Attached I Structural Material <By Categary>
Top Extension Dist... (0.0 - )
Room Boundi v
om founding Heat Transfer Coefficient (U)
Related to Mass
" Thermal Resistance (R)
Shuctiral Thermal mass
Structural | | ri— 0.700000
Enable Analytical M...[] < > fAoserplance o v
Structural Usage | Bearing
v
e el Apply ‘ @ View: Floor Plan: Modify typ Preview >> oK Cancel Apply
s - b b, \CTT FERE T OV
Now add an exterior layer to the wall.
. “ ) “ B ” o
5 Click “Edit” to open the “Edit Assembly” dialogue box.
Type Properties X
SA Family: |System Family: Basic Wall ~| Leeil,
o)
@2‘:‘ Type: |Generic - 300mm + 100mm Exterior Fill ~| ‘ D ‘
DQ Rename...
- Type Parameters
Parameter Value =\~
Structure Edit.
Wrapping at Inserts Do not wrap T T =
Wrapping at Ends None
Width 300.0
Function Exterior
Coarse Scale Fill Pattern
Coarse Scale Fill Color
Structural Material
Heat Transfer Coefficient (U)
Thermal Resistance (R)
o Thermal mass
< > Absorptance 0.700000 -
|@D| View: |Floor Plan: Modify typ ~ ‘ OK | ‘ Cancel Apply

6 Select layer “1” and click “Insert” to insert a layer outside “Core Boundary”.
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Edit Assembly X
A Family: Basic Wall
Type: Generic - 300mm + 100mm Exterior Fill
Total thickness: 300.0 Sample Height:
. Resistance (R): 0.0000 (m2-K)/W
Wl Thermal Mass: 0.00 KJ/K
fTTTTT T 1 .
1 . 1 Layers
1 Exterior | EXTERIOR SIDE
| Structural
Function Material Thickness fuctra
d Material
i Core Boundary  Layers Above Wra 0.0
2 |Structure [1] <By Category>  300.0 v
3 |Core Boundary Layers Below Wra 0.0
| . INTERIOR SIDE
_______ 1 Insert 1 Delete Up Down
" ]
1 . 1
i Interior Default Wrapping
L= At Inserts: At Ends:
Do not wrap b None b
Modify Vertical Structure (Section Preview only)
v Modify Merge Regions Sweeps
< >
Assign Layers Split Region Reveals
@D View: Floor Plan: Modify typ ~ Preview >> Cancel Help
7 Change the thickness of the exterior layer (Layer 1) to 100mm.
Edit Assembly X
A Family: Basic Wall
Type: Generic - 300mm + 100mm Exterior Fill
Total thickness: 400.0 Sample Height: 6000.0
. Resistance (R): 0.0000 (m2-K)/W
W:L Thermal Mass: 0.00 kJ/K
- Layers
EXTERIOR SIDE
Structural
Function Material Thickness Wraps fuctura
B! Material
1 |Structure [1] <By Category>
2 |Core Boundary Layers Above Wra 0.
3 |Structure [1] <By Category> 3000
4 |Core Boundary Layers Below Wra 0.0
INTERIOR SIDE
Delete Up Down
Default Wrapping
At Inserts: At Ends:
Do not wrap 4 None 4
Modify Vertical Structure (Section Preview only)
v Modify Merge Regions Sweeps
< >
Assign Layers Split Region Reveals
@D View: Floor Plan: Modify typ v Preview >> Cancel Help

8 Change the “Material” of the exterior layer (Layer 1) to “Concrete, Sand/Cement Screed”.
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Material Browser - Concrete, Sand/Cement Screed ? X
‘ Q| Identity | Graphics| Appearance Physical Thermal

Project Materials: All ‘r>

8i=

¥ Shading

Name

Concrete, Cast-in-Place - C7 5

Concrete, Cast-in-Place gray

Concrete, Precast

-
-

Use Render Appearance

(&C]lTl RGB 127 127 127

Transparency 0

¥ Surface Pattern

0

Pattern <none>

[@ellsTRRGB 0 00

1
Concretdl, Sand/Cement Screed

Copper

Damp-proofing

ENERERE

Default

Pattern Sand

Color [eiR]

8 ‘l'> Autodesk Materials ‘l'>

» Home Name

. Zinc

Bi-@ -8 «
s
Edit Assembly X
A Family: Basic Wall
al Type: Generic - 300mm + 100mm Exterior Fill
“ap Total thickness: 400.0 Sample Height: | 6000.0
ul Resistance (R): 0.0956 (m2°K)/W
W:l Thermal Mass: 14.04 KJ/K
- Layers
EXTERIOR SIDE
. . . ' Structural
LT - - Function Material Thickness Wraps fuctura
. - . - - - Material
- B ! -, - - - 1 |Structure [1] Concrete, Sand/ |1 100.0
2 |Core Boundary Layers Above Wra 0.0
3 |Structure [1] <By Category> 300.0
4 |Core Boundary Layers Below Wra 0.0
INTERIOR SIDE
Default Wrapping
At Inserts: At Ends:
Do not wrap b None >
Modify Vertical Structure (Section Preview only)
v Modify Merge Regions Sweeps
< >
Assign Layers Split Region Reveals
@n View: Floor Plan: Modify typ ~ Preview >> Cancel Help

9 Now add a Section View across the horizontal wall and go to that view to see the added exterior

layer.
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REEG - KR-7-8 2 -2 0A G0 % B 7 Wallyes Completed) - Stuctural PL. » | Tipe okepworaorprrase | @ [ ¢y 2, Signin W@ -&2x
Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =-
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i @ =
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B evel
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View Sl Sie
Scale Value 1 100 | = 3D Views
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Detail Level Fine ‘ ko 7
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Visibility/Graphics ... Edit... 3 | o
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Show Hidden Lines By Discipline =1 =t ™ Schedules/Quantities (all)
Color Scheme Loca... Background s @ ) sheets (all)
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Sun Path O ‘
EE El =
Erapsities el Apply 10 B ABHE R 0 BHIE < >
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REHG G-~ -8 =7 0A & 0[] & B+ Wl Layers Completed) - Section: Sec.. » [Type a keyword or phrase o & vt Lsignin W @ - &8 X
Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =~
b [ Window [P Roof * [ Curtain System B Railing ~ A} Model Text B Area - Y g: e o Wall S [} Show
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i ] Component ~  Ceiling [H Curtain Grid A Ramp [\, Model Line ‘: Sh‘ A Wy, Vertical Fcad | e 17 Ref Plane
all  Door _ y  Sha i =
- ) column = (S Floor - EH Mulion & Stair [@] Model Group ~ Tag Room * [ Tag Area - Face 7 Dormer
Select Build Circulation Model Room & Area ~ Opening Datum Work Plane
Properties x o () 52 ~ Project Browser - Wall Layers (Completed) X
— O, Views (all)
Section i a = Structural Plans
Building Section i Level 1
100 300 Level 1 - Analytical
: B
Section: Section 1 ~ | 6@ Edit Type ) Level 2 \ B Level 2
Graphics LIPS N ’ Level 2 - Analytical
Vi sl 3000
Scale Value 1: |50 £ 3D Views
Display Model Normal Analytical Madel
Detail Level Fine B0}
Parts Visibility Show Original (= Elevations (Building Elevation)
Visibility/Graphics ... Edit.. Fast .
Graphic Display Op... Edit... :"':h
Hide at scales coar... 1:100 o
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Crop View 0
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TERE MO To

3.4

(source: Autodesk Knowledge Network)

Detail Description of Structural Wall Instance Properties

https://knowledge.autodesk.com/support/revit-products/learn-

explore/caas/CloudHelp/cloudhelp/2017/ENU/Revit-Model/files/GUID-F1AD4E4F-3505-4B3F-8096-

61BAC86B7ACC-htm.html

Name

Description

Constraints
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Name Description
Location Line Specifies the position of the wall with respect to the line sketched in the project

elevation. For more information, see Place a Wall. The wall location line remains the
same for that wall, even if the type changes.

Base Constraint Specifies the level from which the wall base is referenced.
Base Offset Specifies the offset of the base of the wall from its base constraint.
Base is Attached Indicates whether the base of the wall is attached to another component, such as a

structural floor. This is a read-only value.

Base Extension Distance Indicates the distance you have moved the base of the layers in a wall.
See Compound Structure. This parameter is enabled when the layers of a wall are
set to extendable.

Top Constraint The name of the level to which the wall top is set.

'Unconnected Height if top constraint is unconnected, you may set an unconnected height of the wall. This
value is read-only if there is a top constraint.

Top Offset Specifies the offset of the top of the wall from its top constraint; enabled only when
the top constraint is set to a level.

Top is Attached Indicates whether the top of the wall is attached to another component, such as a
structural floor. This is a read-only value.

'Top Extension Distance  Indicates the distance you have moved the top of the layers in a wall. See Compound'
Structure. This parameter is enabled when the layers of a wall are set to extendable.

'Room Bounding Indicates whether the wall is part of a room boundary. This parameter is enabled after
you place the wall.

'Related to Mass 'This is a read-only value.

Structural

Rebar Cover - Exterior Specifies the rebar cover distance from the wall exterior face.
Face

Rebar Cover - Interior Specifies the rebar cover distance from the wall interior face.

Face

Rebar Cover - Other Specifies the rebar cover distance from the faces of adjacent elements.
Faces

‘Estimated Reinforcement'Specifies the estimated reinforcement volume of the selected element. This is a read-
Volume only parameter that only displays when rebar has been placed.

Structural Specifies the wall as being a structural element able to posses an analytical model.

‘Enable Analytical Model IDispIays the analytical model and includes it in analytical calculations. Selected by'
default. See Disable an Analytical Model.

Structural Usage Either Bearing, Shear, or Structural Combined. The structural use of the wall.

Dimensions
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Name Description
Length Indicates the length of the wall. This is a read-only value.
'Area 'Indicates the area of the wall. This is a read-only value. '
'Volume 'Indicates the volume of the wall. This is a read-only value. '

'Identity Data

Comments A field for entering comments about the wall.

Mark A label created for the wall. This value must be unique for each element in a
project. Revit warns you when the number is already used but allows you to continue
using it. You can see the warning using the Review Warnings tool. See Review
Warning Messages.

'Phasing
'Phase Created Indicates in which phase the wall component was created. See Project Phasing. '
'Phase Demolished Indicates in which phase the wall component was demolished. See Project Phasing.'
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CHAPTER 4 - STRUCTURAL BEAMS (STRUCTURAL FRAMING) and BEAM
SYSTEMS

Structural beams are categorized as structural framing in Revit. Usually beams are placed after
creating datum (grids / levels) and vertical elements (columns / walls). You can Create/Customize
structural beam family for special use (to be covered later in this course). In this section, you will learn

e How to add structural beams.

e QOptions in beam placement.

e How to add a system of beams (Beam System).
e Options in annotating beams.

4.1 Adding Beams with default settings
To add structural beams in Revit,
1 Open from the course folder the “Beams.rvt” file.

2 Click Structural Tab » Beam in Structure panel.

ReZBG:- 0 -0-8 2 - A @A @-® 5 G BeamsandBeam Systems - Structural . ¥ [7y0e o keywora or pvose 8 5 vr Lsonin B @ - &@x
File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =-
[ Q wall - [ Truss % & @ 7 ## Area [ Fabric Sheet g] £ Model Text by g}g 2 Wall i)
: () column B Brace i w3 Path [ cover [%. Model Line w2z = Ry Vertical 7
Modify| |Beam . Me . Connection Isolated Wall Slab  Rebar B, Eabi Component . By Shaft o Grid Set
- B Fabric Area &3 Rebar Coupler - [ Model Group = Face I Dormer [
Structural Framing: Beam (BM) -y Foundation Reinforcement ~ Model Opening Datum  Work Plane
Adds individual beams, a chain of beams, or beams along grid
b= = (3 5% ~ Project Browser - Beams and Beam Syste... X
Add grids and columns before adding beams. =10, Views (all)
5) Structural Plans
= Level 1
@ Level 1 - Analytical
— —@ '_‘ Level 2
Level 2 - Analytical
Site
= 3D Views
Analytical Model
—x—) B0
| = Elevations (Building Elevation)
East
Press F1 for more hel © Nerth
¢ - e ::J]E:l North soulh
Wall Join Display  |Clean all wall joins ‘f"*“ L .
o Sections (Building Section)
Discipline Structural 7 Legends
Show Hidden Lines By Discipline I Schedules/Quantities (al)
Color Scheme Loca... Background Sheets (al])
Color Scheme B @—- i . 1 & 2] Families
System Color Sche... | ' ' # [@] Groups
Default Analysis Di... & Revit Links
Sun Path
P a v v
Properties help Apply 1:100 ERE G QEREY 0 TS < >
Click to select, TAB for altenates, CTRL adds, SHIFT unselects. (/t 2 0 & B Main Model HERDLN O T

3 Inthe Properties Palette, select “300 x 600mm” type from Concrete-Rectangular Beam types.
4 Keep all options unchanged.

5 Pick the start point of the beam on the grid intersection Grid-A-1, then pick the grid intersections
along Grid-A. After picking the intersection point Grid-5-A then press “esc”.

6 Repeat Step 5 and add “300 x 600mm” beams along Grid-B.
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Re8G-&-4-Ql2- 0AG- > &DB Baams - Structural Plan: Level 2

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =~

[y Q wall - [ Truss @ & @ P, ## Area [ Fabric Sheet g] £ Model Text =R ale o wal &
aE
e [} column [ Brace [ cover 22 73
ify| Beam

M 5 vy Lsignin W @ - &x

.3 Patl Model Line Vertical
3 path I Model * g Vertical

Connection Isolated Wall Slab Rebar ‘ Component By Shaft Grid Set
¢~ Floor = [[[] Beam System - B Fabric Area &3 Rebar Coupler - [ Model Group = Face I Dormer # [

Select + Structure ¥ Connection = ¥ Foundation Reinforcement ~ Model Opening Datum  Work Plane

Properties x — (3 53 ~ Project Browser - Beams x
® ® 0l0] A
:im ructural Plan ' ! | ! ! ! ! & Level 1
Level 1 - Analytical

Structural Plan: Level 2 ~ B Edit Type ! ! l ! ! ! ‘ h Level 2

Graphics * A @— -—- -$—- $ ---q} ; $— - —ﬁ— -— Level 2 - Analytical

View Scale . , . | | Lo Site

Scale Value 1: (100 | | | | | | = 3D Views

Display Model Normal I | | ' | Vo Analytical Model

Detail Level Fine | | | | 130}

parts Visbity Show Original | h | Vo = Elevations (Building Elevation)

Visibility/Graphics ... Edit... | | ‘ [ ] :‘m N

Graphic Display Op..___Edt. | ' | i I L ot

Orientation Project North . ¥ —fi—————af} qélf == West

‘Wall Join Display Claan all wall joins ‘ | | ‘ ‘ ‘ El Legends

Discipline Structural | | ! , | Lo I3 Schedules/Quantities (al)

Show Hidden Lines By Discipline | ‘ | | ‘ ‘ ‘ Sheets (all)

Color Scheme Loca... Background | | | | | Lo & 1] Families

Color Scheme <none> | | | | | | B [@] Groups

System Color Sche.. | Edit.. | ! ! ' ' ! Lo &8 Revit Links

Default Analysis Di.. None | | | | L

Sun Path O . 777%7{777177777]'77777%77777%7 L o
T s ©— ~ef— v
R Apply 1:100 FRA G GEWME D 0 BHE < >
Grids : Grid : € il & 0 [ B Main Model TEBD O T

Now, add some steel beams

7 Inthe Properties Palette, select “UB305x127x37” type from UB-Universal Beams types.

8 Pick the intersection point Grid-A-5 and then pick the grid intersection Grid-A-7. Press “esc”.
9 Pick the intersection point Grid-B-5 and then pick the grid intersection Grid-B-7. Press “esc”.

10 Pick the column between Grid-1 and Grid-2 on Grid-C. Then pick the grid intersection points along
Grid-C (skip grid intersection point Grid-C-6). Press “esc”.

11 Add other beams as shown below.

300 x 600

400 x 800mm

300 x 600mm
300 x 600mm

?
|
P
|

i
I
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12 Click = to view the beams placed in 3D.

REEHG-K-7-8 =2-FOA @ 05 &B->  Beams(Completed)-3D View: (30} »

Architecture ~ Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View Manage Add-ins  Modify @«

[y Q) wall = [ Truss [% & 9 e, ## Arca g] £ Model Text b Q:E 2 Wall @ B
. [ coumn B Brace w3 Path Cover I%, Model Line o
odif eam

88 5 & Rsgn w ® - &x

* Ry Vertical
Connection  Isolated Wall Slab  Rebar Component By Shaft Set

(e Floor =[] Beam System B Fabric Area 1 Rebar Coupler [@&] Model Group = Face I Dormer [
Select ~ Structure s Connection * ¥ Foundation Reinforcement = Model Opening Datum  Work Plane
Properties x . (3 53 ~ Project Browser - Beams (Completed) x
=1 .0, Views (all)
9 40 View - = Structural Plans
Level 1
Level 1 - Analytical
3D View: (30} ~ % Edit Type ot
Graphics 2 A Level 2 - Analytical
View Scale Site
Scale Value 1: 100 (@) = 3D Views
Detail Level Fine Analytical Model
Parts Visibility Show Original X Bop )
Visibilty/Graphics .. i | i = Elevations (Building Elevation)
Graphic Display Op..| _ Edit.. Fast
Discipline Structural North
Show Hidden Lines [By Discipline South
West
Default Analysis Di... None ) Legends
Sun Path O [ Schedules/Quantities (all)
Extents : Sheets (ol
Crop View O #- B Families
Crop Region Visible [ i [@] Groups
Annotation Crop ] &8 Revit Links
Far Clip Active ]
Far Clip Offset 304800.0
PP (] v v
Properties help Apply 1:100 B QAGRBHE > o @A GE< 2
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. i || Main Model LR R e v
4.2 Options in Beam Placement

There are many options available to help you to place beams in Revit. Many of the options are self-
explanatory. You can hover over the option and see its description and press F1 for more help. Under
the contextual ribbon tab, the options for beam creation and placement are:

e Draw by: Line / Start-End-Radius Arc / Center-ends Arc / Tangent End Arc / Fillet Arc / Spline
/ Partial Ellipse / Pick Lines.

e Place beams: On Grids / Tag on Placement.

e Placement Plane: Select an available structural level.

e Structural Usage: <Automatic> / Girder / Horizontal Bracing / Joist / Other / Purlin.

e 3D Snapping / Chair

__ A= o~ o~ 80 < i
v | Ko - 58 B QLplg == /-9 = A arC o -
: Ve KDz = = 3 !

Slat - =&+ + — oo 6] & T - 11A D 4 =
Modify| !_' _ ) " PN (O} O =jT oy =2 ® . T Load I On Tag on |
= M W GJO'" M S + Q I =7| gEl X FamilyI ¥  Grids  Placement]
Select ¥ Properties  Clipboard Geometry Modify View Measure Create Mode Draw Multiple Tag |

4.3Adding a system of beams (Beam System)

Revit provides an easy way to add a system of beams within a closed boundary of area. It is called
Beam System in Revit. To add a system of beams (Beam System),

1 Open from the course folder the “Beam System.rvt” file.

2 Click Structural Tab » Beam System in Structure panel.
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File Architecture  Structure | Systems.

Q) wall - 8 Truss
[ column [ Brace

Ly
Modify| Beam

ReEHG- Q-7 -Q=2-F0A G Q% & % BeamSystem (Completed) -Stuctural..  »[lpecrepodomoe |88 & ft L signin W @ - & X
Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify -
@ & Q = # Area [ Fabric Sheet g £ Model Text =R ale o wal &
E]
3 Path [ Cover I\, Model Line B Ry Vertical 7
Connection lsolated Wall Slab  Rebar Component By Shaft Grid Set
- -abric Area ar Coupler - lodel Group * ormer
Fabric Area &1 Rebar Coupl Model G e D =
[ Foundation Reinforcement ~ Model Opening Datum  Work Plane

Structural Beam System (BS)

of a series of parallel beams.

constraints and the Pick Supports tool to define
a beam system.

Press F1 for more help
Structural

Discipline
Show Hidden Lines By Discipline
Color Scheme Loca... Background
Color Scheme <none>
System Color Sche... Edit...
Default Analysis Di...
Sun Path

Mene

[}

v

S ®
Properties help Apply

Creates a layout that is used to control the number and spacing

Beam system boundaries can adapt to changes in the design. Use

P

the boundary of

?

Py
\

‘ o

\
e
;
l

|

|

R a

| I—

O

©——+-

-
T

%

]
|
|
|
%
+
|

¢

1:100 P& MR 0 RMIE <

e EEe

= (3 5% ~ Project Browser - Beam System (Complet... X

=10, Views (all)
Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
£ 3D Views
Analytical Model
30

East
North
South
West
’.'__"| Legends
™ Schedules/Quantities (all)
[ Sheets (all)
F B Families
& [@] Groups
&8 Revit Links

= Elevations (Building Elevation)

Grids : Grid * 1

Irid

&0 =] M Main Model

T M O Fo

3 There are two ways to add a Beam System. One is Automatic (set as default) and the other is by
Sketch where you can draw the boundary of an area to place the system of beams. By default, all
beams in the system will be tagged. Click the “Tag on Placement” to change the tag option.

Beam System

Beam System| Beam System |Placement

Tag

4 Set the Beam Type, Justification, Layout Rule, Tag Style as shown below.

Beam Type: 300x600mm v

Justification; Center

* Layout Rule: Fixed Number v

[}

DS[‘ Walls Define Slopt | Tag Style: Framing

v

5 Hover the cursor near the beam on Grid-A and between Grid 4 and Grid-5, you will see a tentative
beam system displayed. Click to add the indicated beam system.

T
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ReHG 6@ Qe FO0A G 0 E EE ~ bt Complead) St +[recimoromoe |88 & Ssom - W @ - & X

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Madify | Place Structural Beam Systern =2~

N g Q wall - [ Truss % & @ Ve, B ## Area [ Fabric Sheet £ Model Text % gjg A Wall @ 1)

2
Column [ Brace 3 Path [ cover [%. Model Line * Wy Vertical 7
Modify =~ Beam 0 2] Connection  Isolated Wall Slab  Rebar ) 8 Component By Shaft A o Gid  Set 4
¢~ Floor = |[[l] Beam System - B Fabric Area &3 Rebar Coupler - [ Model Group = Face I Dormer
Select ~ Structure ¥ Connection ™ ¥ Foundation Reinforcement ~ Model Opening Datum  Work Plane
Modify | Place Structural Beam System Beam Type: 300 x 600mm ~  Justification: Center ~ layout Rule: Fixed Number ~ 3 O3t ‘Walls Define Slope Tag Style: Framing ~
Properties x CP @ @P @ C? @ — (i 53 ~ Project Browser - Beam System (Complel... X
=110, Views (all)
Structural Beam System . ' ' ' ' I [ ol & Structural Plans
Structural Framing System | | | \ | | S Level 1
i i | ' | o y Level 1 - Analytical
Structural Beam Systems (1)~ & Edit Type (Ay—-—- o - [} L
. . ’ P K . ) Level 2 - Analytical
ED) (] e | | Site
Elevation 00 | 300s [ = 3D Views
Work Plane Level : Level 2 —_ Analytical Model
h 1| ' i
Pattern ’ e | ] v )
Layout Rule Fied Number = = - = Elevations (Building Elevation)
Number of Lines 3 || :“:m
T o
Centerline 5 -— {
enterine Spacing i O ot
lustification Center | ‘ ‘ ‘ ‘ | |
H West
Idﬂzar‘n T;:‘: Concrete-Rectangular ... . | i i i i | i B Legends
lentity I3 Schedules/Quantities (all)
Image | i i | I L [ Sheets (al)
Comments | ‘ ‘ ‘ ‘ | | i+ F1) Families
' I | ' I o
Mark i [@] Groups
| | | | B S
' ' ' ' o
I _ T T 1. L. T, P —
©— =4 b : I
' i I ] I [
§ | | | | | 1 e
Properties help Apply 1:100 FRE IR EBE D 0 RIS < £
Select a support to create a Beam System parallel to that supj &7 < 0 [ 3 Main Model b == N i N Y )

When you select a Beam System, you can then edit its boundary and the direction of the beams or
remove the beams from the Beam System.

L g g

_f__! e — - I[ } Edit Remove

1] ' ' . Boundary Beam System
1 Mode  Beam System

Modify | Structural Beam Systems > Edit Boundary

| X Moo 529

||| Beam Direction  *
J H” eam Direction ® 5> X% .

Mode Draw

e —

' Modify | Structural Beam Systems > Edit Boundary

x [L Boundary Line /@ﬁ -
p [HEeam Diecion .

Mode Draw

1l

4.4Beam Tag/Annotation
To control how the beams are tagged/annotated,

1 Select the beams in the beam system.
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e e — )y i
N (L

5 300x 2o |

6002:1’ T

3000 |

iE [

300x 2 I

6002:1’

1 3000 |

| |

300x 2o (i

1 6002:1’

| 3000 i
- [

e

7
2 Click “Annotation” Tab » Beam Annotations == in Tag panel.

3 Click the builder button of the middle bottom tag and change the Display Elevation to “Bottom
Elevation” then click OK.

Beam Annotations ? s

Use this tool to place beam annotations, tags and spot elevations, on the beams in your current plan view.
Beam annotations can be placed at the ends and mid-points of level and sloped beams. They can also be placed on either side of the beam.

Select the annotation type and location. A schematic preview is given below.

i ?
Placement Select Annotation Type ? X

() All beams in current plan view Select Element to Place

(®) All selected beams in current plan view (O)None
Dlnclude beams from links (O Structural Framing Tag
Remove existing beam tags and spot elevations ®) Spot Elevation
o Beams that have existing host file annotations will not be reannotated. Spot Elevation }
Type:
Annotation location and type Beam Elevation (Project) v ‘
Level beams in plan  Sloped beams in plan Relative Base:
Current Level ~
== 1
<Start> ‘ El M_Structural Framing Tag : E| El I Display Elevation: 1
: ‘Bottom Elevation Ll

[1Do not place when value is equal to:

0 mm

OK | ‘ Cancel

<Start> ‘ El Beam Elevation (Project) |: El :

OK | ‘ Cancel
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The annotation of the selected beams will change to

5
ﬁ

i 300 x [
600mm 1

B0

300 x
600mm

B 2400

300 x
600mm

1 n TBaw |

= _ T
=
|

Notes on Beam Annotation:
e The Beam Annotations tool is only available when working in a structural plan or ceiling
plan view.
e Atleast one structural framing tag specified to “Rotate with Component” in their family
parameters must be loaded for the tool to be available.
o Ifnobeam s selected, the Beam Annotations tool will tag all beams in the current view.

4.5 Detail Description of Structural Beam Instance Properties

(source: Autodesk Knowledge Network)

https://knowledge.autodesk.com/support/revit-products/learn-

explore/caas/CloudHelp/cloudhelp/2016/ENU/Revit-Model/files/GUID-89D4AB0D-4D2E-4391-802E-

F8AF478637FC-htm.html

Name

Description

Constraints

Reference Level

The constraining level. This is a read-only value that is dependent on the work plane on
which the beam was placed.

'Work Plane

The current plane on which elements are placed. This is a read-only value.

'Start Level Offset

IThe distance of the beam start point from the reference level. Values entered here are'

reset when the member is pinned. Read-only when pinned.
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Name Description
End Level Offset The distance of the beam endpoint from the reference level. Values entered here are reset

when the member is pinned. Read-only when pinned

'Orientation IThe beam orientation to the current plane on which elements are placed. This is a read-'
only value.

Cross-Section ‘Controls rotating beams and braces. The angle of rotation is measured from the beam’s

Rotation work plane and the direction of the center reference plane.

Construction (Pre-2014 projects)

Start Extension Applies to steel beams only. The dimension between the edge of the start end of the beam
and the element to which it is connected.

This parameter is only available in projects created in versions prior to Autodesk Revit 2014
containing beam families that have not been updated. It is recommended to use the
Geometric Position Start Extension below. Using both is an additive extension.

'End Extension IAppIies to steel beams only. The dimension between the edge of the finish end of the'
beam and the element to which it is connected.

This parameter is only available in projects created in versions prior to Autodesk Revit 2014
containing beam families that have not been updated. It is recommended to use the
Geometric Position Start Extension below. Using both is an additive extension.

'Materials and Finishes

Structural Material Controls the hidden view display of structural elements. Concrete or Precast will display'
as hidden. Steel or Wood will be visible when another element is in front of it. Unassigned
will not display if hidden by another element.

See Change the Physical Properties of a Material.

'Structural

‘Stick Symbol Applies to steel beams only. '

Location

Start Connection IAppIies to steel beams only. A moment frame, or cantilever symbol at the start end of a
beam.

'End Connection 'Applies to steel beams only. A moment frame, or cantilever symbol at the finish end of a
beam.

'Cut Length IThe physical length of the beam. This is a read-only value. '

Structural Usage Specifies the usage. Either Girder, Horizontal bracing, Joist, Other, Purlin, or Chord.

'Start AttachmentlEither End Elevation or Distance. Specifies the elevation orientation of the beam. End'

Type Elevation maintains the placement level and Distance orients to the join location on a

column. See About Adjusting the Beam Elevation at Column Join.
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Name Description
Start Attachment Specifies the offset of the beam start from the column connection point when Start
Distance Attachment Type is set to Distance. See About Adjusting the Beam Elevation at Column
Jain.

‘End of Referenced Specifies either the Top or Bottom of the beam from which the Start Attachment Distance
Column is determined. See About Adjusting the Beam Elevation at Column Join.

End Attachment Type Either End Elevation or Distance. Specifies the elevation orientation of the beam. End
Elevation maintains the placement level and Distance orients to the join location on a
column. See About Adjusting the Beam Elevation at Column Join.

End AttachmentISpecifies the offset of the bean end from the column connection point when End
Distance Attachment Type is set to Distance. See About Adjusting the Beam Elevation at Column
Join.

End of ReferencedISpecifies either the Top or Bottom of the beam from which the End Attachment Distance
Column is determined. See About Adjusting the Beam Elevation at Column Join.

Rebar Cover - Top Applies to concrete beams only. The rebar cover distance from the beam top face.
Face

Rebar Cover - Bottom Applies to concrete beams only. The rebar cover distance from the beam bottom face.
Face

Rebar Cover - Other Applies to concrete beams only. The rebar cover distance from the beam to adjacent
Faces element faces.

Estimated Applies to concrete beams only. Specifies the estimated reinforcement volume of the
Reinforcement selected element. This is a read-only parameter that only displays when rebar has been
Volume placed.

Camber Size Applies to steel beams only. The beam camber.

Number of Studs Applies to steel beams only. The number of studs per beam.

‘Enable Analyticall Displays the analytical model and includes it in analytical calculations. Selected by default. '
Model See Disable an Analytical Model.

Dimensions

'Length The length between beam handles. See About Beam Handles. This is the analytical Iength'
of the beam. This is a read-only value.

'Volume ‘The volume of the selected beam. This is a read-only value. '

IEIevation at Top IIndicates the elevation used for tagging the top of the beam. This is a read-only parameterl

that reports Varies for sloped planes.

Elevation at Bottom  Indicates the elevation used for tagging the bottom of the beam. This is a read-only parameter
that reports Varies for sloped planes.

'Identity Data
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Name Description
Comments User comments.
‘Mark A label created for the beam. Possible use: shop mark. This value must be unique for

each element in a project. Revit warns you if the number is already used but allows you
to continue using it. You can see the warning using the Review Warnings tool. See Review
Warning Messages.

'Phasing

Phase Created Indicates in which phase the beam component was created. See Project Phasing.

'Phase Demolished Ilndicates in which phase the beam component was demolished. See Project Phasing.

Geometric Position

Start Extension Applies to steel beams only. A dimension that adds beam geometry beyond the start end
of the beam.

'End Extension IAppIies to steel beams only. A dimension that adds beam geometry beyond the finish end '
of the beam.

'Start Join Cutback IAppIies to steel beams only. The dimension between the edge of the start end of the beam '
and the element to which it is connected. Only for the joined start of the element.

'End Join Cutback IAppIies to steel beams only. The dimension between the edge of the finish end of the'
beam and the element to which it is connected. Only for the joined end of the element.

yz Justification Applies to steel beams only. Either Uniform or Independent. Uniform allows setting the
same parameters to both start and end of a beam. Independent allows setting different
parameters to start and end of a beam.

'y Justification IAppIies to Uniform justified steel beams only. Specifies the location of the physicall
geometry with respect to the location line: either Origin, Left, Center, Right.

'y Offset Value IAppIies to Uniform justified steel beams only. The numeric value that offsets the geometry.'
The distance between the location line and the characteristic point set in y Justification
parameter.

z Justification Applies to Uniform justified steel beams only. Specifies the location of the physicall

geometry with respect to the location line: either Origin, Top, Center, Bottom.

z Offset Value IAppIies to Uniform justified steel beams only. The distance between the location line and'
the characteristic point set in z Justification parameter.

Start y Justification IAppIies to Independent justified steel beams only. Specifies the location of the physicall
geometry of the start end of the beam with respect to the location line: either Origin, Left,
Center, Right.

Start y Offset Value  Applies to Independent justified steel beams only. The numeric value that offsets the
geometry at the start end of the beam. The distance between the location line and the
characteristic point set in the Start y Justification parameter.

'Start z Justification IAppIies to Independent justified steel beams only. Specifies the location of the physicall
geometry with respect to the location line at the start end of the beam: either Origin, Top,
Center, Bottom.
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Name Description

Start z Offset Value  Applies to Independent justified steel beams only. The numeric value that offsets the
geometry at the finish end of the beam. The distance between the location line and the
characteristic point set in the Start z Justification parameter.

‘End y Justification IAppIies to Independent justified steel beams only. Specifies the location of the physicall
geometry of the finish end of the beam with respect to the location line: either Origin, Left,
Center, Right.

‘End y Offset Value IAppIies to Independent justified steel beams only. The numeric value that offsets the
geometry at the start end of the beam. The distance between the location line and the
characteristic point set in the End y Justification parameter.

'End z Justification IAppIies to Independent justified steel beams only. Specifies the location of the physicall
geometry of the finish end of the beam with respect to the location line: either Origin, Left,
Center, Right.

End z Offset Value  Applies to Independent justified steel beams only. The numeric value that offsets the
geometry at the start end of the beam. The distance between the location line and the
characteristic point set in the End z Justification parameter.

Other
Start Extension Applies to steel beams only. Specifies family parameters; defines maximum distance of
Calculation start extension parameter.
This parameter is only available in projects created in versions prior to Autodesk Revit 2014
containing beam families that have not been updated.
This is a read-only value.
End Extension Applies to steel beams only. Specifies family parameters; defines maximum distance of
Calculation end extension parameter.

This parameter is only available in projects created in versions prior to Autodesk Revit 2014
containing beam families that have not been updated.

This is a read-only value.
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CHAPTER 5 - STRUCTURAL FLOORS (SLABS)

Slabs are called Floors in Revit. They are loadable families in Revit. You can Create/Customize
structural floor family for special use (to be covered later in this course). In this section, you will learn

e How to add structural floors.

e Options in floor placement.

e How to edit boundary of a floor.
e Add slabs with metal deck.

5.1 Adding Floors with default settings
To add structural floors in Revit,
1 Open from the course folder the “Floors.rvt” file.

2 Click Structural Tab > Floor in Structure panel. (The default option is Floor: Structural.)

ReBG-a-2-@a-FlO0oA G- B+ Floors - Structural Plan: Lavel 2 Type @ keyword or phrase o8 vy Lsignin W @ - & X

Architecture ~ Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View Manage Add-ins  Modify @«

[ Qwall = 0 Tuss % & ég = Eg # Area B Fabric Sheet g] £ Model Text = g:g 2 Wall 3
[ column B Brace w3 Path & cover It Mode! Line 223 E g Vertica I3
Modify| Beam Connection  lsolated Wall Slab  Rebar Component By Shaft o Grid  Set
= Floor[-] [ Beam System . [ Fabric Area ®) Rebar Coupler - [&] Model Group *  Face I Dormer =
¥ Foundation Reinforcement Model Opening Datum  Work Plane
Floor: Structural (58)
Creates a structural floor (slab) for the current level of the building
model = (7 5% ~ Project Browser - Floors x
& 10, Views (al)
To align the floor with existing walls, use the Pick Walls tool. Or to @ = Structural Plans
sketch the floor boundaries, draw lins or pick existing lines in the i ' ! ! ' . & Level 1
model | [ | | ‘ || ) Level 1 - Analytical
) . . E
The floor s offset downward from the level on which it is created. | _ | : f“;_.i_'._ I ) Level 2
Level 2 - Analytical
L
o | ‘ Site
! = = | ! = 3D Views
o || Analytical Model
et
— ! B0}
sdtme | ‘ = Elevations (Building Elevation)
S
— . East
I i i | North
N S e & — O o
\ | | \ L West
| . i . P B Legends
| | | ‘ ‘ [ I3 Schedules/Quantities (al)
Press F1 for more help ‘ | Sheets (al)
Color Scheme Loca... Background ! | ‘ ‘ [ & 51 Families
Color Scheme  <none» ] ‘ | | | | || - [@] Groups
System Color Sche... Edit... , . . , H . ©8 Revit Links
Default Analysis Di... None ©—— = T ! f———
Sun Path 0 I i | | j v
T i | I | | I |1 v
Properties help Apply 1:100 BBk ERE D 0 CRAGTE < 5
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7 P B Main Model LR 1 s v )

3 Inthe Properties Palette, select “Generic —300mm” type from Floor types.

4 Select “Boundary Line” and pick “Rectangle” from the Draw panel. Keep all options unchanged.

x |[L Boundary Linel / UICKG I
@ Slope Arrow ,-"'{: P ' JV' -
'@ Span Direction S D .(L{ﬁ ﬁ -

Mode Draw

5 Pick the first point of the rectangle at Grid-A-1, then pick at Grid-B-2 to finish drawing the rectangle.
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6 Click Finish Edit Mode “to add the floor. You will be asked “Would you like walls that go up to
this floor’s level to attach to its (the slab’s) bottom”. Click “No” such that top of the walls will remain

unchanged.

ReB8aG -®-2-Ql2-A0A G -o5Had~ Floors - Structural Plan: Level 2 »[Dpesiemodorpnose |00 8y & Signin W @ - &x
File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =~
Select * Structure ¥ Connection ™ ¥ Foundation Reinforcement ~ Madel Opening Datum  Work Plane
Properties x ‘ — (g 5% ~ Project Browser - Floors x
=110, Views (all)
-Flmr . | @l = Structural Plans
Generic 300mm Revit « - Level 1
Level 1 - Analytical
- i i X - LY

[ e Ed“:'pe Would you like walls that go up to this floor's . Level 2
g = level to attach to its bottom? | Level 2 - Analytical

Level Level 2 . Site

Height Offset Fro.. 0.0 = 3D Views

Reom Bounding - Analytical Model

e N

Related to Mass I. e B0}
Structural ] = Elevations (Building Elevation)
Structural :‘“‘h

Enable Analytical M... ‘ < ur:h

Rebar Cover - Top ... Rebar Cover 1 <25 .. V:e‘;t

Rebar Cover - Bott... Rebar Cover 1 <25 ... = Legends

Rebar Cover - Othe... Rebar Cover 1 <25 .. i I Schedules/Quantities (all)
Dimensicns * [ sheets (al)

Slope ‘ & B Families

Perimeter #-[@] Groups

Area ‘ ®8 Revit Links

Volume

Hlevation at Top  |Varies

Properties help Apply

1:100 BRI G GERE R 0 RIE <

Ready rid 2 0 @3 Main Model TERRDOF
ReEG-G- -8 2-JOoAle-oal - Floors - Structural Plan: Level 2 ¥[neeakemordorpnrase |3 S ¥ A Signin W @ - & x
File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =~
[y 0 wall = B Truss % (_U} Q =] E:g # Area [ Fabric Sheet gj £ Model Text b E:E 2. wall B
-~ 4 . 22 %
Column [ Brace 3 Path Cover Model Line By Vertical 173
Modify| Beam g Connection  Isolated Wall ~Slab  Rebar = Component IL By Shaft e FGid st =4
(o Floor = ﬂ]]] Beam System = \_& Fabric Area #&1 Rebar Coupler 2 [‘b] Model Group ~  pee [° Dormer @
Select ~ Structure ¥ Connection ¥ ¥ Foundation Reinforcement ~ Model Opening Datum  Work Plane
Properties x — (3 52 ~ Project Browser - Floors x
= O, Views (all)
I, i L( [ Structural Plans
il Level 1
| Level 1 - Analytical
Structural Plan: Level 2 ~ (B Edit Type ‘ ‘ X | 1 Level 2
Graphics * A Level 2 - Analytical
iew e | | | |
ScaleValue 1:  |100 | | | | 3D Views
Display Model  Normal ®_ o — _$,, E— Analytical Model
Detail Level Fine 1lr ki 30)
Parts Visibility Show Original i : [ T 2o [ Elevations (Building Elevation)
mm
Visibility/Graphics ... Edit... 1 I l | - Fast
B ; | | | Vi North
Graphic Display Op.. Edit.. . i ' South
Orientation Project North 1 300 x o
Jall Join isplay Clean all wall joins | | e st
Wall Join Display  Clean all wall joins . - — 7 Legends
Discipline Structural . f i 1 Schedules/Quantities (]
Show Hidden Lines By Discipiine | + | oo ) Sheets (al)
Color Scheme Laca... Background | : | i ; — & 2] Families
Color Scheme <none> i 1 ¥ F [@] Groups
System Color Sche... Edit... o _‘1 { l &8 Revit Links
Default Analysis Di.. None f—fu"' = a5 e
Sun Path ) ‘ | |
IE 2 bt
Properties help Apply 10 FIE Gk GMEP ¢ RRIE ¢ ’

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. /7

5.2

) M Main Model

Options in Creating the Floor Boundary

T O M O o

There are many options available to help you to define the boundary of a floors in Revit. Many of the
options are self-explanatory. You can hover over the option and see its description and press F1 for
more help. Under the contextual ribbon tab, the options for creating floor boundary are:

e Draw: Boundary Line / Slope Arrow / Span Direction
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e Draw by: Line / Rectangle / Inscribed Polygon / Circumscribed Polygon / Circle / Start-End-
Radius Arc / Center-ends Arc / Tangent End Arc / Fillet Arc / Spline / Ellipse / Partial Ellipse /
Pick Lines / Pick Walls / Pick Supports.

e Options: Chair / Offset / Radius

e Note: By default, Revit will extend the floor into wall (to core). If you do not want the floor to
be extended into wall, uncheck this option before you click on any of the boundary creation

d Offset:| 0.0 Exten:d into wall (to core 1

metho
Modify | Create Floor Boundary &~

|[k Boundary Linel /'D UICKOIR
@ Slope Arrow ‘-"‘ . P{‘- ‘5\;” =
) Span Direction & D /[{ ﬁ =

Mode Draw

Now, draw all the floors as shown using Rectangle or any method available. All the floors are Generic
300mm. (Note: Floors are created one at a time. You cannot create two or more floors at the same
time.)
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5.3Edit Floor Boundary and Span Direction

1 Go to Structural Plan / Level 2.

2 Select the top right floor and click Edit Boundary.

ReEEBG-QR-7-8 =2 O0A @05 &> FoosCompleted - Stuctural Plan: .. [l orepmonopnae |68 & g¢ D Signin W @ - &x
File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins Mcdlfy | Floors =2~
N % ¥ cope - [0 §) E @ DQ :: e Q- — [&][(Eﬁ : m /,‘ A Add Point Dl
o=
O S - ‘== ..' n S5 75e £P Add Split Line # B
Mod ) ,n‘ O i = ® @ 1 e |H;ghlught Modify
¥ G- ¥ 4 Hx G B¢ IBoundary JAnalytical Sub Elements B Pick Supports |
Select ~ Properties  Clipboard Gaome(ry Modify View  Measure  Create | Mode  |Analytical Shape Editing Reinforcement
Modify | Floors
Properties x — (5 52 ~ Project Browser - Floors (Completed) x
S |E O] Views (al)
7 o,
- Floor a o @ = Structural Plans
Generic 300mm [,m Level 1
| ' ! ! ! ! 'l Level 1 - Analytical
Floors (1) ~ |28 Edit Type ‘ | | | ‘ ‘ B Level 2
C A N ) . , | v e Level 2 - Analytical
Level Lovel 2 @____.-1 S o DI, , S Site
Height Offset Fro.. 0.0 ‘Ir 1:‘|r 1“"‘r = 3D Views
Room Bounding | ) b Analytical Model
Related to Mass I I i ‘ ‘ || @)
T — I I | | . - = Elevations (Building Elevation)
Structural j IR | ‘ ‘ Easlh
Enable Analytical M... [v/] : N . ! [ ::r:h
Rebar Cover - Top ... Rebar Cover 1 <25 ... i ; k 5 ! ‘ ‘ Wel:t
Rebar Cover - Bott... Rebar Cover 1 <25 .. ! i i == =
| i il il | | | 57 Legends
Rebar Cover - Othe... Rebar Cover 1 <25 ... i 'n i i - ‘ ‘ [T Schedules/Quantities (all)
Dimensions : [ 5 SRR [ SRR R S (. SRR A | [ Sheets (all)
B 1Lk 1r LF 1 ——
Slope 1+ B Families
Perimeter 17000.0 | | | ‘ ‘ i [@] Groups
Area 15.000 m* ! ! ! ! ! ! ! ®8 Revit Links
Volume 4500 m* ‘ | | | ‘ ‘ ‘
Elevation at Top 3000.0 . 1 I 1 1 | | [
P anias aTann i | | | | | [
Properties help Apply 1:100 B Ix GEEE > 0 BMIE < L

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7

i 0 [E B Main Model AR O

4+

3 Select the short edge on Grid-5. < Move it to the outer edge.

4 5

6000.0 3000.0

-

1:100 EFG KME > ¢ rl:mti <

300 x
600mm

400 |

S
|
|
|
|
|

D X | |
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200.0 2800.0
-]

S ==

\ |" |
‘ 303)( [ ‘ v

1:00 EAE Rk QEED 0 Ok fRE < >

4 Click on Span Direction and pick the edge near Grid-5 to change the span direction to this short
span. Click v to finish editing.

ReBG-S-7-8/2-20A @ 0% &M@ -+ FoosCompleted - Stuctural Pan: L. b [peakemorsorpmose |8 &5 ¢ & signin

Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins

File Architecture  Structure  Systems

W @ -&x

Modify | Floors > Edit Boundary Cl=

3 » Y e e T Y I
Modity [ : T 3,03 Py = BEE S 5 & Slope Ao T set Show Ref Viewer
Sy « PBOThaax Q- T ¢ [ - =
Select * Properties  Clipboard Geometry Modify View  Measue  Create  Mode Draw Work Plane
Properties x 4 5 6 = (g 5% ~ Project Browser - Floors (Completed) x
8 |5 10 Views (al)
[ [l i @l = Structural Plans
Generic 300mm 4 Level 1
! Level 1 - Analytical
Floors ~ | B Edit Type =l Lavel 2
e A A : Level 2 - Analytical
Level Level 2 Site
Height Offset Fro.. 0.0 = 3D Views
Room Bounding T Analytical Madel
0
Sz::i:m — f = Elevations (Building Elevation)
Structural East
Enable Analytical M... | e — ] 2::::
Rebar Cover - Top ... Rebar Cover 1 <25 ... et
Rebar Cover - Bott... Rebar Cover 1 <25.. B Legends
_Rebar Cover - Othe..,Rebar Cover 1 <25 .. | | 300 x [ Il I Schedules/Quantities (al)
Dimensions : ) Sheets (al)
slope 600mm & B Famils
Perimeter 170000 & @] Groups
Area 15.000 m* B 2100 8 Revit Links
Volume 4500 m*
i — 30 x | .
Properties help Apply 1:100 FRA G QEREE D 0 (/I8 < 4
Select an edge or a line i1 < 0 @3 Main Model N R R

5 Repeat steps 3 and 4 for the other 3 floors along Grid-5.
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5.4Composite Slab (Slab with Metal Deck)

1 Select the top right floor then change its type to “160mm Concrete With 50mm Metal Deck” from

the Type Selector.

Edit Highlight Modify
Boundary Analytical Sub Elements B Pick Supports

‘3‘0105‘614&:( ® S5

ReBG-S-@-8/2- A 0A @ 0% &M@ -+ FoosCompleted- Stucual Pan: L. b [ipeakemororpmoe |8 &5 ¢ L signin e @ - @ X
[ ~chitecture  Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View  Manage  Add-ins  Modify [Floors (D)«
B cop @ o 1 A Add Point B
l |.‘ cut + ‘8= ? - E & Dh Db [ﬂj] [@ @ @ /‘ P Add Split Line o # By
. v W @Jﬂm N K a

Select * Properties  Clipboard

Geometry

Modify View  Measure  Create Mode  Analytical Shape Editing Reinfarcement

Modify | Floors
Properties x = @ gg ~  Project Browser - Floors (Completed) x
=1 10, Views (all)
-Floor < = Structural Plans.
Generic 300mm ‘ ‘ | : Level 1
r Level 1 - Analytical
a
fearch P ‘ ‘ | B Level 2
Floor a Level 2 - Analytical
I I | | | | Site
75mm Metal Roof Deck ___\:1____ -—-1::---— —= -— [ 3D Views
Analytical Model
_11A0mm Cancrete With 50mm Metal Deck ; I : : | | 30)
160mm Concrete With 50mm Metal Deck : RO in il | | 1= Elevations (Building Elevation)
il i East
I i 0 1 i North
! | South
" b - = | | West
T 1 i o B g
Iy + [ schedules/Quantities (all)
1 L l| I | [ Sheets (all)
it il === ::::I , X i B Families
— Insitu Cancrete 225mm I Ji ' - &l @] Groups
il il I J"l | | @ Revit Links
I Standard Timber-Wood Finish . SRy | gy, | Wy QRN ARy, P —
. 1 TIF 1] T y
Fw nie e 37nn ¥ | | | | | | v
Properties help Aoy || 1100 PR GBED 0 REE < > s

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. iy

120 FE W Main Model R e RS
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2 Click Edit Type then duplicate. Change the name to “225mm Concrete With 75mm Metal Deck”.

Click Ok.
REEG-QR-0-8/=2- P OA G 0% B~ HoosCompleted) - Structural Plan: L. +[oeciopwodopmoe |88 & £ L Signin W @ - &x

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Maodify | Floors =~

S e S S P— —— PE— ———
[ Type Properties
g - | Family: System Family: Floor v Load...

e GEedln | @ Geomt e 160mm Concrete With 50mm Metal Deck v : Duplicate... :  u

Macdify ors I | ——— -
Properties x Rename.. Fd) x

Type Parameters.
Floar ’
FArr] 160mm Concrete With Somm
Metal Deck

Floors (1) B Edit Type |1 Structure
'{, . e, L] Default Thickness 2100

Level Covel 2 Function Interior

Height Offset Fro... 0.0 =

Room Bounding I Coarse Scale Fill Pattern

Related to Mass Coarse Scale Fill Color [

Structural 2 | ration)

Enable Analytical M...

Rebar Cover - Top ... Rebar Cover 1 <25 | BB\ [Heat Transfer Coefficient (U} e

Rebar Cover - Bott... |Rebar Cover 1 <25 .. | Thermal Resistance () 0.2008 (m* KW

Rebar Cover - Othe... Rebar Cover 1 <25 .. Thermal mass 29.48 KK )
Dimensions |Absorptance 0700000

Slope Roughness 3

Perimeter 174000

Area 15.500 m? ¥

Volume 3255 m* L _

EevationatTop  |30000 . << Preview oK Cancel Apaly
Properties help Apply 1100 BBE) Gk GBS 0 CRATE < > ]
Ready 5 20 @ A vain Model TERR O

3 Click “Edit” (within the Type Properties dialogue box) to open the “Edit Assembly” dialogue box.
Click “Preview” to see the section of the floor type.

Edit Assembly X
P Family: Floor
A Y Type: 225mm Concrete With 75mm Metal Deck
=" Total thickness: 210.0 (Default)
= Resistance (R): 0.2008 (m2-K)W
B Thermal Mass: 29.48 ka/K
N Layers.
Function Material Thickness Wraps | Structural Mﬂteriall Variable
1 |Core Boundary Layers Above Wrap 0.0
2 [Structure [1] Concrete, Cast-in-Place  210.0 D
3 |Structural Deck [1] Metal Deck 0.0 ]
4 |Core Boundary ILayers Below Wrap 10.0
Insert Delete Up Down
Structural Deck Properties
Deck Profile Deck Usage
M_Form Deck_Non-Composite : 5 ~  Bound Layer Above 3
v
< >
(o) e ] [ et [ ]| bl

4 Select the Structural Deck layer [1] (Layer 3) and change the Deck Profile to “75 x 200mm”. Also
change the thickness of Structure [1] (Layer 2) to 225mm. (Note that 225 is the overall thickness of
the floor.) You can customize the deck profile and loaded it in the project for use.
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Edit Assembly x
= Family: Floor
Type: 225mm Concrete With 75mm Metal Deck
Total thickness: 225.0 (Default)
Resistance (R): 0.2151 (m2K)/W
1 Thermal Mass: 31.59 kIjK
- Layers
Function | Material [ Thickness Wraps | Structural Material]  Variable
1 |Core Boundary ‘Layers Above Wrap 0.0
2 [Structure [1] Concrete, Cast-in-Place  225.0 ]
3 [Structural Deck [1] |Metal Deck 0.0 | i
4 |Core Boundary ‘Layers Below Wrap 0.0
Insert Delete Up Dawn
Structural Deck Properties
Deck Profile Deck Usage
M_Form Deck_Mon-Compaosite : 75 ~ Bound Layer Above v
M_Form Deck_Non-Composite : 40 x 150mm
M_Form Deck_Non-Comp : 50 x 150mm
M_Form Deck _Non-Composite : 75 x 200mm
» M_Roof Deck : 40 x 150mm
M_Roof Deck : 75 x 200mm
< >
@ View: | Section: Modify type ¢ Preview >> Cancel Help

5 Select the other 3 floors along Grid-5 and change their type to “225mm Concrete With 75mm Metal
Deck”.
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L
75mm Metal Roof Deck 4‘___\;,____ ____l:,____ = r},,, =l T -— = 3D Views
o | ':'\’ [ [ Analytical Model
1 160mm Concrete With 50mm Metal Deck : J_ : : | | n 1 [ 0}
i il ; L __ | | £ Elevations (Building Elevation)
77 225mm Concrete With 75mm MetalDeck‘ i W 1 === - j| East
L i qu 1L 1 1 North
225mm Concrete With 75mm Metal Deck : RO ]
| || South
. ﬁ —==—3=-===4 West
i B2 Iy \ | B Legends
I S L [T Schedules/Quantities (all)
I i ! | | | Sheets (all)
fl— S -
i it - mr X I # ] Families
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i il Ifm J"I' | | &8 Revit Links
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Most Recently Used Types
Floor : 225mm Concrete With 75mm Metal Deck

Floor : 160mm Concrete With 50mm Metal Deck

6 Cut a section across the top right floor and then go to this section view to view the section.

Page |57



Construction

Industry Council

Building Information Modelling (BIM) Advanced Modelling Course
(Structure) — Revit 2018

REEG & @ - Sl2 P 0A G- 0= &M+ Foos Complied-Seuciura ari L.+ [T oromoroooe |98 55 75 & Sanin

W ® -&x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage
l} Q wall - [ Truss % & @ Ve, ## Area [ Fabric Sheet ale o wal @ 1)
ale & e
[} column [ Brace 3 Path Cover 23 E g Vertical 73
Modi Beam Connection  Isolated Wall Slab  Rebar Shaft Grid Set
loor eam System - abric Area ar Coupler ormer
l B Fabric Area #3 Rebar Coupl e D g
Select ~ Structure ¥ Connection ~ ¥ Foundation Reinforcement ~ Opening Datum  Wark Plane
. _ = [ 53 ~ Project Browser - Floors (Complet... X
= 10 Views (all)
Structural Plan . ) Structural Plans
E'”I I | I | | B Level 1
" Level 1 - Analytical
Structural Plan: Level 2~ &8 Edit Type | ‘ | B o
Graphics A Level 2 - Analytical
View Scale 1:100 '_'_| '_'_| ,_‘__‘ : site
Scale Value  1: {100 == e === = (= 3D Views
- e S - ,
Display Model |Normal i i _L:— \ | Analytical Model
Detail Level  |Fine i i ] ! [EDv]
Parts Visibility |Show Original i il . | [ Elevations (Building Elevation
Visibility/Grap... Edit... 11l i in ilastrth
. f Wy 1 ol
Graphic Displa...__Edi.. 1 ' 300 South
Orientation _|Project North i 5004 | o
HE=== = est
\;au}?m Displ .;ca:‘al\rda\ljm X :— 3 240 | Sactions (Bulding Section)
iscipline ructural -
Show Hidden ... By Discipline i 300 x B ogends -
. By Discipl 1 L 600(m [ Schedules/Quantities (all)
Color Scheme ... Background i W IE===5= R Sheets (al)
Color Scheme <none> | i N : ! & 2] Families
System Color ... Edit... 1 i I | i [@] Groups
Default Analys... None S R R [ . S & Revit Links
Sun Path O 5 7 T LT T
e a | | | | v
roperties help Apply 1:100 EEE G GEED o BMIE < > i< 2

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. ¢y

< 0 [ 3 Main Model

ReBG-S-7-82-20A @05 &B-+ Foors(Completed) - Section: Section 1

Bea

Select ~ Structure

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site
Q) wall = [ Truss
[ coumn B Brace

" (e Floor =[] Beam System

& P o

Connection Wall  Slab  Rebar

¥ Connection * ¥ Foundation

Collaborate
# Area

Reinforcement ~

View  Manage
[P Fabric Sheet
wd Path Cover

B Fabric Area 1 Rebar Coupler

R Y T

By Shaft

Opening

R A b M O T

W @ -&x

ale &wil 8
i 19 Level
Ry Vertical 7
rid Set
Face I Dormer

Datum  Work Plane

Section i
Building Section

Section: Section 1 ~ B EditType

Graphics * A

Scale Value 1: |50

Display Model | Normal
Detail Level  [Fine

Parts Visibility | Show Original
isi . Edit..
Graphic Displa...  Edit..
Hide at scales .. 1:100
Discipline 'Suuctma\
Show Hidden .. By Discipline

Color Scheme .. Background

Color Scheme | <none>
Default Analys... None

swpan ]
Extents *
Crop View |

.
Properties help Apply

N A T

|
10 EBE G B 0 ARG <

Le

= Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
= 3D Views
Analytical Model
30}
= Elevations (Building Elevation
East
North
South
West
- Sections (Building Section)
] Legends
[ Schedules/Quantities (all)
Sheets (all)
21 Families
@] Groups
&8 Revit Links

-

< >

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

i B Main Model

R i

You can create and load a customized metal deck profile for the composite floor. It will be discussed
in more detail in the customize families section later.
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Notes:

The amount of cantilever of concrete and metal deck can be adjusted separately for
composite floor. They can be set when you select an edge of the floor after entering Edit

Boundary mode.
Massing & Site Collaborate  View Manage Add-Ins  Modify | Floors > Edit Boundary

| i o - — Boundary Li
D[\Y DI/ LI . x [\, Boundary Line /‘E
_— m 2l T - @ Slope Arrow |/
OFaaxae O Y ¢ §smowinlo:
Modify View Measure Create Mode Draw
¢ Bxtend into wall (to core ‘ Cantilevers : Concrete;| 75603 - T Etezl:r*i][fﬂ- - T SEEEEsEsEsass
T T - . T
\ \ \ \
]
__________ _———
1
1 Selected edge
\ L---“----\---‘ \ \
RN v o
‘\_l,,J L
| 1 I | |
: 300 x
600mm
e e
500
T — _
a’ -_4 . e ) -4—-47’_ L ?4‘
e
® Zal-
a’.| <
- Tla.
)

Steps to create a sloped structural floor:

1. Drawa EASlope Amow e sketching or editing the floor boundary.

2. Specify a value for the Offset from Base property for parallel floor sketch lines.
3. Specify values for the Defines Slope and Slope properties for a single floor sketch

line.
Properties X
I l ~| |
<Sketch> (1) ~ | B Edit Type
Constraints : ‘ [
| Specify Height at Tai ':
1 Level at Tail Default i ] 1]
I Height Offset at... 300.0 -y — T — — — ‘\_rfi‘ " ;- ‘L77J
I Level at Head Default 1 iy g =
| Height Offset at.. 0.0 1 | o H
;Dimensinns : | 3 X = 1‘
Slope 18.43°
3 | -- 600mny’
Length 14400.0 e — -
[ B 2400 |
| ! Ll
| \ 300 x |
| 600jpm .
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5.4 Detail Description of Structural Floor Instance Properties
(source: Autodesk Knowledge Network)

https://knowledge.autodesk.com/support/revit-products/learn-
explore/caas/CloudHelp/cloudhelp/2017/ENU/Revit-Model/files/GUID-1E6B2B45-1650-481B-AC72-
C755FC4BDAC6-htm.html

Name Description

Constraints

Location Line Specifies the position of the floor with respect to the line sketched in the project
elevation. For more information, see Place a Floor. The floor location line remains the
same for that floor, even if the type changes.

Base Constraint Specifies the level from which the floor base is referenced.
'Base Offset 'Specifies the offset of the base of the floor from its base constraint.
Base is Attached Indicates whether the base of the floor is attached to another component, such as a

structural floor. This is a read-only value.

Base Extension Distance Indicates the distance you have moved the base of the layers in a floor.
See Compound Structure. This parameter is enabled when the layers of a floor are
set to extendable.

'Top Constraint 'The name of the level to which the floor top is set.

'Unconnected Height if top constraint is unconnected, you may set an unconnected height of the floor. This
value is read-only if there is a top constraint.

'Top Offset 'Specifies the offset of the top of the floor from its top constraint; enabled only when
the top constraint is set to a level.

'Top is Attached 'Indicates whether the top of the floor is attached to another component, such as a'
structural floor. This is a read-only value.
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Name Description

Top Extension Distance  Indicates the distance you have moved the top of the layers in a floor. See Compound
Structure. This parameter is enabled when the layers of a floor are set to extendable.

'Room Bounding 'Indicates whether the floor is part of a room boundary. This parameter is enabled'
after you place the floor.

'Related to Mass 'This is a read-only value.

Structural

'Rebar Cover - Exterior Specifies the rebar cover distance from the floor exterior face.
Face

Rebar Cover - |Interior Specifies the rebar cover distance from the floor interior face.

Face

Rebar Cover - Other Specifies the rebar cover distance from the faces of adjacent elements.
Faces

‘Estimated Reinforcement'Specifies the estimated reinforcement volume of the selected element. This is a read-
Volume only parameter that only displays when rebar has been placed.

Structural Specifies the floor as being a structural element able to posses an analytical model.

'Enable Analytical Model 'Displays the analytical model and includes it in analytical calculations. Selected by'
default. See Disable an Analytical Model.

'Structural Usage 'Either Bearing, Shear, or Structural Combined. The structural use of the floor.

‘Dimensions '
'Length Indicates the length of the floor. This is a read-only value. '
'Area 'Indicates the area of the floor. This is a read-only value. '
‘Volume Indicates the volume of the floor. This is a read-only value. '

'Identity Data

Comments A field for entering comments about the floor.

Mark A label created for the floor. This value must be unique for each element in a
project. Revit warns you when the number is already used but allows you to continue
using it. You can see the warning using the Review Warnings tool. See Review
Warning Messages.

'Phasing
'Phase Created Indicates in which phase the floor component was created. See Project Phasing. '
'Phase Demolished 'Indicates in which phase the floor component was demolished. See Project Phasing.'
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CHAPTER 6 - STRUCTURAL FOUNDATIONS (FOUNDATIONS)

Foundations are loadable families in Revit. You can Create/Customize structural Foundation family
for special use (not to be covered in this course). In this section, you will learn

e Different foundations (Isolated / Wall Foundations and Foundation Slabs) in Revit and how
to add them.
e C(Create step footings.

6.1 Different Foundations in Revit
You can create foundations for the building model using the following three foundations in Revit;

(1) Isolated Foundations / (2) Wall Foundations / (3) Foundation Slabs

S &<

Isolated Wall Slab

Foundation

e Use Isolated Foundation to place a footing at the bottom of a structural column.
e Use Wall Foundation to place a footing at the bottom of a structural wall.
e Use Foundation Slab to sketch a foundation in the model.

6.2 Adding Isolated Foundations with default settings
To add a footing underneath a structural column in Revit,
1 Open from the course folder the “Foundations.rvt” file and go to Level 1 (Structural Plan).

2 Click Structural Tab > Isolated (Foundations) in Foundation panel.
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6.3 Adding Wall Foundations in Revit
To add footings underneath structural walls in Revit,
1 Open from the course folder the “Wall Foundations.rvt” file and go to Level 1 (Structural Plan).

2 Click Structural Tab » Wall (Foundations) in Foundation panel.
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3 Inthe Properties Palette, select “Retaining Footing — 600 x 300 x 300” type from Wall Foundation

types.

4 Select all walls in the view. Keep all options unchanged.
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6.4Adding a Footing (Foundation Slab) under 2 Columns
To add a footing underneath 2 (or more) structural columns in Revit,
“" H 7 H
1 Open from the course folder the “Foundation Slabs.rvt” file and go to Level 1 (Structural Plan).
. . . . . .
2 Click Structural Tab > Slab in Foundation panel. (The default option is “Structural Foundation:
”
Slab”.)
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Click to select, TAB for alternates, CTRL adds, SHIFT unselects. /¢

2 0 [E M Main Model

<
TGO T

Page |6



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

3 Inthe Properties Palette, select “300mm Foundation Slab” type from Foundation Slab types.

4 Create a 5000 x 2000mm rectangular footing at Grid-B-2 at shown below. Keep all options
unchanged.

ReHBG-QR-~-@2-FO0A @25 M- Foundation Slbs C “Struct. [ 1ype a keyword or phrase M S P Qsignin W ®-
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Select * Properties  Clipboard Geometry Modify View  Measure Create Mode Draw Work Plane
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Properties x . () 5% ~ Project Browser - Foundation Sla.. X
(=1 10, Views (all)
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Height Offset ... |0.0 = 3D Views
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Dimensions I T T 1 I SN 5 Legends
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Enter the diagonal point of the rectangle. it & 0 Wl 2 vain Model GG NMOTo

5 Select M Span Direction Span Direction and pick the shorter edge along Grid-2 to change the span
direction.

6 Click Finish Edit Mode ’/to add the footing.

7 Move the footing to the location as shown below.

1000 3000 1000

1000/ 1000

6.5Creating a Step Footing (Under structural walls)

1 Open from the course folder the “Step Footings.rvt” file and go to West Elevation.
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3 Use “Pick Lines” ¥ to draw the profile and set Offset to 150mm Oﬁset

4 Hover near the bottom of the wall from beneath and click to draw a profile line.
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5 Drawaline < from the mid-point of the wall bottom to the line below it.
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6 Trim the profile using the modify tool - (Trim/Extend Single Element) to form a closed profile of
the wall. (Remember to click the portion of the line you want to retain.)
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Select a reference as the trim/extend boundary. s & 0 B 2 vain Model

£ O M O Fo

7 Click Finish Edit Mode v to finish editing.

8 Create similar step footing for the wall facing south.
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6.6

Detail Description of Isolated Foundation Instance Properties

(source: Autodesk Knowledge Network)

https://knowledge.autodesk.com/support/revit-products/learn-

explore/caas/CloudHelp/cloudhelp/2015/ENU/Revit-Model/files/GUID-F7483668-8348-41EC-AB54-

ED74BBA6D4E6-htm.html

Name Description

Constraints

Level ‘The level to which the slab is constrained. '
'Host ‘The level to which the host of the isolated slab is constrained. '
'Offset ISpecifies the elevation of the top of the isolated foundation relative to its level. '

IMoves With Grids

Changes the column constraint to grid.

'Materials and Finishes

' Structural Material

ISpecifies a material for the structure of the element. This information can be
included in schedules. Click the value box to open the Material Browser.
See Materials.

'Structural

Enable Analytical Model

Displays the analytical model and includes it in analytical calculations. Selected
by default. See Disable an Analytical Model.
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Name Description

Rebar Cover - Top Face Specifies the distance of the rebar cover from the element top face.

Rebar Cover - Bottom Face Specifies the distance of the rebar cover from the element bottom face.

'Rebar Cover - Other Faces ISpecifies the distance of the rebar cover from the element to adjacent element
faces.

‘Estimated Reinforcement ISpecifies the estimated reinforcement volume of the selected element. This is a

Volume read-only parameter that only displays when rebar has been placed.

'Dimensions '
I Elevation at Top Indicates the elevation used for tagging the top of the foundation. I
Elevation at Bottom Indicates the elevation used for tagging the bottom of the foundation.

This parameter is affected by the family parameter Cap (see Specify Family Category
and Parameters). The following image shows the difference between the Cap
parameter enabled (in red) and disabled (in green).

The Elevation at Bottom measurement is taken from this setting.

This is a read-only parameter.

'Identity Data

‘Comments A field for entering comments about the wall.

Mark A label created for the element. This value must be unique for each element in a
project. Revit warns you if the number is already used but allows you to continue
using it. You can see the warning using the Review Warnings tool. See Review
Warning Messages.

'Phasing
'Phase Created Indicates in which phase the component was created. See Project Phasing. '
'Phase Demolished Ilndicates in which phase the component was demolished. See Project Phasing. '
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6.7 Detail Description of Foundation Slab Instance Properties
(source: Autodesk Knowledge Network)

https://knowledge.autodesk.com/support/revit-products/learn-
explore/caas/CloudHelp/cloudhelp/2015/ENU/Revit-Model/files/GUID-C14650C3-F139-4401-B2CD-
2D1E8CD8FD89-htm.html

Name Description

Constraints

Level Specifies the level that the slab is constrained to.

'Height Offset From ISpecifies the elevation of the top of the slab relative to the constrained level of the
Level slab.

'Related to Mass IThis is a read-only value.

‘Structural '
‘Structural If checked, Slab has an Analytical Model and is exported to analysis packages.

‘Enable Analytical Model IDispIays the analytical model and includes it in analytical calculations. Selected by
default. See Disable an Analytical Model.

'Rebar Cover - Top Face ‘The rebar cover distance from the foundation slab top face.

E See Allow Stirrup and Tie Rebar to Snap to the Exterior....

'Rebar Cover - Bottom IThe rebar cover distance from the foundation slab bottom face.
Face

E See Allow Stirrup and Tie Rebar to Snap to the Exterior....

Rebar Cover - Other The rebar cover distance from the foundation slab to adjacent element faces.
Faces

E See Allow Stirrup and Tie Rebar to Snap to the Exterior....

Estimated Specifies the estimated reinforcement volume of the selected element. This is a
Reinforcement Volume  read-only parameter that only displays when rebar has been placed.

Dimensions

'Slope Specifies the slope of the slab from the horizontal plane. '
Perimeter Indicates the slab perimeter. This is a read-only parameter.

IArea Ilndicates the area of the slab. This is a read-only parameter. I
'Volume Ilndicates the volume of the slab. This is a read-only parameter.

'Width IIndicates the width of the slab, if rectangular. This is a read-only parameter. '
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Name Description

Length Indicates the length of the slab, if rectangular. This is a read-only parameter.

I Elevation at Top Ilndicates the elevation used for tagging the top of the foundation. This is a read-only I
parameter.

Elevation at Bottom Indicates the elevation used for tagging the bottom of the foundation. This is a read-only
parameter.

Thickness Indicates the thickness of the slab. This is a read-only parameter.

'Identity Data

Comments A field for placing general comments about the slab.

Mark A label created for the slab. Possible use: shop mark. This value must be unique for
each element in a project. Revit warns you when the number value is already used
but allows you to continue using it. You can see the warning using the Review
Warnings tool. See Review Warning Messages.

'Phasing

'Phase Created Indicates in which phase the slab component was created. See Project Phasing. '
'Phase Demolished Indicates in which phase the slab component was demolished. See Project Phasing. '
6.8 Detail Description of Wall Foundation Instance Properties

(source: Autodesk Knowledge Network)

https://knowledge.autodesk.com/support/revit-products/learn-
explore/caas/CloudHelp/cloudhelp/2016/ENU/Revit-Model/files/GUID-615AB37C-044C-4104-85BC-
7FA8E29A5AEQ-htm.html

Name Description

Constraints

'Eccentricity IBearing walls only. Specifies the offset from the wall center line to the bearing
foundation center line.

Structural

‘Enable Analytical Model Displays the analytical model and includes it in analytical calculations. Selected by
default. See Disable an Analytical Model.

'Rebar Cover - Top Face ISpecifies the rebar cover distance from the wall top face.
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Name Description

Rebar Cover - Bottom  Specifies the rebar cover distance from the wall bottom face.
Face

Rebar Cover - Other Specifies the rebar cover distance from the wall to adjacent element faces.
Faces
‘Estimated 'Specifies the estimated reinforcement volume of the selected element. This is a '

Reinforcement Volume  read-only parameter that only displays when rebar has been placed.

Dimensions

'Length Indicates the overall length. This is a read-only parameter. '

‘Width Indicates the overall width. This is a read-only parameter. '

'Volume Indicates the volume of the foundation. This is a read-only parameter. '

I Elevation at Top Ilndicates the elevation used for tagging the top of the foundation. This is a read-only I
parameter that reports Varies for sloped planes.

I Elevation at Bottom IIndicates the elevation used for tagging the bottom of the foundation. This is a read-only I

parameter that reports Varies for sloped planes.

'Identity Data

'Comments A field for placing general comments about the foundation type.

Mark A label created for the foundation. This value must be unique for each element in a
project. Revit warns you when the number value is already used but allows you to
continue using it. You can see the warning using the Review Warnings tool.

See Review Warning Messages.

'Phasing

'Phase Created Indicates in which phase the foundation component was created. See Project '
Phasing.

'Phase Demolished Indicates in which phase the foundation component was demolished. See Project '
Phasing.
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CHAPTER 7 - TRUSSES AND STEEL CONNECTIONS

Revit include a library of trusses and steel connections tool for your structural model. You can
Create/Customize truss family for special use (not to be covered in this course). In this section, you
will learn

e How to add a Howe Flat Truss in Revit.
e How to edit Top/Bottom chords of a truss.
e Coping diagonal members of a truss.

7.1 Adding a Howe Flat Truss with default settings
To add a Howe Flat truss in Revit,
1 Open from the course folder the “Trusses.rvt” file and go to Level 2 (Structural Plan).

2 Click Structural Tab » Truss in Structure panel.

ReHBG-a-o- 92 0A G- &3~ Trusses - Structural Plan: Level 2 Type @ keyword or phrase M 5 vr Lsignin W @ - &x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =~

N 5 ; Q wall - & & @ P, ## Area [ Fabric Sheet g] £ Model Text =R ale o wal &
i
3 Path Cover I%. Model Line e = Ry Vertical 73
Structural Trusses lsolated Wall Slab  Rebar T Component R By Shaft o o Gid | Set B
Adds a truss o the structure model abe frea SR o0e BrouP T Face orme
5 Foundation Reinforcement ~ Model Opening Datum  Work Plane
Truss chords and struts parametrically conform to meet the needs
of the truss span. — @ ~ Project T x
 © © © oop
' F 1 Structural Plans
| | | | S0 1 Level 1
E—-— — — Level 1 - Analytical
B N e
\ O [ evel 2
\ i | ! Level 2 - Analytical
! I8 I Site
; ‘ ] i 3D Views
: l ' ! | | Analytical Model
i ] - || 130}
—- j} I WO I S T S ——— WO [ Hlevations (Building Elevation
Press F1 for more help ‘ | \ | I East
e North
Graphic Displa... _ Edi | ‘ | ‘ | Lo o
ophic | \ | | I South
Orientation  |Project Nort | | | | | I West
Wall Join Displ. Clean ll wal o | | | | | | | - Sactions (Buikding Section)
Discipline Structural ; H | ' ' Lo B Legends
I I S : . ; o =
Show Hidden ... By Discipline ©— I } ¥ [ I Schedules/Quantities (i)
Color Scheme ... Background | | | | | 1 D sheets (al)
Color Scheme <none> & 2] Families
System Color .| Edit. | | + [@ Groups
Default Analys... None & Revit Links
Sun Path O
e E & v
Properties help Apply 1100 FEIE % QMY ¢ RIE < LA L 2
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7 P B Main Model R N R )

3 Inthe Properties Palette, select “Standard” type from Howe Flat Truss types.

4 Keep all options unchanged. Place the first truss by picking the column at Grid-B-2 and then the
column at Grid-C-2. Place other Howe Flat trusses at Level 2 as shown below.
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7.2 Edit Top/Bottom Chord of a Truss
To edit the top/bottom chord of a truss in Revit,

1 Go to West Elevation and select the truss.

2 Click Edit Profile és and select Top Chord.
ReEHG - R-@-82-A0A 8- 0E&&O Trusses - Elevation: West »[Twearemordorpnae |0 5 ¥ R Signin W @ - &x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify | Structural Trusses > Edit Profile |3

w B pe ~ | e elo —t P
By & Bl Bl = = % =- X @=ase
. . - .= r
o%»owoﬁh““m“ v Q- ¢ Fwtmae)’ O &
¥ KA T EER ] =
Select * Properties Clipboard Geometry Madify View  Measure  Create  Mode Draw
[[Jchair Offset:| 0.0 [JRadius 1000.0
Properties x — (i) 52 ~ Project Browser - Trusses x
=10 Views (all
erpepsey Howe Flat Truss - = Structural Plans
Standard Level 1
Level 1 - Analytical
Structural Trusses. ~ BB Edit Type Level 2
Constraints * A A B G Level 2 - Analytical
Work Plane  |Level : Level 2 A Site

Reference Level |Level 2 ( =30 Views
Start Level OFf...|0.0 ~ Analytical Model
End Level Offset0.0 y [ B0}
L Level 2 g
»

Structural * =1 Elevations (Building Elevatior

Create Top Ch... East

North
Create Bottom... o
Bearing Chord |Bottom = sosh
1 West
Rotation Angle |0.00 - Sections (Building Section)
Rotate Chords... F7 Legends
Bearing Vertic... |Center [T Schedules/Quantities (all)
| Stick Symbol L., Beating Chord _| Sheats ()
Dimensions * B Families
Truss Height  |1800.0 # [@] Groups
Non Bearing ... 0.0 &9 Revit Links
Span 10000.0
P : E © v
Properties help Apply 1100 BAED Gk QR ES D 0 C: AIE < 2l 2
Click to enter fine start point. i i :0 [ 3| Min Model bR N R )

3 Draw a new Top Chord from top of truss at Grid-B to bottom of truss at Grid-C. Press “esc” twice.
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4 Select the original top chord and delete it. Then click Finish Edit Mode v to complete the
change. There will be warning message and you can look into detail later.

Warning
The current transformation of this specific truss layout will some sub membersto  «
overlap.
*»
f
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5 You can edit the other trusses similar to step 4 above but in 3D view.

ReBG-&-2-8la-FO0AS-2E AR~ Trusses - 30 View: {30 V[opearemodorpae |00 S ¥y L Sianin W @ - &X

File Architecture  Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View Manage Add-Ins  Modify (e3R2
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SweEe & S Bo N @ e Taiv, .. @
3 0 column H Brace o Path [ cover
eam

: I\ Model Line Ry, Vertical
P+ T Connection  Isolated Wall Slab  Rebar B s W B it Component R v e~ By Shaft 2 Set B
ax ystem abric Area ar Coupler odel Group *  Face & Dormer
Select ¥ Structure ¥ Connection ¥ ¥ Foundation Reinforcement ¥ Model Opening Datum  Work Plane
Properties x — () 52 A~ Project Browser - Trusses X
= 10, Views (all
@ DV - [} Structural Plans
Level 1
Level 1 - Analytical
3D View: (3D} v EBEdit Type Level 2
Graphics 8 Al Level 2 - Analytical
View Scale Site
Scale Value 1:[100 =) 3D Views
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Parts Visibility  Show Original (30}
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7.3Coping Diagonal Members of a Truss

1 Go to 3D view and select the truss along Grid-2.
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%

2 Click Selection Box in the View panel.

3 Click “Right” on the view cube to view the truss in elevation.

_{:—’]
4 Remove overlapping / redundant member by selecting it, unpin  * and delete X it. (Use the
“tab” key to help your selection.)
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— 7 .

5 To cope the members, first unpin them and extend them into the chords.

4

AN

I, Cope

AN

@

6 From the Modify tab » Cope in Geometry panel.

7 First select the element to be coped. Then select the element (top chord in this example) with
which to cut.

8 You can try to tidy up the truss using the cope tool. Remember to unpin and extend the
members.
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|

T

To view full 3D view, click on any empty space in the 3D view and uncheck the Section Box in the

property palette.

Redag-&-o-8

g X

Type @ keyword or phrase

2- A 0A G0 E DG

Trusses (Completed) - 3D View: {3D}

88 5 vr Lsonin W @

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Moadify [oE3
$ cope + | ca ofs T} . 4
= &= Bl Bz = _ B (]
ot - ‘&= 8- 4+ O = 0O Bl & == ,
Y Fon- & B Q O LIEER] ) @ P
Select ¥ Properties  Clipboard Geometry Modify View Measure Create
Properties x — (5 ~ Project Browser - Trusses (Compl.. X

@ 3D View

3DView B0 — - SEdtlpe
0 ____ Ji~

Locked Orient
Perspective

Eye Elevation 15367.2
Target Hevation|3900.0

Camera Position|Adjusting
3

Identity Data
View Template <None>
ViewName {30}

Dependency  [Independent
Title on Sheat

Phasing *
Phase Filter  Show All
Phase New Constructi...

v

Properties help Apply

= 10, Views (all)
) Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
= 3D Views
Analytical Model
(30}
Elevations (Building Elevation
East
North
South
West
- Sections (Building Section)
7] Legends
[T Schedules/Quantities (all
) Sheets (al)
+ &) Families
+ [@ Groups
&8 Revit Links

i B T B B o B EE <

>

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. /¢

7.4

<
TGO To

2 0 [E M Main Model

Detail Description of Truss Instance Properties

(source: Autodesk Knowledge Network)

https://knowledge.autodesk.com/support/revit-products/learn-

explore/caas/Clo

udHelp/cloudhelp/2018/ENU/Revit-Model/files/GUID-3BB898A5-CD06-4091-AB37-

908686B1A807-htm.html

Name

Description

Constraints

Reference Level

The level from which the Start and End Level Offsets
are measured. This value is dependent on the work
plane of the truss. If the truss is detached from its work
plane, you can set this parameter.
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Name Description

Start Level Offset Specifies the vertical offset from the Reference Level
for the start point of the location line.

'End Level Offset 'Specifies the vertical offset from the Reference Level
for the endpoint of the location line.

Structural

Create Top Chord Creates the Top Chord. Clear the check box when you '
do not want the top chord to be created. This is useful
for preventing overlaps when creating 3D space
trusses.

Create Bottom Chord Creates the Bottom Chord. Clear this check box when
you do not want the bottom chord to be created. This
is useful for preventing overlaps when creating 3D
space trusses.
'Bearing Chord 'Specifies the chord bearing, determining the position
of the truss with respect to the location line.
'Rotation Angle 'Sets truss axial rotation. '
'Rotate Chords With Truss 'Aligns the chords with the truss plane on rotation. '

Deselect to align the chords with the placement plane
of the truss.

%

B .

'Bearing Vertical Justification 'Sets the Vertical Justification parameter in bearing
chord members.

‘Stick Symbol Location Specifies the location of the coarse view plan
representation of the truss: either Top Chord, Bottom
Chord, or Bearing Chord.

Dimensions

Truss Height Specifies the distance between the top and bottom
reference planes in the truss layout family.
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Name

Description

Non Bearing Offset

Specifies the horizontal offset of the non-bearing chord

from the location line.

Span

Specifies the furthest extent of the truss along the

location line. In many cases, this parameter does not
correspond to the value of the Length parameter in the

truss family.

'Identity Data

Engineering Type

The text field that can be used to tag trusses. The

value is non-unique.

Comments

A field for entering comments about the truss.

Mark

'The standard Object parameter. The value is unique

per instance.

Tag new members in view

'Specifies the view in which to display new beam

elements added to the truss.

Phasing

Phase Created

Indicates in which phase the brace component was
created. For more information, see Project Phasing.

Phase Demolished

'Indicates in which phase the brace component was
demolished. See Project Phasing.

Other

Number Panels

'Displays the number of truss panels, based on the

Actual Panel Width. This is a read-only value.

'Max Panel Width

'Specifies the width of a single truss panel.

Actual Panel Thickness

7.5 Revit Built-in Steel Connections

'Displays the width of each truss panel, based on the

overall width and number of panels for the selected

truss. This is a read-only value.

In Revit 2018, there is a library of Steel Connection components to help you model the connection
between steel members. You will learn how to install and load them for use in a project. Two of the
connections will be used as examples to demonstrate this powerful tool.

7.5.1 Install and Load Steel Connections

1 Open Autodesk Desktop App from your Window Toolbars.
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Autodesk Desktop App

2 Scroll down until you find the Revit 2018 Steel Connections and click “Update” to install.

B\ Autodesk el B e
{\ AUTODESK B~ 2~ @ philippe Bonnesu ~
& K e

LN .

nector geometry and to modify Updata
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Course

R Autodesk Steel Connections for Revit 2018 - X

Autodesk” Steel Connections for Revit® {\ AUTODESK.

Install > Installation Complete

You have successfully installed the selected products.

v Autodesk® Steel Connections for Revit® 2018

3 After installation, open from the course folder the “Steel Connections.rvt” file.

4 Click Manage Tab » Settings panel > Connection Settings to load steel connection components.
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Opens the Structural Connections Settings dialog in which you
can load and unload add-in connections into Revit. If no add-ins
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Press F1 for more help
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(*Alternately, you can open Connection Settings by clicking on the little arrow at the bottom right

of the Connection panel in Structure Tab.)
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Connection Group:
All Connections v

Available Connections: Loaded Connections:

d;,h Base plate ~
Tube base plate

Corner base plate

u Base plate cut

E Base plate with traverse, bolted

E Base plate with traverse, welded

[[: End plate

%Binding plates

HEKnee of frame bolted, with haunch

ﬁGable wall end plate

ﬂknee of frame with plate haunch and end plate

ﬂ;Knee of frame at web with plate haunch and end plate

ECDIumn Beam Seat Angle
[ — 8 4

| All ‘ ‘ None

| OK | ‘ Cancel ‘ | Help ‘

5 You can see there are many steel connection components such as “Base Plate” and “Column
Beam Seat Angle”.

Scroll down the list of Available Connections and find “Splice joint”. Select it and click “Add”. Then
click “OK” and the connection component “Splice joint” is loaded into the project.
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Structural Connection Settings
Connections Parameters

Connection Group:
All Connections ~

Available Connections: Loaded Connections:

E:Stiffened seated beam connection ~ ESplice joint
E Beam Seat T

i: Moment connection

E Moment flange plates
t Moment flange T
gpﬂst double beam

2]; Apex Haunch

I Front plate splice
j]thuble apex haunch
@ Cranked beam to beam

jﬂ{ Moment column splice

Eecllp angle - Skewed v

| All | ‘ None

oK | ‘ Cancel ‘ | Help

7.5.2 Create a Splice Joint (joining two steel beams)

1 Go to 3D view and click Structure Tab » Connection panel » Connection and select “Spice joint”
from the Type Selector in Properties Palette.

REBG- Q- -8l=-7©OA @- 2|5 S B~ StelConetions SBNAIIN 1yze o keyword or phrase a0 5 Y Lsignin W @ - & x
Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage Add-Ins  Modify ®-

k Q) wall = [ Truss [% & ég =) D ## Arca £ Model Text E g}g 2 Wall ) @ 1)

Column Brace w3 Path (] cover [\, Model Line * Ry Vertical
14
By Shait Set

- &= Floor = [l Beam System e el b B, Fabric Area &) Rebar Coupler S [ Model Group = Face [ Dormer =
Structural Connection oy Foundaticn Reinforcement = Madel Opening Datum  Work Plane
Adds a structural connection to structural elements.
= [ 58 ~ Project Browser - Steel Connectio... X
If structural connection add-ins are not installed, you can place =10, Views (all)
the symbolic Generic Connection to held information about the 1 Structural Plans
designed connection. Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
=3 Views
Analytical Model
(30}
= Elevations (Building Elevation
East
North
South
West
] Legends
Press F1 for more help [T Schedules/Quantities (all)
Camera - Sheets (all)
Rendering Set... Edit... + 2] Families
Locked Orient... + [@ Groups
Perspective i 8 Revit Links
Eye Flevation 122198
Target Elevation 14414 .
Properties help Apply 1:100 BFHR QGRBEEY o ARGIE < > i« >
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. ¢ &0 3B Main Model % 5 M O Fo
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Select * Properties  Clipboard Geometry Modify View  Measue  Create  Connection

Modify | Place Structural Connection
Properties x = [ 583 ~ Project Browser - Steel Connectio... X

| =10} Views (all
— GenericConnection = 1 Structural Plans
Level 1
Level 1 - Analytical
[search Fo Level 2
. i Level 2 - Analytical
+— Generic Connection Site
Generic Connection 53D Views
Analytical Model
(3D}
splice joint 1 = Elevations (Building Elevation
East
Splice joint Selection order: 1. Beam, 2. Beam North
South
' West
Profiles: any pr?ﬂle as long as both beams are the same, most B Legends
common | sections [T Schedules/Quantities (all
Sheets (all
" Desaiption: Two parallel beams are spliced with bolted tab # EI] Families
- plates. The tab plates can be attached at the web, at the web and # ol Groups
goaeet o 8 Revit Links
= the flanges, or at the inner sides of the flanges.
S Options: Joint design, reinforcing plate ©
00 ogpp X LY RN U3 Y W LE AN D9 e < > < >
Click to select, TAB for alternatives, CTRL adds, SHIFT unselect (7't &0 [F B Main Model TEE DS T

Ill

2 Select the two steel beams as shown below. (Hold down “ctrl” key while selecting the beams.)
Then press “spacebar” and a splice joint is added to join the selected beams.
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Architecture  Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View  Manage  Add-Ins  Modify | Place Structural Connection (@ =

v D K b® R et

St - = G-

i 1 I Il
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Modify
Select * Properties  Clipboard Geometry Modify View  Measure  Create Connection
Modify | Place Structural Connection
Properties x o (3 53 ~ Project Browser - Steel Connectio... X
& = (0, Views (all)
2 Splice joint - =1 Structural Plans
- e Level 1
b Level 1 - Analytical
|New Structural Connecti ~ 5 Edit Type =5
Structural 2 Level 2 - Analytical
Approvl Status site
Modify Paramet Edit... (= 3D Views
Input Elements | UB457x191x89, . Analytical Model
Dimensions * (30}
Volume =1 Elevations (Building Elevation
Structural Analysis B :‘“:ﬂ‘
Code Checking ... |Not Calculated 5° o
out
Identity Data * West
Image 7] Legends
Comments [T Schedules/Quantities (all)
Mark Sheets (all)
+ & Families
i [@] Groups
&8 Revit Links
v
Properties help Apply 1:100 BHRAGCRKEY o GRGE < > i< 4
Click to select. TAB for alternatives, CTRL adds, SHIFT unselect (¢ & 0 [F M Main Model GBSO T2

3 Zoom into see the splice joint just added.
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| Note that Steel Connection :
1 ¢ X

, canonly beseenwhenthe 1 ]
1 Lo

1 1 - -

1 5 .

detail level is set to “Fine”.

4 Select the splice joint and click “Edit” to modify the detail of this joint. Notice the number “2” on
the left beam. This indicates that it is the “2.beam” in this joint configuration.
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Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Madify | Structural Connections [ E3

¥ I cope - E] E & DL: le :: o» 9 : & - [%ﬁ @
Modify|

Fcut - & - @
II LI U j 1u] ‘g¢ o3 o =—_~‘] U‘u = AR ® ) E;D Modify
= - ¥ Fen- A& O ih 2 x % B9  Paameters
Select ¥ Properties  Clipboard Geometry Modify View  Measure  Create  Connection
Meodify | Structural Connections
Properties X Project Browser - Ste... X
- = 10, Views (al)
3 3 = Structural Pla
= Splice joint - ructural Plans
Level 1
Level 1 - Analy
Structural Connections { ~ 8 Edit Type
Structural ® Splice Joint
Approval Statusp Mo m = = y Properties % | Type of splice
Modify Paramety. | Edit. | | = General # | ® 1. Web and both flanges splice
Input Elements =TUBASTR1 ST, .= () 2. Web splice
Dimensions #  Welds () 3. Both flanges splice
Volume b= = O 4. Web and one flange splice
Structural Analysis * i (0)5. Web and other flange splice
Code Checking .. Not Calculated Flange®op ¥ | spice plane
Identity Data f Flange Bottom ¥ | ("
Image B 7. Gap to 2.beam
Comments =
: 8. Offset
Mark 8
Phasing ileg Straight cut
Phase Created  New Construction | T @
Phase Demolish... None -
Properties help ¥
Properties heip S R N3 Y LR R E < 2
Click to select, TAB for alternates, CTRL ad £ 0 [ 5 Main Model R R Y

5 From the “Web” menu, select “Web plates” and set

e Plate alignment: “centered 1.Beam”
e Distance web plate from top: “0”
e Type of connection: “both bolted”

The splice joint will be updated automatically as you enter the changes.
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B Jot- & 8- 5 - BEEl®M /S 00
B s O2 C) o (T ® . P32  modiy
¥ Gen- & T O M= x % B9 Parameters
Select = Properties  Clipboard Geometry Modify View  Measure  Create Connection
Modify | Structural Connections.
Properties X Project Browser - Ste... X =%
L = 0] Views (al)
el
o = Structural Plans
Splice joint -
- Level 1
Level 1 - Analy
Structural Connections ( ~ £8 Edit Type
Structural ® Splice Joint
Approval Status  None Properties ¥ | web plate side Dot -
Modify Paramet.. Edit.. E General &l e = = =
Input Elements | UB457x191x89, Web 2 2 £
. i s Distance relation Bolt i
s g
Volume €0 pates 1. Distance web plate from top 0 e i
Shructiral Analyss B | Web reinforcement {5 Langth web plate L. Beam 235
Code Checking ... Not Calculated Dist. bolts web 3, Length web plate 2. Beam o7
’ 0 Bolts web
Identity Data ] 4. Width web plate 152
Image Flange Top ¥
= 5. Thickness web plate 13
Comments = Flange Bottom ¥ L
Mark Type of connedtion both bolted -
Phasing lam
Phase Created ~ New Construction & [@
Phase Demolish... None ™
Properties help v
Properties help Apply TR ET I V LH RO < 2
Click to select, TAB for alterates, CTRL ad: r—. o0 B Main Mode - R N e i

Note the little diagram with annotation to help you understand what parameter you are

changing.
Splice Joint n
Re——— Y | Web plate side |both e .
v
et ¥ | Plate alignment |centered 1.Beam ~ |:
2 a
Web A

Web plates

Web reinforcement

Bolts web
Flange Top M
Flange Bottom ¥

Properties help

Distance relation

1. Distance web plate from top
2. Length web plate 1. Beam
3. Length web plate 2. Beam
4. Width web plate

5. Thickness web plate

Type of connection

1
1
1
| 1
Bolt o 1
|| il ==
o | i JEE3EES !
F Ll |
235 : \s :
1
229 ! i
152 T
E—
‘both bolted v

6 Next, from the “Flange Top” menu, select “Flange plates top” and change “Type of connection” to
“both bolted”. Then select “Bolts flange top” and change both “Number of Columns 1.beam” and
“Number of Columns 2.beam” to “2”.

Note the “Same for bottom” option. Uncheck it if you want the joint setting for top and bottom

flanges to be independent of each other.
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® Level 1
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Image  flange plates...
E T “| 3. Number of Columns 2.beam
Comments _Bolt rows flange
i
Mark g Flange Bottom_ % Bolt stagger 2.beam
Phasing flem 4. Number of Rows
Phase Created  New Construction | | @ Type of bolts connection
Phase Demolish... None =
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Properties help Apply COERET S ¥ LA BN O a < >
Click to select, TAB for alternates, CTRL ad &0 [ B Main Model R & Fa

7 You can create a callout of the joint from the north elevation of the model. Then annotate the
callout for drawing production.
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Properties x o (3 58 ~ Project Browser - Stee.. X
= 10, Views (all)
ﬁ Elevation o = Structural Plans
Building Elevation Level 1
Level 1 - Analy
|Elevation: North - Calloy ~ &8 Edit Type s
Graphics i~ Level 2 - Analy
View Scale Site
Scale Value 1: {10 (= 3D Views
Display Medel | Normal Analytical Mot
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7.5.3 Create Gusset Plate joints for Bracings

1 Go to 3D view and turn on the Connection Settings by clicking the little arrow in the Connection
panel (Structure Tab).
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ReHG-G-2-Q2-F0A G-
Architecture  Structure  Systems  Insert  Annotate

[} g QWaII ~ [ Truss %

[] Column E Brace
Modify] Beam Connection
¢~ Floor ~ [[] Beam System

TN
Select ¥ Structure 3 Connection "\ yj)
<o

Choose “General bracings” in “Connection Group”. Then select “Gusset plate at one diagonal”

and “Gusset plate for 2 diagonals” and click “Add”. Click “OK” to load these connections into the
project.

Structural Connection Settings X
Connections Parameters

1 Connection Group: B

LGeneraI bracings v

Available Connections: Loaded Connections:

I?Gusset plate at one diagonal A Splice joint

@Gusset plate (triangle) at one diagonal

/28 Gusset plate for 2 diagonals

ﬁGusset plate for 3 diagonals

ﬁGusset plate (variable) for 3 diagonals

EGusset plate to column and base plate
L@ Flat bracing with tension bolt
@Hat bracing with tension bolt and base plate

PETIY
@Hat bracing with tension bolt - 2 diagonals K4 AN
I
@Bracing 1 Splice Plates Single
\, 4
@Bracing 1 Splice Plates Add Obj S’

téiBracing 1 Splice Plates Double

@Bracing 1 Splice Angle Single
Lot . N

‘ All | | None

2 Click Structure Tab » Connection panel » Connection and select “Gusset plate at one diagonal”
from the Type Selector in Properties Palette.
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3 Select the left brace and the column as shown below. (Hold down “ctrl” key while selecting.)
Then press “spacebar” and a gusset plate joint is added to join the selected brace to the column.
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4 Create another gusset plate joint for the right brace.
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5 Now, click Structure Tab » Connection panel » Connection and select “Gusset plate for 2
diagonals” from the Type Selector in Properties Palette.

III

Select the two braces and the horizontal beam (Hold down “ctrl” key while selecting). Then press
“spacebar” and a gusset plate joint is added to join the selected braces to the column.
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Click to select, TAB for alternates, CTRL adds, SHIFT unselects. /¢

&0 [3 3 Main Model
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You can select any steel connections created and click “Edit” to modify the details of the joints.
Try changing the setting of the joints so that they look like the details shown below.
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[R] Elevation: South - Steel Connections (Completed)
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CHAPTER 8 - STEEL BRACINGS

Bracing is called Brace in Revit and is placed vertically by default. You can Create/Customize brace
family for special use (not to be covered in this course). In this section, you will learn

e How to add bracings.

e How to edit bracings and cope them.
e  Options in bracing placement.

e Symbolic representations of Bracing.

8.1 Adding Bracings with default settings
To add bracing in Revit,
1 Open from the course folder the “Steel Bracing.rvt” file and go to Level 2 (Structural Plan).

2 Click Structural Tab » Brace in Structure panel.
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To add braces, open a plan view or a framing elevation view, @P @ @(P =0 Views Gl
Braces attach themselves to beams and columns and adjust H : o = Structural Plans
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(A—-—- A N— o Level 1 - Analytical
i 3 Level 2
\ i | Level 2 - Analytical
f i Site
| | = 3D Views
| Analytical Model
‘ Ly |1 30)
| i ‘ | = Elevations (Building Elevatior
,77 A (V. + W S East
3
[ | O North
H ' South
Press F1 for more help | || West
N i Sections (Building Section)
Discipline Structural | ‘ | ) Legends
o : '
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Color Scheme ... Background | - [ Sheets (al)
b S
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3 Inthe Properties Palette, select “UB127x76x13” type from UB-Universal Beams types.

4 Keep all options unchanged. Pick the column between Grid-1 and Grid-2 as the bracing start
point. Then pick the mid-point of the beam from that column (you can type “SM” to snap to mid-
point). Press “esc” to start adding another bracing.

5 Pick the column at Grid-2 as the bracing start point. Then pick the mid-point of the beam towards
Grid-1. Press “esc” a couple of times.

6 Go to South Elevation to view the bracings added.
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Select ¥ Structure ¥ Connection ™ ¥ Foundation Reinforcement ~ Model Opening Datum  Work Plane
Properties x o (2 §% ~ Project Browser - Steel Bracing (C... X
(= 10, Views (all)
ﬁ Elevation — Structural Plans
Building Elevation Level 1
Level 1 - Analytical
Elevation: South ~ B2 Edit Type Level 2
Graphics f A Level 2 - Analytical
View Scale site
Scale Value 1: {50 = 3D Views
Display Model Normal Analytical Model
Detail Level [Fine 130}
Parts Visibiity Show Original = Hlevations (Building Elevatior
Visibility/Grap... Edit... f:s:rh
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Graphic Displa... Edit...
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Discipline _Structural - Sections (Building Section)
Show Hidden ... By Discipline B9 Legends
Color Scheme ... Background [ Schedules/Quantities (all
Color Scheme <none> [ Sheets (all)
Default Analys... None (& 5] Families
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Sun Path O 2 Revit Links
Extents *
o AR — Aot v
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<
# F0 ] o v FAERG NG To

6 Add similar bracings along Grid-C and from Grid-2 to Grid-5.

8.2Coping the Bracings

1 Go to South Elevation.

2 Select and extend the bracings between Grid-4 and Grid-5.

K Cope

3 From the Modify tab > Cope in Geometry panel.
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4 First select the element to be coped. Then select the element (top chord in this example) with
which to cut.

5 Extend and cope all bracings as shown below.

8.30ptions in Bracing Placement

e Tagon Placement.
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e Start Level (select from available structural levels) and Offset from it.
e End Level (select from available structural levels) and Offset from it.
e 3D Snapping

Modify | Place Brace ‘ Start: Level 1 % ‘ End: Level 2 w7 ‘ [ 13D Snappinc

8.4Symbolic Representations of Bracing

To display bracings on plans instead of showing them as hidden lines, the display Detail Level has to
be set to Coarse. This is a more practical representation of structural bracing on plans.

\ = o 32
) _ _ T T T T
LSRR, S
' Bracings | | Bracings L ! Bracings |
————————— 1 1 —_—————— =
E (Parallel Line) |
_____________ 1
1) (2) 3
1:100 (ﬁ‘ﬂ&&ﬂﬂ@?tﬁmﬁ< 2

To set how bracings are represented on plan, go to Structural Setting in Structure Tag.
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8.5 Detail Description of Truss Instance Properties _~_ _ _i

(source: Autodesk Knowledge Network)

https://knowledge.autodesk.com/support/revit-products/learn-
explore/caas/CloudHelp/cloudhelp/2016/ENU/Revit-Model/files/GUID-035A3219-12A1-4978-9496-
3B01728A2741-htm.html

Name Description

Constraints

Reference Level The constraining level.

'Cross-Section Rotation  Parameter that controls rotating beams and braces. The angle of rotation is measured '
from the beam’s work plane and the direction of the center reference plane.

‘Construction (Pre 2014 projects)

The dimension between the edge of the start end of the brace and the element to
which it is connected.

'Start Extension

This parameter is only available in projects created in versions prior to Autodesk
Revit 2014 containing brace families that have not been updated. It is recommended to
use the Geometric Position Start Extension below. Using both is an additive extension.
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Name Description

End Extension The dimension between the edge of the finish end of the brace and the element to
which it is connected.

This parameter is only available in projects created in versions prior to Autodesk
Revit 2014 containing brace families that have not been updated. It is recommended to
use the Geometric Position Start Extension below. Using both is an additive extension.

'Materials and Finishes

Structural Material Controls the hidden view display of structural elements. Concrete or Precast will
display as hidden. Steel or Wood will be visible when another element is in front of it.
Unassigned will not display if hidden by another element.

See Change the Physical Properties of a Material.

Structural

Start Connection The moment frame or cantilever symbol at the start end of brace, if applicable. '
'End Connection 'The moment frame or cantilever symbol at the finish end of brace, if applicable. '
'Cut Length 'The physical length (not the analytical length). This is a read-only value. '
'Structural Usage 'Specifies Vertical Bracing, Kicker brace, Web, or Other. '

Start Attachment Level The constraining level of the start end of the brace.
Reference

'Start Attachment 'The elevation of the start end referenced from the Start Attachment Level Reference.
Elevation

'End Attachment Level The constraining level of the finish end of the brace.
Reference

'End Attachment 'The elevation of the finish end referenced from the End Attachment Level Reference.
Elevation

Start Attachment Type Distance or Ratio. Type of measure of distance between brace start end and a
designated beam end. Applies to the brace end attached to a beam.

Start Attachment Available when Start Attachment Type is specified as Distance. Distance of separation
Distance of the brace start end from the designated beam end. Applies to the brace end
attached to a beam.

IStart Attachment Ratio IAvaiIabIe when Start Attachment Type is specified as Ratio. Ratio (percentage) of
separation of the brace start end from the designated beam end. Applies to the brace
end attached to the beam.
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Name Description

End of Referenced Available when attached to a beam. Designated end (Start or End) of the referenced

Element beam to which the start end of brace is attached. Applies to the brace end attached to
the beam.

'End Attachment Type 'Distance or Ratio. Type of measure of distance between brace finish end and a
designated beam end. Applies to the brace end attached to a beam.

'End Attachment 'Available when End Attachment Type is specified as Distance. Distance of separation
Distance of the brace finish end from the designated beam end. Applies to the brace end
attached to a beam.

'End Attachment Ratio  Available when End Attachment Type is specified as Ratio. Ratio (percentage) of
separation of the brace finish end from the designated beam end. Applies to the brace
end attached to the beam.

'End of Referenced 'Available when attached to a beam. Designated end (Start or End) of the referenced
Element beam to which the finish end of brace is attached. Applies to the brace end attached

to the beam.
'Rebar Cover - Top 'Applies to concrete beams only. The rebar cover distance from the column top face. '
Face

Rebar Cover - Bottom  Applies to concrete beams only. The rebar cover distance from the column bottom
Face face.

Rebar Cover - Other Applies to concrete beams only. The rebar cover distance from the column to adjacent
Faces element faces.

‘Estimated 'Specifies the estimated reinforcement volume of the selected element. This is a read-
Reinforcement Volume only parameter that only displays when rebar has been placed.

‘Enable Analytical 'Displays the analytical model and includes it in analytical calculations. Selected by
Model default. See Disable an Analytical Model.

‘Dimensions '
'Length The length of the brace location line. This is a read-only value. '
'Volume 'The volume of the selected brace element. This is a read-only value. '
I Elevation at Top Ilndicates the elevation used for tagging the top of the brace. This is a read-only I

parameter that reports Varies for sloped planes.

Elevation at Bottom Indicates the elevation used for tagging the bottom of the brace. This is a read-only
parameter that reports Varies for sloped planes.

'Identity Data
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Name Description
Comments User comments.
Mark A label created for the brace. Possible use: shop mark. This value must be unique for '

each brace in a project. Revit warns you if the number is already used but allows you
to continue using it. You can see the warning using the Review Warnings tool.
See Review Warning Messages.

'Phasing
'Phase Created Indicates in which phase the brace component was created. See Project Phasing. '
'Phase Demolished Indicates in which phase the brace component was demolished. See Project Phasing. '

Geometric Position

Start Extension Applies to steel braces only. A dimension that adds brace geometry beyond the start
end of the brace.

'End Extension 'Applies to steel braces only. A dimension that adds brace geometry beyond the finish '
end of the brace.

Start Join Cutback Applies to steel braces only. The dimension between the edge of the start end of the
brace and the element to which it is connected. Only for the joined start of an element.

'End Join Cutback 'Applies to steel braces only. The dimension between the edge of the finish end of the '
brace and the element to which it is connected. Only for the joined end of the element.

yz Justification Applies to steel braces only. Either Uniform or Independent. Uniform allows setting the
same parameters to both start and end of a brace. Independent allows setting
different parameters to start and end of a brace.

'y Justification 'Applies to Uniform justified steel braces only. Specifies the location of the physical
geometry with respect to the location line: either Origin, Left, Center, Right.

y Offset Value Applies to Uniform justified steel braces only. The numeric value that offsets the
geometry. The distance between the location line and the characteristic point setiny
Justification parameter.

2 Justification 'Applies to Uniform justified steel braces only. Specifies the location of the physical
geometry with respect to the location line: either Origin, Top, Center, Bottom.

z Offset Value Applies to Uniform justified steel braces only. The distance between the location line
and the characteristic point set in z Justification parameter.

Start y Justification 'Applies to Independent justified steel braces only. Specifies the location of the
physical geometry of the start end of the brace with respect to the location line: either
Origin, Left, Center, Right.

Start y Offset Value 'Applies to Independent justified steel braces only. The numeric value that offsets the
geometry at the start end of the brace. The distance between the location line and the
characteristic point set in the Start y Justification parameter.
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Name Description

Start z Justification Applies to Independent justified steel braces only. Specifies the location of the
physical geometry with respect to the location line at the start end of the brace: either
Origin, Top, Center, Bottom.

‘Start z Offset Value 'Applies to Independent justified steel braces only. The numeric value that offsets the
geometry at the finish end of the brace. The distance between the location line and
the characteristic point set in the Start z Justification parameter.

‘End y Justification 'Applies to Independent justified steel braces only. Specifies the location of the
physical geometry of the finish end of the brace with respect to the location line: either
Origin, Left, Center, Right.

End y Offset Value Applies to Independent justified steel braces only. The numeric value that offsets the
geometry at the start end of the brace. The distance between the location line and the
characteristic point set in the End y Justification parameter.

'End z Justification 'Applies to Independent justified steel braces only. Specifies the location of the
physical geometry of the finish end of the brace with respect to the location line: either
Origin, Left, Center, Right.

'End z Offset Value 'Applies to Independent justified steel braces only. The numeric value that offsets the
geometry at the start end of the brace. The distance between the location line and the
characteristic point set in the End z Justification parameter.

Other
Start Extension Applies to steel braces only. Specifies family parameters; defines maximum distance
Calculation of start extension parameter.

This parameter is only available in projects created in versions prior to Autodesk

Revit 2014 containing brace families that have not been updated.

This is a read-only value.
End Extension Applies to steel braces only. Specifies family parameters; defines maximum distance
Calculation of end extension parameter.

This parameter is only available in projects created in versions prior to Autodesk
Revit 2014 containing brace families that have not been updated.

This is a read-only value.
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CHAPTER 9 - STAIRCASES AND RAMPS

In Revit, Staircases and Ramps are non-structural elements. These elements are introduced in this

course to complete a building model. In this section, you will learn

e How to add shaft opening (for lift / staircases) that run through the entire building height.
e How to create staircases.

e Options in staircase placement.

e How to create Ramps.

9.1 Adding a shaft opening with default settings
To add a shaft opening in Revit,

1 Open from the course folder the “Staircases and Ramps.rvt” file and go to Level
Plan).

2 Click Structure Tab » Opening panel » Shaft.

2 (Structural

R EHG- -7 -Q@ 2 FOA G5 BT Staicasesand Ramps (C -S.. ¥ |Type a keyword or phrase o 5y A signin e @ - & X
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[y Q wall - [ Truss % & @ =) ## Area [ Fabric Sheet g] £ Model Text =R |ale| = wal &
i
() coumn B Brace w3 Path Cover [t Model Line =2 (P45 ajy vertical 173
Modify| Beam Connection  lsolated Wall Slab  Rebar Component % By | Shaft o Gid  Set
¢ Floor = [[[] Beam System - B Fabric Area &1 Reby Coleenda I Dormer B
Select ~ Structure 3 Connection ~ ¥ Foundation Reinforcement ~ | Shaft Opening ing Datum  Work Plane
Creates a vertical opening that spans multiple levels, cutting
through ing roofs, floors, and ceilings. —
Properties x A Project Browser - Staircases and .. X
(P @ @ @ You typically sketch the shaft on a host element (such as a flor) i 10, Views (all)
Ti =
Bl svucturel von A . . in a plan view, E Stmdura‘l Plans
I | If you move the shaft opening on one level, it moves on all levels Level 1
\ \ Level 1 - Analytical
Structural Plan: Level 2 | 7 Edit Type Iy S N S S Level 2
Graphics LI il Ed o A Level 2 - Analytical
i )
View Scale i | i o Site
| | I
Scale Value 1: {100 ' ] =30 Views
| )
Display Model Normal o= Analytical Model
|
Detail Level  Coarse f I 30}
Parts Visibility | Show Original i | [ i == ” = Elevations (Building Elevation
|
Visibiity/Grap.. | Edit. | O S S W I S ::::th
Graphic Displa... Edit... I South
Orientation Project North H West
Wall Jcin Displ...Clean all wall joi... | Press F1 for more help { Sections (Building Section)
Discipline Structural | N ) Legends
Show Hidden ... By Discipline . o [ Schedules/Quantities (all)
Color Scheme __|Background | | B Sheets (all)
Color Scheme <none> | ' I & B Families
,,,,,,,,,,,,,,,,,,,,, o T T 1 I N
System Color .| Edit.. O B o e e ] N 8 i O i [ Groups
Default Analys... None i h | L @8 Revit Links
sarah (] O & o O o o
e El b v
Properties help Apply 1:10 O 5% R E > o CafE < 2 il ?
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. (7 ) B Main Model AR O O Fa

3 Sketch the opening by Rectangle. Pick the first point at the lower right corner of the column at
Grid-A-2 and the second point at the intersection of wall edge and beam along Grid-3 as shown

below.
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4 Go to 3D view to view the opening.
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Level 1
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9.2Create Staircases
To create staircases in Revit,
1 Go to Level 2 (Structural Plan).

2 Click Architect Tab » Circulation panel > Stair.

REEG - G-¢-Qe-FPO0A G 0E GF-+ O T T | Y

Staircases and Ramps (C

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =~
[ b u [ Window [ Roof = [ Curtain System HB Railing =AY Model Text [ Room B Area - 4-;? 3[5 2. Wall
R T E) component - & Ceiling [ Curtain Grid & Ramp I, Model Line Room Separator 3 a Wy Vertical & Grid
- () Column = (= Floor ~ EH Mullion [@ Model Group = [ Tag Room = [ Tag Area - Face J° Dormer
Select ~ n Model Room & Area ¥ Opening Datum
Stair

Adds a stair to the building model by creating common run,
landing, and support components.
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k‘? kq’[):
The number of treads for a stair run is based on the distance | | |

between floors and the maximum riser height defined in the stair
type properties. ‘ | ‘

To add stairs, open a plan view or a 3D view.
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(= 3D Views
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2 0 [ M main Model

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

£ G O M O Fo

3

4

From the Properties Palette, select “190mm max riser 250mm going” from Assembled Stair.

Keep all default settings. Start sketching the staircase at the circled corner shown below. (Notice

that as you sketch the staircase, Revit will show you how many risers created and how many

remaining.)

Pick another point after 2000mm to the right.

2000.0

«'\‘
ey =

6 Pick the third point as shown below.
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1200.0

7 Then extend the staircase to the left until O (zero) riser remaining.

Lk

8 Click Finish Edit Mode "to add the staircase.
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9 If you go to the 3D view, you will notice that you cannot see the staircase just created. This is
because Stair is turned off in Visibility Control.

10 In the 3D view, type “wv” (or “vg”) for Visibility/Graphic Overrides. In Model Categories scroll
down to find Stair and enable its visibility. Click “OK”.

Visibility/Graphic Overrides for 3D View: {3D} X

Model Categories Annotation Categories Analytical Model Categories Imported Categories Filters

ghgw model categories in this view If a category is unchecked, it will not be visible.
Eilter list:
o Projection/Surface Cut i ~
Visibility - - Halftone | Detail Level
Lines Patterns Transparency Lines Patterns
O Ramps O
[ Raster Images :
#- O Roads By View
O Roofs By View
Security Devices

] Shaft Openings
O site
‘[ Spedialty Equipment

Sprinklers
%™ Stairs
- Structural Area Reinf...
Structural Beam Syst...
M Structural Columns
B Structural Connections

[_Override..|

lggaoopjoioooooao;

= 3l A - P b v
Al | - | ‘ P— ‘ | Expand Al ‘ Override Host Layers
one nve n
. - : e [ Cut Line Styles —
Categories that are not overridden are drawn N
according to Object Style settings. Object Styles...
0K | | Cancel ‘ ‘ Apply | ‘ Help
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R G- KR -Q =L OA @05 BB Staicases and Ramps (C =3 ¥ |7ype o keyword or phrase Mm s L signin W @ - & X%

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify -
Q b u ] Window 8 Curtain System 1B Railing ~  A4) Model Text (X Area - @ alm = Wall : @ [ Show
(] component * 3 Ceiling [ Curtain Gid D Ramp ]\ Model Line Room Separator O BB Vercal |
Modify| Wall Door By Shaft Set
. 0 column = & Floor ~ BB Mullion & stair [@) Model Group ~ [ Tag Room ~ Tag Area ~ o & Dormer Viewer
Select ¥ Build Circulation Model Room & Area ¥ Opening Datum Work Plane
Properties x — (3 5% ~ Project Browser - Staircases and ... 3
= O, Views (all)
@ 3D View - = Structural Plans
-~ Level 1
S Level 1 - Analytical
3D View: (3D} ~ BB Edit Type Level 2
Graphics A Level 2 - Analytical
View Scale 1:100 site
Scale Value 1: 100 = 3D Views
Detail Level ~ Fine Analytical Model
Parts Visibility  Show Original 3D}
Visibility/Grap... Edit.. =i Elevations (Building Elevatio
Graphic Displa.. _ Edit.. et
Disciphine _ [Structural ;':;:
Show Hidden ... By Discipline West
Defouit Analys:..None @ Sections (Building Section)
Sun Path O B9 Legends
Extents 2 [ Schedules/Quantites (all
CropView  [] Sheets (all)
Crop Region V...[] + B Families
Annotation Cr... [] & [@] Groups
Far Clip Active [] ©8 Revit Links
Far Clip Offset |304800.0
PR (] N 7 A
Properties help Apply 1:100 EHEXGBRBEB? o & > >

<
FERDL O TP

Structural Columns : Concrete-Rectangular-Column : 600 x 75 11 “* 0 @ B Main Model

9.3 Options in Creating Staircase

There are many options available to help you to define a staircase in Revit. Many of the options are
self-explanatory. You can hover over the option and see its description and press F1 for more help.
Under the contextual ribbon tab, the options for creating staircase are:

e Draw (Components): Run / Landing / Support

e Draw (Components) by: Straight / Full-Step Spiral / Center-Ends Spiral / L-Shape Winder / U-
Shape Winder / Create Sketch

e Location Line: Exterior Support: Left / Run: Left / Run: Center / Run: Right / Exterior Support:
Right

e Options: Offset / Actual Run Width / Automatic Landing

¥ Elme 25 =

4

4l

Mode Components

Location Line: Run: Right v Offset:| 0.0 Actual Run Width:| 1000.0 Automatic Landinc

9.4Creating Ramps
To add a ramp in Revit,
1 Goto Level 1 (Structural Plan).

2 Click Architecture Tab » Circulation panel > Ramp.
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ReBG - G- -8 2 P OA @ Q8 G Sisesandamps Complted) -5 [Treciommmomae |00 8 % Lsgon - @ - & X

Architecture  Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View  Manage Add-Ins  Modify ®-

Q t] D [ Window [ Roof = [ Curtain System W Railing = A) Model Text [® Room B Area - rflb\' 2. Wall @ [, Show
*
Set

Componen( - A ceiling E Curtain Grid I%, Model Line 4 Room Separator [ A fary .!l Vertical L7 Ref Plane
Modi Wall  Door By Shaft ¥ Grid .
- a . [@) Model Group - Tag Room = [ Tag Area - Face J° Dormer Viewer
mp
Select * Model Room & Area ¥ Opening Datum Work Plane
Adds a ramp to the building model.
i To add a ramp, open a plan view or a 30 view. | | | - g% A Project Browser - Staircases and .. X
The default settings for the Top Level and Top Offset properties =0, Views (all)
Structural Plan | M3y make the ramp too long. Try setting the Top Level t the I Structural Plans
current level, and the Top Offset to a lower value. r - - — - - —_— - - Level 1
) Level 1 - Analytical
Structural Plan: Level 1~ . 1 1 | I Level 2
Graphics / Level 2 - Analytical
View Scale 1:100 ‘| Site
Scale Value | | 1 (= 3D Views
Analytical Model
| ‘ [EDv]
T— 1 Elevations (Building Elevation
! | East
| North
- South
Orientation
e - - | | | | West
Wall Join Disp LI U Ee il - Sections (Building Section)
Discipline B Legends
Show Hidden e o o I o P Schedules/Quantities (all
Color Scheme Sheets (all)
Color Scheme & ] Families
System Color =) H Groups
Default Analys, | I | I &8 Revit Links
Sun Path |
Properties help Apply 1:100 P& GEME R 0 EBMHBIE < > al< >
Click to select. TAB for altemates, CTRL adds, SHIFT unselects. 17 & 0 [ A Main Model bR i R

3 Set Base Level and Base Offset to Level 1 and -450 respectively.
4 Set Top Level and Top Offset to Level 1 and O respectively.

5 Click “Edit Type”. Then change Shape to “Solid” and Ramp Max Slope(1/x) to 18.222.

ReBG-S-7-8@82-F0A @95 G-+ soicsesand Ramps (C S5 b [rpe akeyword or phrase M5 7y Lsignin W @ - & X

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify | Create Ramp Sketch =~

o — — -
“ 7 Type Properties x & g
e g - T = . L set show et view ]
Select * Properties  Clipboard J Tooe: T T
Properties x 5¢ ~ [Project Browser -
Ramp i B Structural Plans
Ramp 1 Level 1
|ImT = Level 1 - Analytical
[Ramps « B Edit Type] e
Constraints _ _ | Level 2 - Analytical
Base Level i Site
T gase Offset 30 Views
17op Level Analytical Model
Trop Offset 30)
“distory To [ Elevations (Building Elevatior
Graphics * East
Up text North
South
Down text | West
----- 1e22000 o} [ Sections (Building Section)
5 Legends
I Schedules/Quantities (all)
: Sheets (all
Width 110000 & B ramilies
& [@] Groups
88 Revit Links
- o] om | awy
’ v
w0 FAD G QEEE P 9 (aw,d < [ | > ale >
o & 0 W 24 Main Model P &R OFo

6 Pick the start and end points of the ramp as shown below.
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S
\

-/ Start of Ramp

End of Ramp

b9 9 of inclined ramp created, 0 remaining

@ B

7 Click Finish Edit Mode ’to add the ramp.

ReBG-QR-7-8Q=2-FO0A @ 05 &7 Staicasesand Ramps (C
Architecture ~ Structure  Systems

[ EE K Kcope- 0§
B Sout- = 8-

Select * Properties  Clipboard

Insert  Annotate

Analyze

EN%D&DM;“

+ 0
PO Thaaxs

Modify View

Modify | Ramps
Properties x
Ramp i
Ramp 1
|Ramps (1) ~ | BB Edit Type
Constraints A

saseLove

Base Offset  -450.0
Top Level 'Level 1
Top Offset 00
Multistory Top...None

Graphics
Up text up
Downtet DN
Up label =]

Down label 7]

Show Up arro.. [
Dimensiens
Width 110000 |
Identity Data

Image

Comments

S[] =

v

e
Properties help Apply

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7

1:100 AP GGHMHAEE Y s MBS <

£H

2300 W 7ype o keyword or phrase am % v L signin

Massing & Site  Collaborate  View  Manage

ve=-BR 4

w 7=

o=0

Q- b

Measure Create

E’ 0 E M Main Model

Add-Ins  Modify | Ramps

Edit

Sketch

Mode

W @ - &@x

W ) 53~ Project Browser - Staircases and .. X

= .0, Views (all
[ Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
= 3D Views
Analytical Model
{30}
|- Elevations (Building Elevatior
East
North
South
West
Sections (Building Section)
Legends
[ Schedules/Quantities (all)
Sheets (all)
& B ramilies
7 @] Groups
&8 Revit Links

~

> >

TR A (b M O P

8 When you select the ramp, you can change the ramp up direction by clicking the direction arrow

(highlighted below).
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Flip Stairs Up Direction

@ B

9.5 Detail Description of Ramp Instance Properties

. al v
NEES
I

(source: Autodesk Knowledge Network)

https://knowledge.autodesk.com/support/revit-products/learn-

explore/caas/CloudHelp/cloudhelp/2017/ENU/Revit-Model/files/GUID-14D7B7D6-F29A-4AD2-8A14-
B91AD4A99ECA-htm.html

Name Description

Constraints

‘Base Level Sets the base of the ramp.

'Base Offset Sets the ramp's height from its base level. '
'Top Level ISets the top of the ramp. '
'Top Offset Sets the ramp's offset from the top level.

'Multistory Top Level Sets the top of the ramp in a multi-story building. '
IGraphics I
'Up text Specifies the up text.

'Down text ISpecifies the down text. '
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Name Description

Up label Indicates whether the up text appears.

'Down label ' Indicates whether the down text appears.

‘Show Up arrow in all views Indicates whether the up arrow appears in all views.

‘Dimensions '
‘Width Width of the ramp.

'Identity Data

‘Comments Specific comments about the ramp.

IMark IA unique identifier for the ramp. I

'Phasing '

'Phase Created The phase when the ramp was created. See Create a phase. '

'Phase Demolished The phase when the ramp was demolished. See About Demolishing '
Elements.
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CHAPTER 10 - PILES and PILE CAPS

Piles and Pile Caps are loadable families In Revit. You can Create/Customize these families for special
use. In this section, you will learn

e How to load Pile and Pile Caps families.
e How to place Pile and Pile Cap in Revit.
e How to create new Pile/Pile Caps type from existing types.

10.1

Loading Pile and Pile Caps Families in Revit

Pile/Pile Cap families are not automatically loaded in Revit. To load a Pile/Pile Cap family,

1 Open from the course folder the “Piles and Pile Caps.rvt” file and go to Level 1 (Structural Plan).

2 Click Insert Tab > Load from Library panel > Load Family.

ReBG-4-4-82-20A @ -0 % &M@ - PieadpieCap-Srucural Plan: Leve.. b [peakeworsorprose |8 & ¢ L signin

Architecture  Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View Manage  Add-ins  Modify @«

oo
bRt S
Modify| Link Link Link DWF

Revit IFC CAD Markup

Select ~

Properties x

Yva @ e R WM

Decal  Point Coordination Manage Import Import  Insert mage Manage | Load |load as
Cloud  Model links ~ CAD gbXML from File Images |Family] Group

Link m Library
Load Family

@m‘ Structural Plan -

Structural Plan: Level 1~ 5 Edit Type
Graphics A
Scale Value 1: {100

Display Model |Normal

Detail Level Fine

Parts Visibility | Show Original
Visibility/Grap...
Graphic Displa...
Orientation Pro
Wall Join Displ.../Clean all wall joi
Discipline Structural
Show Hidden .. By Discipline

View Scale

Color Scheme ... Background

Color Scheme <none>
System Color ... Edit. |
Default Analys.. None
Sun Path O
A 2 ¥
Properties help Apply

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. ;Ft

W @ -@&x

Loads a Revit family into the current file.
You can load families from local or networked libraries, the web
library, or other sources. Then use Place a Component to place an

instance of the family type in the drawing area

Press F1 for more help

3

&

e

e I
|
o]

1:100 FHE G GEMER 0 BMAITE <
< 0 [ 3 Main Model

3 Select the path for the families to be loaded.

B This PC
. 05(C)
ProgramData
Autodesk
RVT 2018
Libraries
Hong_Kong
Structural Foundations

4 Select M_Pile Cap-3 Pile and click OK.

— (9 53 ~ Project Browser - Pile and Pile Cap X
=i 10, Views (all)
) Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
= 3D Views
Analytical Madel
[EDv]
=} Elevations (Building Elevation
East
North
South
West
- Sections (Building Section)
B Legends
[T Schedules/Quantities (all)
R Sheets (all)
& 2] Families
+ [@] Groups
8 Revit Links

v

> >

-2 Ny W
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R Load Family ? X
Look in: | Structural Foundations ~ | &= @ 4 q Views
Preview
Name Date modified Ty ~
E; M_Footing-Rectangular 13/3/2017 10:26 PM Al
(£ M_Pile Cap-1 Pile 13/3/2017 10:26 PM Au
(&) M _Pile Cap-2 File 13/3/2017 1026 PM Au
[E) M _Pile Cap-3 Pile 13/3/2017 1026 PM  Au
Documents E; M_Pile Cap-4 Pile 13/3/2017 10:26 PM Au
E; M_Pile Cap-5 Pile 13/3/2017 10:26 PM Al
- E; M_Pile Cap-6 Pile 13/3/2017 10:26 PM AL
My Computer EJ M_Pile Cap-7 Pile 13/3/2017 10:26 PM AL
M_Pile Cap-8 Pile 13/3/2017 1026 PM Au
~ [E) M _Pile Cap-9 File 13/3/2017 1026 PM Au
My Network PI... [&) M_Pile Cap-Rectangular w Piles 13/3/2017 10:26 PM Au
‘ E; M_Pile Cap-Rectangular 13/3/2017 10:24 PM A
EJ M_Pile Cap-Triangular 13/3/2017 10:24 PM A
Favorites E; M_Pile-HP Shape 13/3/2017 10:26 PM Al
B a s rete com ot e - PP PR Y
< >
Desktop File name: | M_Pile Cap-3 Pile.rfa v
Files of type: |AII Supported Files (*.rfa, *.adsk) v |
N
5 Also load “M_Pile Cap-Rectangular” and “M_Pile-HP Shape” families into the project.
R Load Family ? X
Lealk i | Structural Foundations v ‘ & B ¥ Bl Vvews -
~ Preview
Name Date modified Ty A
E; M_Footing-Rectangular 13/3/2017 10:26 PM Au
(&) M_Pile Cap-1 Pile 13/3/2017 1026 PM A
E; M_Pile Cap-2 Pile 13/3/2017 10:26 PM Au
(&) M_Pile Cap-3 Pile 13/3/2017 1026 PM A
Documents E; M_Pile Cap-4 Pile 13/3/2017 10:26 PM Au
(&) M_Pile Cap-5 Pile 13/3/2017 1026 PM A
- E; M_Pile Cap-6 Pile 13/3/2017 10:26 PM Au
My Computer E; M_Pile Cap-7 Pile 13/3/2017 10:26 PM Au
£ [E) M Pile Cap-8 Pile 13/3/2017 1026 PM A
~ (&) M_Pile Cap-9 Pile 13/3/2017 1026 PM A
My Network Pl... E; M_Pile Cap-Rectangular w Piles 13/3/2017 10:26 PM Av
‘ E; M_Pile Cap-Rectangular 13/3/2017 10:24 PM A
E; M_Pile Cap-Triangular 13/3/2017 10:24 PM A
Favorites i@ M Pile-HP Shape 13/3/2017 10:26 PM AL
[ PP Y
< >
Desktop File name: | M_Pile-HP Shape.rfa o |
Files of type: |AI| Supported Files (*.rfa, *.adsk) ~ |
oo | o

Now when you select/create a foundation element, you can find the loaded Pile/Pile Cap in the Type

Selector from the Properties Palette.
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ReBG - S-7-82-2A0A @ 0% &M@ - PeadpieCap-Srucural Plarc Leve.. b [peakeworsorprose |8 5 ¢ & signin

Modify | Structural Foundations ()=

W ®@- & X

*® ] D' D s e Q- iE = [(‘CT
G XKoo O et 90 = i
&= = oo =¥ =t - i N
Modi } ‘_g" (o)) o = T ® . T~ Edit  Highlight  Pick New Rebar
¥ Jon- Z& PO i x B9  Family Analytical Work Plane
Select * Properties  Clipboard Geometry Modify View  Measure  Create  Mode Analytical Work Plane Reinforcement
Madify | Structural Foundations Moves With Grid:
- x — [ 5z ~ Project Browser - Pile and Pile Cap X
> N N B
4 L =0, Views (al
M_Footing-Rectangular _| [~ = Structural Plans
1800 x 1200 x 450mm Level 1
1 1 1 I | I | Level 1 - Analytical
[search o | | ‘ ‘ | ‘ Level 2
N Level 2 - Analytical
P M_Footing-Rectangular | | | | o Site
1800 x 1200 x 450mm | | ‘ ‘ | ‘ 3D Views
Analytical Model
2400 x 1800 x 450mm | 1 | | l | i)
__________ - | 7 7
m M _ile Cap-3 Pile 1 R | ‘ ‘ | ‘ 8 E'e":"“"s (Buikding Elevation
t
; | asi
1800 x 2000 x 900mm g B ; ! North
. ] ..m 3 Fm Em
QM_PileCnp—Redangular 1 ] EX ] 5 st
2000 % 2000 % 900mm 1 | ! ! ! ! {# Sections (Building Section)
! ! | o =
2600 % 1850 % 1100mm 1 S [T Schedules/Quantities (all)
| M_Pile-HP Shape ! ) Sheets (al)
1 # HI] Families
HP200X53 1 il [@] Groups
HP250X62 1 8 Revit Links
| MPOSONES o LR
‘Most Recently Used Types v
M_Pile-HP Shape : HP200X53 0 BO%GME o MME < > e 5
Ak Dl e inrtasen e - 3N w MUV ¥ ot &0 [F B Main Model L e R

10.2  Adding Pile and Pile Caps in Revit
To place Piles/Pile Caps in Revit,
1 Click Structure Tab > Foundation panel > Isolated.

2 Select “1800 x 2000 x 900mm” from M_Pile Cap-3 Pile family.

Properties x

M_Pile Cap-3 Pile
1800 x 2000 x 900mm

lSeﬂrch

’ M_Footing-Rectangular

1800 x 1200 x 450mm
2400 x 1800 x 450mm

M M_Pile Cap-3 Pile

[ 1800 x 2000 x 900mm ]

3 Place the Pile Cap at Grid-C-3, Grid-C-4 and Grid-C-5. Press “esc” a couple of times.
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R2BG - Q-7 - @ =-FOA G 25% &B >  PladileCap-30View 3D  »[iocoreomodopmoe |08 8 ¢ L Signin ‘W ® - &x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View Manage Add-Ins  Modify -

Q wall - W Truss % & @ &7 i Area £ Model Text b E:E -2 Wall @ [i:¢]
0 column B Brace : 13 Path [ cover I\, Model Line = T Ry Vertical
dify| Beam Connection  Isolated Wall Slab  Rebar Component By Shaft Set
& Floor =[] Beam System - [B Fabric Area &1 Rebar Coupler - [&) Model Group *  Fpce £ Dormer ]
Select ¥ Structure  Connection ¥ ¥ Foundation Reinforcement ¥ Model Opening Datum | Work Plane
Properties x N~ — G 5z ~ Project Browser - Pile and Pile Cap X
; / V i 10, Views (all)
@ 3D View - 4 = Structural Plans
i v Level 1
o T o Level 1 - Analytical
3D View: (30} ~ B Edit Type Level 2
Graphics A Level 2 - Analytical
View Scale Site
Scale Value 1: {100 = 3D Views
Detail Level  Fine Analytical Model
Parts Visibility Show Original (30}
Visibility/Grap... Edit... | = Elevations (Building Elevation
Graphic Displa... Edick__f East
Discipline _Structural torth
Show Hidden ... By Discipline South
West
Delault Andlys:: Nona i) Sections (Building Section)
Sun Path O B Legends
Extents d B2 Schedules/Quantities (al)
CropView [ [ER) Sheets (al)
Crop Region V...[] i B Families
Annotation Cr... [_] + [@) Groups
Far Clip Active |[] 8 Revit Links
Far Clip Offset |304800.0
Coatize N — ¥: v
Properties help Apply 1:100 EHRXXGHRBB R e BRMEE < > i< =
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7§ 2.0 3 M Main Model BFARDMLMOTo

4 Now, place 2 piles to support the footing at Grid-C-2. Go to Level 1 (Structural Plan) and select
Isolated from foundation panel in Structure Tab.

5 Select “HP205x80” pile and place at the column locations on the footing.

Re8G-&-7-8/=2-POA G 0 EG&Q > rlndleCap-30Viewd  d[ipcoromsopmoe [ & Qsnn - W @O - & X

File Architecture ~ Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View Manage  Add-Ins  Modify | Structural Foundations -
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! om0 B e Bl g = B S fo ¢ o

Modify| ) o2

‘V
0B St &= &%~ oo = .
[ 2 O =1|-‘ 7 Edit  PickNew  Filter
II - ¥ G- R PQ O M2 x & ® S Family Work Plane 5} Edit

Select ¥ Properties  Clipboard Geometry Modify View  Measure  Create Mode Work Plane Selection
Modify | Structural Foundations Moves With Grid:  Activate Dimensions
Properties x W 5; ~ Project Browser - Pile and Pile Cap X
= 10, Views (all)
| M_Pile-HP Shape < =1 Structural Plans
HP250X85 Level 1
i | Level 1 - Analytical
Structural Foundations ( v &8 Edit Type Level 2
Constraints * A Level 2 - Analytical
Level Site
Host Foundation Sla. = 3D Views
Height Offset ... -350.0 Analytical Model
Moves With G... ] (30}
Materials and Finishes B (- Elevations (Building Elevation
Structural Mat... Steel, 45-345 _J East
Structural * Noith
- South
Enable Analyti... [] West
Dimensions * [# Sections (Building Section)
Elevation at Top|-200.0 B Legends
Elevation at B... |-6350.0 [ Schedules/Quantities (all)
Identity Data i Sheets (all)
Image i Families
Comments & [@) Groups
Mark 88 Revit Links
Properties help Apply 1:100 BHKXIGRBEBE P o B/ E < > < 24
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 77 %0 5 3 Main Model TERDNOT2

10.3  Create New Pile and Pile Cap (from loaded type)
You can create a new pile and pile cap by duplicating a loaded type.

1 Select an existing pile cap (at Grid-C-3) and click “Edit Type”.
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2 Click “Duplicate” and change the name to “2000 x 2500 x 1200mm” then click OK.

ReBG G- - = - FO0A G 0E GB-* Memdpiecn
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Foundation Thickness
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Level 2
Level 2 - Analytical
Site
= 3D Views
Analytical Model

) Elevations (Building Elevation
East
North
South
West
[ Sections (Building Section)
] Legends
[ Schedules/Quantities (all)
Sheets (all
(-2 Families
+ [@] Groups
8 Revit Links

v

> >

Ready

100 B ERIGHREGRY c @B OE <
bl

& 0 W3 Main Model

4| €
FEMRLOT

3 Change the Pile Type to HP360X174 instead of 500mm Diameter. Also change the Foundation
Thickness, Width and Length to 1200, 2500 and 2000 respectively.

Type Properties

Family:

\M_Pile Cap-3 Pile

~] Load...

Type: ‘2000

x 2500 x 1200mm

Type Parameters

i ‘ Duplicate...

Parameter

Pile Type<Structural Foundations>

éMiPilefHP Shape : HP360X174

Foundation Thickness 1200.0

Width 2500.0 i
Width Indent 500.0

Length 1 800.0

Length 2000.0 ]
Cut-off 150.0 |
Clearance 450.0

Assembly Code A1010130

Type Image

Keynote ‘ o]
Model

Manufacturer ]
Teinn Cmnn +n Y
][ e

4 Click OK and a new Pile Cap type is created.
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ReB8G-&-7-3

Select * Properties  Cliphoard
Modify | Structural Foundations

Properties x

v % Pon- &

2-/OAG-0E &R -

Pile and Pile Cap (Cx

-3DVie.. *|7ype akeyword or phrase Mm S v Lsignin

+. 0O = A8
PO Taax s
Geometry Modify

Moves With Grid:

Measure Create

Activate Dimensions

e oO=-0
- A

Architecture ~ Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View Manage Add-ins  Modify | Structural Foundations (-~
R TR LN

. kel Pz - ] 0 (3

B Slot- & & BBEl® #-F Edit  Highight PickNew  Rebar

Family Analytical Work Plane
Mode Analytical Work Plane Reinfarcement

M_Pile Cap-3 Pile

2000 % 2500 x 1200mm

Structural Foundations { ~ 8 Edit Type
Structural Mat... Concrete, Ca.. | | A
B

Structural
Enable Analyti.. (7]
Rebar Cover - .. Rebar Cover 1.

Rebar Cover - . Rebar Cover 1 ...

Rebar Cover - ... Rebar Cover 1 ...
Dimensions

Elevation at Top|0.0

Elevation at B... |-72000
Identity Data

Image

Comments

Mark
Phasing

Phase Created | New Constructi...

Phase Demolis... None

Properties help Apply

10 BHRGGHRHEEY c BHGE <

— (3 52 ~ Project Browser - Pile and Pile Ca... X
0] Views (all
£ Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
3D Views
Analytical Model
{30}
~ Hlevations (Building Elevation
East
North
South
West
H Sections (Building Section)
55 Legends
= Schedules/Quantities (all)
Sheets (all)
- ] Families
- [@] Groups
&8 Revit Links

v

>

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. /¢

0 &M vainModel

<
FARL®OT
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Chapter 11 - 3D REINFORCEMENT

3D reinforcement (rebar) can be modelled in Revit. Reinforcement must be hosted by a valid host
such as structural wall, column and floor. In this section, you will learn

11.1

How to place reinforcement for Columns.
How to place area reinforcement for Floors.
How to control visibility of rebars.

Various reinforcement settings in Revit.

Modelling Reinforcement for Columns

1 Open from the course folder the “3D Reinforcement.rvt” file and go to Level 2 (Structural Plan).

2 Click Structure Tab > Reinforcement panel > Rebar.

Reda-&-

220 A @5 GiB-F 30 HReinforcement (Completed) - Struc..

88 5 & Rsgnin ‘W @ - &@x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =~

[y Q wall - [ Truss % & Q =) B ## Area [ Fabric Sheet @ £ Model Text R aleg o wal &
==
() coumn B Brace w3 Path Cover [t Model Line =22 FE ajy vertical 173
Modify] Beam Connection Isolated Wall Slab |Rebar Component By Shaft o Grid Set
¢ Floor =[] Beam System - B Fabric Area &3 Rebar Coupler - [ Model Group = Face I Dormer B
Select ¥ Structure | geructural Rebar Reinforcement ~ Model Opening Datum  Wark Plane
Places planar, multi-planar or free form rebar.
Properties (R T ] — E|Bz ~ Project Browser - 3D Reinforceme... X
The placed element is a rebar instance with the properties of the UrPEirrtl 1 (50 Views@)
o specified rebar type, rebar shape for shape driven rebar Iy gy "SI Structural Plans
S|l Structural Plan geometry. In free form rebar, the placed element maintains the ‘
rebar type and rebar geometry. In either instance, rebar will Level 1 7
respect cover references and constraints when placed e Level 1 - Analytical
Structural Plan: Level 2~ & Edit T i
Graphic Displa. Edit... Press F1 for more help Level 2 - Analytical
Orientation Project North I Site
Wall Join Displ...,Clean all wall joi =l 3D Views
Discipline Structural | - - Analytical Model
Show Hidden ... By Discipline | il il a0}
Color Scheme . Background | = Elevations (Building Elevation
Color Scheme <nonex ‘ ‘ Ll :laﬂh
System Color ... Edit... | o
ystem Color i A I 11 South
Default Analys... None West
suneth = . B - - —_— fl.L === == = *J‘J—l‘ 1 Sections (Building Section)
Underlay L B 8 i - y—
Range: Base L.. None [T Schedules/Quantities (all)
Range: Top Le... |Unbounded D Sheets (all)
Underlay Orie... |Look down & B Families
Extents * + [ Groups
Crop View O | & Revit Links
Crop Region V...[_] o |
P——e—— v
Properties help Apply 1:100 DR KME> 0 RATE < > < >
Floors : Floor : Generic 300mm 7 0 B Main Model 5 E kW O T

3 First, place the main (longitudinal) rebars with the following settings:

Use default 40R rebar

Placement Plane: Near Cover Reference
Placement Orientation: Perpendicular to Cover
Rebar Set: (Layout: Fixed Number and Quantity: 5)

Hover over to the left side of the column at Grid-B-1 and place the rebars. Revit will show you
boundary of the cover in green dotted lines.

4 Select the rebars just created and mirror (type “MM”) them to the other side of the column.
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5 Next, place the links to the column. Click Structure Tab » Reinforcement panel > Rebar.

6 Select

Rebar Shape: 51

12T rebar

Placement Plane: Near Cover Reference

Placement Orientation: Parallel to Cover

Rebar Set: (Layout: Maximum Spacing and Spacing: 300mm)

&

7 Now change the view visibility of these rebars. Select all the rebars and click “Edit” in View
Visibility from the Properties Palette and make the rebars “View unobscured” and “View as solid”
in 3D View {3D}. Then click OK.
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Properties X | ; ; ; !
! = I 1 !
Rebar Bar - : ! ! ! :
Multiple Types Selected | | I 1 |
I g | I
I I I
1 View Visibility ... : | :
L : “z I
Structural ° | | |
Reinforcement...} | . | bt |
Dimensions # I 4 | I
A I | e
! L
B I > & t
C I _ o
5 I N I
I N [
E 0.0 mm (0 mm) | |
F 0.0 mm (0 mm) | . L |
G 0.0 mm (0 mm) ! !
H 0.0 mm (0 mm) : :
J 0.0 mm (0 mm) 1 " . ® |
K 0.0mm (0 mm) | |
o 0.0 mm (0 mm) : :
P 0.0 mm (0 mm) | |
Q 0.0 mm (0 mm) 1 1
n PN S ) -
razertes e Apply 1:100 FA&EXBE P 0 BHE <
Rebar Element View Visibility States ? X
Show rebar element unobscured and/or as a solid in 3D views (in fine level of detail).
Click on column headers to change sort order.
View Type View Name View unobscured View as solid N
3D View Analytical Model ]
3D View [E15] N R v7 R R V7 B 1
———————————————————————————————————————————————— ol
Elevation South )
Elevation East ]
Elevation North ]
Elevation West []
Section Section 1

Structural Plan

<]

Structural Plan

Structural Plan

Level 2 - Analytical

Structural Plan

Level 1 - Analytical

Structural Plan

Site

J0os

8 Go to 3D view and the rebars can be seen unobscured now.

Cancel
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RE2EG-S-7-8 =2-20A @- 0% &B- 30Rinforcement

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins

[y Q wall * B Truss
) column F Brace
Modify| Beam
¢~ Floor = [[[] Beam System
Select ~ Structure
Properties x
@ 30 View -
3D View: (30} ~ | B8 Edit Type
Section Box [ ] ~
Camera *
Rendering Set... Edit.. |
Locked Orient.
Perspective
Eye Elevation 254622

Target Elevation 4088.1
Camera Position|Adjusting

Identity Data *

View Template | <None> |

View Name {30}

Dependency |Independent

Title on Sheet |
Phasing *

Phase Filter Show All

Phase New Constructi...

v

Properties help Apply

& LPo

Connection

¥ Connection ™ ¥

Isolated Wall  Slab

Foundation

-3DV.. »|7ype o keyword or phrase o0 5 ¥ L signin

Modify (-
# Area ‘ £Y Model Text
3 Path Cover I\, Model Line
Component

Rebar
B Fabric Area 1 Rebar Coupler

Reinforcement ~

1100 BHRIGRHEE? ¢ AR GIE <

Madel

[@) Madel Group ~

W ® - &x
== g}u = Wall @ &
. sr:l Ry Vertical -
y aft et
Face I Dormer E=
Opening Datum  Work Plane

m Project Browser - 3D Reinforceme... X

5

>

v

=10, Views (all)
[ Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
(= 3D Views
Analytical Model
(30}
= Elevations (Building Elevation
East
North
South
West
{# Sections (Building Section)
7] Legends.
[T Schedules/Quantities (all)
Sheets (all)
+ 2] Families
il [@] Groups
&8 Revit Links

>

Click to select, TAB for alternates, CTRL adds,

SHIFT unselects. (¢

20 2 MMain Model

9 < B O M & o

9 You can set the Structural Rebar Object Style and make it easier to view. (Click Manage Tab >

Settings panel > Object Styles

Object Styles

=

Model Objects Annotation Objects Analytical Model Objects Imported Objects

Line Weight . . . ~
Category - Line Color | Line Pattern Material
Project... Cut

[} Structural Conn... |1 1 Beiack Solid

[ Structural Fabri... |1 1 M Black Solid

[} Structural Fabri... |1 1 Beiack Solid

[+ Structural Foun... |2 4 M Black Solid

[ Structural Frami... | 1 4 M Black Solid

[ Structural Path ... |1 1 M Black Solid

[ St 57T Wik e )

[ Structural Rebar... | 1 Black Solid

[# Structural Stiffe... |1 Black Solid

[ Structural Trusses | 1 RGB 000-12] Dash

- Telephone Devi... |1 Black

[+ Topography 1 6 M Black Solid Earth

- Walls 2 M Black Solid Default Wall

[F Windows 2 M Black Solid

[ Wires 1 Black Solid

(V]
Modify Subcategories
Select Al | | SelectNone | Invert |

Delete

[ ok

Apply

Rename
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REHG Q-7 -8 =-FOA @22 & -5 30Rinforcement (Completed) -3DV.. ¥ [ipearemoorpmase |08 8 ¢ L signin W ® - &x

File Architecture  Structure  Systems  Insert  Annotate  Analyze

PES B
®hiaa 2

Modify| Materials Additional _
IF@ - settings
Select ~ Settings
Properties x
@ 3D View -
3D View: {3D) ~ | B8 Edit Type
Section Box | ~
Camera !
Rendering Set... Edit... ]

Locked Orient
Perspective

Eye Elevation 254622
Target Elevation 4088.1

Camera Position/Adjusting
Identity Data
View Template <None> ]
View Name i3’l‘3) vvvvv

Dependency  |Independent

Title on Sheet

Phasing
Phase Filter Show All
Phase New Constructi...

v

Properties help Apply

1:100 BHGKIGRBEEY o MG IE <
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7§

Massing & Site  Collaborate  View  Manage  Add-Ins  Modify

25 G

Manage ,_,  Phases

gn 5
Main Model v ks B a5 s
Design Options

@~

s B 3

@7  Dynamo Dynamo

Player

Manage Project Phasing Selection ' Inquiry Macros  Visual Programming

DWBNEN N\

AN

AViv®

& 0 = MiMain Model

% ~ Project Browser - 3D Reinforceme... X
2 = 10, Views (all)
. =l Structural Plans

Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
=1 3D Views
Analytical Model
3D}
=) Elevations (Building Elevatior
East
North
South
West
il Sections (Building Section)
7 Legends
™ Schedules/Quantities (all)
Sheets (all)
& 2] Families
+[@] Groups
8 Revit Links

v

>

>

FEROERNCTo

10 Next, place starter rebars. First cut a (building) Section of the column and then go to this section

view.

ReBG-S-7-82-20A @- 0% &E- 7 30Rinforcement (Completed) - Struc..  # [Tpeakepmordorprrase |88 5 ¢x L signin W @ - & Xx

Architecture  Structure  Systems  Insert  Annotate

x}acm-ngj E&DIL Dly 0

b ot - & &H-

&
Modify]

+. O ="
P3O

Massing & Site  Collaborate  View  Manage Add-Ins  Modify | Views @~

Reference

= =
- sSize  Splt

Crop Segment
Crop  Section

Y Pon- K24
Select * Properties  Clipboard Geometry
Properties 73

Section -

Building Section
Views (1) ~ B Edit Type
Color Scheme .., Background @

Color Scheme <none>

Default Analys... None
Sun Path ]
Extents
Crop View i~
Crop Region V...~
Annotation Cr... .J

Far Clipping | Clip without line S

Far Clip Offset 607.6
Scope Box None

Identity Data
View Template <None>
View Name Column RC

Dependency  {Independent
Title on Sheet

Referencing S
v

Properties help Apply

. 3l 52 ~ Project Browser - 3D Reinforceme... X
0, Views (al)
= Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
= 3D Views
Analytical Model
30}
~ Elevations (Building Elevation
East
North
—— - South

West

1:100 FAH& AMEP o RAE <
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7

o0 ¥ Main Model

i Sections (Building Section)
57 Legends
T Schedules/Quantities (all)
Sheets (all
i & Families
i [@] Groups
&8 Revit Links

v
>

>

el i o e P

11 Click Structure Tab > Reinforcement panel > Rebar. Select

e Rebar Shape: 00

e Placement Methods: Sketch Rebar and select the footing

e 40R rebar

e Placement Plane: Near Cover Reference
e Placement Orientation: Parallel to Cover
e Rebar Set: (Layout: Maximum Spacing and Spacing: 300mm)
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Sketch the starter rebar as shown below. Then mirror this starter rebar to the opposite face and
move it slightly upward.

11.2

1 Goto Level 2 (Structural Plan).

Placing Area Reinforcement for Floors (Slabs)

2 Click Structure Tab » Reinforcement panel > Area.

REHG-®-0-8 2 -FOA @05 & B+ 30Rinforcement “Stuc. b [pe M5 & Lsonn W @ -&FXx
Architecture ~ Structure  Systems  Insert  Annotate  Analyze Massing & Site  Collaborate  View Manage Add-ins  Modify @«
[y Q) wall = [ Truss =, ## Arca [P Fabric Sheet g] £ Model Text b o gjg 2 Wall 1)
[ coumn B Brace ) [ cover It Mode! Line 223 E g Vertica I3
Modify] Beam Structural Area Reinforcement Component o By Shaft gH Gid  Set @
¢ Floor - [ Beam Sy oy e boundary of an area to populate with rebar. A () ey - (& Modal Group ~ | pace £ Dormer
Select ~ Structure nforcement = Model Opening Datum  Work Plane
The finished sketch is an area reinforcement instance with up to 4
= 1 layers of evenly spaced reinforcing bars for floors, walls and T T T ’ ;
Proj x ~ Proj Browser - 3D Reinforceme... X
perties foundation slabs. i o . _p@ R ~ ProjectBrowser30 Reinforceme= %
- e e ----{TT‘,————--——-'%J— 10, Views (all) ~
I ! Structural Plans
g;lm Structural Plan - | A 14! L I
| . s 300 x ; i Level 1
1 ‘ =/ : . _ _ soopm T Level 1 - Analytical
Structural Plan: Level 2~ 8 Edit Type | | F===3°= = 7” Level 2
Orientation Project North ~ AL ﬁ N ) Level 2 - Analytical
Wall Jain Displ.../Clean all wall joi.. 1k 300 x \_/‘ ) Site
Discipline Structural L _ _ soopm N _¢‘ = 3D Views
Show Hidden ... By Discipline S S | e _‘: Analytical Model
Color Scheme ... Background L I (30}
Color Scheme <nones | I SE% X | I Elevations (Building Elevat
L S%ypm o East
Systern Color . [N Press F1 for more help I = - North
Default Analys... None . . i 1 1" South
Sun Path O [[/ i it IfT ' wu|
esi
. il
LT |- _ Jl———— R S G, S GRS S ———_—!LL = Sections (Building Section
Range: Base L. None 38} ey b i [ Column RC
Range: Top Le...\Unbounded - Section 1
Underlay Orie... |Look down Section 2
Extents * [ ] Legends
Crop View O [T Schedules/Quantities (all)
Crop Region V... [ Sheets (al)
Amnotation Cr... [_] | # E] Families
(P —— e ) v |4 [@] Groups v
Properties help Rty 1:100 P KEME2 ¢ RMEE < > il< ?
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. (7 2 0 & B Main Model TG STo

3 Select the slab below the corewalls on plan. Then sketch the area of the reinforcement on plan
using Rectangle as shown below.
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4 Change the area reinforcement properties as follow.

Layers
Top Major Dir...
Top Major Bar... 20T
Top Major Ho... Standard Hook...
Top Major Ho... Down

Top Major Sp... {150.0 mm

Top Major Nu... :2
Top Minor Dir...
Top Minor Bar... 12T
Top Minor Ho... None

Top Minor Ho... . Down
Top Minor Sp... :300.0 mm

5 Click Finish Edit Mode ”to add the area reinforcement.

6 Create a (building) Section across the slab.
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Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage Add-Ins  Modify =~

h Q wall -+ [ Tuss % & '@ o) ## Area [ Fabric Sheet 3 Model Text b o 3{5 2. wall ) @ [1:6]
[ column [ Brace i w3 Path [E cover I\ Model Line = Ay Vertical 7
Modi Beam Connection Isolated Wall Slab  Rebar Component By Shaft gﬁ Grid Set
&= Floor =[] Beam System - B Fabric Area #3 Rebar Coupler - [&) Model Group = Face 7 Dormer [
Select ~ Structure 3 Connection = ¥ Foundation Reinforcement = Model Opening Datum  Work Plane
o = ! | ! (| E0 5 ~ ot Bower - 30 Rforcame.
I i U = 10 Views Gl ~
Structural Plan - T | e I | B Slruftura\ Plans
evel 1
- I* = Level 1 - Analytical
Structural Plan: Level 2~ | 8 Edit Type | — = L
Graphics * A I | Level 2 - Analytical
View Scale 1:100 l I Site
Scale Value 1: /100 | 20T @ 150 mm (T) | L = 3D Views
Display Model | Normal ] i 12T @ 300 mm (T) == Analytical Model
Detail Lovel  Medium \ 40R @ 300 mm (B) EW. [ B0}
Parts Visibility | Show Original N V | 1! | [ Elevations (Building Elevat
Visibility/Grap.. | Edit. § Il il I st
Graphic Displa... Edit.. JL o A _'LJL North
Orientation  Project North — - e e W e = = south
" B THT il TF— West
Wall Join Displ..{Clean all walljoi. & Sections (Bulding Section
Discipline Structural — Column RC
Show Hidden ... By Discipline Section 1
Color Scheme .. Background | — Section 2
Color Scheme <none> Section 3
System Color . Edit.. ) Legends
Default Analys... None T Schedules/Quantities (all)
Sun Path O 13 Sheets (all)
e : il | v (6B B Families v
Properties help Apply 1:100 FFh WM 0 BMIE < > al< 22
Click to select, TAB for alternates, CTRL adds, SHIFT unselects, 7 i 0 [B W vain Model =R e e R )

ReBG-&-@-8/2-20A @- 0% & B 30Rinfocement (Completed) - Secti..  »[peakeworsorpnose | &5 ¢ L signin e @ - @ X

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify (3

h g Q) Wall = [ Truss [% 9 =) ## Arca [ Fabric Sheet . £ Model Text b g:g 2. Wall By @ 1)
[ coumn B Brace i 1 Path Cover [\, Model Line wlin % Ry Vertical 7
Modify| Beam Connection Wall Slab  Rebar Component By  Shaft Gid  Set
(e Floor = [[]] Beam System - B Fabric Area 1 Rebar Coupler - [@&] Model Group *  Face I~ Dormer
Select ~ Structure s Connection * ¥ Foundation Reinforcement = Model Opening Datum  Work Plane
Properties x | @ 53 ~ Project Browser - 3D Reinforceme... X
=10, Views (all) ~
Section d = Structural Plans
Building Section Level 1
Level 1 - Analytical
Section: Section 3 ~ 8 Edit Type Level 2
Hide at scales ...| 1: 100 ~ / Level 2 - Analytical
Discipline Structural = = - - s = = - - s =¥ ] sie
Show Hidden ... By Discipline u H [ . = 3D Views
Color Scheme ... Background { . . . . . » . . . ] . Analytical Model
Color Scheme <none> G D — = S
St “._—._.JND“E oL LT R I | 1. 71 Elevations (Bullding Flevat
Sun Path 1 Co ST o Lo - o a ’ East
P 5 - - North
c"‘ " S South
9P 'm_[ N k West
Crop Region - - . 1 Sections (Building Section
Annotation Cr... [_| RN P Column RC
Far Clipping  Clip without line e Section 1
Far Clip Offset 63756 S Section 2
Scope Box MNone - - Section 3
Identity Data B cy Legends
View Template <None> - - . [T Schedules/Quantities (all)
View Name  Section 3 - . . Sheets (all)
[P E—— TR, s e v | H] Families v
Propertes helg Eixh) 1 B KF R 0 RRITE > e >
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7 FaE) 2 Main Model L - R S R

11.3  Reinforcement Settings
There are many parameters to control the reinforcement in Revit. To check/revise the setting,

Click Structure Tab > Reinforcement panel
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Reinforcement ¥ . Reinforcement
e Rebar Cover Settings
Rebar Cover Settings X
Add, remove and modify rebar cover settings.
Description Setting Duplicate
Rebar Cover 1 25.0 mm
Rebar Cover 2 40.0 mm
Delete
OK | ‘ Cancel ‘ ‘ Help
e Reinforcement Settings (e.g.
Reinforcement Settings X
¢ General Setting Value
- Reinforcement rounding - —
- Reinforcement presentation Slab Top - Major Direction M
® Area Reinforcement Slab Top - Minor Direction m
- Path Reinforcement : . :
. Varying Rebar Set Slab Bottom - Major Direction (B)
Slab Bottom - Minor Direction (B)
Wall Interior - Major Direction (0]
Wall Interior - Minor Direction 0]
Wall Exterior - Major Direction (E)
Wall Exterior - Minor Direction (B)
Each Way EW.
Each Face E.F.
How do I edit tag abbreviations for area reinforcement? oK | | Cancel
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e Reinforcement Numbering

Reinforcement Numbers X
Minimum number of digits for reinforcement numbers:
Filter partitions Fe) ‘
Rebar Numbers Fabric Numbers Coupler Numbers Remove Gaps
Partition
Start In Use Start In Use Start In Use [ ]
<Unassigned> ] | 1 ‘ 1-7 ]
How do these settings affect reinforcement numbering and partitions? oK ] l Cancel l | Apply
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CHAPTER 12 - WORKING WITH FAMILIES

One of the advantages in using Revit is its ability to create and customize families for users to build
their own parametric objects to be used in a project. There are many aspects in families and once

you master them, you can model almost anything parametrically.

In this section, you will learn
e The concept of “family” and “parameter” in Revit.
e How to create family elements with parametric dimensions.

e how to create parametric frameworks with constraints and parametric dimensions

12.1 Introduction to Families

Family in Revit is a group of components that shares a set of common properties, parameters, and
graphical representation. Components in a family can have different values for each property and
parameter. Various components in architecture, structure, and MEP can be made as families. It is

like "block” in AutoCAD that these two are preset symbol for certain components. The

differences are that families are objects with properties and generally drawn in 3-dimensional way
with parameters to allow user to adjust detail features of each component.

Image from http://www.revit-content.com/content/window/

Generally, Revit elements have a "Family Category > Family > Type > Instance” hierarchy. For a
window family depicted above, the structure is “Windows > Casement Windows > 0610 x
1220mm". Categories control the overall organization, visibility, graphical representations, and
scheduling options of Families within a project. Families serve to represent a discrete building or
documentation elements in a project. It defines parametric, graphical, and documentation

requirements. Types are defined by distinct parametric, graphical, and documentation
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characteristics which makes it unique from other types in a family. An Instance is an individual

representation of a type. There are 3 kinds of families in Revit.

Columns (1)
C r

Fost

Offset

Moves Wah Grids

Moves WiahNearby . |

Family: Column

Family: Pile Cap (Name)

Types (B x D x H):
5mx5mx1m
2Zmx4dmx 1.2m
3mXx2.5mx1.5m

Instance (L):
Pile Length (Varies)
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Columns

Round Rectangular
columns columns

Rectangular |88 Rectangular

Round Round
column column

Type column column
450mm 600mm

450 x 600 x
600mm 750mm

12.1.1  System Families

System families are very basic components in architectural, structural, and MEP representation. They
can be created in a project with basic functions. In Revit MEP, pipes, ducts, cable trays, and conduits
are system families. The shape (more specifically, the section profile) of these families cannot be
changed, but the dimensions can be controlled. They cannot be loaded, but they can host some of
“loadable families”. They are stored within a project and pre-set and can be transferred to another

project using Transfer Project Standards.

12.1.2 Standard Component (Loadable) Families

Standard component families can be created and edited in the family editor. Loadable families
include diffusers, dampers, valves, tags, and so on. They are saved in separate files in "“.rfa" files (not

in project file with "rvt” extension) and they can be loaded to projects for the use. Some of the

parameter values are referred from lookup tables, type catalogues.

12.1.3 In-Place Families

In-place families are project specific families with custom shapes and parameters. In one project,
multiple in-place families can be used and each of them can be copied. Unlike system family or

loadable family, multiple types cannot be created. They are also transferable to other projects.

12.1.4 Family Types

Family types are included in system families and loadable families. Objects under the same type
share type parameters and properties. Family instances are individual objects under a certain type
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in a family. Instances have instance parameters and properties. The image below shows various
types of “Casement Windows" and objects under “0915 x 1200mm” type with different "Sill Height”

instance parameter value.

Figure 1 Various Revit components in families

From “Type Properties”, you can find Type parameters, and from “Properties” palette, you can

control the parameter of each family instance. The below is “0915 x 1220mm” type properties an

instance Properties of a window object.

‘ Select | Proverties | Clioboard Geometry ‘ Modify. ‘Vlewv MNSHNI Create Placement Tools.

Modify | Ducts  Width: 500mm  ~  Height: 400mm ~  Offset. IZEENNN ~
I 3D View: (3D) - for image 01

Rectangular Duct
Default

Ducts (1)
Constraints
Mechanical

System Classification Supply Air
Supply Air
Mechanical Supply Air 7

System Type

488.1 man Keynote

L Model
0.000000 Manufacturer
4444 mm Type Comments
1 URL

6048 m Description

Assembly Description

Assembly Code
Additional Flow Type Mark
Vedocity Cost .
00 P,
0.000000
= 500 mms400 m - o — concel

Prrinartiss hairs Apply -

m 0

Ready # 0Omm ZPress & D17y |

Figure 2 Family Parameters in an instance’s properties and type properties
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12.1.5 Parameters

In Revit, parameters are values that control the geometry or properties of model components. In a
model component, relationships between parameters are defined that users can easily have desired
results by changing parameters. For successful implementation of Revit in a project, it is very

important to understand how parameters behave. In Revit, there are 4 kinds of parameters.
Family Parameters

Family parameters control properties and graphical representations of families. They can be added

and edited only in the family editor. In the project editor, parameter values can be changed.
Project Parameters

This type of parameters is used in a project file. It is mainly used for schedules, i.e., to add new field

to schedules or calculations in schedule.

Shared Parameters

Shared parameters can be used in families, projects, tags, filters, and schedules. They are applicable
to all kinds of categories. You can add your own parameters that are not provided by family

templates or project templates. They are stored in separate text files and loadable from other

projects or families.
System Parameters
System parameters are defined inside of every family. Most of them can be used for schedules

and Tags.

12.1.6 How to add loadable family libraries to Revit

Family libraries are not installed with Revit program by default. To have Autodesk’s family libraries,
additional features need to be installed from control panel. (Control Panel > Control Panel Items
> programs and Features > Autodesk Revit 2017). Select “Add or Remove Features”, from “Select
Content”, check “English — US Metric”. With default setting, libraries will be installed at
“C:\ProgramData\Autodesk\RVT 2017\Libraries\US Metric

12.1.7 Family templates

Family templates are preset canvas for family creation. They define how the family objects behave.

To create a loadable family, template is essentially required.
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v| = B X E] vews ~
. = Preview

Name Date modified Type i

1. Annotations 2014-10-17 2=1... Filefolder |

1. Conceptual Mass 2014-10-17 2% 1.. Filefolder |=

L Titleblocks 2014-10-17 2=1... Filefolder _([]:__ |—_ .
Metric Baluster.rft 2013-02-01 2=4:.. RevitFamil A ]_
% Metric Baluster-Panel.rft 2013-02-01 2= 4:... Revit Famil
Metri: Baluster-Post.rft 2013-02-01 2= 4:... Revit Famil |
Metri: Casework wall based.rft 2013-02-01 2= 4.... Revit Famil
Metric Casework.rft 2013-02-01 2= 4:... Revit Famil

% Metric Column.rft 2013-02-01 2= 4.... Revit Famil
Metric Curtain Panel Pattern Based.rft 2013-02-01 2= 4.... Revit Famil
Metri: Curtain Wall Panel.rft 2013-02-01 2= 4:.... Revit Famil
Metric Detail Item line based.rft 2013-02-01 2= 4:... Revit Famil

Metric Detail Item.rft 2013-02-01 2= 4:... Revit Famil
E&;Metric Division Profile.rft 2013-02-01 2= 4:.. Revit Famil

Metri( Door - Curtain Wall.rft 2013-02-01 2= 4.... Revit Famil

[z Metric Door.rft 2013-02-01 2= 4:... Revit Famil
F= Metric Flectrical Faninment ;"f;r Nn12.n2-0 ‘0 =4 Revit Farv;?l Rz

File name: Metric Division Profile.rft v

Files of type: [Family Template Files (*.rft)

Default path for Family Templates is
C:\ProgramData\Autodesk\RVT 2017\Family Templates \English.

Major family templates

Wall-based Template Template for wall mounted family objects. With “opening” component,
doors and windows can be created. In Revit MEP, lightings and fire alarm

families use this kind of template.

Ceiling-based Template Template for ceiling mounted family objects. This can be used to create
ceiling mounted lightings, sprinklers, and diffusers.

Floor-based template Template for floor mounted family object. In Revit MEP, heating register
families can be created with “opening” component.

Roof-based Template Template for roof mounted family objects.

Standalone Template Template for standalone family objects. The family objects do not require
host, they can be placed anywhere in a project model. (e. g., furniture, duct
fittings)

Line-based Template Template for family objects along lines

Face-based Template For reference plane mounted family objects. The host of the family objects

is changeable and could be placed in any kind of faces.

12.1.8 Reference plane

Understanding the concept of reference plane is fundamental in creation of Revit family and
parametric frameworks. It is very important for users to understand how it works to implement Revit
it a successful way. It is basically guide plane that your model object can refer to in order to establish

parametric frames works for family objects. There are 3 main use of reference plane.

1. Users can draw base sketches on it to create extrusions and other “formworks” in Revit.
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2.

3.

Faces of models can be aligned to reference planes to create constraints.

In between reference planes, parametric dimensions can be added to create parametric

framework of a model.

While creating parameters and constrains, test the model as many as you can. This will make sure

you are

creating parameters and constraints as you intend, it is also helpful to use least number of

views for constrains for the future edit and use of the model.

12.2 How to create a family?

9 Steps to create a family

This is supposed to give you a clearer picture of what we are about to cover. The order can be

changed, and some steps can be skipped when you become familiar with family creating & editing

process.

Design what you want kind family to you want to create. More specifically, you need to
know what are required specifications, parameters, category, and shape of your family. You

can do some sketch if you need.
Select template file.

Template defines types and hosts for your family. More specifically, it determines your family
is going to be either wall-mounted or ceiling-mounted. If you want to create annotation,

or title instead of models, you have to choose right template. Once template is selected for

family creation, this cannot be changed in later stages. In other words, a wall-mounted
lighting family cannot be a spot lighting family.
Set category of your family.

Base on the category you set for your family, the function will be determined. Some

parameters will be added as well.
Create parameters of your family

Create "type parameters” and “instance parameters” for your family. This can be edited in

the process.

Arrange reference planes/Reference planes works as guide for the shape of your family.

They are also used to set constrains.
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6. Create components and set parameters to family

Components can be solids for shapes, or texts for annotations. If you set dimension, this
can be turned into parameters. Based on the function of each component, you should make it

refer to certain database (catalogue, lookup tables) or constraints.
7. Test your family

In the process, you should do as many tests as possible to make sure your family works as

you designed.

8. Set graphical representation
Set graphical representation of your family in 2D and 3D views.

9. Save and load into a project file

Save your family in “rfa” format and load it into a project file. Here you need to test your

family again to check if it works well with other families in the project.

You do not have to fully understand what we have covered so far. They will be picked up in the

process of modeling exercises.

12.3 Overview of Family Creation with Structural Column Family

The best way to understand the concept and functionality of family editor is to create a family. In
this tutorial, we will explore the functions in the family editor with a simple structural column
example. Through the exercise, we will look ways to create family elements with parametric

dimension, and how these things work together to create a parametric framework.

Family Editor is a tool to edit and create families. It has a very similar look to project editor. It

provides functions to create forms and set properties for families. There are six taps; “Create”, “Insert”,

"Detail”, "Modify”, “View" and “Manage”. The detail functions will be covered in modeling exercises.
12.3.1 Template

Start your Revit software, and go to “File > New > Family”. Then you will see a window pops up
with a list of templates. Family templates set basic features of families. In order to create a structural
column family, select “Metric Structural Column.rft” file and click “Open” button. If your
window does not show the folder, go to the path “C\ProgramData\Autodesk\RVT 2017\Family

Templates\English”.
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——— -
L | New Family - Select Template File _ - — L

i Look in: | |, English v e B X 8 vew ~
- Preview
Name DA
Metric Specialty Equipment wall based.rft 2 m
Metric Specialty Equipment.rft 2( == = E‘
Metric Spot Lighting Fixture ceiling based.rft 2 m
Metric Spot Lighting Fixture wall based.rft 2
Docgments Metric Spot Lighting Fixture.rft 2
n,ﬂ_j | 1'13 Metric Structural Column.rft 2(
My Computer Metric Structural Foundation.rft Type: Revit Family Template 2
- X Metric Structural Framing - Beams and| Size: 236 KB 2(
/:j Metric Structural Framing - Complex af Date modified: 2012-01-21 @ 7 4:42 | 2(
My Network ... Metric Structural Stiffener Line Based.rft 2
R Metric Structural Stiffener.rft 2
- Metric Structural Trusses.rft 2=
Favorites Metric Telephone Device Hosted.rft 2(
Metric Telephone Device.rft 2
«| i | »
File name: Metric Structural Column.rft
Files of type: IFamily Template Files (*.rft)

12.3.2 Parameter Set up

Once the family editor begins, you will see some dimensions and green dotted lines. The green
dotted lines represent reference planes. The dimensions are associated with the reference planes to
move the planes parametrically. This means that the three horizontal lines always have an equal
distance in-between, and the total distance between the top one and the bottom one will be 500mm.
The distance is controlled by a parameter called “Depth”, which is currently 500mm. Three vertical
reference planes are the same. These are preset features for your structural family, you will see

different elements from different templates.

Properties a||Family1 - Project Browser [a] @R A
410 Views (all)
@ Floor Plans
K Lower Ref. Level " EQ . EQ
@ Ceiling Plans.
Family: Structural Colu » | ¥ £4/1 1 Lower Ref. Level : , !
Constraints : 3D Views | |
Host View 1 |
Structural A # Elevations (Elevation 1) \ [ g
Material for Mo... [Other || Back o N | §
Always export a... ) Front w "
Beam cutback in... From bounding... Left N———- - =
" Right (e} | - s
kentty Deta £ Sheets (al) w | o
Omiclass Num.. 232530110411 |ff 0 - N P N 8
OmniClass Title | Columns |
[l ol Groups
Other = Revit Links !
Cut with Voids .. ™ |
Symbolic Repre... | From Family | |
Shared o | |
Show family pre... # ‘l | |
Width = 500
—
helo Apply 1:20 0O & L L] " »
Click to select. TAB for alternates, CTRL adds, SHIFT unselects. [Press & Drac 7.0

Page |10



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

Select the horizontal reference plane in the middle. You can see that the reference plane is pinned.

This means the reference plane will not move but not the two reference planes related by the

dimensions.
Properties [a||Family1 - Project Browser [a1 o -8 A
10, Views (all)
# Floor Plans i
Lower Ref. Level _EQ EQ =
W Celling Plans / d 74
|Reference Planes (1) = | 1y Lower Ref. Level ! ) .
Construction *fl = 3D Views | | |
Wall Closure View 1 | I |
Identity Data L)  Elevations (Elevation 1) \* i T =
Name Center (Front/Ba.. Back le] 3
T 5 Front ] ! ‘/ -
|
Scope Box None Left | S QG (S| S| PR 1]
S B Right o | I Reference Planes : Reference Plane : Center (Front/Back) J|
-
Is Reference Center (Front/... l : :hee:s (ol L | | []
Defines Origin &1 g Y LR/ P | i Bpmge = = (=]
[ Groups N y
w= Revit Links | | |
| | |
I I |
| [ |
| |
Width = 500
"
Proverties helo Apply 1:20 0O ® oS v @ m »

From the ribbon tab, go to "Properties” group and select “Family Types”

ﬂ =] SECE E&Dk Dbgé"q‘ [(ﬁf 2 &% B Poegmm @

Edit Visibilty|  Edit Pick | € Work Plane | Load into

51
(1 Goin - 8o of 01 =“m f
= - B s () =X Extrusion Settings | Work Plane  New Project
Select | Properties | Family Types | Measure | Create Mode | Work Plane Placement | Family Editor

Allows you to enter parameter values for existing family types,

add parameters to the family, or create new types within the
Properties family. =8RES

In one family, you can create multiple family types, where each EQ EQ
type represents a different size or variation within the family. Use i w
the Family Types tool to specify the parameters that define the HH’ 3

Famil: Structural Colu| ferences between fami types. I I I =

“onstrai | | |
CH . i Press F1 for more help [ | |
ost
Structural L] & Elevations (Elevation 1) - e sl co menems m gl o
Always export a... 0 Front w | | | 1]
Beam cutback in... From bounding... Laft s# "= mEs s e T = ‘I ****** ~
= Right | s (=
ety Do 2 B Sheets (all) 8 | e a
OmniClass Num... 232530111411 || 2o N ! | @
OmniClass Title | Columns N N i T i o
| & Groups
Ll = Revit Links | | |
Cut with Voids ... & | | |
Symbolic Repre... | From Family | | |
Shared o | | |
Show family pre... | |
Width = 500
|Proverties helo Apply 1:20 O@® MBS m »
Click to select. TAB for alternates, CTRL adds, SHIFT unselects. [IPress & Drac 7.

You can see that "Depth” and "Width” parameters are listed under “Other” Group.
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Select | Properties

Datum | Work Plane | Family Editor
e - =0R
it Name: ¥, ¥
Family Types b
[ ne EQ EQ pf‘
Family: Structural Colun = | 4 £ fees I I I o
| Constraints Delete I I I
Host I I |
| Structural e amdb ] s Sraias s Sl o
Material for Mo... RN | | 8
Always export a... &
. bl : — I I I
-Bearn ciitbackih... From hovad Modfy... R T e i £ I
Identity Data °a =
OmniClass Num... 23.25.30.11.1 RIS I | [}
OmniClass Title | Columns D

Other
Cut with Voids .. 71
Symbolic Repre... From Family
Shared @
Show family pre... @

5]

Properties helo

change the value of “Depth” parameter to “600", or any other number. Then you can see that

the dimension changes accordingly and so do the reference lines.

Select | Properties Connectors Datum Work Plane | Family Editor
s m ]

Prope @R A
Properties ‘ Nomie’ - n
Family Types [
New.. EQ EQ .
Family: Structural Coluy ¥ | 7 £t Structural Material (def = | Rename... | | | e
Constraints Delete | | |
Host | | |
| Structural il it et ol O\T\
Material for Mo... | Other optadleid [ | | 8
Beamn cutback in... From t di Modify... P o sl i s e 25 o= c
= | ! I = E]
Identity Data o
OmniClass Num... 23.25.30.11.1: | | | @D
OmniClass Title | Columns = e el e B ay
Other | | |
Cut with Voids ... = | | |
Symbolic Repre... From Family | | |
i B Lo
Show family pre... ¥ | |
Width = 500
« m | »
Properties helo Apj m »

o

Now select the “Depth” parameter and click "Edit Parameter” 7 button. “Parameter Properties”
window will pop up. Change the "Other” under "Group parameter under:” to "Dimensions”.
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Cipboard | Geomery [ a——— | Foiy Edior
il 3 Electrical
! Family Types ngm: = G'r"mmng
lectrical - Lighting =
Properties Neane: v  Hlectical - Loads =8
Eledtrical Engineering =
Family Types Energy Analysis 18
Fire Protection ~
General "
Graphics Z
Family: Structural Coluy ¥ |~ £/t Structural Material (def e mwm[;w i - nd families, exported to ODBC, and
Constraints Delete Es:;"a"‘““"
Host Materials and Finishes . .
Mechanical Select... xport
Structural b Mechanical - Flow E
Material for Mo... | Other ;ned\avg'r: - Loads
Always export a... Adds e
rag Overall Legend Ol
Beam cutback in... From boundin Modify... | Phasing ype
Identity Data
OmniClass Num... 23.25.30.11.14 [ Remowe | Pumblog * Instance
OmniClass Title | Columns Segments and Fittings P =
K | ns Eegeislal I Re‘pon ing Parameter
Other Structural (Can be ueed 1o exty
Cut with Voids ... & Strichued Analysis o o
i A e —
Shared =
Show family pre... ¥ m [ Py ] [ Help
« 1 » |
|
[ oot T[ meev [ ep ,
T T |
| |
I | -
Proerties helo Apply 1:20 O8 e o @ m »

Ready

click “OK" button to close the “Parameter Properties” window. Now
to the parameter list and “Depth” is under “Dimensions” now.

T

"Dimensions” group is added

Select

Host
Structural

Identity Data

OmniClass Title

Other

Shared

|Properties helo

Properties

Material for Mo...
Always export a... -
Beam cutback in...
OmniClass Num...
Cut with Voids ...

Symbolic Repre...

Show family pre...

Columns

{a]

From Family
{a}

L]

Apply

Clipboard

Family Types

Rename...

Delete

Remove

Work Plane

Placement | Family Editor _

6OOL

Depth

@

LY

sy

.0

We are going to use a square section for the column family. So we do not need to control the
"Depth” and “Width"” parameter separately. Type in "Depth” to “Formula” of “Width" parameter. use
the exact letters. This way you can associate parameters to each other. By changing one of the values,

you can change the both parameters now.
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12.3.3 Base Geometry

Now we are going to create a geometric object that is associated with the parameters we set.

"Extrusion” is the most commonly used function to create a solid object. Go to “Create” tab and

select “Extrusion” button from the ribbon tap.

5

=
B

8@GRE I\ @ -

[ Show
[ Viewer

+ N @ @ |

Blend Revolve Sweep Swept Void _| Model Component - Control Reference Reference | Set Load into
ALt L - [@] Model Group + Line Plane Project
Select | Properties Solid Extrusion odel Control Connectors Datum Work Plane | Family Edilmi
Creates a 3D solid by extruding a 2D shape (profile)
[Properties When you sketch a 2D shape, it is used as the basis for a 3D il ~
shape extruded between a start point and an endpoint EQ EQ
b
| , 1 ~
I | I
[Famit: Strucural ol ] % £ ‘ ‘
Constraints 3 ‘
Host | |
smavdd |} LY | BB N— - R ey I — r®)
Material for Mo... [Other | I | o
Always export a... | | ©
Beam cutback in... From bound | | | 1]
T | T | D =
OmniClass Num... 23.25.30.11.1 press F1 for more help / ; ; °
OmniClass Title | Columns | M Groups (NN ‘ ‘ : 8 [
Other w Rovit Links < ---—--F—-——t ——— - ==
Cut with Voids ... & | | |
Symbolic Repre... From Family [ | |
Shared = | | |
Show family pre... ¥ | | |
| [ |
&\_/Idth =600
Proverties helo Apply 1:20 O® " on 2 L] m »

To create an extrusion, you need to create a two-dimensional sketch first. Once you click started the

function, the ribbon tab will be automatically refreshed to show the sketch functions. Select

“Rectangle” from the “Draw” menu.

D VR0
b | Bl Bo &Pl Dl == & = [0 X | /BSO- gf o @R
P 8o ] . Y
Modify Il v .0‘ o O 5“ p */% B Rectangle
= - ¥ g Q t R R “ > Creates a rectangular chain of lines by picking 2 opposite
Select | Properties | Clipboard Geometry Modify Measure | Create Model corners.
Depth 2500 |/ Chair Offset: 00 |Radius 1000.0
= You can specify an offset for the rectangle. If you want the
Properties 41 [Family1 - Project Browser [a1 comers to be curved, specify a radius for the fillet -0n A
| 41 Views (all)
| = Floor Plans
Lower Ref. Level S
4 Ceiling Plans
|xtrusion 2 ¥ Edit Type Lower Ref, Level
Constraints | 30 Views
Extrusion End  [250.0 H View 1
Extrusion Start 0.0  Elevations (Elevation 1)
Work P Back ) o
ork Plane Level : Lower Ref . o
Graphics * Front (JJ @
Visible f" |_] b 4 I
PR 7 = Right =
Visibility/Graphi... Edit... K o
|l = Sheets (aly =
Materials and Finishes : (@] Q
. @ @) Families T g
Material <By Category> U L (]
+ |[[* & Groups (@)
Identity Data « Revit Links N
Subcategory None
Solid/Void Solid
J(Wldth = GO(j/
Properties helo Apply 1:20 O ® L A N ] m »

As the instruction suggests, designate the two corners of the rectangle and make sure that the
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two corners do not coincide with any of the reference planes. The size does not matter at the

moment.

EL &&Dh Db“"“‘ X /B0¢9- @ & @
Modify | [T B8 SO Set  Show Viewer
=4 1RO T aa f v |54
Select | Properties Clipboard Geometry Modify | Measure | Create | Mode Draw Work Plane
Depth 250.0 \ .| Chair Offset: 0.0 1| Radius 1000.0
pel (a/||Family1 - Project Browser (5] =08 4
5 Views (all) 4
< & Floor Plans. EQ EQ =
Lower Ref. Level / L "
& Ceiling Plans / / %
Extrusion ~ | B3 Edit Type Lower Ref. Level n
Constraints A1l = 30 Views o—
Extrusion End | 250.0 ] View 1
Extrusion Start | 0.0 |f| = evations (evation 1) \
Work Plane | Level : Lower Rel... Back 8
| Graphics : 0 Front 8 ©
Visible I [J ‘:“h " "
S =1 = ight A
Visibility/Graphi..., Edit 9 g 8 =
3
Materials and Finishes | tepsdig g o =
Material | <By Category> || T [0) =
e | [ Groups o)
Identity Data. w Revit Links N -
Subcategory | None
Solid/Void | Solid
/Lv\/idth =600
Proverties helo Apply | 1:20 O Lo s W m »
Enter the diagonal point of the rectangle. T

From the “Modify” tab, select “Align” function. As the name suggests, you can align two different

object to each other.

e /8060 o @ (@
e e e e v
N Align (AA P S 7| Set Show Viewer
7] 03‘ ign (AA) > >4 —
Seect | Properies | Cipboard R Aligns one or more elements with a selected element. e o Vo P
Modify | Create Extrusion || Multiple Alignmen Prefer: Walll vou can lock the alignment to make sure that other model
[Properties ]| [Famiy2 = Project Browser| honges do not affect it IR
= 5 Views (all) y
- & Floor Plans. o
Lower Ref. Leve| "
e & Ceiling Plans A
| Extrusion »)| 85 Edit Type Lower Ref. Level —
Constraints 21| = 3D Views
Extrusion Start | 0.0 U & Elevations (Elevatio ﬁc
Work Plane Level : Lower Ref Back
| Graphics 0 Front C
Visible @ th q
Visibilty/Graphi..| s Edits Right
> a Sheets (all)
Materials and Finishes = 2%
, = B Families =
Material <By Category> || ~ =
Jdentity Data : e |1 g“‘;”s . Press F1 for more help
= Revi ini
Subcategory None | J
Solid/Void Solid -E
Proverties helo Apply | 1:20 O® NI I W 5
Please select line or point reference for alignment. Y

Select the top reference plane as the target. Then click the top edge of the rectangle. The edge will

move and be aligned with the reference plane. A small lock will appear in the screen.
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Family1 - Floor Plan: Lower Ref. L...

3| Type a keyword or phrose

o= .H&DRDL)“““ ‘@B
| 1 ~ 5 <
Modify * ‘ - E] A Set Show Viewer
= Fh Q s
Select | Properties Clipboard Geometry Modify Measure | Create | Mode Work Plane
Modify | Create Extrusion || Multiple Alignmen  Prefer: Wall centerlines v
[Properties (5] [Family1 - Project Browser [=] —@% -
= G Views (all) i
& Floor Plans .
Lower Ref. Level "
| = - = Ceiling Plans :
| Extrusion w | 68 Edit Type Lower Ref. Level
Constraints *|| = 3D Views
Extrusion End D View 1 o
Extrusion Start 0.0 u & Elevations (Elevation 1)
Work Flane Level : Lower Re. Back Please select a new reference for alignment or Ctrl-dlick
| Graphics 2 Front to keep aligning to the current reference.
Visible @ Left
Visibility/Graphi..| __ Edit.. o R‘9’“I
2 o
ials and Finishes * . heets” (all)
Material <By Category> J] 3 Faples =
o 4 > J|[l« & Groups
Identty Data « Revit Links
Subcategory None
Solid/Void Solid
Proverties helo Apply 1:0 0@ & &a®m> o 74 m »
oct a new reference for alignme T

Please select a new reference for alignment or Ctrl-dlick to keep alianing to the current reference.
click the lock to close the lock. This means you just constrained your edge to the reference

line and the line will move along with the reference line.

=1l .&Dh Db“““ 75069 @ & @
= ] SOCON.
ad =112 iIkaciom EET] Ll - ek
Select | Properties | Clipboard Geometry Modify | easure | Create | Mode Draw Work Plane
Modify | Create Extrusion || Multiple Alignmen  Prefer: Wall centerlines v
[Properties "5/ [Family1 - Project Browser (5] @8
= 0. Views (all) -
Il = Floor Plans @
Lower Ref. Level "
| = 8 & Ceiling Plans 3
| Extrusion | ¥ Edit Type Lower Ref. Level
Constraints * = 3D Views &
Extrusionnd 2500 ] View 1
Extrusion Start | 0.0 U & Elevations (Elevation 1)
Work Plane Level : Lower Ref Back
| Graphics 0 Front
Visible e Let
Visibility/Graphi.. Edit., - he’:‘g"‘"
Mmdsmd?mﬂus 2 _S .t.s(a)
Material <By Category> D 51 Cabes =
= o < Il® [ Groups
Identty,Data = Revit Links
Subcategory None
Solid/Void Solid
Proerties helo |__Apply 1:20 0O . ] m »
Vo

Please select a new reference for alignment or Ctrl-dlick to keep aligning to the current reference.

Repeat the same steps to other edges and lock up the lines so that all edges are constrained to

the corresponding reference planes.
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AEERA = - A 3 Family1 - Floor Plan: Lower Ref. L..| » | 7ype  keyword o phrase a8 S
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DELE Ko Bl Di g s 3= 0] X /2000 @ B B
- N b B A« : roceN.
B8 - v PROTFaax| & ®>4 [ = TV
== -
Select | Properties Clipboard Geometry Modify |Measure Create | Mode Draw ‘ Work Plane
Modify | Create Extrusion
[Properties 'a||Family1 - Project Browser [a]] —@%
= . Views (all) 1
|| & Floor Plans e
Lower Ref. Level "
& Ceiling Plans 3
B Lower Ref. Level
Constraints *|| = 3D Views
ExtrusionEnd 2500 ] View 1
Extrusion Start 0.0 & Elevations (Elevation 1)
Work Plane Level : Lower Ref Back
Graphics Ey Front
Visible @ Lett
Visibility/Graphi... Edit., _ —Right
Materias and Finishes |l
Material <By Category> D & B Families =
= - < |l® [ Groups
Identtty Gata = Revit Links
Subcategory None
Solid/Void Solid
Properties helo Apply 1:20 0O& @B > ] m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. Press & Drac¥:n

Now go back to “Modify” tab and select “Offset” function.

E Dl Dl eis oo 3 e
Offset (FF)

O

30 S

Set  Show Vi
Copies or moves a selected element (such as a line, wall, or b - e

v omEe- A [=n
dalt s & &

SaET | e [ [ beam) a specified distance perpendicular to its length. o N T
Modify | Create Extrusion You can offset a single element or a chain of elements belonging
b ] [Fomiyt = Project Browser | 0 the same family. R R
5 1. Views (al)
& Floor Plans -
Lower Ref. Level "
= & Ceiling Plans ='1F .
Extrusion )| 8 Edit Type Lower Ref. Level
Constraints A = 3D Views
Extrusion End View 1
Extrusion Start 0.0 H & Elevations (Elevation 1)
Work Plane Level : Lower Ref Back
Graphics 0 Front
Visible @ et
wSibimy/Gmpm.fLI[D Right
Materals and Finishes | Ml
; = 8 Families =
Material <By Category> D 4 Groups T e =
Identity Data e Revit Links
Subcategory None
SolidVoid ~ Solid
Properties helo Apply 1:20 0O & 5 2 W4 m »
Click to select, TAB for alterates, CTRL adds, SHIFT unselects. IPress & Drac V.0

Set the "Offset” value to “20" from the option bar. Then click any empty spot in the canvas. Then

bring your cursor over one of the edges and make sure a dotted line appears inside of the rectangle.

Hit “tab” button on your keyboard to offset all the edges together.
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3 B;,@x o Bl B % = x{u@w@ 88 @

% paste - @ ‘3‘ @ O am ‘:4" f o Set  Show Viewer
Select | Properties Cllpboa'd Geometry Modify ’ Measure | Create | Mode .
Modify | Create Extrusion " Graphica @ Numerica Offset: 20.0 V! Copy
Properties [a]||Family1 - Project Browser [=] @R A
= 0. Views (all) =
& Floor Plans B
Lower Ref. Level LN
& Ceiling Plans
| Extrusion v | B Edit Type Lower Ref. Level -
Constraints 2 = 3D Views
Exrusion End  1250.0 | View 1
EtusionStart 00 | ||[l = Elevations (Elevation 1)
Work Plane | Level : Lower Ref.... Back
e T Front
Visible ;?"M
"""""""""" ig!
‘frslbmtsyf:;;h';m Edit | Shosts 1
Material <By Category> || e famhles =
e R AR e o & [ Groups
Identity Data 2o Revit inks
Subcategory | None
SolidVoid | Solid 1]
Properties helo Apply 1:20 oe &P CI m »
Chain of walls or lines - g

Once a dotted square appears inside the sketch, click the edge. Then the all lines will be offset

together.

/8860-

@5

o B Mg = =000
ri. =
Modrfy aste h A O] Set Show Viewer
-E% % | % 54
Select | Properties Clipboard Geometry Modify |Measuve Create | Mode Draw Work Plane
Modify | Create Extrusion | Graphica @ Numerica Offset: 20.0 |V Copy
Properties (5] [Famity1 - Project Browser o =o3
= . Views (all) .
& Floor Plans o
Lower Ref. Level "
= Ceiling Plans K
| Extrusion | B8 Edit Type Lower Ref. Level
Constraints *[ = 3D Views
BdrusionEnd 12500 || View 1
Extrusion Start |00 ||| = Eevations (Elevation 1)
Work Plane  {Level : Lower Ref... Back
Graphics 'y Front
Visible ‘ et
Visibility/Graphi... Edit shet‘g'“ :
=
Materials and Finishes || i
Material <By Category> J 53 Eames =
=Y U £ [ ® Groups
Identty Data « Revit Links
Subcalegmy |[None
Solid/Void | Solid
Properties helo Apply 1:20 0O . ] m »
Vo

Select a Wall or a Line to offset. Press TAB to select a chain of elements.

Finish the sketch mode and go to 3D view. You should see a solid geometry like the below image.
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BB B %o E&D;}!D“""'“' - [ /5060- @@ @ (g

& ¥ recea.
Join + & (O] Set Show Viewer| Load into
.% - ¥ i ’3‘ Oﬁ‘ & ® oK s | Project

Select | Properties Clipboard | Geometry Modify ‘Measure Create | Mode | Draw [ Work Plane IFam!ly Editor

[Properties []|[o1 Working with Families (1) 2.rfa - .. [& —0R A
5 10! Views (all
& Floor Plans
Lower Ref. Level

= & Ceiling Plans

Family: Structural Colu w | £dit Type Lower Ref. Level =
Constraints *|| = 30 Views %

Host View 1 5
| Structural & {30}

Material for Mo... & Elevations (Elevation 1)

Always export a... Back

Beam cutback in... From bounding... Eronk

Identity Data 3 Laft

OmniClass Num..| 23.2530.11.14.11 Right

OmniClass Title | Columns 15 Sheets (o) =

e es PN  Families

Other @ [ Groups

 Cut with Voids ... _D - RentLine

Symbolic Repre... From Family

Shared a

Show family pre... @

Prooerties helo | Apply | 1:10 @9 & s AB Q> o @4 ] »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. Press & Drac V-0

Go to “Front” view under “Elevation”.

R &&ww--u /0060 @@ @ (3

% S gy Gioin ~ 8- ’3‘ O:?m_l */* 75 gg;r&’t Set Show\ﬁewer‘ L::J;r;o |

Select | Properties Clipboard | Geometry Modify ‘ Measure | Create | Mode | Draw [ Work Plane IFarMy Editor

[Properties (5]/]01 Working with Families (1) 2.rfa - .. |8 | -0 ~
[0 Views (all y
! & Floor Plans R ‘_l ‘_ . . __UsperRefLevel G ) =
Lower Ref. Level | | | = =
| & Ceiling Plans (R
Family: Structural Colur ¥ | 7 Edit Type Lower Ref. Level Lol N
Constraints #[ = 3D Views
Host View 1 bl
| Structural & {30} | | |
Material for Mo... & Elevations (Elevation 1) | 4
Always export a... 7 Back | | |
Beam cutback in... From bounding... Front AR
Identity Data g i Lo
OmniClass Num...| 23.25.30.11.14.11
OmniClass Title | Columns 15 Sheets (o) JEE =
st o % 2 Families | | |
e SRS = [ Groups Lo
 Cut with Voids ... ‘D e Revit Links
Symbolic Repre... From Family TR
Shared = | | |
Show family pre... @ | | |
| | |
I |
S e IS
=l |
IR
Properties helo | Apply | 1:0 0@ & “a®> o @4 m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. HPress&Drac¥on

Use the align function again to coincide the top face of the solid and the “Upper Ref Level” reference

plane.
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01 Working with Families (1) 2.rf..|» | 7ype o keyword or phrase 68 8 7 L signln ) LA o) el

YEEEHEET I&m Wt = /E0es- @B @ W |
o EE oy O BB OTFaax S v 05k e e
Select | Properties Clipboard Geometry Modify 1 Measure‘ Create | Mode Draw | Work Plane | Family Eaﬁor

|| Multiple Alignmen Prefer: Wall centerlines v

[Properties 18] |o1 Working with Families (1) 2. - .. [ =03 -
= 0. Views (all) Y
= & Floor Plans o ‘ I ‘ /Ij . o ___UpperRef Level ! S o
Lower Ref. Level | lmahgnmem constraint | »
& Ceiling Plans | P
Family: Structural Colur v | % £l Ty Lower Ref. Level | :
Constraints 2 = 3D Views
Host View 1 I
Structural s {30} |
Material for Mo... = Hlevations (Flevation 1) I
Always exporta... Back |
Beam cutback in... From bounding... Froak |
Identity Data 2 peit |
OmniClass Num.. 232530111411 || _ %ot
OmniClass Title | Columns Sheets;(el) ‘ =
I & |[1# & Families |
Other - - @ [& Groups |
Cut with Voids ... &/ « Revit Links
Symbolic Repre... From Family |
Shared o |
Show family pre... @ |
|
|
|
R | o _lowerReflewl G )
| | |
T
Prooerties helo Apply | 1:20 OO & & Ma®P s @4 m »
Create or remove a lenqth or alianment constraint Fa

12.3.4 Parametric Dimension

Go back to “Lower Ref. Level” view under “Floor Plans”. Select the extrusion that you just created.

Then “Edit Extrusion” button will appear on the ribbon tab. click the button.

~ 01 Working with Families (1) 2.rf..\» | 7ype o keyword or phrase

= & B P @

88 n-ou Bl ¢ . .
& oin ~ 8- o2 O Em f isibility | Edit Pick v Load into
9’ ‘3‘ Q = H X| o ettings | Work Plane  New Project

Clipboard Geometry Measure | Create Edit E 5 Placement | Family Editor
Moty | Ednison Bl 40000 Maodifies an element in sketch mode.
Properties (3] |ox Working with Families (1) 2.rfa - .. (%] | | =08 ~
[0 Views (all Press F1 for more help ;
|| & Floor Plans ! ¥ ! -
Lower Ref. Level | | | "
E—= NN & CeingPlans | . | 7\ o i
Other (1) |8 Edit Type Lower Ref. Level v -
Constraints 21| = 3D Views |
asontod [i000 )| vews |
Extrusion Start 0.0 1) 30}
Work Plane Level : Lower Ref & Elevations (Elevation 1) Sy |
| Graphics e Back g |
Visible @ i I
Visibilty/Graphi..| s Edits vt:hm |
% & g/
hiaaets 300 Finehes Sheets (all) ! =
Material <By Category> J] Itk @ WS s g - - = - = - = — - — - = = M S i R et 1=
2 B B 0
Identity Data @ [ Groups |
Subcategory None o Revit Links |
Solid/Void Solid
|
|
|
|
_________ ! e A el A S e
3000
' = ! ‘
| | |
I I I <
Properties helo Apply | 1:20 0@ % & am» o w4 m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. Press & Drac V.

Then you can edit the sketch of the extrusion. Click the "Aligned Dimension” button under “Measure”

group. Add a dimension in-between the top two edges.
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P SEE BENN LS
Modify‘% = . ’3‘ Q -l X‘IZH 02 Angular Radial Diameter Arc

Length

Select | Properties Clipboard Geometry Modify
Place Dimensions Wall centerlines v
[Properties 1] |o1 Working with Families (1) 2.fa - %] NTE
= 0 Views (all &
! g tyle _ & Floor Plans -
B Lower Ref. Level e "
& Ceiling Plans ) o
New Dimensions | B8 Edit Type Lower Ref. Level B

& 3D Views z‘»_ \\E
View 1
30}

& Elevations (Elevation 1)
Back
Front
Left
Right
D Sheets (all) [ EI
-2 Families
@ [ Groups
= Revit Links

Measure Dimension

Properties helo | Apply % ¢
Select references, then dlick in empty space to place dimension. Y

Repeat the same steps to the other sides.

&&D&‘Db“"“ “ 5 & Pog=m

..3‘ @ O am :" ‘/* 729 edt visibiley|  di © Work Plane
Extrusion Settings | Work Plane New

Clipboard Geometry Modify Measure | Create Mode Work Plane Placement
Modify | Extrusion > Edit Extrusion
e ]| 01 Working with Famities (1) 2fa - .5 =2t
= [0 Views (all) ‘
& Floor Plans ‘\'m
Lower Ref. Level "
(S 0 & Ceiling Plans O -
| Extrusion > |8 Edit Type Lower Ref. Level — > -
Constraints Al = 30 Views N
Extrusion End U View 1
Extrusion Start | 0.0 1 30}
Work Plane | Level : Lower Ref.. 8- Elevations (Elevation 1)
e & Back
Visible 2 hront 2 O
e T = Left
Vﬁlb{'l‘y{g(ap"l:. Edit... Right
 Materials and Fnishes o Sheets (all) 7 E
Mf\terlal <By Categcy) J] -8 Families § j
Identity Data e Groups
Subcategory None # Revit Links
Solid/Void Solid

Proverties helo | Apply | 1:20 O@ % wa® 2 i @4 (]
Click to select, TAB for altemates, CTRL adds, SHIFT unselects.

IPress & Drac¥n.

Now we are going to parameterize the dimensions. First, select one of the dimensions. Then from

option bar, select "<Add parameter...>" from “Label".
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=L 2! Type a keyword or phrase

AN

] &
“ode O2 & */* D39 | Aligned Angular Radial Diameter  Ar
«| T% igned Angular Radial Diameter Arc
) 2 4 X & P
Clipboard Geometry Modify Measure | Create Dimension

Dimensions  V|Leade Prefer: Wall centerlines v Label: SNOne> s, | |Instance Paramete

e 5] |52 Working vith FamiigghNone> "
- = Views (al) Depth = 600 ‘\u‘n‘
Linear Dimension style _ [l = Floor Plans  wwidih ~ pepth = 600 :

Linear Lower Ref. Level LN
L i & Ceiling Plans 2
Dimensions (1) ~ | B Edit Type Lower Ref. Level
Graphics * = 3D Views
e ]| ven
Baseline Offset... |0.0000 mm 30}
Text #|| = Elevations (Elevation 1) o X
Value 200 Back e ‘ | &
Other 2 Front N
Label <None> Lokt 2 O
- Right
D Sheets (all) [ EI
8 Families
@ [l Groups §
o Revit Links

Proverties helo | Apply | 1:20 DO % amsm» i @4 (] »
Ready. Press & Drac 7.1

Then "Parameter Properties” window will appear. type in “Thickness” for the name and set

“Dimension” for “Group parameter under:”, click “OK" button.

>
s 0% ()
Select | Properties Clipboard Geometry Modify Measure | Create l Dimension
Dimensions  V|Leade Prefer: Wall centerines v  Label: <None> v | lInstance Paramete —ﬁ'm 4 _
[Properties [3]||ox Working with Families (1) 2.rfa - .[&] T
5 0 Views (all) Parameter Type el
Linear Dimension Style _ [l = Floor Plans AR s
Linear Lower Ref. Level (Cannot appear in schedules or tags) "
- - ) & Ceiling Plans ") Shared parameter o
|Dimensions (1) ~| S Edit Type Lower Ref, Level (Can be shared by multiple projects and familles, exparted to ODBC, and
Graphics 2| = 3D Views appear in schedules and tags)
P N || [
Baseline Offset...|0.0000 mm a0} S Dot
o 2 & Elevations (Elevation 1) ) Parameter Dats
Value 200 Back Name:
Other * Front honed .. M@ e
Left
Label <None> o
Right Discipline:
S| all) Common - @
& B Families Type of Parameter:
@ [l Groups Length - 3 '
o Revit Links Group parameter under: regert itin sor 358
N
Properties heln Apply 1:20 OB % -« &V « a9 < [ »
Ready EPress & Drac 7.1

You can see that see that "Thickness” parameter is associated with the dimension.
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BER B X o- E&Dh oo 2= & z
‘ =?n1 & Bl = Edi v""b'r Edi Pick | € Work P
-2 * ‘ O */)‘ it Visibility it i lork Plane
B~ w ) X Bxtrusion Settings | Work Plane _ New |
Select | Properties Clipboard Geometry Modify Measure | Create Mode Work Plane Placement
Modify | Edit Extrusion
Properties 51|01 Working with Families (1) 21fa - .[& ; | | —om -
= 0. Views (all) ‘
[ = Froor plans O -
Lower Ref. Level "
| = 8 & Ceiling Plans N 3
| Extrusion | Edit Type Lower Ref. Level
Constraints * = 3D Views
ExtusionEnd  [40000 ] View 1 I I
Extrusion Start | 0.0 1l 30}
Work Plane Level : Lower Ref & Elevations (Elevation 1) w
| Graphics B Back
rapl
Visible 2 I Front (D
iy Grophi- o ()] |
e h * ig
s 00d b ) Sheets (all) =
Material <By Category> |] 5.9 Familics
Identity Data * 1o i Groups AV 2
Subcategory None o Revit Links
SolidNoid | Solid O %
- —
Properties helo | Aeply | 1:20 D@ % @& 2 ¢ @4 " ] »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. Press & Drac V.0

For the other dimensions, select the “Thickness = 20" for the “Label”.

=42 Type a keyword or phrase

Boa Bl s = =
2 0 P39 | Aligned Angular Radial Diameter Arc
(BB O T anx | | s P
operties Clipboard Geometry Modify |Measure Create Dimension
Dimensions  V|Leade Prefer: Wall centerlines v | Labek: <None> ¥, | Instance Paramete
[Properties (@l|[ox wmmmrm;;‘"""” -@5 -
= . Views (all) 4
Linear Dimension Style _ ||| & Floor Plans O -
Linear Lower Ref. Levwidth = Depth = 600 "
& Ceiling Plans N g
|Dimensions (1)~ | Edit Type Lower Ref. Level a
Graphics & 3D Views
Leader |:| View 1 I I
Baseline Offset... |0.0000 mm 30}
By B & Elevations (Elevation 1) m
Value 200 Back
e 20 L g% 7))
Label <None> Left q) %F‘
- Right
B Sheets (all)
-2 Families C 2 O ‘i’
® I Groups !
= Revit Links v/
O /
. —
4
Properties helo |__Apply | 1:20 OO % hm&» D ¢ @4 ] »
Ready IPress & Drac V..

Repeat the same steps to the rest of the dimensions
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E&Dh Db“'.“*-w 2 5% B iiﬂ—
,i‘ (O] O =?n1 [ Edit  Visibility|  Edit Pick | €©> Work Plane
Extrusion Settings | Work Plane  New
Select | Properties Clipboard Geometry Modify leasure | Create Mode Work Plane Placement
Modify | Edit Extrusion
[Properties (5|01 Working with Families (1) 2.rfa - ... & | ) i TR
= 0. Views (all) e
A Ao o
Lower Ref. Level N "
| = & & Ceiling Plans =
| Extrusion | Edit Type Lower Ref. Level 1l
Constraints * = 3D Views ")
ExtusionEnd  [40000 ] View 1 7))
Extrusion Start 0.0 ]_] 30} — @ %@‘ (@)
Work Plane Level : Lower Ref & Elevations (Elevation 1) . o
i —
i e hlckness =20 ©
Visible @ Front
Visibility/Graphi.. Edit... ;‘_’"m 1]
e = ig
Materials and Finishes g .
1 Sheets (all c
Material <By Category> |] & Fam“.ﬁ(a : Th I Ck n SS 2 0 ra— EE
Identity Data ® [lls 1 Groups 11 o
Subcategory None o Revit Links
SolidNoid  Solid 3 )
O
Properties helo Apply | 1:20 DO % ;&2 ¢ @4 ] »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. Press & Drac¥.n

The dimensions are all jumbled together. To solve this, change the scale of the view to “1:5".

] s |
b E&Dr« DL»“"”*—- RGN e
Modi % | o2 O O =—-tnT f <Y Edit  Visbilty|  Edit Pick | € Work Plane
— 3 Extrusion Settings | Work Plane  New
Select Properties Clipboard Geometry Modify Measure | Create Mode ‘Work Plane Placement
Modify | Edit Extrusion
Properties [51||01 Working with Families (1) 2.fa - (%] . : -0z -
& 0. Views (all) 4
I+ Foor pans o :
Lower Ref. Level N "
D ¥ & Ceiling Plans M i
| Extrusion 'J 3 Edit Type Lower Ref. Level o
[< Al = 3D Views (7))
Extrusion End  [4000.0 0l View 1 7))
Extrusion Start 0.0 ﬂ (30} | e — d) b‘ (@)
Work Plane Level : Lower Ref.. & Elevations (Elevation 1) . o
o | —— Thickness = 20 o
Visible v Front O
Visibility/Graphi..| ___Edit. ] :“m o 1
Materiols nish : i -
[ > AndEk £ Sheets (all) Th k — 20 El
Material <By Category> u & B Families I C e — B e =
£ B
Identity Data & [ Groups 1] €).
Subcategory | None kTR T O
Soldvoid | Solid e 8
s 3 f— GJ O |
1:5
1:10 C
1:20 X
1:50 (&)
1:100 o —
1:200 A =
1:500 |_
1:1000
1:2000
1:5000 S
Properties helo Apply 1:20 DO “« « AB P « @ 4 (| »
Readv Press & Drac .n

Once the scale is set, click “Family Types” button. Set “Depth/20" for “Formula” of “Thickness”

parameter.
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Modify |
Pro ' Name: - =T
Y
Structural Material (def S x
n

Con: 3\1‘

Extrus £

Extru: é

Work

G

Visibl o2 =20

Visibil

Mate ‘E‘
Subc:

Solid

S —
‘ m J »
[ ][ ome || awy

Properties helo Apply | 155 DO % % A8 S ¢ @4 (o] S

a0

try other values for "Depth” parameter to check if the formula works well and the sketch

changes along.

& Family Types

Structural Material (def

= Depth / 20

Thickness = 45
t—

Thickness = 45

Properties heln | Apply 1:5 08 % a A8V ¢ a4 0] »

set "Depth” to “600" again and finish the sketch mode.
12.3.5 Base Geometry 2

Now we have the basic geometry of the column. We will add more elaborated geometry to the

family to have more accurate representation of hollow steel columns. In reality, hollow steel columns

have filleted edges. In computational representation, such fillet is additional features than requires
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more graphical computation. In Revit, there is a way to control the detail level of your family’s

representation.

e’
Cireular hollow Rectengular holew Hot-rolled
gecton H-section

section

The above image is from http://www.tatasteelconstruction.com/

We need another extrusion with filleted edges. We can use the "Extrusion” function under “Create”
tab. Here is another way, when we create something similar to what is already existing, we can use

“Create Similar” function. From the “Lower Ref. Level” view, select the geometry and right click to

select “Create Similar” from the pop-up menu.

01 Working with Families (1).2.1f..[0 7, o keyword or phrase A0S 8 f L signin

! s afe (a#
9«% [D(s:m-m E&DF«D = @0 &% B8 P @
B8 -0
Modi % Groin - - | 48y O3 O = */* Y Edit  Visibiity|  Edit Pick Load into
- ¢ D H = X & @ | Extrusion Settings | Work Plane | New Project
Select | Properties | Clvpboard Geometry Modify Measure | Create Mode Work Plane Placement | Family Editor
Modify | Extrusion Depth 4000.0
Properties [@]/lox Working with Families (1) 2.rfa - ../ 8| P E2 + Lo 1 =08 4
= [ Views (all) |
& Floor Plans |
Lower Ref. Level I |
& Ceiling Plans | |
Other (1) | Edit Type Lower Ref. Level | |
Constraints Al = 3D Views | |
Extrusion End  [4000.0 [l View 1 :
Extrusion Start 0.0 ] @30} I
Work Plane Level : Lower Ref S Elevations (Elevation) |l——— — — — — — — — . 4 R N — S
Giaphics N Back Cancel
Visible v i Fonot Repeat [Create Similar]
Visibilty/Graphi.. I Left al. Recent Commands 5
Matarials and Finishes Roht L Visibilty..
) Sheets (all) a : =
Material <By Category> D &3 Families Create Similar —
Identity Data Mlivcs; === z[l——eae ===l gyl o
Subcategory None oo Revit Links Select Previous
Solid/Void Solid Select All Instances »
Delete
Find Referring Views
Zoom In Region
Zoom Out (2x)
= ¥ N Zoom To Fit - - - S
/! 3000
(=] Previous Pan/Zoom
| Next Pan/Zoom
v Properties
| | =
|Properties helo Apply (=] * P < | »

Create an obiect similar to selected obiect

EPress & Drac V.1

Once you select the function, you will be in sketch mode.

Create a rectangle as we did for the

existing extrusion.
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L8| Type a keyword or phrase

Ea&l?;ﬁl?l/"u X /B060- o @ [

COC A

Oig o2 O =?m */* ‘o ik =‘ Set  Show Viewer

Select | Properties | Clipboard Geometry Modify Measure | Create | Mode | Draw | Work Plane
Depth 2500 /| Chair Offset: 0.0
lProperties ) ]| o2 Working with -0n
= 0 Views (all) :
|| & Floor Plans -
Lower Ref. Level "
& Ceiling Plans
Extrusion » B3 Edit Type Lower Ref. Level o
Constraints ) = 3D Views
Extrusion End 2500 View 1
Extrusion Start | 0.0 1 30}
Work Plane | Level - Lower Ref... |[| = Elevations (Elevation 1) T
| Grophics ' 0 Back : 15
Visible § Front
Visibilty/Graphi..| _ Edit |J ::m
Materialmd | <By Category> J 8 Sheats oh) ‘E
L 2= Families
Identity Data @ [ Groups af
Subcategory | None o Revit Links &
Solid/Void §§olid .
Proverties helo | _Apply | 1:5 DO% amam v i 4 m] »
Enter the diagonal point of the ! T

Align and constrain the edges to reference plane. make sure you select the reference planes

as targets, not the side faces of the existing extrusion.

01 WOddngwith Families (1) 2rf..{» | 7ype a keyword or phrose

& DLJ DL) = “ =[] x|/=eee- g g
| o2» ™ e Set Show Viewer
P S " &" ® >k =
Select | Properties Clipboard Geometry Modify Measure | Create | Mode " Draw Work Plane
Modify | Create Extrusion || Multiple Alignmen  Prefer: Wall centerlines ~
[Properties []||o1 Working with Families (1) 2.fa - .4 | p - 4 =0 4
= [0, Views (all) 5
|l & Floor Plans bos
Lower Ref. Level "
i & Ceiling Plans A
Extrusion ) B8 Edit Type Lower Ref. Level .
Constraints *| = 3D Views
Extrusion End View 1
Extrusion Start 0.0 30}
Work Plane Level : Lower Ref.. & Elevations (Elevation 1)
| Graphics b flack
Visible v Fronk
e -1 - Left
Visibility/Graphi..|  Edit.. | =
2 } * gl
‘IWMN(M‘ ‘I”'d Eipighes o £ Sheets (all) =
Sene <By Category> J_] @ B Families
Identity Data 418 Groups
Subcategory | None Il e Revit Links
Solid/Void Solid
Properties heln | Apply 1:5 DO % aaaudd ¢ @4 (e »
<Sketch> : Line : Reference L
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Now we need to fillet the corners. Select “Fillet Arc” function from the "‘Draw” optlon

E&Dw@lﬁ““ X /5089 @ & @
. " rof
|4 O J i Fillet Arc
Select | Properties Clipboard Geometry Modify Measure | Create | Mode Dra Rounds a comer created by 2 intersecting lines.
Modify | Create Extrusion
i P ERRRE - Select the lines to fillet. Then move the cursor and dick to define
[Properties (21|01 Working with Families (1) 2fa - .= . the filet arc ]
< i e el ically trimmed to the fil 1
&- Floor Plans The elements are automatically trimmed to the fillet. o
Lower Ref. Level "
| = Ceiling Plans
| Extrusion ] 5 Edit Type Lower Ref. Level N
Constraints 2 = 3D Views
Extrusionnd  [2500 ] View 1
Extrusion Start 0.0 {30}
Work Plane Level : Lower Ref... & Elevations (Elevation 1)
| Graphics & Back
Visible @ Fronk
L Y = Left
Visibility/Graphi... Edit.. i
= = A ig
pistaicts sod Py  Sheets (al) £
Material <By Category> D -8 Families
= - - ®
Identity Data ® I Groups
k Subcategory vNm\e | s Revit Links
Solid/Void Solid
Proverties helo [ Aeply | 1:5 DO % ama®m >« @4 (] »
Ready HPress & Drac¥n

Then click two adjacent edges.

y | Create Extrusion
E&le?b“““ X/DG"’@ @ g @
| < O:?m */i« cocEy - Set  Show Viewer
¥ ) ©>4
Select | Properties | Clipboard Geometry Modify Measure | Create Mode| Draw | Work Plane
Depth 2500 | 1] chait I Radius 10000
[Properties (] |01 Working with Families (1) 2.rfa - .5 | . ¢ . =08 -
= [0 Views (all)
|| = Floor Plans o
Lower Ref. Level "
= Ceiling Plans
| Extrusion | B8 Edit Type Lower Ref. Level R
Constraints * = 3D Views
Extrusion End | 250.0 | View 1
Extrusion Start | 0.0 1l 30}
Work Plane | Level : Lower Ref... & Elevations (Elevation 1)
| Graphics Back
Visible § Front
Visibility/Graphi...| Edit ;‘_’“m
(Vs B ig —
‘ Mat 'lmd | <By Category> 8 Sheats oh) =
s sy, CalRg Y. .J 21 Families
Identity Data @ [ Groups
Subcategory | None o Revit Links
Solid/Void | Solid
Proverties helo | Apply | 1:5 DO % am®® i @4 (] »
Draq arc radius to desired location. Yoo

When fillet is done, select the created arc and click the small dimension icon appears”.
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da aje =t

&&DND‘

{2 Type a keyword or phrase

X

/GE -

(= g

OiOO_‘OSm_'. */" ‘g{;;r~;‘ Set  Show Viewer
Clipboard Geometry Modify Measure | Create | Mode | Draw I Work Plane
Modify | Create Extrusion || Keep Concentric
[Properties ~ T]||ox Working with Families (1) 2.rfa - .[% | =08/a
& Floor Plans B
Lower Ref. Level "
= Ceiling Plans
<Sketch> (1) > |8 Edit Type Lower Ref. Level -
Graphics * = 3D Views a
Ve P )| vews
Center Mark Vis... {30}
S e 2 & Elevations (Elevation 1)
Length 13220 Back
Front
Left
Right
 Sheets (al) =
-2 Families
s 8 Groups X5,
= Revit Links -
[.ﬁake this ;empotary dimension permanem]
-]
Properties helo Apply | 1:5 DO ” 02 L] ] »
Make this di EPress & DracVq

Repeat the same step to other corners.

(% Edit  Visibility Edit Pick
Eidrusion Settings | Work Haas: | Naw
Properties Clipboard Geometry Modify Measure | Create Mode Work Plane
Modify | Extrusion > Edit Extrusion
Properties (] |01 Working with Families (1) 2.rfa - .[& 0% -
= 1 Views (all) ‘
& Floor Plans o
Lower Ref. Level "
& Ceiling Plans .
Extrusion | % Edit Type Lower Ref. Level ‘ P T | "
2 = 3D Views ‘ / N [
BdrusionEnd  [2500 ] View 1 ' a IS [
Extrusion Start 0.0 30} 2
Work Plane Level : Lower Ref.. & Elevations (Elevation 1) | 2, \[
| Graphics B Back | 0
Visible @ £t
= T = Left
Visibility/Graphi... Edit... Right
Materi Finish 0 ig!
‘ Mat slmd <By Category> ) Sheets () =
otetal___| <8y Category> [}, g oriies
Identity Data @ [ Groups
Subcategory None o Revit Links
Solid/Void Solid
| |
\ S ’
\ S \
[ I%, 211
\
| 3 / |
\ g r
i B . = |
Proverties helo Apply | 1:5 D6 ame @ (] 0
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. EPress&Drac¥on

Now select one of the radius dimensions and add a new parameter.
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%BJ., B X5 |Bo i DY D =% 5=
e

o] &
o oy O S a| B
| - % Q o x &
FESRE Rl i e e R i e LB
Dimensions  /|Leade Prefer: Wall centerfines v | Label: <None>.....¥ | Instance Paramete
[Properties ~[]|[ox Working with Famili =08 A
= [0 Views (all) Depth = 600 [ ‘
Radial Dimension Style _ & Floor Plans Thickness = Depth / 20 = 30 I=*
Radial Lower Ref. Levwidth = Depth = 600 "
& Ceiling Plans
Dimensions (1) ~ | B Edit Type Lower Ref. Level 3 T oy
Graphics Al = 30 Views rd S
e et F s
Text z 0} <
Value 12000 & Elevations (Elevation 1)
o W Back <00
Label <None> Hrom
. Left
Right
D Sheets (all) [
-8 Families E
s 8 Groups
@ Revit Links
250
|
o
N
v
\\
e
" 7
Proverties helo |_Apply | 1:5 DO % am® D i @4 »
Ready gﬁrm7&7m~h

Name the new parameter “Radius_O" and click “OK" button.

Moidity|
Select | Properties Clipboard Geometry Modify Measure | Create
Dimensions  ¥|Leade Prefer: Wall centelines Label: <N v | lInstance Paramete
[Properties (4] |01 Working with Families 5] =0n A
= 0 Views (al) Parameter Type R
Radial Dimension Style _ |l & Floor Plans © Eamily parameter |5
Radial Lower Ref. Level (Cannot appear In schedules or tags) w
& Ceiling Plans ) Shared parameter i
[Dimensions (1) v it Type Lower Ref. Level e (Can be shared by muliple projects and famills, exported to ODBC, and e
Graphics. A = 3D Views P appear in schedules and tags)
Leader View1
S 5 30} Seled... Export.
Value 200.0 & Elevations (Elevation 1) Parameter Dats
: C Back <00
Other 8 Name:
Label <None> Front s 0 | (@mwe
Left
Right Discpline:
£ Sheets (al) |common = 5
& B Families Type of Parameter:
@ [l Groups [Length *) iy e
© Revit Links Group parameter under: inaformuiacrasa
5
[ JI cn [[ nep |
S
N
o
\\ \ / i
Ng, e
.
Properties heln | Apply 1:5 08 “« * a8 2 ¢ a4 ¢ ] >
Ready - _ - - _ _ _ _ _ ElPress & Drac Wy
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Apply the "Radius_O" parameter to all the corners.

14 V ca ale
o B & DY DI
(O] .
RO T aax
Select | Properties Clipboard Geometry Modify
imensions V| Leade Prefer: Wall centerlines ~ i =200 ¥ | lInstance Paramete
e 1) T
= [0 Views (all) f ‘
Radial Dimension Style _ [f| & Floor Plans e
Radial Lower Ref. Level "
& Ceiling Plans o i
Dimensions (1) ~ | B Edit Type Lower Ref. Level ; o
Graphics Al = 30 Views A 5
Lo Vw1 ' o N
Text 2 3D} O \
Value 200.0 & Elevations (Elevation 1) g,/
i N Back s
Label Radius_O Front Qg
Left
Right
) Sheets (all) =
81 Families =
@ [l Groups
o Revit Links
Radius ¢ _
=Y =200
f
//
__//
" =
Proerties helo [ Apply | 1:5 DO % ~aH 2 @ ] »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. “Press & Drac¥a

Go to “Properties” and click “Family Types” button. From the appeared window, set the formula of

“Radius_O" to “Thickness * 1.5". Then click "Apply” button. This means that the radius for the outer

arcs will always be 1.5 times of the thickness.

EFamﬂyTypes
Dim
[Propertid| Neme: > =08 a
@
» n
Y 5
Structural Material (d fe) "o
Dim - N
s 7.
Thickness 1300 = Depth / 20 d | 9% ki
Leadetd | | padius 0 450 B s * 1.5 LY &
e Depth 6000 - ®
Value - | Adde
Other
= ~
Lot || [With 16000 = Depth || Modfy.
[ Remoe |
=
Lo J[ o J[ aov [[ mep | %,
s
% ’\%O s
§\, ~
U
& <
Pronerties heln [ Apply | 1:5 DO “ aAaHS ¢ & (] »
Ready _ T
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Click "OK" button to go back to the view. Then with “Offset” function under “Modify” tab, set the

distance to 30, click empty spot in the canvas, and then put your mouse over to an edge. With “tab”

button on your keyboard, select the all edges around to offset.

i 01 Working with Families (1) 2.rf..1» | 75 o keyword or phrase
Modify | o S T e

N | a ale C} — r=0
s o Bkt = O 0§ B foms |
Modify ‘,n O =‘11 f ' Edit  Visibility|  Edit Pick | € Work Plane
¥ ‘ = -=§ X Extrusion Settings | Work Plane  New
Select | Properties | Clipboard Geometry Modify Measure | Create Mode Work Plane Placement
Modify | Extrusion > Edit Extrusion ~ Graphica © Numerica Offset: 30.0 | Copy
Properties [a]|[01 Working with Families (1) 2.rfa - ./ 8 | =05 A
[0 Views (all) ;
= & Floor Plans =
Lower Ref. Level "
& Ceiling Plans © :
Extrusion v | B8 Edit Type Lower Ref. Level '?6‘77‘ n’/ B
Constraints 2 = 3D Views o %7,
Extrusion End | 250.0 1 View 1 Sg - .
Ehhsshn oo 1l a0} o) Chain of walls or lines
Work Plane Level : Lower Ref... & Elevations (Elevation 1)
Graphics & Back
Visible i front
Visibility/Graphi... Edit t:hm
= = B ig
Msm Finishes Sheets (all) =
Material <By Category> || e L
z s
Identity Data @ [ Groups
Subcategory | None w0 Revit Links
Solid/Void Solid
o
W
7 '?‘3‘7/0
Q Lo
F ®
8
Proverties helo Apply 1:5 D8 % wame i @4 (] »
Chain of walls or lines .

Once offset is done, select one of the inner arcs. Click the appeared small “dimension” icon.

| e ofe =0 ‘
» R RN RS E&ow =200 ® B #0Emm
% s o 2,0 O =.n1 ™ Edit  Visibilty|  Edit Pick | € Work Plane
U= -4 Extrusion Settings | Work Plane  New ‘
Select [ Properties Clipboard Geometry Modify IMeasuve Create Mode Work Plane Placement
Modify | Edit Extrusion || Keep Concentric
Properties (/|01 Working with Families (1) 2.rfa - ./ 2 0% A
& @ Views (all) 1=t
& Floor Plans -
Lower Ref. Level "
& Ceiling Plans X
<Sketch> (1) )| 8 Edit Type Lower Ref. Level
Graphics 4 = 3D Views
Visible | | View 1
Center Mark Vis... {30}
e # || = Elevations (Elevation 1)
Length 236 Back
Front
Left
Right
Sheets (all) =
81 Families =
= 1§ Groups
= Revit Links \
4
Properties helo Apply 1:5 D& LB e W (] »
Dimensions : Radial Dimension Style : Parameter [IPress & Drac g

You may want to set the scale to “1:1" to make the dimensions more eligible.
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[ Type a keyword or phrase

Y% & B $#oE=m

Edit Edit Pick | €©> Work Plane

E&Dk g ===

.,u’ O =‘-¥nT 88 ‘/'\ <Y | Visibility
< 2 Extrusion Settings | Work Plane  New
Geometry Modify Measure | Create Mode Work Plane Placement
Modify | Edit Extrusion
Properties 7] |01 Working with Famities (1) 2.fa - . %] —0% -
= [0 Views (all)
. & Floor Plans L","‘
Lower Ref. Level w
d - & Ceiling Plans §
|Extrusion | 8 Edit Type Lower Ref. Level -
C i Al = 3D Views
Extrusion End  [250.0 0l View 1
Extrusion Start | 0.0 1] (30}
Work Plane Level : Lower Ref.... & Elevations (Elevation 1)
Graphics B Back
Visible v U Feont \
Visibilty/Graph..[ __Edit. ] ::hm
ig
Nipticels snd ishes M e sheets an / =
Material <By Category> []|fl o o / =
Identity Data " @ [ Groups {
Subcategory | None B P |
Solid/Void Solid 1:1 | s
1:2
155
1:10
1:20
1:50
1:100
1:200
1:500
1:1000
1:2000
1:5000 S
Properties heln Apply 1:5 D& =« « ANV ¢« a4 || »
Ready HPress & Drac 70

Then select the dimension again to add a new parameter.

Bl bibh =
-
SR T
N
¥ ) o Gk &'
Select Properties Clipboard Geometry _ Modify Measure | Create
Dimensions  V!Leade Prefer: Wall centerines v Labek: wmmm
Properties (5] 01 Working with Famili je<None> —',(/ =08 a
= [0, Views (all) Depth = 600 ’ %
Radial Dimension Style _ || & FloorPlans g 0 Thickness * 1.5 = 45
Ractal Lower Ref. Lex Thickness = Depth / 20 = 30 e =
I~ - & Ceiling Plans  Width = Depth = 600 i A
Dimensions (1) ~ | B Edit Type Lower Ref, Level o
Graphics Al = 3D Views
P e || [T
Text J 30}
Value 150 & Elevations (Elevation 1)
Other 8 Back
Label <None> Feon
Left
Right
£ Sheets (all) =
& B Families E
@ [l Groups
@ Revit Links
Properties heln Apply 1S oe ERC B || »
Ready Press & Drac V.q

Type in “Radius_|" for the name of the new parameter. Then click “OK" button.
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Now the dimension is labeled with “Radius_|" parameter.

] &

B> & bl Dl

b >
o

o .
adl ‘i‘OCSOahT-ﬂafo'?m‘:

Properties Clipboard Geometry Modify Measure | Create
Dimensions  V|Leade Prefer: Wall centerlines v Labek: Radius1=15 v | |Instance Paramete
[Properties (a||o1 Working with Families (1) 2.rfa - .[% | —0% A
= 0 Views (all) 7 by
Radial Dimension Style _ & Floor Plans / S
Radial Lower Ref. Level P "
| E— & Ceiling Plans /
Dimensions (1) | B8 Edit Type Lower Ref. Level o o
Graphics 2 = 3D Views /
i || vem
Toxt . 30}
Value 15.0 & Elevations (Elevation 1)
s . Back
Label Radius I Fook
Left
Right
Sheets (all) ‘E
&) Families
@ [ Groups
#o Revit Links
Proerties helo | Apply | 1:1 Do 4% aawv i @l (1] »
Click to select, TAB for alterates, CTRL adds, SHIFT unselects. Press & Drac¥q.

Create dimension for the other inner arcs and label them with “Radius_I".
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DR‘D Jg;:n-

g O S

Edit  Visbilty|  Edit ick | ©> Work Plane
Extrusion Settings | Work Plane  New |
Geometry Modify Measure | Create Mode Work Plane Placement
Modify | Edit Extrusion
[Properties 1] |01 Working with Families (1) 2.rfa - ./ | =08 A
5 Views (all) oo s Y
& Floor Plans e ® o\ =
E - Fa
Lower Ref. Level 8 2 "
| & Ceiling Plans
Extrusion )| 8 Edit Type Lower Ref. Level B
Constraints *|| = 3D Views
Extrusionnd  [2500 ] View 1
Extrusion Start | 0.0 I 30}
Work Plane Level : Lower Ref... & Elevations (Elevation 1)
| Graphics 0 Back
Visible @ Front
T 7 = Left
Visibility/Graphi... Edit.. i
= = ig
| Matatils sod Fpiehes £ Sheets (al) B
Material <By Category> D 5.9 Familics
Identity Data @ [ Groups
k Subcategory vNone s Revit Links
Solid/Void Solid
" o
» ¢ 5.0
Proverties helo Apply | 1:1 O® T »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. EPress & DracWon

For the inner edges, align them to each corresponding inner face of the existing extrusion.

01 WOddng with Families (1)_2.rf...

2 Type a keyword

or phrase

L |
k\ %@ &le'pu"::‘ g L@
Modify % Paste o O3 O ﬁT b f A5 Edit  Visibi Edit Pick | ©> Work Plane
== o 3 Extrusion S Work Plane  New
Select | Properties Clipboard Geometry Modify Measure | Create ] Mode |  Work Plane ~ Placement
Modify | Extrusion > Edit Extrusion | | Multiple Alignmen _Prefer: Wall centerlines v
Properties (]||o1 Working with Families (1) 2.fa - .4 | =0n A
=0, Views (all) o
I = Foor Plans |52
Lower Ref. Level n
& Ceiling Plans
Extrusion =] 8 Edit Type Lower Ref. Level .
Constrai Al = 30 Views
Extrusion End  [2500 View 1 X
Extrusion Start | 0.0 30} x
Work Plane Level : Lower Ref.. & Elevations (Elevation 1) \\
| Graphics 0 Back o \
Visible v Feool
Visibilty/Graphi..|__Edit. | :;'m
s B
Malerialmd Hﬂ‘:ssy Category> ﬂ ) Sheosts (ak) =
B Families
Identity Data g @ [l Groups
Subcategory | None o Revit Links
Solid/Void Solid
Properties helo | Apply 1:1 oe oo I »
Create or length T

G to "Family Types", set the formula of "Radius_|" to “Thickness".
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¢ - a
- _ - e s,
e [V : e 315
Mat El
Subc
~ solid/ll
|Properties heln | Apply 1y D6 “ = & > ¢ 8 4 [ >

After applying the formula, change the value of “Depth” parameter to test your parametric

constraints.

Proverties heln | Apply 151 O8 % % AH + 74 (1] >
Ready Ya

When select any sketch segment, it should look like below image.

Page |36



Construction Building Information Modelling (BIM) Advanced Modelling Course
Industry Council (Structure) — Revit 2018

&&DR‘DJ:&:-- =

,i‘ (O] O =?B1 22 */* 7w Edit  Visibity|  Edit pick | €> Work Plane
Exdiision Settings | Work Pla: | Naw |
Clipboard Geometry Modify Measure | Create Mode Work Plane Placement
Modify | Extrusion > Edit Extrusion
[Properties []|[or Working with Families (1) 2.rfa - ..[% | | =08 4
= 0 Views (all SR o ST S e e &
! & Floor Plans ,ﬂ\ RieN S
Lower Ref. Level ?‘\‘ a (?': "
i & Ceiling Plans = 8 A |
<Sketch> (1) |8 Edit Type Lower Ref. Level [ -
Graphics * = 3D Views ‘
L ||
Dimensions. ) (30} |
Length 5200 & Elevations (Elevation 1)
Back
Front ‘
Left )
Right \
o |
) Sheets (all) @ n { B
'« £ Families = \ aJ E
= 18l Groups 2] [
0 Revit Links |
o |
[
]
-
I ]
»’L
Prooerties helo | Apply | 111 De4saasvi ald W »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. “IPress & Drac ¥q

Finish the sketch mode and go to 3D view. test our geometry again.

o= Y s JE T E&DL}'DV“"'R' ) % [/m0ce- a@ @@ (I

¥ receh.
Paste Join * % Set Show Viewer | Load into
H%- P BQOTaax 54 I bl
Select | Properties Gipboard ‘ Geometry Modify | Measure | Create | Mode | Draw | Work Plane | Familly Editor
[Properties (51|01 Working with Families (1) 2.rfa - ..[% ] =
= [0 Views (all)
& Floor Plans B
Lower Ref. Level \ S
B & Celing Plans :
Family: Structural Colur ¥ | it Type Lower Ref. Level =
Constraints & & 3D Views \ %
Host View 1 Ry ™~
structural 2 (30} e
Materal for Mo.. & Hevations (Elevation 1) -
Always export a... Back
Beam cutback in.. From bounding... i"f"“‘
Identity Data z il
OmniClass Num... 232530111411 | _ 9
= i) ) Sheets (all) (=
OmniClass Title | Columns i
motess e _Soums |+ e Famites
Other [ Groups
Cut with Voids ... = e Revit Links
Symbolic Repre... | From Family
Shared o
Show family pre... @
B
NN
Properties helo [ Ay 1:10 B & ~ . ®H G2 o @« m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. EPress &Dracn

Go to “Front” elevation view. align and constrain the top face to the solid to “Upper Ref. Level”

view.
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Modify

v BB oo EIEDIDG SR = /00 @B @ W |
Modify % paste v & oin - 8o~ ,3‘ Q O =‘:n1 i‘; il x */k | “ g D.A{r ; Set Show Viewer Lc::j::o _
Select | Properties | Clipboard | Geometry Modify | Measure | Create | Mode Draw | WorkPlane | Family Editor | |

|| Multiple Alignmen  Prefer: Wall centerlines v

Properties [5]|[01 Working with Families (1) 2.fa - .6 | =08 -
50 Views (all) ) !
B | i} | L 72 e R o G e
Lower Ref, Level | LY
& Ceiling Plans | %
Family; Structural Coluy ¥ | /it Ty Lower Ref, Level |
Constraints Al = 3D Views
Host View 1 |
| Structural 2 30} |
Material for Mo... & Elevations (Elevation 1) |
Always export a... Back |
Beam cutback in... From bounding... Front |
Beta Y Left |
OmniClass Num.. 23.25.30.11.14.11 Right
OmniClass Title | Columns Shoats o)) I [
4 [ & Families |
Otox & 8 Groups |
Cut with Voids ... © « Revit Links
Symbolic Repre... From Family |
Shared o |
Show family pre... ¥ |
|
|
|
—_— ! e __Lower Ref_Leval G A
| | |
[ [ |
Proverties helo Apply 1:20 O@ o R K ] »
Please select a new reference for alignment or Ctrl-dlick to keep aligning to the current reference. Y

12.3.6 Visibility Setting

For the two geometries, you can set each to different detail level. Go to 3D view, and select the first
extrusion with the right-angled corners. From the “Properties” select “Edit" button next to

"Visibility/Graphics Overrides” field.

s alo » r=
gam.a Bs & Dl D 2 2R B g @
in * Edit  Visibili Edit Pick Load into
.% A T FTT f e I Pl e [P O [ o
Select | Properties Cllpbonrd Geometry Modify Measure | Create Mode Work Plane Placement | Family Editor
Modify | Extrusion Depth 4000.0
Properties [a]||01 Working with Families (1) 2.rfa - .[8 | -@n -
@10 Views (all)
@ Floor Plans
Lower Ref. Level N et
& Ceiling Plans :
Other (1) ;| 4 Edit Type Lower Ref. Level
Constraints Bl = 30 Views @
Extrusion End 40000 View 1 Y
Extrusion Start 0.0 3D} &
Work Plane | Level : Lower Ref @ Elevations (Elevation 1)
Graphics ' Back
Visible @ Ml Front
Visibility/Graphi..|  Edit. :i';'m
Malevl:l.“ Fm‘"::y Category> u Shaets (al) (Bl
| B Families
Identity Data W [ Groups
Subcategory None « Revit Links
Solid/Void Solid
helo Apply 1:100 @ e N m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. — — — . [Press & Drac 7y )

From the appeared window, deselect the “Fine"” option from the list. Then click "“OK" button.
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01 Working with Families (1) 2:f...» | 7, o reyword or phrase

kS e 15
Properties Clipboard Geometry Modify ‘ Measure | Create | Mode ‘ Work Plane | Placement Famil’y'Edkov
Modify | Extrusion Depth 4000.0
[Properties o1 Working with Famies (1) 2.fa - .[8 —o% -
= 8] Views (all)
= Floor Plans ,l; a
Lower Ref, Level QFW: /
. & Ceiling Plans L=
Other (1) v}:!{ Edit Type Lower Ref. Level 9
Constraints o = 3D Views @
Extrusion End 4000.0 | View 1 ®
Extrusion Start 00 | (30} b :
Work Plane Level - Lower Ref, Level = Elevations (Elevation 1) / ‘
gl - ~
apl : er
Visible @ 1 Front Famiy Hlemipt Vebity Sl N\ =
Visibilty/Graphics Overrides | Edit.. ] bt View Specific Display
| Materials and Finishes | [ Display In 3D views and:
5 Sheet :
Material <By Category> . hmm;‘" g V] Plan/RCP =
Identity Data £l < 1 Groues V| Front/Back
Subcategory None « Revit Links V] Left/Right
Solid/Void Solid | When cut in Plan/RCP (I category permits)
Detail Levels
V| Coarse (V] Medium ! |Find
[ o< J[ cne || pefwr [[ b
— — =
Properties helo Apply 1:100 R L B ] 0] »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. & ~ O WA i Model > IPress & Drac 7.

Then go back to the view and select the other extrusion. From the “Family Element Visibility Settings”

window, deselect “Coarse” and “Medium” from the options.

|

v |

Measure Cveatel " Mode ’ Work Plane \ Placement Fan-il;'fditm

Modify

Select | Properties Clipboard Geometry

Modify | Extrusion Depth 4000.0

m 01 Working with Families (1) 2.rfa - .5 |

= Views (all)

N
& Floor Plans ‘.‘ I
Lower Ref. Level \ﬂ'.w‘"
- & Ceiling Plans -
Other (1) | (8 Edit Type Lower Ref. Level {
Constraints X = 3D Views G
Extrusion End 4000.0 { View 1 'Y
Extrusion Start 00 30} A -
Work Plane Level : Lower Ref. Level = Elevations (Elevation 1) / =
Graphics § Back e~ \ /
Vit 0 Front Family Element Visibility Set_t_ings " —
Visibility/Graphics Overides | :‘f‘h View Specific Display
2 ight
Materials and Finishes Shee':-‘s i Display in 30 views and: ]
i p V|Plan/RCP (=
T T .7 — | | = ‘
Identity Data # i Groups B Fronkfeck
Subcategory None = Revit Links V] LefiRight
Solid/Void Solid [V When cut in Plan/RCP (if category permits)
Detail Levels
1| Coarse [ Medium V|Fine
[ ][ concel Defautt || Hep |
Prooerties helo Apply 1:100 B & = 4 & H @ W ¢ @ ¢ (] DA
& ~ 0T i Model  ~ FIPress & Drac 7.1

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

Go back to the 3D view. Now the detail level of your model view might be “Medium”. As you just

set, the filleted extrusion is in halftone.
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01 Working with Familes (1) 216> 1o eyordorprvose B S &5 o A Signin___~ 38 »
Modify

gu-v &M= [ 2 & B P B

B HG- G- =20 A GO

EL

% Groin - o+ o8y O3 O =‘1’r ) @ . f 55 Edit  Visbilty|  Edit Pick | €> Work Plane | Load into
- ¥ v -II = 2 x Extrusion Settings | Work Plane  New Project
Select | Properties | Clipboard Geometry Modify Measure | Create | Mode Work Plane Placement | Family Editor _
Properties 15| [01 Working with Families (1) 2.rfa - ../ | =08 -
= 1. Views (all)
= Floor Plans
Lower Ref. Level
: = Ceiling Plans
Family: Structural Columns Z; it Typé Lower Ref. Level
Constraints Ul = 3D Views
Host View 1
Structural . (30}
Material for Model Behavior = Elevations (Elevation 1)
Always export as geometry o Back
Beam cutback in plan From bounding box Fait
Identity Data g Lete
OmniClass Number 23253011.14.11 Righ
OmniClass Title Columns - Shee_‘.s (el
& | & Families
Other : # 1 Groups
Cut with Voids When Loaded [ = Revit Links
Symbolic Representation From Family
Shared o
Show family pre-cut in plan vie... ¥
Properties helo Apply 1:100 ;
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. IPress & Drac V.0

set the detail level to “Fine”. Then the right-angled extrusion will be in halftone.

01 Working with Families (1) 2.rf..| » | 7ype o keyword or phrase

su-v BR&NMME = 2 & B $opmm @
- 8- g — : it Visibil it i ork Plane | Load into
¥ Gon - o | @ U@ O qllr f Edit  Visibility Edi Pick € Work Pl Load int

5 - 55
> + = x Extrusion Settings | Work Plane  New Project
Clipboard Geometry Modify Measure | Create Mode Work Plane Placement | Family Editor

[Properties [%]| Jo1 Working with Famiies (1) 2.rfa - . =@
Views (all)
| = Floor Plans
Lower Ref. Level
3 = Ceiling Plans
Family: Structural Columns .| (8 Edi Lower Ref. Level
Constraints g = 3D Views
Host View 1
Structural L (3D}
Material for Model Behavior & Elevations (Elevation 1)
Always export as geometry = Back
Beam cutback in plan From bounding box Front
Identity Data ® left
OmniClass Number 2325.3011.14.11 _ —Right
OmniClass Title Columns 9 Sheets il
& ||| B Families
Other I Groups
Cut with Voids When Loaded | & Rk
Symbolic Representation From Family
Shared 0
Show family pre-cut in plan vie... &
Properties helo Apply
Ready IPress & Drac V.

We will check how it works in a project in the later stage.
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12.3.7 Type

From the “Family Types”, you can add types to your family. One of advantages of using a parametric

modeling tool is that, you can use parametric frameworks to create multiple objects with different

geometry.

Geometry Modily Weasure | Create]  miode Work Plane ocerent | Py eatey

Select | Properties | Clipboard

perti l"'FamilyTypes ﬁ - =08 -

Name:
Family Types

Formula

Family: S{
Constraif

Host

5;““""“ " Thickness 500 = Depth / 20 ®
AI"“’"" Radius O 750 = Thickness * 1.5 4
: ways : Radius 1 500 = Thickness i

2 | Depth 1000.0 : "

Identity g

Omnicldy

OmnicCl
Other
Cut with |
Symbolf’
Shared
Show faly

Properties helo

Basdly

.

From “Family Types” window, set “Depth” parameter’s value to “1000". Then click “New" button to

add a type. Type in “1000 x 1000" for the name.

|

1 . e
B - ! 1
Measure | Create | Mode Work Plane Pacoment | Farty ety

Select | Properties | Clipboard Geometry Modify
I & Family Types = =8 A
Name
| Name: v —
| Name; \
‘ Family Types B !
| e ] '
Family: St |
Constrainy Benar
Host =
Dimensions. A : Delet
S;;“"“f’ll } Thickness 50.0 = Depth / 20 ©
A““'"" Radius O 750 <Thickness 15 ¥ S
Bw"” | [Radius 1 500 - Thickness v b
ld::m °E | [Depth 1000.0 : v L Aw. |
ity 0 . ==
OmniCl; Moy, [
OmniCl4 Remoye £
Other
Cut with{ |
Symboli |
Shared
Show faf|
oo [ e [ ay [[ me

Proerties helo Apply m H 1:100 =& &

click "New" button and type in "800 x 800" for the name. Click "“OK" button and set the
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"Depth” parameter’s value to “800". ( note that you have to add a type first and then change the

values.) Create another type "600 x 600" with the depth value of “600".

01 Working with Families (1) 2.rf..1 »  7ype o keyword or phrase

El

Measure | Create l

e I e Moy Mode Work e | Pacerment | oty Ecitcy I
perties| & Family Types X =@x{e
Name
Name: 1000 x 1000 =
Name: 800 x 800 Wy
Family Types |
: Parameter Formula New. [I] lﬁ \
Family: Sf = J
Constrain| ‘ Rename...
Host - Delete
S;“"“f‘: Thickness 400 = Depth / 20 ®
AI‘“e"a Radius O 600 “Thickness *15 ¥ I
lers
. 51 | Radius. 1 400 - Thickness W
e d] (oot T I— amy—
\ity B
Omnicl ‘ Mo
OmniCl | Remoye |
Other
Cut with
Symboll
Shared
Show fal
o [ e [ mey || e
Properties helo ply W S
Ready Vo

test your family by changing the type to different ones. You can also change the formulas to

have different parametric rules and geometric results.

BHG-S-@- = -L0A G0

bt

01 Working with Families (1) 2.rf.. | | 7ype o keyword or phrase

S

Modify

S g P @Dl DI = = &

%o~

L O

88 B &

| 2

& B Pogmm @

- 4 )
y &+ PBOTTaax o]t | T (R

Select | Properties | Clipboard Geometry Modify Measure C:ealei Mode Work Plane Placement | Family Editor —

Properties [@]|]o1 Working with Families (1)_2.rfa - .[8 =05 -
5 3] Views (all)
_|Il = Floor Plans
Lower Ref. Level N e
: & Ceiling Plans |

Family: Structural Columns . Lower Ref. Level
Constraints *ll = 3D Views

Host View 1
Structural * 30}

Material for Model Behavior = Elevations (Elevation 1)

Always export as geometry 0 Back

Beam cutback in plan From bounding box Front
Identity Data * ::hm

OmniClass Number 232530111411 a Sha‘z i &

OmniClass Title Columns IR gl
Other * [ll= & Groups

Cut with Voids When Loaded | AR

Symbolic Representation From Family

Shared =

Show family pre-cut in plan vie... ¥
Properties helo Apply 1:100 @B & O »

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

FPress & Drac V.0

12.3.8 Material

In the structural column family template, “Structural Material” parameter is

“Family Types”, click the small button on the right-top corner of “Value”.

set by default. From the
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01 Working with Families (1)_2.rf...

B Type a keyword or phrase

“o
01 Workig @ | Faml'yTypeg ﬁ.. —@n ~
=0 View [ .
& Flog | Name: [moxmu >
|
& Ceilil Parameter
| 5
2 30| [Structural Material (d s
v =
( o
58 Thickness 300 =Depth / 20 4
Radius_ O 450 =Thickness * 1.5 i
Ay |Radius 1 300 = Thickness P )
Depth 6000 - 4 Addse
Modify.. |
B sh Width 600.0 = Depth P B
& Fa Remove
# ol Grod|
« Revil |
ok J[ conal ([ ooy
1:100 B & = L M H QW o @ 4 m] 5

Then "Material Browser” window will appear. select “Metal” under "AEC Materials” then double
click "Steel, S 355" to add it to the list above. Select “Steel, S 355" from the list above and click "OK"

button. apply the same material to the other types.

Modify

Tl -
‘! ¥ e

B

Measure | Create l Mode

Select | Properties | Clipboard Geometry Modify Work Plane
Material Browser - Steel, S 355 vam)
D &1 Family Types - — ' Material Editor PR F
Name: Ieoo:wo '|
Parameter | Category !
Family: St W Dcfault Miscellaneous
Constrainy . Default Light Source System
sl ot . Default Roof Miscellaneous
tructur:
Thi I = ® =
Material "f‘"”‘ 300 D'_p'h 12 . Default Wall Miscellaneous »|Steel, 5 355
5 Radius O 450 = Thickness * 1.5 id |
. W21 | Radius 1 300 - Thickness ° M Goss Glass
eam Ct
Depth 6000 : " W o : S
Identity 0 | Stainless - Satin Appearance
Omnicl o . 5355 Physical
OmniCHk Width 6000 e DQP"‘ X = Ther H
Other Insulation Name v‘wi
Cut withy Liquid -
Symboll Masonn Zinc Metal Use Render Appearance
St bl vt con ETETEETER
Show f; Misc
s Plistet Il stucture, Ui /Rafter Loyer Metal Transparency 0
Plastic Bl seeel s a60 Metal v Surface Pattem
Roofing Pattern <none>
o Wl stet s 355 Matal
[ g RGB 120 120 120
Tile = I S0l 5075 Matal >
\ = ‘ = | | @ i1} EA!lgnmmt ﬁmnmwm |
— —— ﬂ[wmqm\ ok cancel | apply | .
Proverties helo Apply “’ ” 1:100 @ & R ) < ] ’

go back to the 3D view, and select one of the extrusions. From the properties window, click
the button next to “Material” under “Material and Finishes”. The gray button in the 3 column.

"Associate Family Parameters” window will appear. Select “Structural Material” from the list.
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01 Working with Families (1)_2.rf...|

| Select | Properties | Clipboard |  Geometry | Modify | Measure
Modify | Extrusion Depth 4000.0

Properties 8| |01 Working with Farmilies (1) 2.rfa - ..[@ =08 4
110 Views (all)
&-Floor Plans Associate Family Parameter u
LI°“'E’ Ref. Level Family parameter: Material
Ceiling Plans
Parameter type: Material
Other (1) = Lower Ref; Level i
Constraints *|| = 3D Views Existing family parameters of compatible type:
Extrusion End 40000 (] View 1 <none>
Extrusion Start | 0.0 I (30} Srictol Metwrel
\ fane & Elevations (Elevation 1)
Back
Visible Fron
Visibility/Graphi...| :f‘h
= = s ight
M":tem.lsl and ﬁmsh;s’ . il £ Sheets (al)
el.ena efau M e Famibes
Identity Data & 18l Groups
Subcategory  None o Revit Links
Solid/Void Solid
Proverties heln Apply K
Click to select. TAB for alternates. CTRL adds. SHIFT unselects. & v &0 N i Maa - EPress & Drac V.1

Then the structural material, “Steel S, 355" will be applied to the extrusion. repeat the same

step to the other extrusion. You may want to save your steel column family.

eHG - G-@-=2-LO0A 8- % §83- 3| 01 Working with Families (1) 2:f..{» | 7ype o keyword ¢ M S 7 L signin B = x|
*® - Dl D E—— : [('\Q o ffg m
s g% oG- E{& ke I/m, Ol vz By EZ 0 ] 17y
. ~ — 0O ol o-0 )
Modify/ Il' Q’I Gioin - %~ | o8y O3 = = */9‘ R Edit  Visibilty|  Edit Pick Load into
! B - ¥ v Q im =2 x & 9 | Extrusion Settings | Work Plane  New Project
Select | Properties | Clipboard |  Geometry | Modify Measure | Create Mode " WorkPlane | Placement | Family Editor
Modify | Extrusion Depth 4000.0
Properties 01 Working with Families (1) 2.fa - .. [ —0R A
1 0 Views (all)
| = Floor Plans
Lower Ref. Level
% Ceiling Plans
Other (1) ) Lower Ref. Level
Constraints * = 3D Views
Extrusion End 40000 1| View 1
Extrusion Start 0.0 1] 3D}
Work Plane Level : Lower Ref Elevations (Elevation 1)
Graphics ' Back
Visible @ Il Faonk
Visibility/Graphi... Edit... :“h
- == . ight
Materials and Finishes £ Sheets (al])
Material Steel, S 355 ﬂ R
: # 2 Families
Identity Data L
Subcategory | None - et
Solid/Void Solid
Properties helo Apply 1:100
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. [ZIPress & Drac¥'q

12.3.9. Load into the project

Lastly, you need to check if the family works well in a project file. start a new project

with “Structural Template”.

Page |44



Construction

Industry Council

Building Information Modelling (BIM) Advanced Modelling Course

(Structure) — Revit 2018

01 Working with Families (1) 2.rf...1 » | 7ype o keyword or phrase

Q8 f Qsignin

Select

Properties | Clipboard Geometry Modify Measure | Create | Mode Work Plane Placement | Family Editor ﬁ
[Properties (|01 Working with Families (1) 2.a - .| -@% -
0 Views (all)
5 Floor Plans ‘
Lower Ref. Level "
& Ceiling Plans
Lower Ref. Level

Constraints Y : 3D Views New Project

Host View 1
Structural & {30} dpie e -

Material for Mo... Elevations (Elevation 1) ST B —

Always export Back

Beam cutback in.... From bounding... Front Create new
Identity Data 5 Lot o project Project emplate

OmniClass Num...| 23.25.30,11.14.11 fight

OmniClass Title | Columns = shosts (4) oK ‘ Cancel ‘

< || &0 Famities [ e

Cther B & I Groups

Cut with Voids ... | SR

Symbolic Repre... From Family

Shared a

Show family pre... ¥
Properties helo Apply 1:100

Ready

Once the new project begins, go to “View" tab and click "Tile Windows"

button.

@G-S --.=

=L QA0

S bl

Project - Structural Plan: Level 2 |» | 7ype o keyword or phrase

L, signln -

& Filt
w1 Fiters

Templotes '[E Thin Lines]

Select

Properties

(@ Visibility/ Graphics [ Show Hidden Lines

[E5 Remove Hidden Lines
[ cut Profile
Graphics

Project1 - Project Browser

& Render in Cloud
&8 Render Gallery

View

~8 Plan Views - B B~

5

Switch _
Windows

 Elevation * Ty of: o

8 O

. Section Callout
View

Create Sheet Com|

Tile Windows (WT)

Arranges all open views, tiled in the drawing area.

Structural Plan -

|Structural Plan: Level 2 ~ |5 Edit Type

Graphics > A
View Scale
Scale Value 1: 100
Display Model  Normal
Detail Level Coarse
Parts Visibilty Show Original
Visibility/Grap... @ =

Graphic Displa... Edit..
Underlay None
Underlay Orie... ' Plan
Orientation Project North
Wall Join Displ... Clean all wallj...
Discipline Structural
Color Scheme ... Background
Color Scheme <none>
System Color .. | Edit.. |
Default Analys... None
Sun Path T

Identity Data &
View Template | <None>
View Name Level 2
Dependency | Independent -

Properties helo

= [0 Views (all)
= Structural Plans
Level 1
Level 1 - Analytical
Level 2
Level 2 - Analytical
Site
i 3D Views
Analytical Model
& Elevations (Building Elevation)
East
North
South
West
1 Legends
= Schedules/Quantities
5 Sheets (all)
& & Families
W [ Groups
= Revit Links

Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

Tile Windows is useful for viewing the results of certain actions in
multiple views simultaneously.

Q

Press F1 for more help

1:100

BN v Mode ~

Then the model view sill be equally divided for the family editor's view. Click any spot in the 3D

view of the family editor and click “Load into Project” button.
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Aot~ §

& oin + 8- =% 8 ™ Edit  Visibilty|  Edit Load into|
Extrusion Settings | Work Plane  New

i Mode Work Plane Pl

C oy

Select | Properties | Clipboard Geometry i Measure | Create Load into Project

Loads the family into open projects or family files

Properies 51|[01 Working with Families (1) 2.rfa - .. &1 ) — W If only one project (or other family file) is open, the family is
= 1 Views (al) 18Y Structural Plan: Level 2 - Project1 =[@f= automatically loaded into that file
«f| S FloorPlans If multiple projects or families are open, you can select the files
Lower Ref. Level into which you want to load the family,
L S & Ceiling Plans
Family: Structural Colun » 4 Lower Ref. Level Press F1 for more help
Constraints Y & 3D Views
Host View 1
Structural ] 30}
Material for Mo... & Elevations (Elevation 1)
Always export a... [ Back
Beam cutback in.... From bounding... F";’“
Identity Data X ;im
i
OmniClass Num... 23.25.30.11.14.11
TS ae 1 B Sheets (all)
OmniClass Title Columns 3 =
| B0 Families =
e # 19 Groups od]
Cut with Voids ... S ReiGe
Symbolic Repre.. From Family
Shared o
Show family pre... @
P Aok 1:100 OO % x ® & 2 ¢ @ 4 [ » IR W o4 |m
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. APress & Drac T

You will be automatically taken to the project view to place a column instance. place few

columns in the project.

EHG - Q-F-2-20A G- = Projectl W oes e ot g Q8 7 8 Signln X ] el
Modify | Place Structural Column
Kcope - [0 & o o v | —b i FGP I
b o -l o = v & B Pemm &
Modify I Ot 'm . y O %T v ol f il T~ Edit  Visibility |  Edit pick | € WorkPlane | Load into
| Goin - KK LU = |lxuus‘>on Settings | Work Plane  New | Project -
Select Clipboard | Geometry Modify | View | Measure |  Create Mode Work Plane |  Placement | Family Editor
Modify | Place Structural Column __|Rotate after placemen =~ Depth: v Levell v 4000.0
CIOREINES ) T O T o o 84 3D View: (3D} - 01 Working with Families (1) 2fa | = | @& | 52 |
o1 Woking with & Curtain Wall Mullions e 7‘
Families (1).2 willl| - Qetalttoms 1
it # Division Profiles
# Doors '
New Structural Columr ¥ | B Edit Type ||| & Duct Systems
G i i # Floors
Moves With Grids | & Pattern
Materials and Fini.. Z|[| = piping Systems
Structural Material Steel, S 355 # Profiles
P | # Railings
Enable Analytica... ¥ #*Ramps
Rebar Cover - T... | Interior (framin.. * Rools
Rebar Cover - B...| Interior (framin.. o
Rebar Cover - O... Interior (framin.. = =
- < 3 & Structural Beam Systems =
Piriénsions & Structural Columns
Volume 0.760 m* <01 Working with Families (1),
Identity Data ) 600 x 600
Comments 800 x 800 =
Mark 1000 x 1000
# M_Concrete-Rectangular-Col
# UC-Universal Column-Colum
& Structural Fabric Areas
& Structural Fabric Reinforcement
& Structural Foundations |
Structural Framing
& Structural Loads
# Structural Rebar g
— # Structural Stiffeners S 1:10 O 8 & G R H 2 ¢ @ < m » 1:100 €
Properties helo Apply <| " > —
Click to place a free instance. Press SPACEBAR to cvcle the placement basepoint. & Mad -

Go to 3D view and change the detail level of the view to check if the column geometry

changes accordingly.
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HG-G-@- =-LFO0A G- 2FE &R Projectl ~3D View: (30) b 7y o keyword or phrose 88 S & 7 D Signin - X ] el S

Kew 08 &Moot = BHE| U E B fopmm B
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Properties helo Apply < n » 1:100 B & & o RkEGS 08 " »
Readv & <L OTE A i el v ' [Press & Drac V.n

You can also change the instance parameters from the properties to see if it works well. You may

want to click “Edit Type” button and try different values for the type parameters.

ZHG- G- =L OA G- a8 Projectl =30 View: (30) 1> 7ype a keyword or phrose 0 S 5 7% O Signln B e x|
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Mod ) e o O3 o R S Al T Edit  Visibility|  Edit pick | € Work Plane | Load into
¥ EV: Goin - K ¢ D "= x| =5 £ @ | Extrusion Settings | Work Plane  New Project
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12.4 Modeling Exercise

refer to the previous chapter and the images below to create L-Angled Column

Select | Properties Clipboard Geometry f Measure Cvealel Mode
ModlfylEdllExbusion

=III? -
b =100 Q
Family Types (- | =
— x 525 —
| [Structural Material d [Steel ASTM AS3 |- | Rename... -
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—— t=10
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Remaye o . IE
= 3 ~— ' 7
B - —— ir___.\‘;aj_o _____
1] =
{

Edit  Visibility|  Edit Pick | ©> Work Plane
Extrusion Settings | Work Plane  New

E&Dulbb""‘“ IQ &® B iiﬂ—‘

kAol ¥ \«* D
Geometry Modify Measure | Create Mode Work Plane I Placement

Modify | Edit Extrusion

[Properties [5|[o1 Working with Families (1)_practic... @ 1 - TS
5 0 Views (all) =) ¥ %N 4
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Lower Ref. Level L, ®
K # Ceiling Plans 2 J
Extrusion v 5 Edit Type @ 3D Views
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Work Plane | Level : Lower Ref... ||[|® & Groups
[Giohice # ||| = Revit Links
Visible @ (]
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Material Steel ASTMAS3 H =
Identity Data 4

Subcategory None
Solid/Void Solid

Properties helo |__Apply 555 a8 . I ] »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. EiPress & Drac ¥

]

Disclaimer: The process described in this tutorial is only to help the readers understand the concept of the topic and how

to use related functions. This tutorial does not offer the optimized way to implement a project in Revit.
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CHAPTER 13 - Customize Column Family

In this section, you will learn

e How to create a Tapered Concrete Column Family

<Image from "http://www.architectmagazine.com/photos/brockman-hall-for-physics>

13.1 Template

Go to "File>New>Family” and select “Metric Structural Columns.rft” file for the template.

¥4 Metric Spot Lighting Fixture wall based.rft
84 Metric Spot Lighting Fixture.rft

B4 Metric Structural Column.rit
[ Metric Structural Foundation.rft

¥ Metric Structural Framing - Beams and Braces.rft
¥ Metric Structural Framing - Complex and Trusses.rft
[ Metric Structural Stiffener Line Based.rft

[IW Metric Structural Stiffener.rft

[ Metric Structural Trusses.rft

[ Metric Telephone Device Hosted.rft
¥ Metric Telephone Device.rft

[ Metric Window - Curtain Wall.ft
(4 Metric Window with Trimurft

I8 Metric Window.rft

« it
File name: Metric Structural Column.rft
Files of type: Family Template Files (*.rft)

Autodesk”
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13.2 Reference Plane

To create tapered column, you need to have two different profiles for the top and the bottom. In

order to do so, we need a separate set of reference planes. Once family editor begins, go to “Create”

tab and select "Reference Plane”.

B; TEECEIY

o

@ B, show

@ |

Extrusion Blend Revolve Sweep Swept Void _| Model Component Control Referenc Set VM| dinto
Blend Forms | Line [ Model Group - Line | Plane ‘ Project
Select | Properties Forms Model Control Connectors Roicancs Pa )
Creates a reference plane using drawing tools
[Familly2 - Project Browser (] [Properties =]
= 0 Views (all) In the drawing area, sketch a line to define the new reference
& Floor Plans 5 plane.
Lower Ref. Level
& Ceiling Plans L B - o
Lower Re. Level [Fomity:Structural ol = | % £ 1< >
& 3D Views Constraints s EQ EQ S
View 1 Host | J !
& Elevations (Elevation 1) | Structural B | | |
Back Matedal or Mo.. d o F !
Front Always export a... |
;f"‘ht Beam cutback in... From bounding... o AN = e : = e : e :‘ = !
B sheeltgs (al) identily Da 4 w | | | :
Il OmniClass Num... 23.25.30.11.14.11 ey oy | RN . S
higak OmniClass Title | Columns le] | | | Press F1 for more help
roups : . ] pos
= Revit Links Othe . N RO I el s e oy 2
Cut with Voids .. © | | | o
Symbolic Repre... From Family | | |
Shared = | | |
Show family pre... @ | | [
| | |
| |
Width = 500
Y
Proverties helo Apply 1:20 O 8 CRC K] m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. IPress & Drac V.0

Draw two reference planes one on the left and one on the top of existing reference planes.

| i afe Tk = - ./ -
EL Ao © E&DF« b = Th < iy
Modliy -% @Jom - 8- ‘ o O ﬁT B ‘) o | Loadinto
= Project
Select | Properties cl.pboavd Geometry Modify Measure | Create Draw Family Editor
Modify | Place Reference Plane Offset: 0.0
Family2 - Project Browser ] Properties (5] =08 4
= . Views (all)
& Floor Plans ~ s
Lower Ref. Level | "
& Ceiling Plans | 5
New Reference Pla w BEdtType || 000 e . -
| Lower Ref. Level ew eeisnre anes dit T H. | EQ EQ
& 3D Views Construction 12 I L
View 1 Wall Closure b I
- Elevations (Elevation 1) Tt : ) | | | |
Back Scope Box None | | | |
Front ott - B}
Left N e il s gl comeseee
) Is Reference Weak Reference | |
e Defines Origin | ¢} 1 3
B Sheets (al) w ! I I I I
# B Families 5 =TT g = =
| | | E
# Il Groups 8 I | | | g n
@ Revit Links
levit Linl Al = = = 7| - ke | e [ Q
‘ I I I
| I I I
! I I I
I | | |
| | |
[ Width = 500
| / 7
|
Proverties helo Apply 1:0 0O @ 2 ] m »
Shorteut: (Q) C Copy (Modify>Modify) Vo
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Select one of the new reference plane and go to “Modify” tab and select “Mirror — Pick Axis”

button. Pick the center reference plane in parallel.

| cia a —
cri= [ B §
Goin - & Mirror - Pick Axis (MM)
. Reverses the position of selected elements, using an existing line
Properties | Clipboard Geometry or edge as the mirror axis. 2
Modify | Reference Planes
e Use the Mirror tool to flip selected elements, or to make a copy G ' IS
Fomily2 Project Browser. 5] |properties B o chirsant dad severse s PaAIOR 0 e sbke =2x
= 0 Views (all) 1
& Floor Plans -
Lower Ref. Level LR
= Ceiling Plans
Lower Ref. Level Reference Planes (1) v | £t Typd EGEQ T ===~ —o o
3D Views (@ ﬁH
View 1 Wall Closure (=
& Elevations (Elevation 1) Identity Data | | |
Back Name | | |
Front
R Exents ‘ — e copemrm— o
Scope Box None o
Right | | 0
}::::;:‘“’ s Reference  Weak Reference el e |
i ! ! f
oo B | | L
& 8 Groups Defines Origin ! | "a
= Revit Links Press F1 for more help My - swnem mny 8
| |
| I I I
| I I I
| | I I
I | | |
[ | |
| Width = 500
| / 7
|
|Proverties helo Apply 1:0 0O I ] m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. EPress & DracVa
Mirror both reference planes as the image below shows.
20O G s O ALS O LS ,-.-‘ S e 4 L T ——— B0 S S 7 Osignin - X »]  leslC S

R X | eia ale c;,
= S~ © Eu& Bl IPL; [Q? 1Py
- % . G oin - &~ i O =?W ‘/’* 27| Loadinto
“y ) 4 =l
Select | Properties Clipboard ‘ Geometry Modify | Measure | Create qulyEdltor
[Familly2 - Project Browser 8] |properties 5] —@% A
= [ Views (all) !
& Floor Plans - -
Lower Ref. Level | | ®
& Ceiling Plans = | |
Lower Ref. Level Family: Structural Colur = | 7 =it Type — - _I ——= EEEEQ = 7 |_ e, -
3D Views Constraints X |
View 1 Host I I
& Elevations (Elevation 1) | Structural E | | | | |
Back Material for Mo.. | | I I '
Front Always export a... [ | |
Left = 5 e = e selmem il o e e 8
Beam cutback in... From bounding... 0 T
Right i (¢) | | | Ire)
& sh ety Data w I I
I Sheets (D OmniClass Num.. 23.25.3011.14.11 ! I I n
Wstitend, mniClass Num... 23.25.30.11.14.1 N e i e r-—— ¢
OmniClass Title | Columns (e} | | | = =
# [ Groups Redtlabidovsadbbiani Redociddn— | | o
< Revit Links Other i w I I | o
Cut with Voids .. ©J BN et e gy A e )
Symbolic Repre... From Family | | | | |
Shared o | | | | |
Show family pre... 1 | | | | |
I | | | |
s o e e e o iy e
I Width = 500 I
| |
|Prooerties helo Apply 1:0 O® & Mmoo @4 m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. (=] Drac 7. |
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13.3 Parametric Dimensions

Add dimensions as the image below shows.

3~ ®| Family2 - Floor Plan: Lower Ref. L.\ » | 7ype o keyword or phrase

Modify
i = ( | o e t;, [(tﬁ
| B, Se- © E&ow“‘ iy
! S oin - &~ ‘." (O3 O ﬁT E B ‘/' ol T Load into
! | " g $ e
Select | Properties Clipboard ‘ Geometry Modify | Measure | Create Faml'y Editor
R 6] [properies. ol =TE
= . Views (al) 617 617
& Floor Plans ai pa I ¥ @
Lower Ref. Level | | "
& Ceiling Plans | |
ily: £ Edit Type S| JISVEII SIS e X -
| Lower Ref. Level Famlly'?tmdwalcolu‘ E »l)i — | EQ EQ | ~
& 3D Views Constraints .
View 1 Host | !
& Elevations (Elevation 1) [ Structural 4 | | | | |
Back Materil for Mo.. [Other | & x !
R Ca— 8 B e
Front Always export a... [ © | : | : | | Dimensions : Linear Dimension Style : Linear |
:':hh Beam cutback in... From bounding... o R T A *l il | = |¥ A T _8
ight
4 Identity Dota % i i | W
B Sheets (al) : I I I [T
S Omnicless Numi 2325301141 [l 00 N AL oo o e o Vo Vi o o o s
# B Families o I T £ © El
OmniClass Title | Columns [e] | | | 2= =
# [ Groups e N e e— | | Q.
s ool Other % w I | I @ >L
Cut with Voids ... & V‘7V7f|"'|~v|7‘—1-'—w_Q
Symbolic Repre... From Family 8 | | | | |
Shared B | [ee] | | | | |
Show family pre... ¥ | | | [ |
I | | | |
S == Siatues SfEmumiciee IS oo e Semeeeeie
I Width = 500 I
| |
' 1233 '
L |
A 7
|Proverties helo Apply 1:20 0O k. ] m »
e R ibress & Drc¥n

LA Type a keyword or phrase

@cm-sj &&DL'DU"" =@ @

08 B & el

& Join - h FOx ] O =‘-!5T Edn Load into
1% R R M Witness Lines | Project
Select | Properties Clipboard Geometry Modify Measure | Create | Witness Lines anﬂyEdhor
Modify | Dimensions \ [V Leade mwumm -
Family2 - Project Browser e =] ® = 2ok
= 0 Views (all) §
& Floor Plans Linear Dimension Style __ EQ EQ .
Lower Ref. Level Linear ¥ J ¥ < > 4 =
& Ceiling Plans | & & | o
Lower Ref. Level ~ | B Edit Tfo | |
& N S T 7 3 .
3D Views Grlplus N i EQ EQ ‘
View 1 Leader
& Elevations (Elevation 1) Baseline Offset...| 0.0000 mm ! | ‘
Back o s I I | | ‘
Front Equality Display | Equality Text (¢} | | | | I
Left w | I
Rigt M 4 Nt~ ] bas smllosasles o comlnn. oo o
| |
B Sheets (all) (e] | | I 8
# B Families w | | | | | n S il
% Grougs _—I___I__l__\___r__ 5 ©
= Revit Links ¢} | | o <
w I I I 3 )L
o U T =
8 | I I | ‘
| I I I !
[ I I I |
| | [ [ I
e ittt e e <
I Width = 500 [
| / 7 |
: 1233 ‘
— L b <
|Proverties helo Apply 1:20 0O P M BB @4 m »
Create length @7 migimimi 1
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13.4 Creating Parameters

Click “Family Types” button to edit and add parameters.

o
i = % ( | gnoale T —
E 4 B gu-u BNzt =@ @ |
odifyl [T Groin - %~ o8y O3 O ﬁT - 759 Loadinto
= - ¥ e =% c Project
Select | Propertief Family Types | Measure‘ Create | Family Editor
Allows you to enter parameter values for existing family types,
Family2 - Project iy 2d parameters to the family, or create new types within the —om ~
SO Views@l) | M
& @
¥ Hoornde In one family, you can create multiple family types, where each © EQ | EQ v -
!'_”"' Ref. L type represents a different size or variation within the family. Use ” s i
& Ceiling Plans | yhe Family Types tool to specify the parameters that define the | | _e
Lower Ref. L& differences between family types. | |
& 3D Views N— - - - —-F — — —x
Viewl | Press F1for more help : EQ EQ :
8 ions (Elevafion 1] | | | I
Back Material for Mo... | 1 | | |
Front Always export a... 8 | | | | |
':kh Beam cutback in... From bounding... | | | 3 |
ight Identity Data || I A A T § T
B sh | |
Shests () OmniClass Num... 23.25.30.11.14.11 ) y ' ' ~
# H Families , T w | | | I | n =
OmniClass Title | Columns S Svaa e S s = == o]
# Il Groups - ' o | | | | N < ©o
= Revit Links Qthe; | ‘ Qi
Cut with Voids .. [ w I I I 8 )L
Symbolic Repre... From Family . At " . (i
Shared B g I I I I |
Show farmily pre... ¥ u I I | I ‘
[ I I [ ‘
| | | I I
W o = <
I Width = 500 \
| / 7 |
| [
1233
I | -
Proverties helo Apply 1:20 O I B m »
Ready [IPress & Drac 7.

From the appeared window, select "Depth” parameter and click “Modify” button under

“Parameters”. Change the name to “Bottom_Depth” and “Group~" to “Dimension”.

Y - o9 £ 3 T 5 = v 4w
c 3 o ¢
Select | Properties | Clipboard | Geometry Modify wMeasu'e‘C'eale Fami'vfd"o'_

[Family2 - Project Browser [ Family Types x| =08 A
= [0 Views (all) S o Parameter Properties
& Floor Plans. Name: v| — @
Parameter Type b,
Lower Ref. Level Family Types P "
= Ceili 9 Family parameter :
eiling Plans New. 3
Lower Ref. Level L (Cannot appear in schedules or tags) o
3D Views Rename... bY| | @ shored parameter b
View 1 Delet (Can be shared by multiple projects and families, exported to ODBC, and
elete
& Elevations (Elevation 1) appear In schedules and tags)
Back seet. || Boot. |
Front P e
Left : Parameter Data
Right dds H4|  Name:
Sheets (all) Modify... Bottom_Depth| 9 Type
e L
N Groups Common - ) Instance
@ Revit Links
Type of Parameter: |Reporting Parameter
M| |Length ~ i b sl to endyact valie
Group parameter under: oy
|Dimensions -
Help
I ‘ ™
T T T v
I Width = 500 I
| Y e |
| |
L 1233 L
Prooerties helo Apply 1:0 O@ 6 ca8v . @4 " ) Y
Ready Ta
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Repeat the same step to the other parameter.

¢ B
- 5 o @)
Select Properties Clipboard ‘ Geometry Modify | Measure | Create Family Editor
[Family2 - Project Browser ’Eﬂhmily'l TS
= [0 Views (all)
& Floor Plans Name: - EQ EQ =
Lower Ref. Level Family Types $ + "
& Ceiling Plans Parameter ‘ ]
Lower Ref. Level | .
= 3D Views Structural Material ( Rename... - - EQlfEQ- "~ 7T ———
View 1
Delete
= Elevations (Elevation 1) | | |
Back Bottom_Depth : | ; |
Front Bottom_Width i : ; : |
Left |
Right bodishak aadas. 3
s gl o i =
# B Families | | | I TR I
= Il Groups Renove T e T 8 E
= Revit Links ‘ aT
I | I mi
- - - r--—-o0o
| | [ !
I | I |
I I [ !
| | l I
 — - - - - - - - #o-—
Width = 500 I
| d 1 |
| |
1233
k 2 E
|Properties helo Apply 1:20 0O @ ERC T ) »
Ready T

Add “Bottom_Radius”, “Top_Radius”, “Top_Depth”, and “Top_Width" parameters to the family. All

parameters are “Common” and “Length” under “Dimensions” group.

+
L sl 2
- B 3 Q ’
| Select | Properties | Clipboard | Geometry Modify | Measure | Create | Family Editor
Family2 - Project Browser [n Family Types: ) =08 a
= 0 Views (al) >
& Floor Plans Parameter Properties [l =) @
Cetl!".;law' ol ) ]| porameter Type .
Lower Ref. Level S « Iy e )
: (Cannot appear in or
3D Views Structural Material Rename... —] )
View 1 Delete " Shared parameter
& Elevations (Elevation 1) = (Can be shared by multiple projects and families, exported to ODBC, and
Back Top_Radius 00 - r appear in schedules and tags)
Front s
e Bottom Radius | 0.0 - = Seledt.., Export...
Right Bottom Depth | 500.0 4 = 4| Parameter Data
Sheets (all) Bottom Width | 500.0 = = Modify... Name:
ep o2 T o =
= 8 Groups Keynote . || oisapiine:
= Revit Links Model T = Common - () Instance
Manufacturer = 3 Type of Parameter: Reporting Parameter
TypeComments L s et
| / fr v
URL = Group parameter under: e 53
Desptn —
Assembly Code -
[ o ][ el || hep
[ ok [ cnca |[  mey [[ hew =
- = m— RAALCILA) YOO T
| f 1 |
| |
1233
A al/ v
|Proverties helo Apply 1:20 0O8 & 5 e w4 " »
Ready T

For "Formular” of “Top_Radius”, type in "Top_Width/2" and for that of “Bottom_Radius”, type in
"Bottom_Width/2".
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| Measure | Create | Family Editor

=R A
EQ EQ [
Lower Ref. Level Family Types i =8 B
& Ceiling Plans Parameter S | e
Lower Ref. Level — |
5 3D Views Structural Material ( Bename..; - EQ'EQ - 7 T
View 1
et
& Elevations (Elevation 1) Besz [
Back Top_Width 00 = . F i |
Top_Radius 00 ~TopWidth/2 T | |
Front Pt | = Top.\
Left Top_Depth 00 r aboindd L :
Right Bottom_Radius 250.0 =Bottom Width/2 ¥ Lo il el e 20
D Sheets (all Bottom Depth | 500.0 3 4 | | | | T
B Families Bottom Width 1 500.0 d e miEcaen e s 5 i) B |
e o T T g8
e Revit Links I a =
I I I mi
I | | I -a
I I I |
I | | !
| | I !
R . ) | | I
= = | SR  —
Width = 500 |
| 1 d I
| |
1233
L b s
Proverties helo Apply 1:20 OB &« « B ¢ @ m »
Ready o

Associate the parameters to dimensions as the image below shows.

{3~ ®| Family2 - Floor Plan: Lower Ref. L..| »

e ;T‘W

Type a keyword or phrase

=

Sou- @ B Ho @
Gioin - 8- | 29 O3 O =‘-¥ﬁT S Edit Load into
o H4Ax S | Witness Lines| _Project |
Clipboard Geometry Modify Measure | Create | Witness Lines | Family Editor
Modify | Dimensions | [V/Leade Prefer: Wall centerlines v | Labet: <Addparameter., v, | | Instance Paramete
P g e v T [Fovarie - H <None> ) =T
= 0 Views (al) . ~_Bottom_Depth = 500 G
& Floor Plans Linear Dimension Stgowom Radius = Bottom Width /2 = 250 EQ EQ =
Lower Ref. Level Linear Bomvn:w' idth =500 g ¥ A+ Y
& Ceiling Plans Top_Depth = 1657 | |
Lower Ref. Level Dimensions (1) ~ | B EditTop_Radius = Top_Width /2 = 0 | ‘
EBDVYIews Graphics ***I***EQEQ***T**‘—‘—‘
& Elevations (Elevation 1) Baseline Offset... 0.0000 mm [ |
i Tt 0t ! I I | !
Front Value 12333 ¢} | | | \ I S~
Left % B w | | 315
g 00000 [ — e s o N n-Q
Label Top_Width | | bl
B Sheets (all) . (e] | | I £
# B Families w | | | | | % Ned =
o= Evamrali e e s = = L
# ol Groups all | | | in Qa o
= Revit Links [¢] | | 1 8
ul I I I £.5
_ﬂ___l__l__\___t___o_ﬁ.
=
] | I I I ‘ 5 2
= | I I I ! @
[ I I I |
I | | 1 I
== paony vl iiimdeni
| Bottom_Width =500 |
| / 7 |
| < |
3 Top_Width = 1233 :
|Prooerties helo Apply 1:20 OO & c@MB/2 o @4 m »
Ready. EIPress & Drac V.1
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13.5 Geometry — Solid Blend

To create a solid with different profiles on the top and at the bottom, you have to use “Blend”

function under “Create” tab.

TR TEECE I | 5@t o

Viewer
Extrusion| Blend| Revolve Sweep Swept  Void _| Model Component Control Releven(e Reference| Set = Load inta
Bland_Forms | lina [& Model Group Line  Plane | Project
Select | Properties Solid Blend | Control Connectors Datum ‘ Work Plane | Family Editor
Creates a solid 3D shape that changes along its length, blending
o e fi| from astarting shape to an ending shape. T
5 1 Views (all) This tool blends 2 profiles. For example, if you sketch a hexagon a
& Floor Plans and a circle above it, a solid 3D shape is created that blends the EQ EQ =
Lower Ref. Level 2 sketches together. K t A "
& Ceiling Plans | |
Lower Ref. Level | | a
& 3D Vi P —_—_—_— - —_ e~ A --- - - — —_—
iews ‘ & | EQ 'EQ |
View 1
= Elevations (Elevation 1) | | | I
Back ‘ | | I ‘
Front g | | I 8 ~
Left w | ! ! | 3 g
Rt | I SO ..y 90O —8—— - — — - e - — - e
B Sheets (al) ‘ \ I ‘ £
# B Families | | | | | Qo c =
= 2 Svarala Sjana = == i@ 3= L
# [ Groups 1 n a o
92 Press F1 for more help | | | o)
@ Revit Links | [ |
Cut with Voids . ™ wr | | | £. Ol
Symbolic Repre... From Family S S T *'g‘ o
Shared o (¢} | | | | | S ’_O_
Show family pre... # w | ‘ i J | 1]
[ I I I |
| | | | I
e g e i | T T %
[ Bottom Width = 500 |
| / 7 |
I . - |
| Top_Width=1233
Proverties helo Apply 1:20 O @ LR e o W m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. IPress & Drac V.0

Once you run the function, you will be in the sketch mode for the bottom profile. Select “Rectangle”

in the "“Draw” group and draw a rectangle in the middle.

EL E&D DI/“"“* X Q@ (»/Beee- @\ @
‘ M . rocen.
Modify II % | o2e O ﬂT f Edit Set Show Viewer
= £ Q, Top | Ve @ D i =
Select | Properties Clipboard Geometry Modify Measure | Create | Mode Mode Work Plane
Depth 250.0 | /I Chair Offset: 0.0 ! |Radius 1000.0
Family2 - Project Browser (8] [Properties (5] —0% A
= . Views (all)
& Floor Plans A EQ EQ b
Lower Ref. Level } i s ~
& Ceiling Plans -
Lower Ref, Level Blend | 88 Edit Type
5 3D Views Constraints i EQ EQ
View 1 SecondEnd 2500 Il L |
& Elevations (Elevation 1) Fstend oo : : .I
Back Work Plane | Level : Lower Ref...|
Front [Grophics : s @] ° 8 -
, 2800
Left Visible i 1] = 1 .38
. h“'g"; Visibility/Graph.. Edit | T T “ g -
I Shet o Materials and Finishes s g - £
# B Families x | w o Q El
Material <By Category> J | S O = L
# [l Groups ——— e & Qo
= Revit Links Identity Data (@] 1 | @
Subcategory | None wl £ D[
Solid/Void Solid . I S o
¢ = ;E
L m
Bottom_Width = 500
Top_Width = 1233
Proverties helo Apply 1:0 0@ AR m »
Enter the diagonal point of the rectangle. Y
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"Align” and constrain the left edge and the right edge to each corresponding reference planes.

&DRW""‘* XQ H)ecet- @R
o O =‘-tnT B Al = f S | Edit CoeCNy Set Show Viewer
P S 4% Top | 2 »{ &
__Geometry __Modify Measure | Create | Mode Mode Work Plane
Modify | Create Blend Base Boundary ‘ [V Multiple Alignmen  Prefer: Wall centerlines v
[Family2 - Project Browser (a||properties [a]] P PN =%
= 0 Views (all) | 1 ]
& Floor Plans < o
Lower Ref. Level "
& Ceiling Plans 2
Lower Ref. Level Q £8 Edit Type _e
= 30 Views Const ' EQ 'EQ
View 1 Second End 250.0 } " |
= Elevations (Elevation 1) First End 00 !
Back Work Plane | Level ; Lower Ref.
Front | Graphics B
lfﬁ Visible @ H o N~
Right Visibility/Graphi.... Edit... o Te)
B Sheets (al]) v (9]
o o Materials and Finishes ©
# B Families Material <By Cat »: I =
&l Groups laterial By egory: J‘] o
= Revit Links ety Data i <
Subcategory VNone 77(&! -
Solid/Void Solid { % ! o
[Create or remove a length or alignment constraint | "a_
! = o
)
-~ Q.
-~ (@]
O =
m
Prooerties helo Apply 1:20 O Lomme oW m »
Create or length

Y

Select “Circle” in the “Draw” group and draw a circle. click on the vertical center reference
plane for the center of the circle.

- E&DE&W“"“ XQ /necl- gy &
OO A,
Modify - (oY O ﬁT ‘/* | Edit Set Show Viewer
1% 4% AR LY S
Select | Properties | Clipboard Geometry Modify Measure | Create | Mode Mode Work Plane
Depth 250.0 | /IChair Offset: 0.0 | Radius 1000.0
Fomi2 - et Browse 1 [propertes o o o -on -
& 0] Views (all) ! }
& Floor Plans = o
Lower Ref. Level "
& Ceiling Plans -
Lower Ref. Level Blend - |88 Edit |\;n _e
= 3D Views Constraints E Q EQ -
View 1 SecondEnd 2500 _] p ‘
& Elevations (Elevation 1) First End 0 0 IJ /| Ve
4 ~ ~ i
Back Work Plane | Level : Lowe Re.. P4 e |
Front P B \ |
Left : | i / \ o
Visible { 2506
Right ek — (R s o N~
isibility/Graphi.... Edit (9]
B Sheets (all) % \ O
S Materials and Finishes \ / O
# B Families Materisl <By Cat N ‘J \ 3 | | E
# ol Groups sl By Categony’ ! . 4 -
= Revit Links Identity Data . < 0
Subu(egorx None —
Solid/Void | Solid Q
O =
n <
| )
o) I
S o
- O
O -
m
Proverties helo Apply 1:20 O N - ] m »
NEAREST to [Reference Planes : Reference Plane : Right]

Y
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Select the circle and go to the properties to check “Center Mark Visible” option.

E,&D[}vm}“.,. . X [, /=060 & @ @

""O’OﬁT x Edit £e00 N Set  Show Viewer
¥ M Top Sr.] :
Geometry Modify Measure | Create | Mode Mode Draw Work Plane
Modify | Create Blend Base Boundary
Family2 - Project Browser o |Poperties @ - T —@% ~
= [0 Views (all) f {
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reference plane.
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Select the circle to make the temporary dimension visible.
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Go to "Modify” tab and click “Split Element” button.
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Click the lower part of the circle to put splitting point.
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Then click “Trim/Extend to Corner” button from the “Modify” tab.
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“Trim” each side and the upper part of the split circle.
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The trimmed profile should look like the image below.

=5 oy .
» EEE A GRNERE &&Mu;;;:- d|x @ 22000 @& @
o % - . g ,3‘ Q) O ﬁT */” e 5:‘: \ > 5.4 | set Show Viewer

Select | Properties | Clipboard Geometry Modify Measure | Create | Mode Mode Work Plane
Modify | Create Blend Base Boundary

T — - EQ ' EQ Q 5

& Floor Plans -

Lower Ref. Level | |
& Ceiling Plans
Lower Ref. Level Blend | 78 Edit Type =
% /

5 3D Views Constraints /
View 1 SecondEnd  [250.0 ]
= Elevations (Elevation 1) First End 00 i 6
, Y

=

Back Work Plane Level : Lower Ref o
Fram | Graphics £ = 6
Lfk Visible @ 8
Right Visbilty/Graphi..|___ Edit. | v % \
D Sheets (all) i and F A / \\
& B Families Mslamats anc kinies [ \ I
Material <By Category> || { B

# [l Groups - s —
o Revit Links Identity Data ’ /
Subcategory | None
Solid/Void Solid \0

Prooerties helo Apply 1:20 O@& oMWY v W m

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. IPress & Drac V.o

Select the semi-circle and then go to “Modify” tab and click “Mirror — Pick Axis” button.
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Click the horizontal center as the axis.
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Then align the center of the semi-circle to the lower horizontal reference plane to constrain the

center to the reference plane.
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To parameterize the radius, repeat the same steps to the mirrored semi-circle.
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Trim each side and the semi-circle.
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The profile the bottom face is done.
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Before moving on to the top profile, test the parametric frameworks. Open “Family Types”
and type in different values to “Bottom Depth” and “Bottom_Width".
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If the parametric frameworks work file, click “Edit Top” button.
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Before finishing the sketch mode, test the top profile as well.
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Go to 3D view and then, your geometry should look like that of the image below.
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Go to “Front” elevation view.
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L |
Right Identity Data A ! 6 :
. OmniClass Num... 23.25.30.11.14.11 | |
Sheets (all) niClass Title | I i et On 4 B
# B] Families et - L1
i [l Groups . o | o |
= Revit Links St voth Vorsie t I I
Symbolic Repre... From Family | | I |
Shared A o L)
Show family pre... IS | l
o | |
| O |
| kol |
LS 1
N iy
| ] | °
[0l |
|Proerties helo Apply 1:20 OO0 & “ MBS o @4 m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. EPress & Drac V0.
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"Align” and constrain the top face of the solid to the “Upper Ref. Level” annotation.

Bz -G-2-=2-20A G- &8 Family2 - Elevation: Front b 75e o keyword or phrose 88 QS 7v D signin X »] el s

k @I 2 @(ul' w &Di\« le :Engﬂz‘ ;' uﬂ

o .
Modify % @ roin - &~ o O =‘=‘ﬂ f 739 Loadinte
- . %o EER: | Project
Select Properties Clipboard Geometry Modify Measure | Cveale‘ Family Editor

V| Multiple Alignmen  Prefer: Wall centerlines v

Family? - Project Browser (8| [properties (g} =@% 4
= 0] Views (all)
& Floor Plans - >
Lower Ref. Level "
& Ceiling Plans y
Lower Ref. Level [Family: Structural Colur =/ 7 £ Ty e
= 3D Views Constraints N
View 1 Host
130} Structural *
& Elevations (Elevation 1) Material for Mo...
Back Always exporta... [
Front Beam cutback in... From bounding...
= o :
OmniClass Num...| 23.25.30.11.14.11
D Sheets (all) = [
i OmniClass Title | Columns =
# 8 Families =
i [ Groups Other
« Revit Links Cut with Voids ... &
Symbolic Repre... From Family
Shared o
Show family pre... @
e Low Ret Lo G %
Prooerties helo Apply 1:20 O GomwS s el m y
Create or remove a length or alignment constraint T
add more types to the family. You can try it with the catalogue function.
el G -S-a- =2l O0A 8- EE Ok £33~ ®| Tapered Column_3.rfa - 3D View: | » | 7ype a keyword or phrase 8B fr Lsignin A QH:_&“

| o R P . T .
‘ s 0 AP
Select | Properties Clipboard Geometry Modify Measure | Cleale] Family Editor

Tapered Column_3.rfa - Project Bro... "ﬂ}lepeﬂles 4] =08 a
= (0] Views (all) |
& Floor Plans = =
Lower Ref. Level { :M\J nf‘\
& Ceiling Plans -
Lower Ref. Level Family: Structural Colun | 11t Ty« 3
= 3D Views. 2 o
e Name: -
Family Types
Parameter Formula ———
Structural Material il
| =
=m | Delete =
=i f| |Top.Width 12333 = s
|| |Top_Radius 616.7 =TopWidth/2 T
Parameters
Top_Depth 16568 = r
Bottom_Radius  400.0 = Bottom Width /2 A
Bottom Depth  500.0 = 4 Modify...
Bottom Width  800.0 = & = }
Remove
(oo J[ o J[ mwy [[ ne
Properties helo Apply 1:100 @& & . B Y T |m »
Ready T

Disclaimer: The process described in this tutorial is only to help the readers understand the concept of the topic and how

to use related functions. This tutorial does not offer the optimized way to implement a project in Revit.
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CHAPTER 14 - Customize Beam Family

In this section, you will learn

e How to create a Cranked Beam Family
14.1 Template

Start a family editor and select “Metric Structural Framing - Complex and Trusses.rft” for

the template.

f Bk
[ [ New Family - S F

Look In: | J. Eng"Sh

al Templ

5 < Name
Structural T

% Metric Spot Lighting Fixture wall based.rft
[ Metric Spot Lighting Fixture.rft
4 Metric Structural Column.ft
¥% Metric Structural Foundation.rft
[ Metric Structural Framing - Beams and Braces.rft
[ Metric Structural Framing - Complex and Trusses.rft
8% Metric Structural Stiffener Line Based.rft
¥ Metric Structural Stiffener.rft
B Metric Structural Trusses.rft
¥4 Metric Telephone Device Hosted.rft
¥4 Metric Telephone Device.rft
84 Metric Window - Curtain Wall.rft
8% Metric Window with Trim.rft
¥4 Metric Window.rft
“ "
File name: Metric Structural Framing - Complex and Trusses.rft
Files of type: [Family Template Files (*.rft)

14.2 Reference Planes

Go to "Front” elevation view and place two reference planes on both sides of the “Ref. Level”.
EHG: -G 20 A 3D 5 kS ] Cranked Beams.a - Elevation: Fr|» | 7,pe o reyw /S S 7 L signin - X »] el s

BL 0 0@OSRE |\ G 8w . B ag- W

E]E'il3 Extrusion Blend Revolve Sweep Swept Void _| Model Component

Reference Reference | Set Load into
Blend Forms | Line [@) Model Group ~ s Plaia Project
Select | Properties Forms Model Control Connectors Datum Work Plane | Family Editor |
|Cranked Beams.rfa - Project Browser & |||Properties & =@% A
= 0! Views (all)
& Floor Plans 4
Ref. Level
= Ceiling Plans
Ref. Level Family: Structural Fram ~
@ 3D Views Constraints E
= Elevations (Elevation 1) Host
Back
Front

|

|

Structural i |
Structural Frami... |
|

|

|

Left Material for Mo... Other
Right Always export a...
® Shees (al) e "
I :2:;"‘:: OmniClass Num... 23.253021.14 S S e B e e e S gl e !
. OmniClass Title | Trussed Beams a __[Clcktoselect TAB for akternates, CTRL adds, >Hm|— R 5
v . T unselects, ey
Work Plane-Based™ |l — — — — — — — — — — — — s = maSaes S e S st
Always vertical @
Cut with Voids .. 1
Symbolic Repre... From Family
Shared

Show family pre...

Prooerties helo Apply 1:10 =) ® & 2 “ LJ

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. [IPress & Drac ¥-n

Page |70



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

Then select the vertical center. Click appeared “Pin” icon to unpin the object.

> 2D 1 » S5 4 40} - ¥  Cranked Beams.rfa - Elevation: Fr..|» | 7ype o keyword or phrase
cia ala 1

S~ © F'_—.&Dleb : & B @

Propagate | Load into

 Extents Project

o 1RO xe &

Clipboard Geometry . Modify Measure Create Datum | Family Editor
Modify | Reference Planes
(Cranked Beamsfa - Project Browser (@ |[Properties & & =@n/a
10! Views (all) 4
& Floor Plans 2 -
Ref. Level
& Ceiling Plans
Ref, Level Reference Planes (1) v % Edit Tyoe - 1 —
# 3D Views | Construction * |
& Elevations (Elevation 1) WallCloswe [T ] |
Back &
Identity Data ' |
Front Name Center (Left/Right)
Left Tants 0 |
L '“9"; ScopeBox  None I
D Sheets
L] Families( : : :
Is Reference Center (Left/Ri... 1 | -
% i Groups i i =
T Defines Origin | |
intine 00 |Eessstdicennmess NGNS etaEe S e oeeeEs Sy [Prevenl or allow change of element position]_ i g s
N e e ey E dinlil
i o
______________ ———————————— = — = = = —
|
|
|
|
|
|
|
Center (L_eanlgrn) &
|Prooerties helo Apply 1:10 OO0 % = @& 2 ¢ @4 ] »
Pre T T T - - SPress & Drac 71

2| Type a keyword or phrase

lD

Propagate | Load into
Extents Project

Y PR

Feu- © E}&DMDUZ”"R l‘ 1Py

Clipboard Geometry Modify Measure | Create | Datum | Family Editor
Modify | Reference Planes
Cranked Beams fa - Project Browser (@ |[Properties & -t~
=70 Views (all) Y
& Floor Plans i @
Ref. Level "
& Ceiling Plans 1
Ref. Level Reference Planes (1) v |/ Edit Tyoe i =
& 3D Views Construction *
= Elevations (Elevation 1) WallCoswe  [1__— ]| !
Back Identity Data £ !
Front Name Center (Left/Right) [
Left Extents C |
= '“9"; Scope Box None |
L Fa:::i:: : - |
Is Reference Center (Left/Ri...
# [ Groups Defines Origin 12 H e e e R g e gt =
< Revit Links bl ;/
e <
R el
I
|
I
I
|
|
|
Center (LefRight) =
|Proverties helo Apply 1:10 O 6 “ M &2 @4 ] »
Pre all ch: 3 E7 Brl 3 i DT‘I c g »
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Add one more reference plane in a horizontal way, and place four vertical reference planes.

refer to the image below.

= W | cia ale T =
S~ @ E&Dkl Db g [‘Eﬁ 1Py
S oin - &~ (O3 O ﬁT */* 5 Load into
-% ¥ %3 A o e
Select | Properties Clipboard ‘ Geometry Modify | Measure | Create Faml'y Editor
(Cranked Beams fa - Project Browser (]| |Properties =] =08 4
= 0! Views (all) 4
& Floor Plans 2 =
Ref. Level "
& Ceiling Plans __ S | | | | .
Ref, Level Family: Structural Fram | (2 £t Tyoe | | | | a
# 3D Views Constraints * | |
& Elevations (Elevation 1) Host ! .
Back | Structural g ! ‘ I |
Front Structural Frami... l:] ! | | |
Left Material for Mo... | Other | | | |
Sh::?sh(:ln Ahiajopot e B ; : ! ! :
15 Famibs D s sty ) [P e e i Rl RN o
& i Groups riClass Nurmi, 23253021, - i A . S T e e e &
<o Revit Links OmniClass Title | Trussed Beams a.. | !
ev e e A e =
Work Plane-Based ! ! ‘ I !
Always vertical ¥ | | | | |
Cut with Voids ... & | | | |
Symbollc Repm From Famﬂy | | | |
Shared a | | | |
Show family pre... # - _I . T __________ [ I_ I
| \ | |
|Proverties helo Apply 1:10 O . - ] (] »

14.3 Parametric Dimension

refer to the image below and place dimensions to the reference planes.

| gnoale T —
S @ E&ow ‘.u— fﬂK@f 7y
Modrfy '% @;om <% | o8 O3 O ﬁT &1 |2E| 2" |[Aigned] Angular Radial Diameter Arc | Load into
= ¥ Length | Project
Select | Properties Clipbourd Geometry Modify Measure | Create Dimension Family Editor
Wall terlines v
Cranked Beams o - Project Browser (4] Propertes =] o -
= [0 Views (all)
& Floor Plans Linear Dimension Style 2 I(.""
Ref. Level Linear S
= Ceiling Plans
Ref. Level |New Dimensions | BB Edit Type o
# 3D Views | | | |
& Elevations (Elevation 1) | i o 1 |
oce | | | |
Front w0 50
Left
Right | | | |
D Sheets (all | | | |
::milies N S [ e g e o
oups. 0 DIV AC R s SN K B S et =
= Revit Links i. T [ = = g G E
————— frmrm A = s Sl e
| | | |
B | | | |
| | | |
| | | |
i - [ T
| | | |
|Prooerties helo | Apply 1:10 O s MM o W (] »
MM"'“’?’““, ﬁ--l V,T —
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Turn one of the dimensions into "EQ" dimension.

Properties

Clipboard

ﬂ‘.‘y Sla - @ &&Dh DI/I
R R Y

Geometry Modify

gia dlo

“'j

Measure

7y
=) 0
Create

| [&]
|

K
Edit
Witness Lines
Witness Lines

Py

Load into

Family Editor

Modify | Dimensions

| I¥/Leade Prefer: Wall centerlines +

(Cranked Beams fa - Project Browser (]| |Properties =) ! TS
=2 Views (all) | ‘4‘
& Floor Plans Linear Dimension Style | (==
Ref. Level Linear | 580 |
& Ceiling Plans 1 —3
Ref. Level [Dimensions (1) | B it e
% 3D Views | Graphics [ |
& Hlevations (Elevation 1) Leader I ‘
Back Baseline Offset... |0.0000 mm | | I
Left Equality Display  Equality Text | |
Right
 Sheets (all) ' ‘
# B Families ot B s T
# [l Groups Ep o | \@
= Revit Links 3 z = = = ==l
o~
Llcf o | Toggle Dimension Equality I ‘
______ S o) | SN g |
| |
| |
| |
3 | |
e | |
| |
| |
| |
. | |~
|Prooerties helo Apply 1:10 O @& LR ] »
Toqale Dimension Equality Press & Drac V'
Add "Width_1", "Width_2", “"Width_3", "Height", and "Drop” parameters with “Common”, “Length”,

"Dimension”, and “Type" options.

Select | Properties Clipboard Geometry | Modify Measure | Create | Family Editor
N O, == __
50 ! Parameter Properties
Name: v
8
Family Types Parameter Type
New. '® Family parameter
8 ew..
(Cannot appear in schedules or tags)
Rename... -
® (" Shared parameter
Cl Delete (Can be multiple projects and families, exported to ODBC, and

shared by
appear In schedules and tags)

580

|
|
Width 3 00 = :
Width 2 00 T [ | seet. || Bgot. !
Width_1 00 = r |
e 1 - !
B - n =
! 23
&R Remove
-y
ok [ cme || amy |[  hHep
Proverties helo | Apply 1:10
Ready
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Refer to the image below and associate the parameters to the dimensions.

EHG - KS-a- 27,0 =2 o §83 - ®| Cranked Beams.fa - Elevation: Fr...|» | 7ype o keyword or phrose A0S 8 7 L signin B ol e
Modify o
PEL D K s &M= @ @
t Groin - 8o~ o8y O3 e 27| Loadinto
e gy OB e GO T a x| B |
Select | Properties | Clipboard ‘ Geometry Modify | Measure | Create Fa;ni';[dnov
e T T o ey
= 10! Views (all) 7
& Floor Plans -
Ref. Level "
& Ceiling Plans i
Ref. Level |Family: Structural Fram | (% £ 10 . . .
% 3D Views Constraints i Width_2 = 1240
& Elevations (Elevation 1) Host ) !
Back | Structural i I\Mdm_1 - IWiﬁIh_S - 50
Front Structural Frami.. ,:] —
Left Material for Mo... | Other | | I |
Sh:eitgh; Always export a... ! - | | | |
ﬂFamiIise:n deatly Data ’ S5 il e e e sl o
et OmniClass Num... 23.25.3021.14 ) E T ST e - L Ref.Level
uos Ormriclass Title | Trussed Beams a s e 1 - [Reference Planes : Reference Plane] ~ —* =
@ Revit Links Wadiatideivad i Sttt @ | | |
Other : = 3
Work Plane-Based ! ': ! I | I
Always vertical ¥ g | | I |
Cut with Voids ... © = | | | |
Symbolic Repre... | From Family N O | US| ||| | ———
Shared | | | | |
Show family pre... | | ' |
|Prooerties helo Apply 1:20 O . I (] »
i Planes : Ref B

14.4  Sweep

Go to "Create” tab and click “Sweep” button.

Cranked Beams.rfa - Elevation: Fr...| » | 7ype o keyword or phrase

{a a @ O ‘Gé @ Q Ik- [ A Model Text A ed ¢ 5 [ show 0]
5 t * &8 Viewer
% Extrusion Blend Revolve |Sweep| Swept  Void || Model Component ¢ Reference Reference | Set Load into
Blend Forms | Line [‘H Model Group * A 3 i Line Plane  Project
Select | Properties Forms Solid Sweep ontrol Connectors | Datum ‘ Work Plane Family Editor
o . : Creates a 3D shape by sweeping a 2D shape (profile) along a
[Cranked Beams.rfa - Project Browser (@ | [Properties path. =05 A
= 0, Views (all) ‘
& Floor Plans =
Ref. Level "
& Ceiling Plans |
Ref. Level Family: St : —
# 3D Views Constraints |
& Elevations (Elevation 1) Host
Back y !
| Structural ;—]l B =580
Front Structural Fram| >
-~
Left Material for Md ‘ I I I I
e "'9"(;0 Always export | | | |
A Identity Data | press F1 for more help R e e
# B Families =
OmniClass Nur.. e P o Ref. Level
# [ Groups - - g o 0 El
T OmniClass Title | Trussed Beams a.. o D S [ S | S /- A A . L
@ Revit Links - . ] | | 1 |
Other 4 T 3
Work Plane-Based ! ¥ ' ! ! |
Always vertical ¥ g | | | |
Cut with Voids .. & o | | | |
Symbolic Repre... | From Family e M e e | A
Shared o | | | |
Show family pre... ¥ | | ' |
|Prooerties helo Apply 1:20 0@ % % @& 2 o @4 ] »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. EPress & DracV.n
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Click “Sketch Path” button from the ribbon menu.

Cranked Beams.rfa - Elevation: Fr...

2| Type a keyword or phrase

& & 00 D) = = =5 i ] X | @ ) [ Loswars
0-3. o2 O 5}1 -I l ‘/\ o Set Show Viewer %M Skistch pith

Enters sketch mode, where you can use drawing tools to create
Select | Properties Clipboard Geometry Modify Measure | Create | Mode Work Plane or modify a 2D path for a sweep or a swept blend.
M| The path can be a closed h h
S — e e path can be a closed or open path, You cannot have
Cranked Beams rfa - Project Browser (@ [Properties =] multiple paths. The path can be a combination of straight lines
& 0! Views (all) and curves, and it need not be planar
& Floor Plans -
Ref. Level Press F1 for more help
& Ceiling Plans .
Ref. Level Family: Structural Fram v |12 it Tyoe
# 3D Views Constraints s Width_2 = 1240
& Elevations (Elevation 1) Host 3 %
Back | Structural * Width_1 = 580 Width_3 = 580
Front Structural Framii P’ § ¥ i’
Left Material for Mo..
Right Always export a... =/
Sheets (all) > ‘ ‘g i %
&1 Famili Adeathy ¢ )
® £l Famijes OmniClass Num... 23.25.3021.14 o m) I Ref. Level
# [ Groups 5 s £ g 0 =
% OmniClass Title | Trussed Beams a. = R L
= Revit Links . . i s "
Other = @
Work Plane-Based ! "
Always vertical ¥ g
Cut with Voids .. & -
Symbolic Repre... From Family A
Shared =
Show family pre... @
|Proverties helo Apply 1:20 O@ % s« &2 @4 ] »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. EPress &Dracn

draw a line that go through the intersecting points of the reference planes. Refer to the
image below.

Badligss =X 82200 @ 5 6
E_I @ | = rOCCN,
*3‘0105% ‘/\..‘ > 54 Set  Show Viewer
Clipboard _Geometry Modify Measure | Create | Mode Draw Work Plane
["|Radius 1000.0
TR ] T
& Floor Plans - '(.“"'
Ref. Level X
& Ceiling Plans 4
Ref. Level Sweep « | B Edit Type _o
© 3D Views Constraints * Width_2 = 1240 i
& Elevations (Elevation 1) Work Plane | Reference Plane o ¥ ‘
Back Graphics Width_1 = 580 Width_3 = 580 1
Front Visible — ¥ e i
Left Vi |
Right PR s e 5
Shests () Material | <By Category> | | =
# B Families 0 " o Ref. Level
# [l Groups £ oT 1} - =
< Revit Links = vt
- ©
% B
"
Trajectory Seg... |~ | g
Maximum Seg... |360.000° | -
& x o
Proverties helo Apply 1:0 O6 % xa&H 2 @4 ] »
INTERSECTION of [Reference Planes : Ry Plane] AND Y R X A ey ’,’u' a’m 70N Al

Y
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Finish the sketch mode and click “Edit Profile” button.

> == - §B - ®| Cranked Beams.rfa - Elevation: Fr..| » 7,pe o keyword or phrase U 5 I A 1 " 'W

B &= Dl B2 =

do | =2 X @ ﬁb (@ 2.9 sketch path % Profile:
+ O n 3 <By Sketch> i
B WG S Set  Show Vi d Select
9 O ﬁT 2 f BN ‘ R Sl profile "2 Edit Profile Y Load Profile
Select = Modify | Measure | Create § Mode | Work Plane | Sweell e 4it Profile =1
Modify | Sweep | | Yo Angle: 0.00° Modifies an element in sketch mode.
[Cranked Beams rfa - Project Browser & ties (= =d &
e ) Press 1 for more help ’
= Floor Plans i o
Ref. Level "
= Ceiling Plans — .
Ref, Level Other (1) w.| (8 Edit Type o
# 3D Views Profile *
& Elevations (Elevation 1) Profile
Back Horizontal Profi... 0.0 L Width_2 = 1240
Front Vertical Profile ... |0.0 P - -
Left Angl 0.000° |
it e e Width_1 = 580 Width_3 = 580
igl Profile Is Flipped ¥ ' ¢ x
B Sheets (all
# B Families
# [l Groups o @
@ Revit Links Sx—ay
. W Ref. Level "
£ (o] I 0
x | 0
g —E— |
* 3
o
f
a
3
(=]
A
|Prooerties helo Apply 1:20 0@ % x@&m2 o @4 ] »
Ready EPress & Drac¥a

Select “Left” elevation view for the profile.

PHG-S-D-2-F0A G 0 -

+ - S <By Sketch>
. + @ ¥
Select | Properties Clipboard Geometry Modify Measyre Create | Mode Work Plane Sweep
Modify | Sweep dit | Load profiles... X: 0 |¥o Angl Towmal
A ————=— Go To View e E,
|Cranked Beams.fa - Project Browser |8 ||Properties &) =Sk
=0 Views (all) In order to edit the sketch, please open one of the following 3
e views where the sketch will be parallel to the screen: @)
& Floor Plans < - =
Ref, Level Elevation: Right = =
& Ceiling Plans ol
Ref. Level T |
# 3D Views
& Elevations (Elevation 1) Profile Width_2 = 1240
Back Horizontal Profi.... 0.0 2 .
Front Vertical Profile ... {0.0 % <
H Width_3 = 580
Left Angle 0.000° e "
Right ' 1 T or one of the following views where the sketch will be seen at
Sheets @) Profile Is Flipped an angle to the screen:
# B Families 3D View: View 1 =
#  Groups =
«o Revit Links Ref. Level " =
0
« »
Prooerties helo Apply 1:20 O @ % % MH B + 74 m »
Ready _ - . [ZPress & Drac 7q
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Draw a profile for a c-channel in the view. align the top and bottom line segments to the

reference planes.

-@ le[ Dl/'""q'H' /o0&
i ] rOCON,
y BB O T aax S °54 &
Select | Properties Clipboard Geometry Modify Measure | Create | Mode Draw Work Plane
Modify | Sweep > Edit Profile | Multiple Alignmen Prefer: Wall centeriines v
Cranked Beams.rfa - Pno}eclsrwsef al Properﬂes (=] =08 A
= Views (all)
& Floor Plans = .
Ref. Level "
= Ceiling Plans :
Ref. Level |Sweepn | R Edit Type =
3D Views Constraints *
= Elevations (Elevation 1) Work Plane Reference Plane :...
Back | Graphics : l
Front vible [P ]
et Vit Graphi. | Ed ]
Right | Materials and Finishes 7]
Stieats (4l Material | <By Category> ||
# B Families e e
Identity Data
# [ Groups Subcatt N el
o Revit Links ubcategory one —— - _—_—n e - — — - —_—
Solid/Void Solid
Other *
Trajectory Seg... ™ U
Maximum Seg... |360.000°
Proverties helo | Apply 1:10 O % -« /& 2 « @« (] »
Create or length T

Byl bl - o=

[y [ X @ % . 2.3 sketch Path % Profle:
-
dify h O] Set  Show Viewer | | Select
¥ 12RO “ |l S proie
Select | Properties Clipboard Geometry Modify Measure | Create | Md Finish Edit Mode (QQ) Sweep
M R | e . - . Saves changes and exits the tool.
(Cranked Beams rfa - Project Browser (@ | [Properties [=] =05 A
= 5 Views (all) Press F1 for more help »
& Floor Plans = .
Ref. Level "
& Ceiling Plans L x -
Ref. Level Family: Structural Fram v | 2 £t Type
& 3D Views Constraints *
& Elevations (Elevation 1) Host
Back | Structural *
Front Stuctural Frami [ |
Left Material for Mo... | Other
L “‘9"; Always export a... &
£l Fa::ises( : ety Data :
OmniClass Num... 23.2530.21.14
S Coups OmniClass Title | Trussed Beams a. E]
= Revit Links i LA - e Z = P—
Work Plane-Based !
Always vertical ¥
Cut with Voids ... ©
Symbolic Repre... | From Family
S ]
Show family pre...
Proverties helo Apply 1110 O6 % @8> « @4 (] C
Click to select, TAB for altemates, CTRL adds, SHIFT unselects. Press & Drac V..
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Go to 3D view, then you can see the geometry of your cranked beam is there.

| o ale ‘ (bo \
Jeu- G E& g === [ [y
Clipboard Geometry Modify Measure | Create | Family Editor
(Cranked Beams.rfa - Project Browser '@ ||Properties (=] =08 A
= 0 Views (all)
= Floor Plans < i
Ref. Level | gt
& Ceiling Plans R -
Ref. Level Family: Structural Fram v | 1 3
# 3D Views Constraints s %
& Elevations (Elevation 1) Host =
Back Structural * 3
Front Stuctwral Fomi. [ |
Left Material for Mo... | Other
Right Always export a... &1
Shee.l.s (all) iy oo "
@ ] Families S
OmniClass Num... 23.253021.14
# i Groups OmniClass Title | Trussed Beams a. =
= Revit Links oo ‘
Work Plane-Based !
Always vertical @
Cut with Voids .. &
Symbolic Repre... From Family
Shared ]
Show family pre... @
Prooerties helo Apply 1:100 B & amH G e W« m »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. Press & Drac V.0

145 Test

Change the values to see if the parametric frameworks work as intended.

E] ) ) : ) C » . :
. o9 . vl i
. s X
Select | Properties | Clipboard Geometry Modify Measure C'NlE.Fﬂm“yfdilO'_

(Cranked Beams.rfa - Project Browser E“"Pfopeﬂ!es | =0R A
= 0] Views (all) &1 Family Typesl ™ ‘
& Floor Plans _ o=
Ref. Level 'l P
3 Name: M N
& Ceiling Plans
Family Types
Ref. Level |
Parameter [
# 3D Views New... %
& Elevations (Eleval e
Back Structural Mater cibaall
Front Delete
Left Width 3 500.0 r
Right Width 2 1200.0 = r &
B Sheets (all) Width 1 5800 r ot
%59 Familas Height 5000 - r L A
# [l Groups [ IE
Droy 764.0 - r | Modfy.. | E]|
= Revit Links P

[ ok ][ | ey || hep
i

Proverties helo Apply 1:100 & & L ] (888 E

Ready . T

Disclaimer: The process described in this tutorial is only to help the readers understand the concept of the topic and how
to use related functions. This tutorial does not offer the optimized way to implement a project in Revit.
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CHAPTER 15 - PRECAST HOLLOW CORE SLABS

In this section, you will learn

e How to create precast hollow core slabs structural families in Revit

<image from http://www.bison.co.uk/>

15.1  Template

First of all, we are going to create a basic geometry of the hollow core slab. Start a family editor

with “Metric Generic Model”.

Architecture &S

Projects Resources

e B X B yews
Preview

Name . DA
¥ Metric Entourage.rft 2 )
[ Metric Fire Alarm Device Hosted.rft 2 I
[ Metric Fire Alarm Device.rft A |
¥ Metric Furniture System.rft A [
[ Metric Furniture.cft 2

I8 Metric Generic Model Adaptive.rft AE

[ Metric Generic Model ceiling based.rft A

[ Metric Generic Model face based.rft A

[ Metric Generic Model floor based.rft 2
[ Metric Generic Model line based.rft A
¥ Metric Generic Model Pattern Based.rft 2
[ Metric Generic Model roof based.rft e

3 3 | Type: Revit Family Template
I Metric Generic Model wall based.rft Jpe v Aty Jenpe

- b 1 Size: 200 KB
2 Metric Generic Model.rft Date modified: 2012-01-21 97 4:41 | «

« ]

File name: Metric Generic Model.rft
Files of type: |Family Template Files (*.rft)

Autodesk®

cranked beam T
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15.2  Reference planes

Once the family editor begins, add reference planes as the image below shows. - Go to

“Create” tab and click “Reference Plane” button.

[= .;r? RSSO A B ,-- Hollow Core Slab.fa - Floor Planz..{» | 7pe o keyword or phvose M S 7 L signin X ] el RS

(= A Model Text @ Pipe Connector g} Show
(7] 1%, Reference Line
@3 Cable Tray Connector [ER Viewer
Extrusion Blend Revolve Sweep Swept Void _| Model Camponem Control | Electrical  Duct ‘ 7 Reference Plane | Set Load into
Blend Forms | Line [ Model Group ~ Connector Connector ™ Conduit Connector | Project
Select | Properties Forms ‘ Model ‘ Control Connectors Datum Work Plane | Family Editor
Hollow Core Slab.fa - Project Brows.. |||Properties =] bdid =
= 5. Views (al) i
& Floor Plans & | -
Ref. Level | n
= Ceiling Plans — | o
Ref. Level Family: Generic Models v [ it Type : e
3D Views Constraints M RS e s S Foes=ns
View 1 Host el SEE i ==
& Elevations (Elevation 1) | : 2 | |
Back Part Type Normal | |
Front Structural A | |
I:;:h Can host rebar & | | |
b i .
Identity Data
& Sheets (al) ‘ ! [
OmniClass Num...
# B Families = ~ + 1 | ‘E
OmniClass Title | s e e R | — —
# [ Groups H = | |
= Revit Links Other i
Work Plane-Bas... I | |
Always vertical ¥ | |
Cut with Voids .. & | |
Shared =) | |
|
|
|
|
|
|
|
|
Properties helo Apply 1:20 O@ % @2 o 74 [mi] »
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. IPress & Drac V.

Then mirror the upper 2 reference planes to the other side.

| ia aje
b | 5 S © E&-Db - = [
MOd“Y .% @Jom "R O ﬁT f " | Load into
P 3 o Projet
Select | Properties Clnpboard Geometry Modify Measure | Create | Datum Selection Family Editor
Modify | Reference Planes V| Copy
Hollow Core Slabsfa - Project Brows. [ ||Properties [a] T
= [0 Views (all) 5
& Floor Plans 4 | @
Ref. Level I L
& Ceiling Plans ; I i
Ref. Level Family: Generic Models v [ it Type :
= 3D Views Constraints . e e SEas = Sats s b= ==
View 1 Host e --—--
& Elevations (Elevation 1) 5 : * | |
Back Part Type Normal | |
Front Structural 2 | 1
:""h Can host rebar | |
ight 2
Identity
© Sheets () yDete | |
2 OmniClass Num...
© B Families : i ! =
OmniClassTile | Il === e e mmiemmmiem e e o e (S [
# [ Groups —— g |
= Revit Links Other ; |
Work Plane-Bas... &/ Reference Planes : Reference Plane : Center (Front/Back) :
Always vertical @ | Reference
-
Cut with Voids .. & | |
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! |
e O
= N | R
|
|
|
Proverties helo Apply 1:0 D@ % a8 ® o @4 (] »
Planes : Ref Plane : Center (F; k) : Ref T
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Go to "Left” view, add a reference plane on either side of the horizontal center reference plane.

2 Type a keyword or phrase

pry &&ww-« | | I3

Goin ~ & . O ﬁT f ﬂ Propagate | Load into
3‘ Q = H o Extents |  Project |
Geometry Modify Measure | Create | Datum | Family Editor
Modify | Reference Planes
Hollow Core Slab.rfa - Project Brows..[ @ ||Properties 3] P | fi 1 TR
5 0! Views (all) | S
& Floor Plans 2 kit | ki .
Ref. Level o 1 ) Y
& Ceiling Plans i | |
% , —
Ref. Level | Reference Planes (1) £ Edit Type i o | |
& 3D Views Construction i el | i
View 1 Wall Closure |
& Elevations (Elevation 1) Identity Data * L | Il
Back Name 1l TR »
Front Extents : 2 o4 | i
;":' Scope Box None ([ | | |
ight : 2 |
Other I (I
B Sheet.s (all) Is Reference Weak Reference |
© B Families e H Il ki =
& 8 Groups M ) ik Al ) I |
= Revit Links i ! i
(I | ! (N |
B ] | O e e - - -
&1 |
R T e = = = = |l ]
Lo : It
1=l | Y |
|
-
Proverties helo Apply 1:20 OO0 % - ;& ¥ o 74 (] »
ference Planes : Reference Plan, ElPress & Drac¥1

Then mirror the added reference plane to the other side of the horizontal center reference plane.

| e dle =-
(BT X s Dl‘/ln iu @ o @
Modify II % @Jum %~ ..i¢ o O =?-?ﬁT - f M ie| Loadinto
— a° L Project
Select | Properties Clipboard Geometry Modify Measure | Create |  Datum Family Editor
Modify | Reference Planes V| Copy
Hollow Core Slabsfa - Project Brows...s ||Properties 5] i | 14 —@% ~
5 0! Views (all) | 4
& Floor Plans 2l kol | Il ==
Ref. Level ko § [N "
& Ceiling Plans ) | |
—_— &
Ref, Level Family: Generic Models | (7 £/t Type i | [
3D Views Constraints il | it
View 1 Host |
& Elevations (Elevation 1) | Mechanical - * L i Il
B Pt e o N
Front Structural ) | | | | |
:"; Can host rebar & W o I [
ight : 2 |
 Sheets al) ety Deta bl 5%
OmniClass Num... |
# B Families > el | | I (| E]
OmniClass Title |
# ol Groups e Il Il
= Revit Links Other il I |
Work Plane-Bas... ©/ |
Always vertical @ R | |
Cut with Voids .. & i e S e e S e i
Shared =] S e —| = = e ]
S=CH=Saes e = Select the axis of reflection.] — — — — — — [F=—=—"= ==
| | IS8
|
Proverties helo Apply 1:20 O& % - &2 o W4 [m1] »
Select the axis of refl o
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15.3  Parametric Dimension

In the “Left” elevation view, add dimensions as the image below shows.

| SHG K- -0 3 - O Z= e~ ¥ Hollow Core Slab.rfa = Elevation: 2 » 7ype o keyword or phrase 48 Q8 7 L signin b WL F=ates x|
Modify o
i = W ( | gnoale T —
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SES v et eSO 8RS
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Select | Properties Clipboard ‘ Geometry Modify | Measure | Create | Family Editor
Follow Core Sl - Project Brows ] [Fopertes & 1 : - —anfs
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Ref. Level (il ! I =
& Ceiling Plans (1 | el o
Re. Love [Fomil: Genric Modes = % ¢ 110 : —
= 3D Views Constraints G I | .
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= Elevations (Elevation 1) | : & F— L —+
Back Part Type Normal I l ]
Front Structural A (I L Il
Eait Can host rebar ) 1314 | 1314
Right e : [ , L
I :hee,:,’ alh OmniClass Num... I Ll | I
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# [l Groups e R B Jg Ll I I
= Revit Links ey SEASS e g e e e e e
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1145 | J'ﬂ_.’il
Proverties helo Apply 1:0 OF % s e o 74 (m R
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. Press & Drac¥n
Go to "Family Types” window and add a parameter called "Width". set the options to
"Common”, “Length”, "Dimensions”, and “Instance”.
ZH G- 50 e AL O B LEk == HollowGore SiabiialEievationt ] 1 o reyword or phrose MO S A Dsonin - X ] lealChmes

/|1 - “%- o8 O3 &

— R | b 1
I Family Types | Wieasure | Create | Famiy Eda7
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Family Types L | Lo =025
ope [ : Lo aQ
I
Parameter Type I | I 2
@ Family parameter [ : | e
(Cannot appear in schedules or tags) [ 1
® e pranats (I ; Lo
(Can be shared by multple projects and familis, exported to ODBC, and L. i 2628 g
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|
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145 | 14ﬂ
Properties helo Apply 1:20 OB % o« M & 2 « 8 ¢ (e »
Readv Fn
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With the same settings, add “Depth”, “Core_Radius”, and “Core_Offset".

| Measure | Create VFaﬁ"t‘ﬂ’y‘ Editor
l Family Types i | y —ou -
i Parameter Value Formula Lock : : i : : Cm
Width @efoul) 00 |- r Rename... | (! : Lo "
Depth (defaul) 00 C | Doete | I ! I A
Core_Radius (defaul 0.0 i [ ! Il
Core_Offset (defaul 0.0 = i | 1l
Parameters
- = L
1 ' I
L ! o
[ Remoe | o — : it o
b1 _é. Ly
| | r
| ! ®
I o
Lo : Lo
B o i = e = S o e i e = =
_§ SHEERCE= = = = +— — e
f s s o St 2 Lo s s = e = =
Lo ‘ I
I
145, | 145
ok || coel || ey [ b |
-
Proverties helo | Apply 16200 D@ % =B ® ¢ @4 (] »
Ready B o R B o . _ S _ B _ Vq
. . M n n . M
Go back to the view, and turn the two sets of dimensions to “EQ" dimension.
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l‘odhﬂ' (=]
{ = * 1 | cia afe —
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ST REE e —T B
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= 9 Views (al) Il I v
& Floor Plans d [ | [+ 3 ;‘(.‘”'
Ref. Level il ! [ b
& Ceiling Plans i ! [ | e
P —e
Ref. Level Family: Generic Models 1% it Type |
5 3D Views Constraints & L | 174
View 1 Host I %) A
= Elevations (Elevation 1) |Mechanical z i ! [
Back Part Type g ' |1
Front ey 2 z 2628 !
a4 T
:":' Can host rebar & | il | £.3
soht i y
B Sheets a0) wOmniCﬁNum il : e
% B Families e f fi EQ ! Ea [ =
OmniClass Title
# Il Groups sedeboransid g [l I ]
< Revit Links Ottey I
Work Plane-Bas.. ©I Ig 4 ER:
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Cut with Voids .. £ g g gl T g Ref, Level
I R D v | SR 1. R T
Shared B B i o= o o malle s ey o I A QD
|
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|
45| | 145
Proverties helo | Apply 1:20 D@ % = ;&2 74 [m] b
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. APress & Drac V-
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Associate "Core_Offset”, "Depth” and "Width"” parameters to the dimensions as below.

EH G- KR 220 =9

T KA
O ew-v BR&EMNE =

88 B «

il
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d I
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Set the value of “Width" to “1200", “Depth’s” to

Select | Properties |

Clipboard | Geometry

| Measure

Create

“150", and “Core_Offset's” to

“100".
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Go to the floor plan view and add a dimension between the vertical center and the paralleling

reference plane. Label the dimension with a new parameter called “Length”. The group needs to be

“"Constraints”.
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154 Solid Geometry

Now we are going to create a solid geometry for the family. Go to “Left” elevation view and

click

“Extrusion” button.
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Place a rectangle within the reference planes.
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Go to the top view and align and constrain the two faces of the extrusion to each reference plane.
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15.5 Void Geometry

Now we need to add void extrusion to the solid extrusion. Go to “Create” tab and click “Void

Extrusion” button.
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Place a Circle on the right side of the extrusion.
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check the “Center Mark Visible” option to align the circle to the reference planes.
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Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

Turn the temporary radius dimension into permanent and label it with “Core_Radius” parameter.
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Finish the sketch mode and go to 3D view. Align and constrain the starting face of the void extrusion

to that of the solid extrusion.
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Select the void and associate its “Extrusion End” parameter to “Length” family parameter.
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Before moving on, open “Family Type” and change the “Length” value to test the constraint.
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Go to the "Ref. Level” view click ‘Model line” under “Create” tab.
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From “Subcategory”, select “<Invisible lines>".
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Add an invisible line around the void extrusion.
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Align the invisible line to the reference plane that go through the center of the void extrusion.
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Select the invisible line and the void extrusion and click “Group” button under “Modify” tab.
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Type in "Hollow Core” for the name.
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Select the group, then it should look like the one in the image below.
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Align and constrain the invisible line in the group to the reference plane.
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Set the “Move to” to “Last” from the option bar and click then standard point and target point for

the array. At this point, you don't need to change the number of the array.
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Once array is done, align and constrain the arrayed group to the reference plane.

refer to the image below.
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Now select the two group to make the number annotation visible.
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Type in “Number of Core” for the name of the parameter.
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Open “Family Types” window and change the values to test your parametric frameworks.
note that in this kind of complicated processes, constraints can be lost. make sure this works

properly. Otherwise, identify where constraints are lost and fix the problem.
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Open the “Family Types” window and click add a parameter called “Material”. Set the options to

“Common”, “Material”, “Materials and Finishes”, and “Type".
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From the Autodesk Materials, find “Concrete, Precast” and add the material to the document.
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Go to the 3D view and select the extrusion. From its properties, relate “Material” property to

"Material” parameter. save your geometry.
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159 Nesting

Now you can load what you have done into a project. Or you can nest it into another family to

make it work like other structural elements. Start another family editor with “Metric Structural

Framing — Beams and Braces”. You also can use “Metric Structural Framing = Complex and Trusses’

based on your project requirements.
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You can see that there are preset geometric objects, an extrusion and a line.

Type a keyword or phrase M SR S X e el S
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Select the geometric objects and erase them.
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Switch back to the generic mass model and load it into the new family editor.
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Place it along the horizontal center reference plane. align the center of the imported mass

to that of the horizontal center.
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Align the left side the second left reference plane - where the preset extrusion solid was aligned.
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Select the geometric object, then arrow heads will apper on the four sides.
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Drag the arrow head on the right side and algin it to the second right reference line.
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add "Width", "Depth”, “Core_Radius”, and “Core_Offset". set the options to “Common”,

“Length”, "Dimensions”, and "Type".
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Lastly, add “Number of Cores” parameter” with “Common”, “Integer”,

"Other”, and "Type”.
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amily1 - Project Browser o] ]
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View 1 Length Depth 1500 =
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Set the value of parameters as the below image shows.
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Then go back to the view and select the loaded mass. From its properties, associate "Width", “Depth”,

"Core_Radius”, "Core_Offset”, and "Number of Cores” to the family parameters.
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open "Family Types” window and change the values to test the parametric frameworks. You

can try to add types by using catalogue. Save the family with the name of “Hollow Core

Slab_Nested.rfa".
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15.10 Load into Project

Start a new project with “Structural Template”.
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Switch back to the family and load it into the project to draw a family instance in the project.
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Select the added object and try to adjust the value of the family parameters.

Hollow Core_Loaded.rvt = 3D Vie...| » | 7ype o keyword o phrase 4
Modify | Structural Framing

re | Create | Mode VAnalytkaI‘ Work Plane | Placement | Reinforcement |
=08 -
@
Width <
Depth 150.0 %
Core_Radius I 550 —3
Core_Offset 250.0
= =
Number of Cores 6
<< Preview ‘I} Cancel | Apply
|Prouem‘esheln Apply 1:10 B & % . G R H GV 9 B« e »
Read & ~ SO N\ Model FPress & Drac V1

Disclaimer: The process described in this tutorial is only to help the readers understand the concept of the topic and how

to use related functions. This tutorial does not offer the optimized way to implement a project in Revit.
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CHAPTER 16 - STRUCTURAL ANALYSIS IN REVIT

In actual project settings, Revit is used for model development, coordination and documentation.
Developed models can then be used for structural analysis. The two most common solutions are
“Robot Structural Analysis Professional” (RSA) and cloud based “Revit Structural Analysis Toolkit”. In
this section, you will learn

e How to prepare structural (analytical) model for analysis.

e Options in structural modelling for analysis.

e  Structural analysis using RSA.

e How to view analysis result in Revit.

e The 2-way linkage between Revit and common structural analysis program such as ETABS.

16.1  Structural Analytical Model in Revit

A Structural Analytical Model comprised of a set of structural member analytical models. The
following structural elements have structural member analytical models: Structural Columns,
Structural Framing elements (such as beams and braces), Structural Floors, Structural Walls, and
Structural Foundation elements.

Analytical model is created automatically when you create the physical model and can be exported
to analysis and design applications.

3D View: Physical Model - 3D Reinforcement (Compl... Elﬁ 3D View: Analytical Model - 3D Reinforcement (Com... E@

~

~

1
1
1 = 1 =
P @ e Qﬁ :

v v

1:100 B XGEHEB2 o i E 1:100 FFx XGRHEED o H &<

16.1.1 Structural Member Analytical Models

Structural member analytical models are represented by lines joining their analytical nodes. Apart
from analytical properties, they are characterized by their local axes. The following figures depicted
how the member analytical models’ local axes are defined.
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X
Analytical , Local
Column
axes .
Ty Analytical
node
Base e I Analytical Beam
(Green) J(A Analytical
Analytical node node

Analytical Floor / Foundation Slab
Analytical Top ‘ — Top
Wall
“

Localy y ' Local axes
axes
y
z Bottom — Analytical
Bottom The direction of x-axis depends on node
how the floor is drawn and the span
Analytical node direction taken.

The analytical model of any one structural element has:

e Instance parameters

e Physical material properties

e Default position relative to the structural member itself

e Location with respect to a projection plane, either as placed or as adjusted

The properties of an analytical beam are listed below as an example. You can go to Autodesk
Knowledge Network for more details of other structural member analytical models.
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Properties

|Analy‘h'ca| Beams (1
Analytical Model

Code Checking
 Analytical Links
Analytical Propert...

Family Type

Physical Materia...
- Length B

Cross-Section R...
Analytical Alignm...

Start Alignment...
. Starty Projection-
. Start z Projection !

End Alignment ... !
. End y Projection

End z Projection
Releases / Memb...
Properties helo

) = | £# Edit Type

LHIPN

(source: Autodesk Knowledge Network)

| Analytical Beams (1) S edit Type |dgnmyData*
Releases / Memb... a: ~ Member Number 0
e — _StartRelease  |User Defined | Comments
: * _ Start Fx Phasing 2
Concrete-Recta... Start Fy t Phase Created  New Constructi.. |
[Concrete(1) StatFz | o Phase Demolish... None
T ra— Start Mx _D : i
10.000°  Start My e v
....................................... | Statmz & Properties helo Apply
Auto-Detect End Release Pinned
Location Line | EndPx =
Bottom of Ele... End Fy
Aot Detect B T
{Location Line End Mx i
-E_!_p_tt_p!'rl_c_a_f_E!_e._._._ “ TV Ca—
- v “End Mz
Apply Member Forces | Edit...

https://knowledge.autodesk.com/support/revit-products/learn-

explore/caas/CloudHelp/cloudhelp/2017/ENU/Revit-Model/files/GUID-0AF3EAB9-D369-4C07-BAAD-

CB1EE2DEC7B2-htm.html

Name

Description

Analytical Model

Analyze as

Used by external analysis applications to determine whether beam conditions contribute

to lateral analysis.

IAnaIyticaI Links

'Either Yes, No, or From Column. A frame element that can be set to fully rigid or

released in global directions. When Analytical Links are enabled, an additional analytical
segment is engaged in the model between the end of the analytical model of a beam
and the analytical model of a column. From Column defines the analytical link of the

beam to that of its connected column.

See Analytical Link.

Approximate Curve IAppIies to curved beams only. Select to create segment based on both the values for

Maximum discretized offset and Use hard-points. See Segmented Analytical Model

Parameters.

Maximum discretized Applies to curved beams only. Limits the distance between a smooth curve and a line

offset

segment when the Approximate curve parameter is selected. See Segmented Analytical

Model Parameters.
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Name Description
Use hard-points Applies to curved beams only. Forces the segmented analytical model to have nodal

points at the ends of the members attached to the curved beam when the Approximate
curve parameter is selected. See Segmented Analytical Model Parameters.

Analytical Properties

'Family Type The family type of the element.

'Physical Material ‘The name of a physical asset assigned to the beam material (read-only). '

Asset

'Length “The length of the analytical model. '

Cross-Section IDispIays the cross-section rotation of analytical members. The angle of rotation is '

Rotation measured from the work plane of the member and the direction of the center reference
plane.

'Analytical Alignment

'Start Alignment Either Auto-detect or Projection. Specifies if the horizontal and vertical references of the

Method beam start position are automatically justified or have a defined projection.

Start y Projection Either Location Line, Left of Element, Center of Element, Right of Element, <Grids...>, or
<Reference Planes...>. Available when Start Alignment Method is specified as
Projection.

Specifies the horizontal location of the analytical model at the start of the beam.

'Start z Projection IEither Location Line, Top of Element, Center of Element, Bottom of Element, <Level...>,
<Reference Level...>, or <Reference Planes...>. Available when Start Alignment Method
is specified as Projection.

Specifies the vertical location of the analytical model at the start of the beam.

End Alignment Either Auto-detect or Projection. Specifies if the horizontal and vertical references
Method of the beam end position are automatically justified or have a defined projection.
‘End y Projection Either Location Line, Left of Element, Center of Element, Right of Element, <Grids...>, or

<Reference Planes...>. Available when End Alignment Method is specified as Projection.
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Name Description

Specifies the horizontal location of the analytical model at the end of the beam.

'End z Projection IEither Location Line, Top of Element, Center of Element, Bottom of Element, <Level...>,
<Reference Level...>, or <Reference Planes...>. Available when End Alignment Method
is specified as Projection.

Specifies the vertical location of the analytical model at the end of the beam.

Structural Analysis

(See About the Structural Analytical Model.)

'Start Release Specifies the end release condition: either Fixed, Pinned, Bending Moment or User
Defined. User Defined allows you to enable/disable each of the end release conditions.

‘Start Fx ‘The translational release at the start end of the brace along the local x-axis. When
selected the degree of freedom is released and the force is not available.

Start Fy ‘The translational release at the start end of the brace along the local y-axis. When
selected the degree of freedom is released and the force is not available.

Start Fz The translational release at the start end of the brace along the local z-axis. When
selected the degree of freedom is released and the force is not available.

Start Mx The rotational release at the start end of the brace along the local x-axis. When selected
the degree of freedom is released and the moment is not available.

Start My ‘The rotational release at the start end of the brace along the local y-axis. When selected '
the degree of freedom is released and the moment is not available.

Start Mz ‘The rotational release at the start end of the brace along the local z-axis. When selected '
the degree of freedom is released and the moment is not available.

'End Release ISpecifies the end release condition: either Fixed, Pinned, Bending Moment or User
Defined. User Defined allows you to enable/disable each of the end release conditions.

'End Fx IThe translational release at the end of the brace along the local x-axis. When selected
the degree of freedom is released and the force is not available.

'End Fy IThe translational release at the end of the brace along the local y-axis. When selected
the degree of freedom is released and the force is not available.

IEnd Fz IThe translational release at the end of the brace along the local z-axis. When selected
the degree of freedom is released and the force is not available.

End Mx The rotational release at the end of the brace along the local x-axis. When selected the
degree of freedom is released and the moment is not available.
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Name Description

End My The rotational release at the end of the brace along the local y-axis. When selected the
degree of freedom is released and the moment is not available.

'End Mz IThe rotational release at the end of the brace along the local z-axis. When selected the

degree of freedom is released and the moment is not available.

Member Forces Specifies the internal forces at the start and end of the analytical beams and braces.
This data communicates load information for both documentation and connection

fabrication. Click Edit to enter user-defined force and moment values.

'Identity Data

Member Number An identifier created for the analytical member. This value should be unique across
Analytical Beams, Analytical Braces and Analytical Columns in a project. Revit warns
you if the number is already used but allows you to continue using it. You can see the
warning using the Review Warnings tool. See Review Warning Messages.

Comments User comments.

Phasing

'Phase Created Indicates in which phase the beam was created. See Project Phasing.

'Phase Demolished  Indicates in which phase the beam was demolished. See Project Phasing.
16.1.2 Analytical Links

When a beam is not directly support at the centre of a column, an analytical link is needed to
correctly model the effect of such eccentricity for structural analysis. Note that an analytical beam
starts and ends where you picked the physical beam.

Usually you will pick the centre of the supporting columns and the analytical beam will follow.

o

1 ‘Not linked +~_\ Not linked
\
T = = - —+ @ |!

V| — : 5 . = — = = - |

When the beam is not supported directly at the centre of the columns, there is no analytical links
provided. This is because, by default, beams’ analytical links are from columns, but analytical links
are not enabled in analytical columns.
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Analytical Columns (1) v BBt Type | Analytical Beams (1) v | B8 Edit Type
Analytical Model 8 A Analytical Model 2 A
Analyze As Gravity Analyze As Gravity
Code Checking Code Checking
Analytical Links ] Analytical Links  From Column

If you want Revit to provide analytical links for the beam at its ends, you should set the analytical
links option to “Yes” for the analytical beam.

Analytical Beams (1) v Edit Type

Analytical Model = IS Analytical Link provided Analytical Link provided
Analyze As Gravity L .
Code Checking s K_ B - = e : . == = - - A x
Analytical Links  Yes ) : ) :

However, if you only want Revit to provide analytical link at one end of the beam, you should set the
analytical links option to “From Column” for the analytical beam and enable the analytical link
option in that supporting analytical column.

16.1.3 Member End Releases

There are 6 degrees of freedom (DOF) in each node of a member analytical model. These degrees of
freedom are called “Releases” in Revit. You can set the releases as predefined options (Fixed /
Pinned / Bending Moment) or “User Defined” that you can release any of the DOF. A check in the
DOF, Base My for example, releases the rotation degree of freedom about (local) member y-axis and
there will be no moment My.

Properties X Properties X Properties X

Analytical Columns (1) v HaEdil Type  Analytical Columns (1)~ | B2 Edil Type  Analytical Columns (1)~ | B2 Edit Type

Base x Projecti... éBase Level Refe...

‘A Base x Projecti... gBase Level Refe... Base x Projecti... %Base Level Refe.

Releases / Member Forces A Releases / Member Forces # Releases / Member Forces

Base Release  Fixed Base Release  {Pinned Base Release  Bending Mom
Base Fx Base Fx Base Fx

Base Fy Base Fy Base Fy

Base Fz Base Fz Base Fz

Base Mx Base Mx Base Mx

Base My Base My Base My

Base Mz Base Mz Base Mz

Note that you should check and set the member releases to ensure it is analytically correct for
structural analysis. For example, Revit does not automatically set the member releases at cantilever
end to “Free” (i.e. all 6 DOFs released)!

16.1.4 Boundary Conditions

You must impose/add Boundary Conditions to support your structure or it will be unstable for
analysis. Boundary conditions are usually added at the base of columns and walls.

Page |9



Construction

Industry Council

Building Information Modelling (BIM) Advanced Modelling Course

(Structure) — Revit 2018

Notes:

e “Fixed” boundary condition is automatically set for Isolated Foundation. You do not need
to add a boundary condition to it.
e For Foundation Slabs, you will need to add boundary conditions or it will be free to move.

To add boundary conditions,

1 Click Analyze tab » Analytical Model panel » Boundary Conditions.

2 Select “Point” / “Line” / “Area” Boundary Conditions.

3 Click at the base of a column / wall / foundation slab to place the Point / Line / Area boundary

conditions.
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Modify [ 1 Paste Fot - = & 5 8] =
Bl ™ 5 0u e #BOTaax
Select ¥ Properties  Clipboard Geometry Mod\fy View  Measure
Madify B State:  Fixed ~
Properties x

Boundary Conditions - 3D View: Analy...

R Y T

Add-Ins  Madify | Place Boundary Conditions =~

@
&
[

Create  Boundary Conditions

New Boundary Conditic ~ =

Structural Analysis #

Orentto
Boundary Condi...Point
State Fixed
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Properties help Apply
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State Fixed Analytical Model
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Select * Properties  Clipboard Geometry Modify View  Measure  Create Boundary Conditions

Madify | Place Bour on State:  Pinned v

Properties X

New Boundary Conditic ~ 1 Fdit Type

Structural Analysis #

Orient to

Boundary Condi...Area

State Pinned “%}

Trenslaonin  *

X Translation  [Fixed

¥ Translation |Fixed

Z Translation  |Fixed
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Level 1
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Level 2
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= 3D Views
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Pick Analytical Floor or Wall to create area boundary conditior 5§ Fa) B Main Model
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The number of DOFs is different for Point, Line and Area boundary conditions. For Point boundary
conditions, all 6 DOFs can be set. Each DOF has three options: Fixed / Release / Spring (with user

input spring modulus value).

Properties X Properties X  Properties x
g R Yy R ‘D“

R Point - Line 7 Area N
|New Boundary Conditic Edit Type |New Boundary Conditic Edit Type |New Boundary Conditic ~ |% Edit Type
Structural Analysis *  Structural Analysis *  Structural Analysis A

Orient to Project Orient to Project Orient to Project
Boundary Condi...:Point Boundary Condi... Line Boundary Condi.../Area
State User State Fixed State Pinned
Mranslationin :“ Translation in Translation in A
: X Translation Fixed ! X Translation Fixed X Translation Fixed
: Y Translation Release 1 Y Translation Fixed Y Translation Fixed
1 Z Translation Spring 1 7 Translation Fixed Z Translation Fixed
: Z Spring Modulus 1.00 kN/m ! Rotation about *
IRotation about I* X Rotation Fixed
: X Rotation Fixed :
: Y Rotation Fixed 1
: 7 Rotation Fixed 1
e
Properties help Apply Properties help Apply Properties help Apply
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Click to select, TAB for alternates, CTRL adds, SHIFT unselects.

16.1.5 Load Cases

) B Main Model

Open from the course folder the “Structural Analysis Building.rvt” file.

To set Load Cases, click Analyze tab > Analytical Model panel > Load Cases

0P 5 O M O P

ReBG-S-7-8 =2-20A G- % & M- 7 Studual Anolysis Buiding - 30 View:.. # [Tpeakemoorprrae |@ 85 ¢y & Signin W @ - &@x
Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage Add-Ins  Modify | Place Loads @~
it ) I i i 5 ieH
1 : | Structural Settings x
1
1L Cases Cy | Symbolic Representation Settings Load Cases Load Combinations Analytical Model Settings Boundary Conditions Settings
Select * Analytical Model Structural Analysis
) Load Cases
Pr‘n gz e MName Case Number Nature Category A Add _ e — =
e ~ Project Browsar - aly...
G 1 Dead Dead Loads Delete o 2 —Iy
— 2 |w 2 Live Live Loads - ‘;‘ ‘:“’;‘“”]‘ o
int Loads re| . tructural ns
Point Load 1 3 |WIND1 3 Wind Wind Loads Foundation
4 [SNOW1 4 Snow Snow Loads Level 1
New Point Loads ~ B Edit Type 5 (LR ° Roof Live Roof Live Loads Level 1 - Analytical
Sl S 2 A 6 |Acct 6 Accidental Accidental Loads Level 2
Load Case CIRIE] 7 |rEmp 7 Temperature Temperature Loads. Level 2 - Analytical
Nature Dead 8 [sEist 8 Seismic Seismic Loads Level 3
Orient to Project < ROOF
Forces i Sfle
Fx 000 kN Load Bures 3D Views
y 600 KN Name ~ Add Analytical Model
Fz -1.00 kN 1 |Dead o (3_D] . )
i o = Elevations (Building Elevatior
Moments 2 |Live East
=i as
Mx 0.00 kN-m 3 |Wind North
My 0.00 kN-m 4 [Snow South
Mz 0.00 kN-m 5 [Roof Live et
Identity Data 4 6 |Accidental ) Legends
Description 7 |Temperature [ Schedules/Quantities (all)
Comments 8 [Seismic Sheets (all)
Other : ¥ & ] Families
s Reaction O & [@] Groups
s v | @8 Revit Links
Properties help Apply 1.8 Cancel Help > e N
Ready Gl T O Vi Model FEDRLOFTo

There are 8 load cases automatically set in Revit if you use its Structural Template. Some load cases
are not commonly used in Hong Kong and you can select and delete them. For example, SNOW1,
LR1, ACC1, TEMP1 and SEIS1 can be deleted.
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Structural Settings X

Symbolic Representation Settings Load Cases Load Combinations Analytical Model Settings Boundary Conditions Settings

Load Cases
Name Case Number Nature Category ~ Duplicate
1 |DU1 1 Dead Dead Loads Delete
2 L 2 Live Live Loads

Wind Wind Loads

You can add a load case by duplicating an existing one and rename it. Usually you will need more
than one wind case. Add WIND-Y by duplicating WIND1. Also rename WIND1 to WIND-X.

Structural Settings X

Symbolic Representation Settings Load Cases |oad Combinations Analytical Model Settings Boundary Conditions Settings

Load Cases
Name Case Number Nature Category R Duplicate
1 |DL1 1 Dead Dead Loads Delete
2 L 2 Live Live Loads
3 |WIND-X 3 Wind Wind Loads
4 |WIND-Y 4 Wind Wind Loads

With all the load cases created, you can next set the load combinations for your structural analysis.

16.1.6 Load Combinations
Continue with the “Structural Analysis Building.rvt” model and set Load Combinations.

Click Analyze tab » Analytical Model panel > Load Combinations
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To add a load combination,

1 Click Add.

2 Click Add in Edit_Selected Formula to add load cases for the load combination.

3 Change the Factor and Load Case as necessary.

Structural Settings

Symbolic Representation Settings Load Cases Load Combinations Analytical Model Settings Boundary Conditions Settings

Load Combination

Name Formula ‘ Type ‘ State ‘ Usag ™ ‘ Add L‘_ _1
1 New Combination 1 1*DL1 + 1*LL1 Combination Serviceability
v
< >
[ ]show third-party generated load combinations
p———
Edit Selected Formula 1 2 : Load Combination Usage
t
Factor | Case or Combination | ‘ Add w L -1 Set Name ~ Check All
1(1.000000 DL1 Check None
2(1.000000 |LL1 r=—- ~
T T
3,
[ Mg
Delete
v v
| oK | ‘ Cancel ‘ | Help |

Add another load combination with formula 1.4*DL1 + 1.6*LL1 and set the State to “Ultimate”. Then

rename this load combination to “ULS1” and the first load combination to “SLS1”.
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Structural Settings

Symbolic Representation Settings Load Cases Load Combinations Analytical Model Settings Boundary Conditions Settings

Load Combination

["]show third-party generated load

Edit Selected Formula

combinations

Load Combination Usage

~

Name Formula | Type | State | Usag ~ ‘ Add ‘
I (all BED e BED
W1 [stst 1 1#*DL1 + 1*LL1 Combination SEnr_ice_ab_ilit_y
112 [ULS1 : 14*DL1 + 1.6*LL1 Combination: Ultimate 1
| S S LR p——— -

W

Check All

Check None

Delete

Factor | Case or Combination | # ‘ Add ‘ Set Name
I -
\ 1(1.400000 DL1 1
1(2[1.600000 |LL1 v !
I S s —
v
oK

Next you can apply loads to the structure.

16.1.7 Applying Loads

Continue with the “Structural Analysis Building.rvt” model and apply loads to the structure.

Click Analyze tab » Analytical Model panel > Loads

There are Point Load / Line Load / Area Load / Hosted Point Load / Hosted Line Load / Hosted Area
Load that you can apply to the structure. Hosted loads require structural elements to host them
while other loads can be applied at anywhere.

|

Point
Load

¢ T | 4 B

Line Area Hosted Hosted  Hosted
Load Load Point Load Line Load Area Load
Loads
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Now apply the following loads to the structure (“Structural Analysis Building.rvt”).

1 Go to Analytical Model view then click Analyze tab > Analytical Model panel > Loads > Hosted
Area Load.

2 First, apply some Hosted Area Load as Dead Load to the structure. Set the Load Case to DL1 (1)
and enter -2.00 kN/m2 for Force Fz 1 (other forces set to zero value). (Note that positive z-
direction is upward. Therefore, gravity load should be input as negative value.)

3 Hover over to the roof floor and add the hosted area load. Add this load to the other floors.

REEHG- Q-7 -Ql=-FOA @25 G~ SuctualAnlsiBuiding-30 View .. »[oearowodopmoe |48 & ¥ L Signin W ®- - & X

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View Manage  Add-Ins  Modify | Place Loads @~

v Cope ~ | e oo - —
b Koe 00 BafePihgeet oo o L8 & o8
Modify [ [W] Glot- %8 5 oo BE e /= ' Point| Line | Area Hosted = Hosted | Hosted
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5 Next apply some Hosted Area Load as Live Load to the structure. Set the Load Case to LL1 (2) and
enter -5.00 kN/m? for Force Fz 1 (other forces set to zero value). Then apply this load to all floors.

Page | 16



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

R2HG- Q-7 -8l=-LOA @25 B> SuctudlAnalysisBuiding - 30 View. . »[1oeareomodopmoe |48 & ¥ L signin W ®- - &x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View Manage  Add-Ins  Modify | Place Loads @~

h| 6B Jiuatloralll T 1 1, el B2 L ¢ 5|8
Modify| &c“" | 9% S O =, = E_] N = ® . @ 7 Point Lline Area Hosted  Hosted | Hosted
= Y Gon- K&K T Q 0= x Load  Load ' Load Point Load  Line Load|Area Load]
Select ¥ Properties  Clipboard Geometry Modify View  Measure  Create Loads
Modify | Place Loads
Properties x [ 5% ~ Project Browser - Structural Analy... X
= [0, Views (all)
Area Loads A =l Structural Plans
Area Load 1 Foundation
s Level 1
New Area Loads ~ | B Edit Type Level 1 - Analytical
Strugtural Analysis _ _ _ _ _ Lovel2
I Load Case () 1 Level 2 - Analytical
Natwe v | Level 3
Orient to Project ROOF
Projected load_ (] _ _ _ _ _ v
Forces 7] = 3D Views
Tt 000 kN/m? I Ansltical Model
Try1 0.00 kN/m? | i ey dding Blevaii
Mz | - Elevations (Building Elevation
= = —— East
\dentity Data North
Description et
Comments West
Other . ¥ Legends
Is Reaction O = Schedules/Quantities (all
Area Sheets (all)
# 2] Families
+ [@ Groups
v | 8 Revit Links
Properties help Apply 1:100 MK IXGREGR o RESE < > < >
Pick Analytical Floor or Wall to create area load. 5 20 [3 M Main Model i e S

6 Next apply some Hosted Line Load as Wind Load to the structure. Select Hosted Line Load from
the Load panel. Then set the Load Case to WIND-Y (4) and enter 20.00 kN for Force Fy 1 (other
forces set to zero value). Then apply this load to all the columns along Grid-C as shown below.
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7 Lastly, apply a Point Load as Wind Load to the structure. Go to ROOF plan view. Click Analyze tab
» Analytical Model panel > Loads » Point Load. Then set the Load Case to WIND-X (3) and enter
100.00 kN for Force Fx 1 (other forces set to zero value). Then apply this load to the center of the
floor.

8 You may not be able to see the load in plan view. Go to Analytical Model view to check your
input. Alternatively, you can set to view Structural Load in plan view by going to
Visibility/Graphics (type “wv” for shortcut) and turn on Structural Load.
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Now that the structure has all the ingredient and it is ready to be analysed.

16.1.8 Check Supports and Consistency Check

Revit provides two checking options for you to make sure the structural model is good without
missing supports and that it is analytically consistent. These options are under the Analyze tab.
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You can view and set the checking criteria by going to the Analytical Model Settings.
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Now, turn on both the Member Supports and Analytical / Physical Model Consistency checks on
under Automatic Checks and see what will happen if you try adding something unsupported to the
model.
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For example, if you copy a column to a random spot in 3D then you will get a warning. The warning is
“Structural element may not be supported — verify support for element.”. You can continue to build
your model and view all these warnings later by going to Manage tab > Inquiry panel > Review

Warnings .
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16.1.9 Analytical Adjust and Analytical Reset

You can adjust the analytical model using the Analytical Adjust tool. Revit also provides an Analytical
Reset option to reset the analytical model of an element to its default position.
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Now, add a shaft opening, some walls and copy a column in the model before you adjust the
analytical model. (Note: exact dimensions on plan are not important when placing the elements.)

1 Go to 3D view then click Structure tab » Opening panel > Shaft.
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2 Align the view to “Top” and then set the “Base Offset” to “~-1000” and “Unconnected Height” to
“15000”. Sketch a rectangle in the structure as shown below.
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3 Then place two wall objects from level 1 to level 2. Place them separately as shown below.
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4 Copy a column at Level 1 and place it on level 1 floor as shown below.
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5 Go to the Analytical Model view and you will see the analytical model is updated as well.
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6 Go to “Analyze” tab and click “Analytical Adjust Model”.
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7 Select “Wall Adjustment”. This function modifies the analytical wall element in relation to other
walls. Click one edge and then click the target that you want to connect. Note that the analytical

walls have been adjusted to connect but the physical model remain unchanged.
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8 With “Openings”, you can modify the analytical model to include / exclude an opening from the

surface.
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9 With “Analytical Link”, you can add an analytical link (like rigid link in common structural analysis)
connecting 2 analytical nodes.
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16.2  Structural Analysis using Robot Structural Analysis Professional (RSA)

After checking and adjusting the analytical model, you can now export the structure to RSA for
analysis. You can then view the result in RSA or import it back to Revit for viewing and
documentation. You can download RSA free trial (30 days) and test it out with your Revit 2016 or
above version.
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You can see an RSA icon in the “Analyze” tab after installing RSA.
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16.2.1 Sending Revit Model to Robot Structural Analysis (RSA)
1 Click Analyze tab » Structural Analysis panel > Robot Structural Analysis Link

2 Select “Send model” and “Direct integration” from the dialogue box.
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3 Click “OK” to start exporting the analytical model to RSA. RSA will start automatically during the
process.
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4 Go to RSA and you should see your model in RSA interface.
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You can turn on the Load symbols to see if the loads are transferred correctly. For example, below
screenshot shows the forces applied to the structure for the load case “WIND-Y”.

i Autodesk Robot Structural Analysis Professional 2018 - Pro;ectSuudure Results (FEM): available Type a keyword or phrase - a X
DBEBU@BX @ﬁﬂf\ - . FQQ&VMM#’.
A ]t WW.B—QJ- AR EE
) = ~ 02
Number o.
=4
g N
o4 L]
&
0/4034 I
v
ometry f, Groups — '
B &
ml
o
b
&
&
=
\/ =
3 'I' -
View

5 Now click Analysis » Calculation to analysis the structure.
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6 There is error in this case because of material properties problem.
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If you select one of the floors, then you will see that the material used is “Default Floor” and it has
zero values for its material properties.
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7 You can resolve the problem in RSA or in Revit. In RSA,

(1) Select all the floors.

(2) Click ”Thickness".'t"
(3) Double click on “Generic 300mm”.

(4) Change the material from “Default Floor” to “C35” and click “Add” to modify it. Then all the
floors with this thickness type “Generic 300mm” will be changed.
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8 Carry out Calculation again to analysis the structure with the new material properties of the
floors. This time there is no error.

Page |32



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018
E Autodesk Robot Structural Analysis Professional 2018 - Project: Structure - Results (FEM): during analysis Type a keyword or phrase - X
File Edit View Geometry Loads Analysis Results Daiw Tools  Add-Ins  Window HelE Currlnm‘y —-FX
D ﬁ E a w @ @ x I% G ﬂ a R Autodesk Robot Structural Analysis Professional - Calculations - X
A - (? BN g 2o STATIC ANALYSIS 15019 f2 [ R
Object Inspect View P
e =n MULTITHREADED SOLVER o
HTZE Q4 @ S
PHASE OF ANALYSIS PRI =
.
e == o S 0 &2
| = Undefined
3ol of o st [ ————— -
| 8= Beams 0108 : [}
[l om E—
| &2 o o Resolution stage 00:00:01 Y
| —Floor 181 e 5 -
—Floor 182 - m))
“Floor 183 1 I
|| Floor 184 —
| %A Nodes 04034 Calculation Messages (RoorF)
~ Auxiliary objects v 15i19:15_Stort of the structure verification D) v
Number of errors: 0 =
G.nmctrv _______ [}
L L Groups 7 "MRurmber of warnings: 0 = '
Value  |Unt| ~ Srioie e ofthe ; (Leveiz) il
15:19:16  Start of the analysis R
(Level1) a
Statistics Resources In Use AE=T) o
Number of Nodes E 4034 Memory 8706.539 7.503
Number of Elements B 5408 Disk. 33884.930 9.971 a
Number of Equations g —=
i = 210% :; o sy E Object/window/capture selection
nalysis ; 19:
i : Estimat. Run Time : =2
Optimized
B — =
v pause s £
\l’ View v
alre|s 7P =i o > e~
View
ORI © Results (FEMY: during analvsis 4 L} ! 4=300.v=000 7= =

You can examine the analysis result in RSA or send it back to Revit for viewing and documentations.
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16.2.2 Sending RSA Analysis Results to Revit

1 Click Add-Ins » Integration » Autodesk Revit Structure. Select “Send model and result” and
“Direct integration” and click “OK”".
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3 After sending the analysis results from RSA, go to Revit and click Results Manager from the
Analyze tab. You will see the latest analysis results and you can click explore to view the results.
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16.3  Revit and other Structural Analysis Programs

16.3.1 Revit and CSI Software

Although RSA is the most compatible, effective and efficient way to link your Revit model, there are
other available linkages between Revit and other structural analysis software such ETABS and S-
FRAME.

For Revit and ETABS linkage, there is a CSI developed plugin called CsiXRevit that provides a bi-
directional link between ETABS (also SAP2000 and/or SAFE) and Revit (2016 and above). Four (4)
options are available to interchange data:

e from Revit Structure to create a new CSI model

e from Revit Structure to update an existing CSI model

e from CSI software to create a new Revit Structure project

o from CSI software to update an existing Revit Structure project

These options provide for true round-tripping of data between CSI software and Autodesk Revit®
Structure.

The content below is extracted from the CSiXRevit Data Exchange Documentation (for Revit 2018).

(Source: https://www.csiamerica.com/sites/default/files/CSiXRevit 2018 Manual.pdf)
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The flow of information is represented in the schematic below:

Revit® Structure

Export from Revit to create a new ETABS, SAP2000 or SAFE model.
Export from Revit to update an existing ETABS or SAFE model.

project.

Revit project.

Import from ETABS, SAP2000 or SAFE to create a new Revit

Import from ETABS, SAP2000 or SAFE to update an existing

ETABS®, SAP2000® or SAFE®

EE S -

The table below provides an overview of the data imported in ETABS when exporting from Revit to
create a new ETABS model:

Action

Project Element

Supported

Notes

Creation of...

Grid Lines

Story Levels

Materials

Structural Columns and
Structural Framing

Transfers geometry, offsets, end releases, and beam
and brace alignment points into ETABS. Imports
columns based on splice information in ETABS.

Steel Column and
Framing Family Types

Creates and maps equivalent ETABS frame sections.
Makes Auto-Select Lists in ETABS for all families used
in the Revit project.

Concrete Column and
Framing Family Types

Creates and maps equivalent ETABS frame sections.

Walls

Slanted or warped walls not imported.

Wall Family Types

Creates and maps equivalent ETABS wall sections.

Wall Openings

Floors

Sloped floors with more than four outer corners are
projected on a horizontal plane.

Floor Family Types

Creates and maps equivalent ETABS slab and deck
sections.

Floor Openings

Footings

Creates fixed joint restraints in ETABS wherever a
footing occurs in Revit.

Point / Line Loads

Area Loads

Non-uniform area loads not imported.

Load Cases

Creates both an ETABS load pattern and load case for
each Revit load case.

Load Combos
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You can see that the link is not fully compatible, care must be taken in using it. Critical items should
be checked after export / import. These checking should include but not limited to

e Critical loads values

e Material and Section properties

e Local axes direction of critical members

e Connectivity of secondary members

e Loads transfer from slabs to supporting beams/walls

16.3.2 Revit and S-FRAME Analysis Software

The software S-FRAME Analysis is another popular structural analysis software in North America. It
has a free bi-direction link provided for transferring models with Revit. Similar to ETABS’ CSiXRevit
link, the S-FRAME and Revit link is not fully compatible. However most of the information needed for
structural analysis can be transferred from and to Revit seamlessly.
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CHAPTER 17 - DRAWINGS PRODUCTION in REVIT

One of the objectives of using Building Information Modelling (BIM) is to share information
seamlessly across all processes of the building life-cycle. Information shared from design to drawings
is one of these key information transfer processes. In Revit, all 3D elements modelled are parametric
and drawings of the building model composed of these elements can be produced by putting
different views into sheets. As such, any change in detail of the Revit model will be reflected in the
drawings automatically and this is one of the ultimate goals of using Revit to avoid loss of
information when date is transferred from design output to drawings production.

In this section, you will learn

e How to create drawing sheet and customize a title block in Revit.

o How to create General Arrangement (Framing Plans) from Revit model.
e How to create Sections Drawings from Revit model.

e How to create R.C. Details Drawings from Revit model.

17.1  Creating Drawing Sheets in Revit

The simplest way to create a drawing sheet in Revit is to use its available template and modify it to
suite your use.

1 Select “Sheets (all)” from the Project Browser. Then right click and click “New Sheet...”.
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2 Select A1 metric and click “OK”.

Page |40



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

ReEHG - ®R-@-8 2 - FOA @25 &5  Poject! - Sheet:5.1 - Unnamed v [opeorepoorpae |G 8 ¥ L Sianin W @ - &x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =

|.\\, [ v - - y Area ~
Modit ) ‘
= - - | [@®] Model Group ~ -

Select ~ Build Circulation Model Room & Area ~ Opening Datum Work Plane
Properties x — (3 5% ~ Project Browser - Project1 x
0] Views (all)
b £ Structural Plans
Sheet -
—— Level 1 - Analytical
Sheet: Unnamed ~ | 8 Edit Type o Level 2
Graphics LIPY = = Level 2 - Analytical
Visibility/Grap... Edit... s F Site
Scale = 3D Views
o B | Analytical Model
Dependency  |Independent &~ Hlevations (Building Elevation
o o East
Referencing S,
. == North
Referencing D. "
Current Revisi Sout
Current Revisi... | west
urrent Revisi... 5] Legends
Current Revisi... | == I Schedules/Quantities (all)
Current Revisi -
Pt e 5 [ Sheets (all)
Current Revisi -9 Families
Current Revision peneed !
urrent Revision) — - [@] Groups
Approved By  |Approver — &8 Revit Links
Designed By | Designer I
Checked By (Checker = |
Drawn By Author
AL awntas I M v
Properties help Apply | |2 @ < > < >
Title Blocks : A1 metric : A1 metric & & 0 [ M Main Model FATRM N OCTo

3 Double click on the sheet to edit it. Note that now you are in Family Editor and any change made
will affect all sheets of the same type created before and in the future.
4 Now delete the Autodesk logo and insert a CIC logo (can be found in your course folder).
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5 From the Create tab, you can create many components such as Line, Text and Label to customize
your title block.

REEG Q-0 Q& FO0A G 0EG&B  mnachswe-  [moomre (RS # Qsem oW @ - 8X
m Create Insert View Manage Add-Ins

A0 R BEECASSFAAY S @B &

i II E% Line Detail | Symbol Masking Filled = Aligned Angular Radial Diameter Arc  Label Text Check Find/ Reference Set Show Lloadinto  Loadinto
e Group Region Region Length Speling Replace  Line Project Project and Close
Select ¥ Properties Detail Dimension ¥ Text ¥ Datum | Work Plane Family Editor

Page |41



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

6 Select and delete the text “www.autodesk.com/revit”. Then click Create tab » Text panel > Text,
and choose “5mm” from type selector. Pick a location inside the box under the CIC logo and type

%]

in “BIM Advance Course”. Click “Close” “** to add the text.
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(Notice that there are many tools available to help you to format the text.)
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7 You can also include information specific to the project as “Label” in the sheet. The advantage of
this is that you only need to change the information once and Revit will automatically update all
drawings that contain such information. To insert a label into a sheet, click Create tab > Text
panel > Label. Then select “Building name” and click “Add parameter(s) to label”. Click “OK”.
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8 Now save this title block as a new family. Click File > Save as » Family, and name it as “CIC
Course Title Block”. Next click “Load into Project and Close”.
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9 Go to the sheet view again and select the title block. Now you can choose the CIC BIM Course
Title Block from the type selector.
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10 Select the CIC Course Title Block and you have your customized title block to prepare your
drawings. You will notice a “?” mark when you select the title block. This is because the label
information, in this case “Building name”, has not been input for this project.
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11 To input project information, click Manage tab > Settings panel > Project Information. Type in
“Construction Innovation and Technology Application Centre” for the Building Name.
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You can align the label to a better position by double clicking on the title block to open the family
editor.

17.2  Creating General Arrangement / Framing Plans in Revit
To add General Arrangement / Framing Plans in Revit,
1 Open from the course folder the “Drawings Production.rvt” file.

2 From the Project Browser, select “Sheets (all)” and right click to add new sheet.
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3 Click “Load” and find the “CIC Course Title Block” family (which you should had saved in the
course folder) to load it into the project.
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4 Select the newly created sheet (S.1 - Unnamed) and right click to rename it. Change the (Sheet)
Number to “S101” and rename it to “FRAMING PLAN”". Click “OK".
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5 Now click on “Level 1” (Structural Plan) and press down the left mouse key then drag it into the
sheet area. You have just created a framing plan drawing.
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6 The framing plan drawing just created, however, need to be refined for submission to authority.
This will involve some visibility settings to control how the framing plan looks like. Since one view
can only be place into one sheet, therefore a more proper way to do this is to use a duplicated
view instead of the original Level 1 structural plan.

7 Delete the level 1 view from the $S101 drawing. Then click on Level 1 (Structural plan) and right
click to Duplicate View » Duplicate with Detailing. Rename this duplicated view to “Level 1
Framing Plan”.
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Using this “Level 1 Framing Plan” view, you can hide details that you do not want to be shown.

There are two ways to hide details. First way is by controlling an element’s visibility.

Type “wv” for Visibility/Graphics control. In the “Annotation Categories”, unselect “Elevations”.
Then you will not see any elevation symbol in this view.
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The other way to hide an element in the view is to select that element then right click and “Hide
in View” » Elements.
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9 Next, to add beam sizes on the framing plan.

Click Annotate tab > Tag panel > Tag All. Select “All objects in current view” and “Structural
Framing Tags” and click “OK”.
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10 The text does not display nicely. You can double click on it and edit the family. Select the Label
and drag the boundary longer then “Load into Project and Close”.
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No need to save change to “M_Structural Framing Tag.rfa”. Then “Overwrite the existing version”.

ReBG-QR-0-8 =2 0A -2 % &M@  MSudulfemingTag-Sheet: - [loeoremonopnae |40 & g D Signin W @ - & X

Create  Insert View Manage Add-Ins  Modify | Label =~

¥ ‘ — n
5 PN ( 2 v b
5 3 " "
Select *  Properties  Clipboard Geametry Modify Measure Create Label Family Editor
Modify | Label
Properties x — (5% ~ Project Browser - M_Structural Fr.. X
0 Views (all)
Label i it D Sheets (al)
s Save File X Families
+-[@] Groups
Structural Framing Tags | 8 Edit Type Do you want to save changes to M_Structural 88 Revit Links
CiE e ! Framing Tag?
Sample Text  1i. |
Label Edit.. r—--
Wrap between ... []
Vertical Align  Middle 'J :_ i __JJ|_Enes)
Horizontal Align Center |
Keep Readable 1 1 I
Visible 1
v
Properties help Apply | |\ £ < >
Ready FEDBR L OT

Page |51



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

ReHG-R-7-2 2" O0A G5 B 7 Davings ion (C ~St.. b |Type o keyword or phrase m S vy Lsignin e B - & X

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =

[y */" |-—-| é (%, Radial ~® Spot Elevation [ Detail Line £} Revision Cloud = A Text l_@ n@j 2P-Q ['% ) _m_ AN

Diamets A Spot Coordinate  [5f Re - Detail Group ~ “3° Check Spell [0l
Modil Aligned Linear Angular ® meter = i ‘ <=0 FA] o i s :.. .ec i Tagby Tag ‘? & Keynote — Symbol i»
{7 Arc Length = Spot Slope B component * B8 Insulation fig Find/ Replace  Category Al 10 B % - - = = [
Select + Dimension ¥ Detail Text ¥ Tag ~ ColorFil Symbol
Properties x | — (5% ~ Project Browser - Drawings Produ... X
v Alremh % 0] Views (all) ~
1] Family Already Exists =)
%“m'ﬁl S & v Y = Stucural Plans
_ I Foundation
’ A - —F You are trying to load the family M_Structural Framing S Level1
Structural Plan: Level 1 F ~ 5 Edit Type 4 ) . i i - Level 1 - Analytical
Graphics "IN Tag, which already exists in this project. What do you Level 1 Framing Plar
View Scale want to do? Level 2
Scale Value 1:{100 Level 2 - Analytical
Display Model Normal | e e e e e e e o Level3
Detail Level  Medium o i I ROGF
Parts Visibility Show Original | —> Overwrite the existing version Site
{ —— o —— - — -] = 3D Views

Visibility/Grap... Edit...
Graphic Displa... Edit...

—> Overwrite the existing version and its parameter Analytical Model

sk - x E w E [}
Orientation Project North o £ | values o £ = Hlevations (Building Elevat
Wall Join Displ...Clean all wall joi.. =)= [=X=
. 1 +Q JFc East
Discipline Structural @ o North
Show Hidden ... By Discipline o] South
Color Scheme ... Background . West
Color Scheme <none> | ¥ Legends
System Color ... Edit... Click here to learn more I schedules/Quantities (all)
Default Analys... None M = [ Sheets (all
Sun Path O 5101 - FRAMING PLAN
— (i ANN v |1 ANN v v [ & Families v
Properties helo Apply || 1:100 FE K KMEP ¢ BARIE < > al¢ >
Floors : Floor : Generic 300mm & & 0 [ % Main Model FARD N OTFo

RedBo-®-~-@2- 7 OA @G-85 GMB % DaingsProducton (C TS| 1ype o keyword or phrase M5 7 Lsionn W @ - &8x

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify (3

ﬂ i3 C Kewe 08 P APl = B0 = [ [R]
Mod

Sletr & 8&- g o = BB = .
B Pon- A P 50 ?H‘-"ﬂﬂx ®'®“

Select * Properties  Clipboard Geometry Modify View  Measure  Create
Properties x | | — [ 53 ~ Project Browser - Drawings Produ... X
= 100, Views (all) ~
T 400 x 800mm 400 x 800mm = Structural Plans
Sl  Stuctural Plan - \ clura’
-
\ — [ — — ——— — — — Level 1
Structural Plan: Level 1 F ~ 4 Edit Type ‘/ L. Level 1 - Analytical
Graphics * A Level 1 Framing Plar
View Scale I 1 Level 2
Scale Value 1 .100 | 11 Level 2 - Analytical
Display Model | Normal N 0 Level 3
Detail Level | Medium Roor
Parts Visibility | Show Original I 1 site
Visibility/Grap.. | Edit.. e ||l g Il £ =30 \'::;‘fyhl Model
Graphic Displa... _ Edit. £ | £ £ .
Crientation _Project North g | S | g a Elev(auc,ns (Building Elevat
Wall Join Displ...Clean all wall joi 2 | < Il @ fast "
Discipline_ Structural o |1 o I o North
Show Hidden ... By Discipline g || S g South
Color Scheme ... Background West
Color Scheme | <none> I Il B Legends
System Color .. Edit.. | i I Schedules/Quantities (all
Default Analys... None | h 1 [ sheets (al)
Sun Path 0 5101 - FRAMING PLAN
P i | Il v | 2] Families v
Properties help Apply 1:100 A% KERE D 0 afhE < > ¢ >
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7 FaE) 2 Main Model L - R S R

11 Lastly, add some dimensions to the plan.

Click Annotate tab » Dimension panel » Aligned. Then pick Grid-1, then Grid-2 to Grid-6 and click
anywhere right to Grid-6. Press “ese”.

Repeat Aligned Dimension and click on Grid-A to Grid-B.
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12 Now the “Level 1 Framing Plan” view looks more like a framing plan for submission.

You can insert this view into Sheet “S101”. First go to Sheet “S101” (i.e. double click on S101 in
the Project Browser). Then drag the “Level 1 Framing Plan” view into the sheet area.
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With some final refinements on the viewport and the drawing will be ready for submission.

13 Select the viewport. (1) Then drag the title line to appropriate length and location. (2) Type in
“1/F PLAN” in “Title on Sheet” at the Properties Palette.
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14 The title of the 1/F PLAN still does not look professional because of the bubble and detail number
“1”. You need to edit the “View Title” family to remove that.

First, notice that when you select the title and click “Edit Type”, you will see that the family used
for the title style is “M_View Title”.
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Now from the Project Browser, find “Families” > “Annotation Symbols” > “M_View Title”

click and click edit.

. Right
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e . i 1 1" ;
- M_View Reference
I I {1 &
Sheet: FRAMING PLAN ~ 58 Edit Type 400 % 800mm 400 x 800mm 400 x 800mm 400 x 800mm [ Multi-Rebar Annotatic
Graphics 2 A - — - — 5 [ Structural Framing Tac
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Current Revisi 1:100
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Current Revisi... - Detail ltems
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Approved By |Approver & Doors
Designed By | Designer % Duct Systems
Checked By  |Engineer & Ducts
Drawn By Draftsman - Flex Ducts
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E% Line Detail | Symbol Masking Filled ~Aligned Angular Radial Diameter Arc  Label Text Check Find/ Reference Set Show Loadinto Load into
Group Region Region Length Spelling Replace  Line Project Project and Close
Select ¥ Properties Detail Dimension ~ Text ¥ Datum Work Plane Family Editor
Properties x = [ 58 ~ Project Browser - M_View Title.rfa X
0] Views (all)
R i i [ Sheets (all)
21 Families
+ [@] Groups
Family: View Titles ~ | B8 Edit Type &8 Ravit Links
Other :

oo com [T ]

@ View Name

View Scale

v

Properties help Apply B0 < >
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. s MO Fo

Now delete the bubble and the label “1”. Then select the “View Name” label and click “Edit Type”
in the properties palette. Duplicate the type and rename it to “6mm Underline”. Remember to
check the “Underline” box.

Type Properties X

Family: |System Family: Label 52 ‘ Load...

I === = =
Type: 1 |6mm Underline 1 V ‘ Duplicate...

Type Parameters

Parameter Value =
Color H Black
Line Weight 1
Background Transparent
Show Border O
Leader/Border Offset 2.0320 mm
Tee
Text Font Arial
Text Size 6.0000 mm
Tab Size 12.7000 mm
Bold O
ddic - - o o o oo oo o 1 .
IlUnderline 1
WidthFactor — — ~ ~ -~~~ 77 fogodde~ —~ -~ T T T T T T 7 a
<< Preview | oK | ‘ Cancel ‘ Apply

Click “OK”. Then save this edited family as “View-Title-Framing Plan” in the course folder. Now
click “Load into Project and Close”.

Now when you select the title and click “Edit Type”, you can change the “Title” style to the one
you have just created which is “View-Title-Framing Plan”. Remember to uncheck the “Show
Extension Line” too.
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Finally, the title style looks good for submission.
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15 Input the project information to complete the drawing.

Click Manage tab > Settings panel » Project Information. Type in the information as shown
below.
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16 You can also edit the parameter by clicking on the label in the sheet view.
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Drawn by Author south
Sheet Height  |594.0 West
i a Chocked by E F) Legends
File Path C\Users\Geocrge .. ClTAC S101 z ™ Schedules/Quantities (all)
& = D Sheets (all)
saae 1:100 || 2 [ 5101 - FRAMING PLAN
- v | 2] Families v
Properties help Apply P g < > < >
Enter parameter value &t &0 [ B Main Model TR G b M & T

Now with some general notes, the sheet (drawing) is ready to be printed for submission.
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17.3  Creating Sections Drawings in Revit
The create a section of your building,
1 Go to Level 2 (Structural Plan).

2 Click View tab » Create panel > Section.
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3 Cut a section between Grid-2 and Grid-3 as shown below. Then select the Section line and click
“Go to View”.
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4 Select the View box and drag the control point downward to view the footings as well.
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5 Select the level line and drag it further away from the building. Note that all level lines will be

moved.
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6 To hide the pattern on beams, columns and footings, type “vv” for Visibility/Graphics Control and
edit the “Structural Columns”, “Structural Foundations” and “Structural Framing” settings as

below.
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7 Now add some dimensions to the section.

Click Annotate tab » Dimension panel » Aligned. Then pick Grid-A, then Grid-B and Grid-C and
click anywhere right to Grid-C. Press “ese”.

Also add some dimension for the levels.
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9 Next add a new sheet to place the section prepared above. Select “Sheets (all)” from the Project
Browser and then right click to add a New Sheet with the same CIC Course Title Block.

11 Select the new sheet (5102) and right click to rename. Rename it to “SECTIONS”. Click “OK”.

12 While still in sheet 5102, find and click Section 1 from the Project Browser and drag it into the
sheet. Then move the title to the centre of the section.
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13 Go to Level 2 (Structural Plan), then click View tab > Create panel > Section. Add another section
between Grid-B and Grid-C as shown below.
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14 Go to the newly formed section view (Section 2) and adjust the cut line of Section 1 as shown
below.
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15 Add dimensions and hide crop region as in Steps 7 and 8 above.
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16 Go to Sheet “S102” (double click on it from the Project Browser). Then click on Section 2 and drag
it into the sheet S102.
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Creating Column R.C. Detail Drawings in Revit

T D 0P

You have learnt how to model 3D rebars in Revit earlier in this course. In this part, you will practice
this skill again and learn how to create R.C. detail drawings for beams and columns.

To create R.C. detail drawings for columns,

1

2

3

Go to Level 1 (Structural Plans).

wall section as shown below.
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4 Double click on the wall section to go this wall section view. Alternatively, you can
section line then right click and select “Go to View”.

At this wall section view, drag the bottom control point until you can see the footi

select the wall

ng.
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5 Now, zoom to the column from Foundation to Level 1 and start to add 3D rebars.

Click Structure tab » Reinforcement panel » Rebar. Click “OK” to the message.
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6 Select Rebar Shape: 51 with Rebar Bar 10T and set “Placement Methods”, “Placement Plane”,

“Placement Orientation” and “Rebar Set” according to the setting shown below.
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7 Hover near to the left edge of the column, Revit will show you a temporary set of rebars. Click to
place the rebars as indicated.
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8 Select the rebar set and edit its View Visibility from the Properties Palette. Set “View
unobscured” and “View as solid” for 3D View (View Name {3D}). Then go to 3D view to see the
rebar set just created.
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9 Go back to the wall section view (Section 3 in the Project Browser). Then select the rebar set and

sketch it up to Level 2.
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10 Create similar rebar set with maximum spacing set to 200mm for the same column from Level 2
to ROOF.
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11 Now, create a detail view to add main rebars for the column.

Click View tab » Create panel > Section and choose Detail View in the Type Selector. Then create
a Detail View near ROOF level as shown below. (Click the Flip Section button if your detail view is
opposite to what shown below.)
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12 Right click on the Detail View and select “Go to View” to go to this detail view. Now, zoom to the
column and start placing rebars.

Click Structure tab » Reinforcement panel > Rebar. Select Rebar Shape: 00 with Rebar Bar 32T.
Set Placement Plane to “Current Work Plane”, Placement Method to “Perpendicular to Cover”
and Rebar Set to “Fixed Number and Quantity = 3”.

Hover over to the left and right edges of the column and place the rebar sets.
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13 Go to Wall Section view (Section 3) and create two more Detail Views near Level 3 and Level 2 by
copying the existing detail view.

ReBG-S-7-82-20A @G- 0[5 &DE- 7 Reetaiof Coumns 25 b [rvpe akeyword or phrase M5 7y L signin W @ - &8 X
Architecture ~ Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View Manage Add-Ins  Modify @-
*/i\ r—-l é (%, Radial A2 Spat Elevation Detail Line £} Revision Cloud A Text l_@ E@ 3 3 [% a 4+ 4
(S Diameter & Spot Coordinate [T} Region ~ [A] Detail Group = %% Check Spelling [0} ] 1
Aligned Linear Angular e Tagby Tag Keynote ~ ._ | Symbol
{7 Arc Length 71 Spot Slope B component * ] Insulation @i Find/ Replace  Category Al £8 M %~ - i= m
Select ~ Dimension ¥ Detail Text b Tag ¥ Color Fill Symbol
Properties x — (i 53 ~ Project Browser - RC Detail of Cal.. X
Level 2 ~
Section i ROOF G Level 2 - Analytcal
Wall Section 12000 Level 3
ROOF
Section: Section 3 ~ BB Edit Type o
Graphics * A = 3D Views
View Scale Analytical Model
Scale Value 1: {100 30
Display Model | Normal [ Elevations (Building Elevat
Detall Level  \Coarse - Level 3 Y -
Parts Visibility | Show Original 1 ‘\‘—' North
Visibility/Grap... Edit... 1 8000 South
Graphic Displa.., __ Edit. 1 West )
; . [ Sections (Building Section
Hide at scales ... 1:100 :
L Section 1
Discipline Structural Section 2
Show Hidden ... By Discipline & Sections (Wall Section)
Color Scheme ... Background Section 3
Color Scheme <none> - gt = Detail Views (Detail)
o 1 Level2 \ Views
Default Analys... None 1 (/A\ I Detail 0
Path | 1 T o : \ i
Sun Patl OJ — - =0 4000 Detail 1
Extents N 1 N = Detail 2
Crop View | % _______ ! 5 Legends
P . hd = v | [ Schedules/Quantities (all]
Properties help Apply 1:10 O G#FEHE? o @MBIE < z e 2
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. (/1 0[S M|main Model W ™ OV

14 Go to the detail view near Level 3 (double click on it). Place rebars along the left and right edges
of the column with the following settings.

Rebar Shape: 00 with Rebar Bar 32T. Set Placement Plane to “Current Work Plane”, Placement
Method to “Perpendicular to Cover” and Rebar Set to “Fixed Number and Quantity = 4".
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15 Place another set at the middle face of the column using the following setting:

Rebar Shape: 00 with Rebar Bar 25T. Set Placement Plane to “Current Work Plane”, Placement
Method to “Perpendicular to Cover” and Rebar Set to “Fixed Number and Quantity = 2”.
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Remember to set the View Visibility if you want to view these rebars unobscured in 3D view.
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Eye Elevation 68687 Section 3
Target Elevation -3225.0 1 Detail Views (Detail)
Camera Position Adjusting Detail 0
Identity Data * Detail 1
View Template <None> Detail 2
ViewName (30} 5] Legends
pp BT " ¥ v [ Schedules/Quantities (all)
Apply 1:100 Bk G GRMAEY o RHEE < < >
Floors : Floor : Generic 300mm & 0 [ 5 Main Model bR N R R

You can change the colour of the rebars for easy viewing. Type “wv” for Visibility/Graphics control
and edit the setting for “Structural rebar” as below.
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Structural Path Reinf...

uctura

Far Clip Active |
Far Clip Offsat {304800.0
O

ReHG ®-&-8=F0A & o=ad s ... |
Fil tect i i
NGRS Sucture SNSRI RS EERSSIN |11odel Categortes | Anntation Calsgories | Analytice Hode Gatnories | Imporie Cafegorles | ltes
Show model categories in this view If a category Is unchecked, it will not be visible.
Fiter list: | <show all> ~
Select * Structure “ Connection = ¥ Foundation Visibility ‘ Croleclion/Surface C:‘" { Halftone | Detail Level|
| | Lines Patterns | [ Datt
+ [ Specialty Equipment Fill Pattern Graphics x
s £ B Sprinklers : - Ll t
[ stairs [ Pattern Qverri L
@ 30 View - Structural Area Reinf... E [Avisible .
M Structural Beam Syst... |
i M Structural Columns || [ i
3D View: (3D} ~ BB Edit Type + M Structural Connections Pattern: [soia [ N
Extents P M Structural Fabric Areas |
Crop View O & B Structural Fabric Rein...
Crop Regian V...[] M Structural Foundations | Clear Overrides Cancel |
Annotation Cr... [_] + Structural Framing
G
[

Override...

Section Box Structural Rebar Cou.. G v
Camera * Override Host Layers
All Hone Invert Expand All '
Rendering Set... Edit... [l cut Line Styles Edt...
Locked Orient Categories that are not overridden are drawn
Perspective according ta Object Style settings. Object Styles...

Eye Elevation 68687

Target Elevation -3225.0

Camera Position Adjusting
Identity Data : 2 Cancel Apply Help

View Template <Nane>

View Name (3D}

Detail 2
= Legends
v | [ Schedules/Quantities (all)
>

Properties helo

B oM< > <
Ready [} i 0 W | Main Model TEMR T OFo

16 Use the steps mentioned above, place the following rebars for the column in Detail 2.

ReBG - ®-7-82-A0A @ 0% &@E-~ RrDetaiof Coumns B rype a keyword or phrase M5 7 Lsignin W @ - &8x

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View Manage  Add-ins  Modify | Place Rebar

SIS

o Modify | View . Create  Placeme.. load Placeme... Placeme. Reba.. = Rebars..
Cyeiza Q s
Select * Properties  Clipboard Geometry - v Measura | = - Family - - - - -
Mocdlif Rebar Shape : 00 = (.|
Properties x (5 52 ~ Project Browser - RC Detail of Col.. X Rebar Shape Browser X

Structural Rebar (1) v 38 Edit Type ~

] 1 =7 Level 2 ~ ~
Rebar Bar | i Level 2 - Analytical

1 40T 1 Level 3

L ROOF

Site

Construction * A - = 3D Views

Partition |:| Analytical Model

Schedule Mark a0y Rebar Shape : 01
Geometry |Shape Driven =/ Elevations (Building Elevat

Style Standard Fast

Shape oo North

Rebar Shage : 11
South

West
Sections (Building Section

Shape Image | <None>
Hook At Start  |None
Hook AtEnd  None

End Treatment..|None Seon? fieber Shane 12
d Treat . Section 2

End Treatment...None , P ) Sections (Wall Section) )]
Rebar Set N P Section 3

Layout Rule  Single = Detail Views (Detaily Rebar Shape : 13
Quantity 1 = A Detail 0

Spacing Detail 1

Graphics * Detail 2

View Visibility ... | ] Legends Aebar Shave 14
e v , v | I Schedules/Quantities (al) v ¥
Properties help Apply 1:100 O % GaE &2 o CRMRIE < 2 i€ > e
Click within a valid rebar host to place rebar. & & 0 [F B Main Model N R )

17 Now, you can tidy up the detail views for R.C. detail drawing of the column.

(1) Change the scale of the view to 1:25.

(2) Hide the crop region by clicking the button i | (Buttons near the bottom of the drawing
area.)

(3) Move the Grid Bubbles closer and hide the bubbles at the opposite ends.
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(4) Select the section view, right click and hide it in view.
ReEHG - ®R-0-8 2 7@ A G- % &E-+ RCDeiof Columns (C SBR[y o keyord or phrose & 5 vr Lsignin B @ _&x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Madify | Views =~

Oy Aot - 1 7
2. 02 =4 e v s split
i o O =M - ® - N ize p
- B Pun- K PO = x oo Grop) | Segment
Select * Properties  Clipboard Geometry Modify View  Measura  Create R Cancel
pceliy|ViEws Repeat [Visibility/ Graphics]
Properties x Recent Commands » Project Browser - RC Detail of Col... X
Flip Section Level 2 .
Section 4 Level 2 - Analytical
Wall Section ool e Level 3
Rotate ROOF
Views (1) ~ S EditType Hide in View > Site
. B
Graphics & Override Graphics in View > | F 3D Views
View Scale 1:100 o Analytical Model
Scale Value 1:|100 Create Sl-mllar firs
Display Model |Normal Edit Family [ Elevations (Building Elevat
Detail Level  Coarse - Fe bR s East
Parts Visibility |Show Original Select All Instances ’ North
Visibility/Grap... Edit... Delete ;&:utlh
: est
GTap ic Displa. - Edit.. Find Referring Views 1 Sections (Bulding Section
Hide at scales .| 1:100 g Section 1
Discipline Structural Zoom Out (24) Coction 2
Show Hidden ... By Discipline Zoom To Fit = Sections (Wall Section)
Color Scheme ... Background . Section 3
Color Scheme <none> . c;us F;aanoom = Detail Views [Detail)
Default Analys... None lext Pan/Zoom Detail 0
Sun Path | Browsers ’ Detail 1
Extents * o ! il Properties Detail 2
Crop View =7 ) Legends
P .= 2 I v | [ Schedules/Quantities (all) v
Properties help Apply 1:5 O % G# 82 o BEE< LI 2
Hide selectad elements (in tha current view) & Far) B | Main Model N 0T

(5) Hide the pattern of concrete for beams and columns. (Go to Visibility/Graphics control and
set turn the Cut Pattern not visible for Structural Framing and Structural Columns.

REZHG - &-0-8/2-A0A @G- 9= &M~ RCDetaiof Columns Visibility/Graphic Overrides for Detail View: Detal 1

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate -
) Model Categories Annatation Categories Analytical Model Categories Imported Categories Filters

Show model categories in this view If a category is unc

Filter list: | <show all> ~
Projection/Surface Cut

Structure * Connection ™ ¥ Foundation Reinforg Visibility ‘ : : ]
| tines Patterns | Transparency Lines Patterns

Specialty Equipment
Sprinklers

+ M stairs |
Structural Area Reinfor... |
¢l Structural Beam Syste..

kS
"=

OO Detail View i
Detail

|
Detail View: Detail 1~ ~ £8 Edit Type ‘
|

..+
R

Structural Connections |

Graphics A
View Scle
Scale Value 1: 25

Display Model 'Norma\

Detail Level  Coarse

Parts Visibility | Show Original

St Fi| Pattern Graphics

" :
| Clviise | Hidden

o
sty Color: [ <t overrige>

Strul -
- Pattern: _<Nn Override> ~

HEEH R BB R
NN R EEE
2
E]

Visibility/Grap.. | Edit..

Graphic Displa_.. Edit... | Al Olﬂﬂmﬂe Host Layers

Hide at scales ... 1:100 : : ! Cut Line Styles

Discipline _ Structural Cotogor] I MOSHOERGES o)

Show Hidden ... By Discipline accord et Styre sevangs-

Color Scheme ... Background

Color Scheme <none>

Default Analys... None

Sun Path a %K Cancel
Extents ' 2 T " Detail 2

Crop View E Legends

- v v [T Schedules/Quantities (all) v

Apply 1:5 O & EH? 0 BMHIE < > < >
il &0 @ Main Model FED RO T

Page |77



Construction

Industry Council

Building Information Modelling (BIM) Advanced Modelling Course
(Structure) — Revit 2018

ReEG-QR-0-8 =22 ©OA @05 &B-~ RCDetaiof Columns (C BB 0 o keyword or phvose 8 8 vr Lsonin v ® . &x
File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Madify =-
[y g Q wall - [ Truss % @ = ## Area [ Fabric Sheet £ Model Text =R ale o wal @ &
J ==
Brace 3 Path [ cover [%. Model Line * Wy Vertical 7
Modil Beam E Connection Wall Slab  Rebar . Component By Shaft . Grid Set =
&= Floor = [[]] Beam System - B Fabric Area &3 Rebar Coupler - [ Model Group = Face I Dormer
Select ~ Structure ¥ Connection ~ ¥ Foundation Reinforcement ~ Model Opening Datum  Wark Plane
Properties x | — [ 52 ~ Project Browser - RC Detail of Col.. X
Level 2 ~
OO Detail View i Level 2 - Analytical
Detail Level 3
ROOF
Detail View: Detail 1~ &5 Edit Type Sio
Graphics A = 3D Views
View Scale Analytical Model
Scale Value 1: 25 30}
Display Model |Normal 1 Elevations (Building Elevat
Detail Level  Coarse + Fast
Parts Visibility | Show Original | North
Visibility/Grap... Edit... C " * xmh
Graphic Displa... _Edit.. - - | e ’
T . b = Sections (Building Section
Hide at scales ... 1:100 i
Section 1
Discipline Structural cection 2
Show Hidden ... By Discipline [ 1 Sections (Wall Section]
Color Scheme ... Background Section 3
Color Scheme | <none> 1 Detail Views [Detail
Default Analys... None Detail 0
Sun Path a Detail 1
Extents * Detail 2
Crop View 7] Legends
TR ¥ v [T Schedules/Quantities (all) v
Properties help Apply 1:25 Otk KEF P o BMIE < > .« >

Ready

(6)

L

< 0 [ 3 Main Model

R A b O P

Finally add some break lines for the beams. Break lines are Detail Components and can be

found in Annotate tab > Detail panel > Component. Click “Load Family” and find the break
line detail item “M_Break Line” from the path shown below.
(C:\ProgramData\Autodesk\RVT2018\Libraries\Hong_Kong\Detail Items\Div 01-General)

ReBG-QR-0-8 =2 0OA @05 &B-~ RCDetaiof Columns (C BB e o keyword or phrose 8 8 vr Lsonin v ® . &x
File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify =~
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Modil Aligned Linear Angular ® ﬁ F] . Tagby Tag = & Keynote . Symbol {A
{7 Mic Length 1 Spot Slope [E] companent[+] 8 Insulation G Find/ Replace  caeqory Al 1B B % - . i= 1]
Select ~ Dimension ¥ ttail Text 3 Tag ~ Color Fill mbol
@ Detail Component = £
Properties Detail Component J — (5% ~ Project Browser - RC Detail of Col.. X
Adds a view-specific detail component to a view, Level 2 ~
OO Detail View Level 2 - Analytical
Detail If no detail component families are loaded into the project, load || Level 3
a detail family from the library, or create your own detail family. ROOF
Detail View: Detail 1~ | You can add keynotes to detail components. Site
Graphics = 3D Views
View Scale 1:25 Analytical Model
Scale Value  1: |25 30}
Display Model Normal [ Elevations (Building Elevat
Detail Level  Coarse + Fast
Parts Visibility | Show Ori | North
Visibility/Grap... Edi South
Edi — — West
i 1100 = Sections (Building Section
i e_a_lscaes.‘._ : Saction 1
D\sclplm‘e Slluc‘tufa\ Section 2
Show Hidden . By Discipl | e more help | =1 Sections (Wall Section)
Color Scheme ... Backg! Section 3
Color Scheme | <none> 1 Detail Views (Detail)
Default Analys... None Detail 0
Detail 1
Extents ? Detail 2
Crop View = | 7 Legends
e h ~ [T Schedules/Quantities (all) v
Eroperties help Apply 1:35 Gk GEH2 ¢ RHETE < > >

Structural Framing : Concrete-Rectangular Beamn : 300 x 600m ﬁ

2 0 [= ¥ Main Model

<
TR O P
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ReEHG - QR-0-8 2 7@ A G- % &+ RCDeiof Columns (C SBR[ 1y7e o keyord or phrose & 5 vr Lsignin ‘B ® _&x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Madify | Place Detail Companent ==

i 07 . y > : 4 % +
L) ( - - 1
- B . & 5 "

Select * Properties  Clipboard Geometny Maodific View  Measure  Create  Mode
Maxiify | Place Detail Companent R Load Family ? x
Properties x |~ Project Browser - RC Detail of Col... X
Look in: Div 01-General v| 4o B X E] Vews v M leel2 o~
evel ~
UB-Universal Beam- I Deskiop Previen Level 2 - Analytica
Section - ' This PC ”
305%165x40UB £.05(C) Level 3
PragramData ROOF
Detail ltems | 68 Edit Type Autodesk cie
RVTU z:amu; 3D Views
Documents Hong kong —’/\/— Analytical Maodel
Detail Ttems 30}
- [ Elevations (Building Elevat
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: & etk South
4 OneDrive 0
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22 Dropbox [ Sections (Building Section
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Temp for Lambeth Demo - Sections (Wall Section)
g v Section 3
File gome: | M_Break Line.rfa ~ 1 Detail Views (Detail
Files of type:  All Supported Files (.rfa, *.adsk) ~ Detail 0
Detail 1
Tools - Open Cancel Detail 2
E Legends
v | 7 Schedules/Quantities (all) v
i Apsly 15 DI %% GE B 0 GRS ¢ >l 2
Ready &t 20 @5 Man Model FED R OTo

Place the break lines as shown below. (Note: you can press “spacebar” to rotate the break line
and sketch it by dragging the arrows.)

Repeat adding break lines for detail views “Detail 0” and “Detail 2”.

ReEHG - ®R-0-8 2 7@ A G- % &E-+ RCDeiof Columns (C SBR[y o keyord or phrose & 5 vr Lsignin B @ _&x

Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify ®-
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Select ¥ Dimension ¥ Detail Text » Tag ~ Color Fill Symbol
Properties x — (58 ~ Project Browser - RC Detail of Col... X
Level 2 -
OO Detail View i Level 2 - Analytical
Detail Level 3
; : ' | ROOF
| Detail View: Detail 1 ~ B Edit Type cie
Graphics A = 3D Views
View Scale Analytical Model
Scale Value 1: |25 B0}
Display Model |Normal I Elevations (Building Elevat
Detail Level  Coarse | East
Parts Visibility | Show Original C - . —— North
Visibility/Grap... Edit... o . ;‘:mnh
3 es
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T phic Displa...| i =) Sections (Building Section
Hide at scales ..., 1:100 Section 1
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Color Scheme .., Background Section 3
Color Scheme <none> = Detail Views (Detail)
Default Analys... None Detail 0
Sun Path O Detail 1
Extents a Detail 2
Crop View ) Legends
P a—— > v | [T Schedules/Quantities all)
Properties help Apply 1:5 O & SEEY o RAMIE < > < >
Detail ftems : M_Break Line : M_Break Line & &0 3B Main Model R R . S S R

(7) Now, save the view setting as a View Template and apply it to other detail views. To do this,
select Detail 1 from the Project Browser and right click to “Create View Template From
View”. Name it as “RC Detail View 1” and click “OK”".
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(8) To use the view template “RC Detail View 1” for other detail views. Select Detail 2 from the
Project Browser and right click to “Apply Template Properties”.

Then find and select the view template named “RC Detail View 1” and click “OK”.

Repeat this for detail view “Detail 0”.
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18 To create the drawing R.C. Detail of Column, add a new sheet (right click on “Sheets (all)” and
select “New Sheet”). Use the CIC Course Title Block then rename this sheet to “R.C. Detail of
Column” (right click and rename).

Page | 82



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

ReHG - QR-0-8 2 -7 ©@A G- 0% &E-+ RCDetiof Columns (€ S Tye  keyword or phvose & 5 vr Lsignin B @ _&x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Madify =~

% ‘/" |-—-| (%, Radial * t Detail Line £} Revision Cloud =~ A Text l,@ . : I.% _a_

i X . & Diameter - [EA] Detail Group = *F Check Spelling -3
Modify  Aligned Linear Angular = Tag by Keynote Symbol
{7 Arc Length - i Find/ Replace  Category B -
Select ~ Dimension ¥ Detail Text s Tag * Color Fil Symbol
Properties x = [ 58 ~ Project Browser - RC Detail of Col... X
I Elevations (Building Elevat A
Sheet - fast
North
South
Sheet: R.C. Detail of Col ~ 24 Edit Type West
Graphics A [ Sections (Building Section
Visibility/Grap... Section 1
Scale Section 2
dentity Data 3 1 Sections (Wall Section)
Dependency |Independent | T Section3
Referencing S. = Detail Views (Detail)
Referencing D Detail 0
; Detail 1
Current Revisi.
C it Revisi Detail 2
urren i B9 Legends
Curent fevisl. [ Schedules/Quantities (all
Current Revisi & R Sheets (all)
Current Revisi... | 15101 - FRAMING PLAN
Current Revision| Structural Plan: Lev
Approved By Approver #5102 - SECTIONS
Designed By _ Desgner -
Checked By  (Checker = B2 ramilies
Drawn By \Author = Annotation Symbols
- e v A1 metric v
Apply [\ 9 < > < >
&t Fa B Main Model LR N )

19 While still activated this sheet, select Detail View “Detail 0” and drag it onto the sheet “S103 —
R.C. Details of Column”. Continue to drag “Detail 1” and “Detail 2” onto the sheet.
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20 Double click the details and select the section line then hide it in view.
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21 Select all viewports and change the type to “No Title”.
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22 Next, create a table to place the details. You can draw the table using “Detail Line” and “Text”
from the Annotate tab. Use the dimensions shown below as reference to draw the table.
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23 Copy the table for one level to form a complete table for the R.C. details.
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24 Revise the text according to the details and the R.C. Detail of Column is almost ready.
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25 Double click on the viewport of the 2/F to FDN detail to annotate it with some tags.

Click Annotate tab » Tag panel > Tag by Category. Then tag the column, one main bar and the
link. You will need to modify these tags for better presentation.
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26 Double click on the column tag then edit the following items:

e Rotate the tag to align horizontally.
e Change the “Horizontal Align” to “Center”.
e Drag the tag boundary longer.

Then “Load into Project and Close”. Do not save the family and “Overwrite the existing version”.
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27 Activate the detail in the drawing (Sheet 5103 - R.C. Detail of Column). Move the column tag to
the box for “Size” and remove “Leader Line” from the tag.
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Now, if you change the column size, the drawing will be updated automatically.
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Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7 Fa) B\ Main Model

28 Next, change the type of links/binders tag. Select the binder tag and click “Edit Type”. Duplicate

and rename to “Type & Spacing”. Select “Type & Spacing” instead of “Type”
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29 Go to the sheet view and double click on the detail then move the tag to appropriate location.
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29 Finally, change the type of tag for the main bar to “Quantity Type & Number” and duplicate it
with name “Quantity & Type”. To get rid of the rebar number, you have to double click on the tag
and edit its family.
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30 Find the corresponding label and “Edit” it. Remove the parameter “Rebar Number” from the

label.
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Click to select, TAB for altemnates, CTRL adds, SHIFT unselects. 7 0 @™ Main Model

PED RO

Then “Load into Project and Close”. Do not save the family and “Overwrite the existing version”.
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31 Tag other main bars and move these tags to appropriate location in the drawing.
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Now, when you change the rebar set in your model (say in Level 1 plan), the drawing R.C. Detail
of Column will automatically be updated.
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32 One minor detail still needed to be changed. In Revit, the default naming of rebar is, for example,
40T instead of T40 that is commonly used in Hong Kong. To change this, select the 40T rebar in
any view then click “Edit Type”. Rename it to “T40” and click “OK”. Now the tag looks more
familiar.
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33 Revise and refine the other details with reference to the above steps. Then you should be able to
get a R.C. Detail of Column drawing like the one below.
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Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 1/}
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WAL O T

17.5

Creating Beam R.C. Detail Drawings in Revit

The steps to create R.C. Detail drawings for beams are similar to that for columns. First, you create
some section views, then place rebars and finally create new sheets, annotate and tidy up the

drawings.

To create a R.C. Detail of Beam drawing,

1 From the course folder, open the file “RC Detail of Beams.rvt”.

2 Go to ROOF (Structural Plan).

3 Click View tab > Create panel > Section. Make sure that “Building Section” is selected.
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4 Create a section alone Grid-6 and flip its direction as shown below.
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5 Go to this section by double clicking it or select it then right click and select “Go to View”.
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6 Clean up the section view with the following steps:

(1) Rename the section view to “Roof Beam Section”. (Right click near the view name in the
Project Browser, then select rename.)

(2) Hide elements that are not necessary in this view. Select levels and section line, then right
click and select “Hide in View > Elements”.
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shown below.
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(4) Clear the hatch pattern of the beams and columns. Type “vv” for Visibility/Graphics control,
then edit that for Structural Columns and Structural Framing. Make the pattern in Cut view
not visible for these elements.
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(5) There are still some lines showing elements that are not to be shown in a R.C. Detail
drawing. Carefully select the floor and the beams that go into the paper and hide them in
view. (Select then right click and select “Hide in View » Elements”. (Use the “tab” key to
help toggle between elements to assist your selection.)
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Then hide the view crop region (click

s

) and give a clean outline of the roof beams from

the model. This outline of the beams will automatically update if you change the size or
location of the beams.
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7 The next step is to add reinforcement or rebars to the beams.

Click Structure tab » Reinforcement panel > Rebar.

Site

= 3D Views

| Analytical Model
3D}

[= Elevations (Building Elevat
East
North
South
West

[ Sections (Building Section
Roof Beam Section
Section 1
Section 2

v Bl Sections (Wall Section) v
> < >

WA T O D T

‘ ROOF

Select Rebar Shape: 11 with Rebar Bar T25. Set Placement Plane to “Current Work Plane”,
Placement Method to “Parallel to Work Plane” and Rebar Set to “Fixed Number and Quantity =

3”.
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Hover over to top and bottom of the beam near Grid-C and click to place the rebar sets. (Press
“esc” a couple times to end the command.
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8 Select the bottom rebar set and drag its left end to near Grid-B as shown below.

R2BG-QR-0-8/ =2 0A @5 S B RCDetaiof Beams - Section: Roof Be..  + [Ioe siemodopase |08 B ¢ LSignin W @ - &Xx

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Modify | Structural Rebar =-

Bl & Cis otk s s Eaun— B = d

= 020 G it PickNew | Reba. | Rebar.. | Rebars..
- ¥ (;‘ ié \ .n. Q) O i "H | X & ® ; B8O stetch Family Host
Select * Properties  Clipboard Geometry Modify View  Measure  Create Mode - Host - - -
Modify Rebar Shape : 11 |-
Properties x — [ 53 ~ Project Browser - RC Detail of Be.. X
s B O, Views (al) ~
Rebar Bar - = Structural Plans
T25 Foundation
Level 1
|Structural Rebar (1)~ Z Edit Type Level 1 - Analytical
Construction * A Level 1 Framing Plan
Partition I:E Level 2
Rebar Number |9 Level 2 - Analytical
Schedule Mark |5 | Level 3
Geometry {Shape Driven ROOF
Style Standard | Ste
Shope 7 - & 3D Views
Analytical Model
Shape Image | <None> | | ‘ 0y
Haok At Start_|None = Elevations (Building Elevat
Hook AtEnd  None
: | East
Rounding Ove... _ Edit.. North
End Treatment...|None South
End Treatment...|None West
Rebar Set y = Sections (Building Section
Layout Rule  Fixed Number Roof Beam Section
Quantity 3 Section 1
Spacing | Section 2
P @ v | = Sections (Wall Section) v
Properties help Apply 10 O %% k&S B> o REwIE < > al< >
Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7 0 ™ Main Model = i e

9 Select the top rebar set and drag its right end to the middle of Grid-C and Grid-B as shown below.

Page | 100



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

ReEBG-QR-0-8/=-20OA G- |5 &~ RCDetiof Baams - Section: Raof Be..  +[1oeciepwodopnoe |48 & ¢ L signin W @ - & X

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Madify | Structural Rebar =~

B 0 XKLS BENNg s B G [ -
Modify|

D=8 o=+a

L1 Edit  Edit PickNew Reba.  Rebar. RebarS.

Bl “youra B3O THaaxs ®' B Sheich Fami Host
Select * Properties  Clipboard Geametry Medify View  Measure  Create Mode - Host - - -
Madify | Structy Rebar Shape : 11 v [
Properties x — (5 58 ~ Project Browser - RC Detail of Be.. X

= 10, Views (all) ~
Rebar Bar - 1 Structural Plans
125 C B Foundation
Level 1
Structural Rebar (1)~ S8 Edit Type Level 1 - Analytical
Construction 2 A Level 1 Framing Plan
Partition ] Level 2
Rebar Number (8 Level 2 - Analytical
Schedule Mark 5 Level3
Geometry Shape Driven ROOF
Style Standard \ | | She
Shape n N B30 Views
Shape Image | <None> v - Analytical Model
4> 0}

Hook AtEnd  None East
Rounding Ove..|  Edit. | North

Hook At Start  |None ‘ | [l Elevations (Building Elevat

End Treatment..|None | | South
End Treatment... _V\DHL‘ West

Rebar Set # [ Sections (Building Section
Layout Rule Fixed Number Roof Beam Section
Quantity 3 Section 1
Spacing Section 2

- m v ~ - Sections (Wall Section) v

Properties help Apply 1:100 P& G E> 0 RAHTE < > < ’

Click to select, TAB for alternates, CTRL adds, SHIFT unselects. (7 £ 0 [F B Main Model E == S e Y

Y|
10 Copy these two rebar sets by mirroring them about Grid-B. (The Mirror — Pick Axis [5]@ command
is under Modify tab. (Also change the Scale of the view to 1:50.)
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11 Next, add rebar set to the top of the beams at Grid-B.
Click Structure tab » Reinforcement panel > Rebar.

Select Rebar Shape: 00 with Rebar Bar T32. Set Placement Plane to “Current Work Plane”,
Placement Method to “Parallel to Work Plane” and Rebar Set to “Fixed Number and Quantity =
3”,

Then select this rebar set and drag its ends near to the middle of Grid-C and Grid-B as shown
below.
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12 Now, select all the rebar sets and change its view visibility for 3D View {3D} to both “View
unobscured” and “View as solid”. Then go to 3D view to view the rebar sets you added.
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13 Next, add some transverse reinforcement or links to finish placing rebars to the beams.

Go to the section view “Roof Beam Section”, then

Click Structure tab » Reinforcement panel > Rebar.

Select Rebar Shape: 63 with Rebar Bar T10. Set Placement Plane to “Current Work Plane”,
Placement Method to “Perpendicular to Cover” and Rebar Set to “Maximum Spacing and Spacing

=200mm”.

Hover over the left beam and click to place the links.
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14 Select the links and drag its ends to just outside the column face.
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15 Add links to the right beam with the follow settings.

Select Rebar Shape: 63 with Rebar Bar T10. Set Placement Plane to “Current Work Plane”,
Placement Method to “Perpendicular to Cover” and Rebar Set to “Maximum Spacing and Spacing
=100mm”.

Hover over the right beam and click to place the links. Drag the links to outside the column face
as before.
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16 After placing all the reinforcement, you can begin to cut some sections at the beams and start
annotating all these detail sections.

First, tidy up and annotate the “Roof Beam Section”.

(1) Add break lines to the columns. Break lines are Detail Components and can be found in
Annotate tab » Detail panel » Component. Click “Load Family” and find the break line detail
item “M_Break Line” from the path shown below.
(C:\ProgramData\Autodesk\RVT2018\Libraries\Hong_Kong\Detail Items\Div 01-General)

(Press “spacebar” to change the orientation of the break line if necessary.)
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(2) Add dimensions between the Grids.
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Click Annotate tab » Dimension panel > Aligned. Then pick Grid-C, then Grid-B and Grid-A and
click anywhere right to Grid-A. Press “ese”.
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(3) Now, add tags to annotate the beams and their reinforcement.

Click Annotate tab > Tag panel » Tag by Category. Then tag the beams, the top and bottom
rebars and the links. You will need to modify these tags for better presentation.
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(4) Now, double click on the beam tag “300 x 600 mm” to customize it.

In the Family Editor, select the label and click “Edit”. For the Type Name parameter, add
“(“ as prefix and “)” as suffix. Click “OK” then save as a new family named “CIC_Beam Size

7

Tag”.

II)II
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Now, select the two beam tags and change their type to “CIC_Beam Size Tag” (Standard) and

“Leader Line” as well.
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(5) Next, edit the links tag. Double click on it to edit its family.

In the family editor, click “Label” to create a new label. Click a location and start editing the
new label.

VN

Add parameters “Quantity”, “Type Name” and “Spacing” to the Label Parameters. Also type

in “-“ as Type Name’s suffix and “S.S.” as Spacing’s suffix as shown below.

Click “OK” then stretch the label outline so that the text display in one line.
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Before saving or loading the family into the project, you should add a new type to this family
for selection.

Select the new label and click “Family Types”. In the Family Types editor, click new type
and name it as “Quantity Type-Spacing S.S.” and click “OK”.
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Next, add new parameter to this type by clicking the icon at the bottom. Set the new
parameter name as “Quantity Type-Spacing S.S.” and other settings as shown below. Click
“OK” and then uncheck the “Type” parameter. Click “OK” to finish editing the new type.
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Click “Load into Project and Close” and click “Yes” to save change. Save the family as
“CIC_Beam Links Tag.rfa”.

Page | 111



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

Now select the links tag and change its type to CIC_Beam Links Tag: “Quantity Type-Spacing
S.S.” from the Type Selector. And uncheck “Leader Line” and move the link tag to an
appropriate location.
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(6) For the main rebar tags, select them and click “Edit Type” and display arrow set to “Arrow
Fill 20 Degree”. Click “OK” and then move these tags to proper locations.
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Click to select, TAB for alternates, CTRL adds, SHIFT unselects. 7

Fab B Main Model A O T

(7) Now, copy the beam size tag and double click to edit it. In the Family Editor, select the label
and edit it.

Remove the “Type Name” parameter and add the “Mark” parameter as shown below.
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Save the edited family as “CIC_Beam Name Tag.rfa”. Then click “Load into Project and

Close”.
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Select the beam tag and change its type to “CIC_Beam Name Tag: Standard”. You will notice
that Revit display the tag as “?”. This is because you have not given the beam a “Mark”.
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To give a beam mark, select the left beam and scroll down to find “Mark” from its Properties
Palette. Type in “RB1” for this beam and click “Apply”.
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For the beam on the right, type in its mark as “RB2".
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(8) The beam elevations have been from the above steps. Next, add a beam section for the
beam RB1.

Click View tab > Create panel » Section and choose Building Section. Place the section as
shown below.
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Resize the section view crop region and move Grid-6 closer as shown below. Also change the
scale to 1:20.
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Next, change the visibility to show no hatching. Type “vv” for Visibility/Graphics control and
set Cut pattern for Structural Framing to not visible.
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Tidy up this beam section view by:

e Hiding “Level” and “Section line” in this view.

e Add break line to the slab. (Break lines are Detail Components and can be found in
Annotate tab > Detail panel » Component. Click “Load Family” and find the break
line detail item “M_Break Line” from the path
C:\ProgramData\Autodesk\RVT2018\Libraries\Hong_Kong\Detail Items\Div 01-
General.)

e Hide Crop View. ﬂ (button is located at the bottom of the draw area.)
e Rename the section as “RB1 Section 1”.
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(9) Now, use the methods described in Steps (3) to (7) above, try to annotate the beam section
of RB1 as shown below.
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17 With the beam elevation and section created, you can now create a new sheet to place these

details as a R.C. Detail of Beam drawing.

(1) To add a new sheet (right click on “Sheets (all)” and select “New Sheet”). Use the CIC Course
Title Block then rename this sheet to “R.C. Detail of Beam” (right click and rename).
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(2) With the sheet “R.C. Detail of Beam” still activated, select “RB1 Section” and drag it into the

sheet. Do the same for “Roof Beam Section”.

Page | 119



Construction Building Information Modelling (BIM) Advanced Modelling Course

Industry Council (Structure) — Revit 2018

ReEEG- Q-0 -8/=2-20OA G- 2|5 &~ RCDiofBeams - Sheet:S104-R.. +[hoeoriwodomoe |48 § £ L sSignin W @ - &x

File Architecture  Structure  Systems  Insert  Annotate  Analyze  Massing & Site  Collaborate  View  Manage  Add-Ins  Madify =-

ﬂ B B sty Ba&Mket =

g
] EIP .
Bl g @ $BO T aax Q- Q=

Select ~ Properties Clipboard Geometry Meadify View | Measure  Create
Properties x — [ 53 ~ Project Browser - RC Detail of Be.. X
East ~
@ Sheet - North
2 Ee==n South
jan] West
Sheet: R.C. Detail of Bea ~ | &) Edit Type -[F 5 Sections (Building Section
Graphics A RB1 Section 1
Visibility/Grap... | Edit... gt Roof Beam Section
Scale As indicated Section 1
\dentity Data B Section 2
Dependency  |Independent [l Sections (Wall Saction)
Referencing ... | Section 3
Referencing D | e = Detail Views (Detail)
Current Revisi... | Detail 0
Detail 1
Corent Revisi. | Detail 2
Current Revisi... E Legends
Current Revisi... | [ Schedules/Quantities (all)
Current Revisi... | = [ED Sheets (all
Current Revision = 5101 - FRAMING PLAN
Approved By Approver Structural Plan: Lev
Designed By | Designer {5102 - SECTIONS
Checked By (Checker [l 5103 - RC. Detail of Colu
DrawnBy  Author . [ 5104 - R.C. Detail of Bea
v CITAC i 4 .
Lo rana i v | =& Families v
Properties help Apply 2 9 < > < >
Click o select, TAB for alternates, CTRL adds, SHIFT unselects. (7 F M Main Model =R e R

(3) Double click on the Roof Beam Section in the sheet. Then select the section line and click the
“Gaps in Segments” symbol to provide gap to the section line. Also click the “Cycle Section
Tail” symbol to hide the section tail.
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(4) Change the viewport type of the Roof Beam Section view to “Viewport No Title”
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(5) Next, change the title of the “RB1 Section 1” viewport to “SEC 1”.
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Finally, you have created a R.C. Detail of Beam drawing.
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You can follow the steps described above and draw the beam section for RB1 and try to annotate
the support of the beam as well.

Note that the sections included in this drawing are parametric. Hence, if you change the size or
rebars details of the model, then all related details in the drawing will be updated automatically.
An example is shown below for reference.
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CHAPTER 18 — Model Standard (Structural)

The BIM standard set out the methodology of modelling elements in Revit and other BIM software.
The BIM uses provide a guideline for modelling following the Level of Developments (LOD). In this
chapter, we will introduce the common standards used for BIM Modelling and their BIM uses in
Structural Engineering.

The following two standards are commonly referred.

1. BIM Standards — CIC Building Information Modelling Standards (Phase One)
2. PAS 1192 by BSI from UK

Please refer to the chapters in each standard.

CIC BIM Standards — CIC Building Information Modelling Standards (Phase One)
Reference could be made on the following Chapters for modelling standards:

e Chapter 2 — Modelling Methodology

e Chapter 2.1.3. — Structural Modelling Guidelines

e Chapter 2.3. — Collaborations Procedures.

e Chapter 3.2.3. — LOD Responsibility Matrix — Structural Model
e Chapter 3.3.3. — LOD Specifications — Structural Model

e Chapter 4.1 — Folder Structure

e Chapter 4.3 — Drawing Production

cien coeuons I
S Issue Main Contract Tender
Requirements
Design Stage

BIM PXP -

T Draft
i Construction
BIM PXP

Assess N

Construction
Stage BIM
PXP

<

y Produce BIM
Deliverables
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Table of BIM Uses by Project Phases

g §
5 3 2 g‘
(=]
Bele : £
£ & & = E g
o { = ) =
o & 3 s
21z |& 5 2 g
£ T = & =5
B3 % B o E| = E £ 3
2% |3 |55|F | |3t
O w | o 3 w o I2 L&) < O
Design Authoring YI/IN|YIN|[Y/N|Y/N|[YIN|Y/IN
Design Reviews YIN | YN[ YN[ YIN[YIN|YIN
Existing Conditions Modelling YI/N|[YIN|[Y/IN
Site Analysis

3D Coordination

Cost Estimation YIN

Engineering Analysis

Facility Energy Analysis

Sustainability Evaluation

Space Programming

Phase Planning (40 Modelling)

Digital Fabrication

Site Utilization Planning

3D Control and Planning

As-Built Modelling

Project Systems Analysis

Maintenance Scheduling

Space Management and Tracking

Assst Management

Each of the BIM Uses in the table are defined below. The competencies and resources
needed for each BIM Use are included in Appendix D.

Engineering Analysis
A process which uses the BIM model to analyse and assess different design options to

determine the most effective engineering solution to meet design codes and client

requirements.

For structural analysis, the analytical modelling software uses the model to determine the

behaviour of a given structural system.

Reference - "CIC Building Information Modelling Standards (Phase One)." 30 Sep. 2015,
http://www.cic.hk/cic_data/pdf/about cic/publications/eng/reference materials/CIC%20BIM%20Standards FINAL ENG v1.pdf.
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’Structural Analysis DESIGN
Description

A process in which analytical modeling software
utilizes the BIM design authoring model so to
determine the behavior of a given structural
system. With the modeling minimum required
standards for system design and analysis are used
for optimization. Based on this analysis further
development of the design takes place.  The
development of this information is the basis for
what will be passed onto the digital fabrication and
construction system design phases.

= Improve specialized expertise and services
offered by the design firm

= Achieve optimum efficient design solutions by
applying various rigorous analyses

= Faster return on investment with applying audit
and analysis tools for engineering analyses

= Improve the quality of the design analyses

= Reduce the cycle time of the design analyses

Code Validation DESIGN

A process in which code validation software is
utilized to check the model parameters against
project specific codes. Code validation is currently in
its infant stage of development within the U.S. and is
not in widespread use. However, as model checking
tools continue to develop, code compliance software
with more codes, code validation should become
more prevalent within the design industry.

Crecxad components e

« Validate that building design is in compliance = e
with specific codes

+  Reduces the chance of code design errors,
omissions or oversights i v i e T 151
+ Continuous feedback on code compliance as ™
design progresses T M ———
« Reduced turnaround time for 3D BIM model

review by local code officials

« Save time on multiple checking for code

L compliance

Automated Code Checking

fopin Yier |33+ 12
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PAS 1192

The production of co-ordinated design and construction information is a task- and time-based process,
independent of which procurement route or form of contract is used. Each task needs to be carried
out in a particular order for the mutual benefit of all those involved, otherwise known as ”collaborative
working”. In a collaborative working environment, teams are asked to produce information using
standardized processes and agreed standards and methods, to ensure the same form and quality,
enabling information to be used and reused without change or interpretation. If an individual, office
or team changes the process without agreement, it will hinder collaboration — a participant insisting
on “my standard” is not acceptable in a collaborative working environment. (BSI, n.d.)
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NEED
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Graphical Model

MOBILIZATION

: 'SM

4 5 6 7
BUILD & HANDOVER &
e ) conrr [ oermon [ oeson [ i [l I5GGJf oreanon st

((OMMON DATA ENVIRONMENT ((DE))
Opex =
I S ) S (©\) (e s s e )
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CDlCD CJl() CDJ'CJ OO0 O CDlC) CDlCD €2 {Forceats onsuppters |
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g and employer’s decision
© © © O © e
CIC Scope of Services ;

Legend
Information e Management
proces proces

Figure 17 — Structural engineer’s issue to SHARED

[ Maintain, Refurbish, End of Life or Build |

Reference architectural and structural models

SHARED e e _
completeness, dimensional accuracy
J— and against modelling standards
s ol .

)

1. Design and produce structural model
2.Share clash rendition and check
against the architectural clash rendition

2. Change model suitability to 51
(Suitable for co-ordination) and set
major revision

3. Share clash rendition

4. Check information exchange

(COBie) and documentation for stage
completeness

5. Change information exchange and
documentation suitability to 52
(Suitable for information) and set major

3. Modify design if clash occurs
4. Perform 2 and 3 until no clashes occur
5. Prepare information exchange data
(COBie)

6. Prepare documentation

1. Native model and clash rendition
2. Information exchange (COBie)

TASK TEAM Check Review and Approval

3. Documentation revision
fﬂ:r:ﬁ?:f;:llleg:.dg;;:trlﬂri;blm fobe (SL”TAB”JTY SD) (REVlSlON Pl'll\.rl)
(SUWAE“JTYSI'I ) (RE\ﬂleN Pnn ) Structural Engineer (S)
AN \ y

NOTE Copyright is claimed in this illustration. Reproduction of this illustration and making products from it might
infringe that copyright. Details of the copyright owners can be found in the Foreword.

References - "Standards | BIM Level 2." http://bim-level2.org/en/standards/.
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Project Phasing

Projects phases represent a distinct time period in the life of the project. Revit tracks the
phase for elements created or demolished. Phase filters are used to control the flow of
building model information into views and schedules. This allows you to create phase-specific

project documentation.

The following image shows a floor plan in different phases of a project: (1) existing

Construction, (2) demolition, (3) new construction, and (4) complete.

e p TR

Phase Properties for Views

Each view in Revit has a Phase property and a Phase Filter
property. The Phase property is the name of the view phase.
When a view is opened or created, it automatically has a Phase
value. You can copy a view and then select a different phase
value for that view.

e For example, the original view has Phase 1; the copy
has Phase 2. You create an element in Phase 1 and
demolish it in Phase 2. The element displays as new in
the original and as demolished in the copy.

Properties - |

@ 3D View v

3D View: Aerial v 8 Edit Type
Perspective v ~
Eye Elevation [15107.7
Target Elevati.. 16764

era Posit

Phasing 3
Phase Filter Show All
Phase New Constru..,

e The Phase Filter property lets you control the display of elements in a view. For
example, demolished walls may display in blue dashed lines, while existing elements
display in solid black lines. You can apply a phase filter to a view to see elements from

one or more specified phases.
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Properties 8

Phase Properties for Elements

—— Basic Roof =
Metal Panels

Each element that you add to a project has a Phase Created Roofs (1) v £ Edit Type

property and a Phase 466191 A
Identity Data L]

Demolished property. Comments
Mark
Phasing 2
Phase Created New Constru...

e The Phase Created property identifies the phase in Phase Demoali.. None
which the element was added to the building model. 1 v

The default value for this property is the same as the Properties help
Phase value for the current view. You can specify a
different value as needed.

e The Phase Demolished property identifies the phase in which the element was
demolished. The default value is None. When you demolish an element, this property
updates to the current phase of the view in which you demolished the element. You
can also demolish an element by setting the Phase Demolished property to a different
value.

Workflow for Phasing

This workflow describes a typical method of using phases and phase filters to manage a
project.

1. Determine the phases of work that you want to track for the project, and create a phase
for each. For example, depending on your needs, you might create phases named Phase 1,
Phase 2, and Phase 3.

2. Create one or more copies of a view for each phase, and name these views appropriately.

For example, duplicate the Level 1 floor plan several times, and rename the views to

include the phase names: Level 1 - Phase 1, Level 1 - Phase 2, and so on. Tip: Organize the
Project Browser by phase. The Project Browser sorts phases and views by name

alphanumerically. Plan your phase names and view names carefully so they will be listed in
the desired sequence.
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3. For each view, on the Properties palette:
a) Set the Phase property to indicate the project phase to which the view corresponds.

b) Set the Phase Filter property to control the display of elements for that view.

Example:
'\:[ w | o
(1) Phase = Phase 1, Phase Filter = Demolition = (2) Phase = Phase 2, Phase Filter = New + Existing

4. (Optional) Specify graphics for elements that are: existing, new, temporary, and demolished.

Example:

J ]
1

(1)Demolished elements = red dotted lines > New elements = magenta solid lines

5. Specify the Phase property for each element. By default, elements are assigned to the
phase that is specified for the view in which they are created. (For example, in the Level 1 -
Phase 1 floor plan, you create a wall. By default, the wall is assigned to Phase 1.)

6. (Optional) Create phase-specific schedules for the project. (For example, you can create a
Phase 1 door schedule that lists all doors to be removed or demolished, and a Phase 2 door
schedule that lists all new doors to be purchased and installed.)

7. (Optional) Create phase-specific construction documents.

Phase Filters

A phase filter is a rule that you apply to a view to control the display of elements based on
their phase status: new, existing, demolished, or temporary. Each view can show one or
more phases of the construction. You can specify different graphic overrides for each phase
status.
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New. Element was created in the phase of the current view.

Existing. Element was created in an earlier phase and continues to exist in the current
phase.

Demolished. Element was created in an earlier phase and demolished in the current phase.

Temporary. Element was created and demolished during the current phase.

Create a Phase Filters

Create phase filters can control the display of elements based on their phase status.

Click Manage tab » Phasing panel » B (Phases).
In the Phasing dialog, click the Phase Filters tab.
Click New to insert a new phase filter. The filter is assigned a default name.

(Optional) Click in the Filter Name box to edit the name.

on o o o

For each phase status column (New, Existing, Demolished, and Temporary), specify how
you want to display the elements:

By Category. Displays elements as defined in the Object Styles dialog.

Overridden. Displays elements as specified in the Graphic Overrides tab of the Phasing
dialog.

Not Displayed. Does not display the elements.

6. Click OK.
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Project Phases. | Phase Filters | Graphic Overrides

Filter Marme Mew Existing Demaolished Temporary

1 Show All By Category Orverridden Overridden Overridden

2 Show Complete By Category By Category Mot Displayed Mot Displayed
3 Show Demo + New By Category Mot Displayed Overridden Overridden

4 Show MNew By Category Mot Displayed Mot Displayed Mot Displayed
5 Show Previous + Dem : Mot Displayed Chverridden Overridden Mot Displayed
b Show Previous + Mew | By Category Overridden Mot Displayed Mot Displayed
7 Show Previous Phase ;| Mot Displayed Chverridden Mot Displayed Mot Displayed

o ) o ][ J[ e )

Apply a Phase Filters

Apply a phase filter to a view to control the display of elements for the view based on
project phases.

1. Access view properties for the view.

2. On the Properties palette, for Phase Filter, select one of the following:
a. A default phase filter.
b. A phase filter that you created.

c. None to apply no phase filter. (All elements are shown without any graphic
overrides.)
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Design Options

e Design options can be used to explore alternative designs in the building model. You
can use design options to explore multiple designs as the project develops, all within
the same project.

e At any time in the design process, you can have multiple sets of design options.
Typically, each set of design options addresses a particular issue or area. After the final
design is chosen, you can incorporate the chosen options into the main model and
remove the alternatives.

Workflow for Design Options

This workflow describes a typical method of developing sets of design options for your
building model.

1. Decide on the areas for which you want to develop design options.

2. Create the building model, including all elements that will be common to all of the design
options. (This is the main model.)

Note: If you add elements to a building and later decide that those elements should be

part of a design option, you can move them to the design option.

3. Create a design option set for each area.

4. For each design option set, edit the primary option. When you create a design option

set, Revit also creates a primary option for the set. The primary option is typically the
preferred design that you think will be chosen. It will be displayed in project views by default.
Other design options will appear in views only when you specify. Edit the primary option to
add elements to the design as desired.

5. Create secondary options for each design option set. You can create one or more secondary
options for each set. In general, any elements that will be modified or referenced in an option
should belong to the design option instead of the main model.
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Now Editing: Now Editing: Now Editing: Edit
[Main wodel | Main Model [main Model Edit Selected
= Opfion Set1 = Option Set | Finish Editing
Option | (primary) Option | (primary)
Option 2
Option 3 Option Set.
Option 4

Option 5
Option 6

6. Create views that display each design option.

By default, all project views display the main model with primary design options only. To see
secondary options, create project views that show them. (These are called dedicated views.)
You can then place these views on sheets to present the designs to clients.

Visibility/Graphic Overrides for 3D View: {30} E3

| Model Categories | Annotation Categories | Analytical Model Categories | Imported Categories ] Filters Design Options

Design Option Set Design Option A
Option Set 1 <Automatic> ™

{<Automatic> A
[Option 1 (primary)
‘Option 2

{Option 3
_ v

7. Incorporate a design option into the main model.

After the client has selected the desired option for each option set, you can incorporate the
selected designs into the main model. This process deletes the design option set, so the other
options in the set are no longer available, and the selected option becomes part of the
building model.
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View Design Option

When you create a design option set, Revit displays the main model and the primary option
in all project views by default. To see secondary options with the main model, you must edit
the option, change a view’s display option settings and dedicate views to the design option.

Determine the Active Option

The active option is the design option that is currently being edited. If you are editing an
option, the current view displays the main model and the active option. To determine
whether you are currently editing a design option, use one of the following methods:

Status bar - Check the status bar. It indicates the active design option. If the status bar

displays Main Model, you are not currently editing a design option. If the status bar does not
display the active design option, enable by:

View tab > Windows panel > User Interface drop-down > Status Bar - Design Options.

Ribbon - Click Manage tab Design Options panel. The drop-down list indicates the current
design option. Changes that you make will affect the active option. If the drop-down list
displays Main Model, you are not currently editing a design option.

& 0 4 Main Model v [
Main Model —
Option Set 1
OEtion 1 (irimai) r.
D X '%
Option 3 Design .
Option 4 Options Main Model v
Option 5 1 - - ‘
Option 6 | Design Options
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Dedicate Views to a Design Option

To see secondary options with the main model, create duplicate views that are dedicated to
those options. These views are called dedicated views. A dedicated view typically displays a
specified design option for each set. You can dedicate all kinds of views (including schedules)
to a specified design option. For example, you can create one schedule for the primary option
and another schedule for a secondary option. Each schedule lists elements that are in the
main model as well as elements that are in the design option.

To create a dedicate view to a design option, please follow the below steps:

1. Open a view that you want to dedicate to a design option.
2. By default, the view displays the primary option with the main model.
3. In the Project Browser, right-click the view name, click Duplicate View > Duplicate
with Detailing.
4. Revit creates a duplicate view > rename the duplicate view.
=0, Views (all)
Floor Plans
Ceiling Plans
= 3D Views
RevolvingDoor-GableRoof
RevolvingDoor-MansardRoof

Storefront-GableRoof
Storefront-MansardRoof

5. Specify design options for the view, as follows:

a) In the Project Browser, right-click the duplicate view name, and click Properties.
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@ 10 Views (all)

Level 1

App"'
From
Kitch:
Living
Sectij
Solar
(30}
. Elevatio
East
NortH
South
West
4 Sections

Long
Stair

@ Floor Plans

~

Site
= 3D View

Open
Close
Find Referring Views...

Apply Template Properties...
Create View Template From View...

Duplicate View
~ Convertto indepen&em view

Apply Dependent Views..,

Save to Project as Image...

Delete

Copy to Clipboard

Rename...

Select All Instances

Build@ Properties

Save to New File..

Search...

R ncieo S
Duplicate with Detailing

Duplicate as a Dependent

G EY I RE C

b) In the Properties palette, for Visibility/Graphics Overrides, click Edit.

Properties

@ 3D View v

3D View: {3D} v {4 Edit Type
View Scale 1:100 A
Scale Value 1: 100 I
Detail Level Medium
Parts Visibility Show Original
Visibility/Grap.. ©  |Edit...| ]
Graphic Displa... Edit.. I
Discipline Architectural

¢) The Visibility dialog displays the Design Options tab. Select the design option to
display in this view. The view displays the main model and a selected design option for
each set.

6. Repeat Steps 3-5 for each combination of design options that show in individual views.
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Chapter 19 — Collaboration with Team

Enable Worksharing

Enabling worksharing involves creating a master project model, known as a central model,
from an existing model.

The central model stores the current ownership information for all worksets and elements in
the project, and acts as the distribution point for all changes made to the model. All users
should save their own local copy of the central model, edit locally in this workspace, and then
synchronize with central to publish changes to the central model so that other users can see
their work.

To enable worksharing and create a central model

1. Open the project file (RVT) to use as the central model.

2. Click Collaborate tab » Manage Collaboration panel » e (Worksets).

Note: If you have installed the Collaboration for Revit add-on, then:

a. Click Collaborate tab » Manage Collaboration panel » £2 Collaborate.

Collaborate X

Eg b Acﬁve Workset: You are enabling collaboration, This will allow multiple people to

work on the same Revit model simultaneously.

~ Collaborate ] ' : % €= €=-=> %

Manage Collaboration

How would you like to collaborate?

® Collab within your
You can collaborate only on a local or wide area network (LAN or
WAN). The model will be converted to a workshared central

E‘g %iﬁ? Active Workset: O ::::;otate using the cloud

You can collaborate over any Internet connection. A copy of the
2 wmset‘ ] model will become workshared and be uploaded to the project
Collaborate in Worksets Sh d L | d G d you select, The original model will remain as a backup.
Cloud ik Ve an ngs Which collaboration method should | choose?
Mana|LWorkset1 | o ] [coma |
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b. In the Collaborate dialog, select Collaborate within your network and click OK.

The Worksharing dialog displays, showing the default user-created worksets (Shared Levels
and Grids, and Workset1).

3. If desired, rename the worksets.
In the Worksharing dialog, click OK. The Worksets dialog displays.

5. Inthe Worksets dialog, click OK.

You do not need to create worksets at this point.

Click File tab » Save As » I (Project).

In the Save As dialog, specify a file name and directory location for the central model.

When specifying a name for the central model, use a naming convention that identifies it as
the central model (for example, OfficeBuilding_CentralModel.rvt).

Worksets =
Active workset:
Workset1 w | [l Gray Inactive Workset Graphics
Mame Editable Owner Borrowers | Opened| Visible in all viey | MNew |
Shared Levels and Grids iYes BIM Manager Yes : .
Workset] Yes BIlM Manager Yes [+] | Delete |
| Rename |
Gpen
| Close
Editzble
< > | MNonEdtable |
Show:
Liser-Created []Project standards
[]Families [(views
ook [ Cencel || Hep |

Attention: When you save the central model, be sure that it is saved to a network drive to
which all team members have access. If you are using server-based worksharing, Revit Server
must be installed on any machine hosting a central model, and the Host role must be enabled
in the RSN.ini file on that machine.
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8. In the Save As dialog, click Options.

9. Inthe File Save Options dialog, select Make this a Central Model after save.
Note: If this is the first time you have saved after enabling worksharing, this option is
selected by default and cannot be changed.

10. Select a default workset for local copies.

11. Click OK.
12. In the Save As dialog, click Save.

The file is now the central model for the project. Revit creates the file in the directory you
specified and creates a backup folder for the file.

For example, if your central model is called OfficeBuilding_CentralFile, you see the project file
and the backup folder (OfficeBuilding_CentralFile_backup) in the directory.

() OfficeBuilding_CentralFile_backup

) Revit_temp
= QFficeBuilding_CentralFile, rvwe

The backup folder contains the backup information and editing permission information for
the central model.

The Revit_temp folder contains files that provide progress information on operations (such
as Synchronize with Central) to the Worksharing Monitor.
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Create Worksets

After enabling a team project for worksharing, create worksets to organize elements into
collections so that team members can display and work on selected worksets.

—

o M DN

Open your local copy of the central model.

Click Collaborate tab » Manage Collaboration panel » & (Worksets).

In the Worksets dialog, click New.

In the New Workset dialog, enter a name for the new workset.

To display the workset in all project views, select Visible in all views.

Clear this option if you want the workset to display only in views where you specifically turn
on its visibility.

You can change the visibility of worksets later in the Visibility/Graphics dialog.

Note: To improve performance, hide worksets that are not required for current work in the
local model.

Click OK.

The new workset displays in the list of worksets; it is editable, and your user name displays
for Owner.

If you are setting up a workshared model for your team and want to assign owners to each
workset, each team member must open a local copy of the central model, select the workset
in the Worksets dialog, and then select Yes in the Editable column.

When you finish creating worksets, click OK to close the Worksets dialog.

If you have added only one new workset, Revit prompts you to make the new workset active.
Click Yes or No.

Worksets =

Active workset:
Levels and Grids v | [ClGray Inactive Waorkset Graphics
Name Editable Owner Borrowers | Opened|Visible in all vie | I New |
Architecture Yes BIM Manager Yes o
Beams Yes EIM Manager Yes 1 l Delete —l
Columns Yes BIM Manager Yes = R
Floors Yes BIM Manager Yes ™~ .
Levels and Grids Yes BIM Manager Yes
MEP Yes BIM Manager Yes [
Shared Levels and Grids [Yes BIM Manager Yes [ DOpen
| e |
Editable
< > | NonEdtable
Show:
User-Created [IProject Standards
[CIFamilies [views
oK || camed || Hep |
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Create a Local Copy of a Central Model

It is good practice for users to create a local copy of the central model every day. Creating a
new local copy ensures a local copy is always on your hard drive each time you begin

modifying a project.

To open a model and create a local copy

Change the Username in Options such as Stru Eng

Username

Stru Eng

You are currenty not signed in, When you sign in, your Autodesk ID will be used

a5 Your username.

1. Click File tab > Open.

2. In the Open dialog, navigate to the folder where the central model resides and select it.

3. Under Worksharing, verify that Create New Local is selected.

Note: If you select Detach from Central, then Create New Local will be cleared. Clear both
options to open the central model itself instead of a copy.

6 Project Management v ¢ B X B vews
) < Preview
Name Date modified Type
[l Central_File.vt 3/28/20182:03PM  Autodesk Revi s
EmWorksharing.nt 3/28/20121206PM  AutodeskRevi
Central_File_backup 3/28/20182:03PM  File folder = #;
Revit_temp 3/28/20181:39PM  File folder 8
T T Ii
-
< >
Fie name: [Central_Fie.rvt %
Files of type: | All Supported Files (*.rvt, .rfa, *.adsk, %.rte) |
Worksharing
[ Audit [CIpetach from Central [Acreate New Local | open | Cancel

E Central_File_Stru Eng.nt
Central_File_Stru Eng_backup

uJ

wJ

General

User Interface
Graphics
Hardware
Rendering
Check Spelling

SteeringWheels

.| ViewCube

Project template files: The first five project templates will appear as links on the
Recent Files page.

1E Name Path

[c fon Tem... |C\ProgramData\Autodesk\RVT 2018\Tem...
C [ Architectural Temp... C:\ProgramDataVAutodesk\RVT 2018\Tem...
& Template Ci\BrogramData\Autodesk\RVT 2018\Tem...

Mechanical Templ... :C:\ProgramData\Autodesk\RVT 2018\Tem...

Default path for user files:
l C:\Users\huang\Documents Browse...

Autodesk Revit Pr... 12,300 KB

File folder
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To create a local copy from an open central model

Use this procedure if you have already opened the central model, and you want to create a
local copy of it.

Click File tab » Save As » I3 (Project).

2. Inthe Save As dialog, navigate to the desired location on the Revit Server network or on
your hard drive.

3. Enter a name for the file, and click Save.

Make Worksets Editable

When working on a workshared project, you can use various methods to make worksets
editable.

To make worksets editable from the Worksets dialog

1. Open your local copy of the central model.

2. Click Collaborate tab > Manage Collaboration panel » (?'i? (Worksets).

3. In the Worksets dialog, to filter the display of worksets, make the appropriate selections
under Show. For example, to see the Project Standards worksets, select Project Standards.

4. Click under Editable for the workset, and select Yes. Alternatively, you can select the

workset name, and click Editable.

Note: If a workset is owned by another user, you cannot change its editable status.
5. Repeat the previous step for as many worksets as you want to edit.

6. Click OK.

When you click OK, ownership information is communicated to the central model and to all
local copies of the central model, so that all team members have the current ownership
information.
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Worksets X

Active workset:
Levels and Grids (Not Editable) | [[IGray Inactive Workset Graphics

Name Editable Owner Borrowers | Opened|Visible in all viex ‘ New
Architecture No Yes N
Beams No Yes ¥ 1 Delete
Columns ' Y “ ‘ IR
Floors No Yes ™ =
Levels and Grids No Yes
MEP No Yes ¥
Shared Levels and Grids |No Yes Open

Synchronize with the Central Model

When working on a workshared project, use the Synchronize with Central tool to save your
local changes to the central model.

To Synchronize with Central: Click Collaborate tab > Synchronize panel > Synchronize with

'
Central drop-down » @f] (Synchronize Now).

If you want to modify the Synchronize with Central settings before you synchronize with

central: Click Collaborate tab > Synchronize panel > Synchronize with Central drop-down >
i |

@JE (Synchronize and Modify Settings). The Synchronize with Central dialog displays.

- —
Synchronize with Central M

Central Model Location:

| Ct\Project3.rvt | |  Browse..,

[7] compact Central Model (slow)

After synchronizing, relinguish the following worksets and elements:
| |Project Standard Worksets [ ] view Worksets
|| Family Worksets [ User-created Worksets

| |Borrowed Elements

Comment:

| |Save Local File before and after synchronizing with central

Lo J[ concd J[ teb |
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1. In the Synchronize with Central dialog, verify the location of the central model.

If necessary, click Browse to specify a different path for the central model. Specify the new
path in the Central File Location dialog, and click OK.

2. Select Compact Central Model to reduce file size when saving.

Note: Selecting this option increases the time needed to save.

3. Under After synchronizing, relinquish the following worksets and elements, select from the
following options:

e To make your changed worksets and elements available to other users, select the
appropriate checkboxes.

e To synchronize the changes to central but keep the worksets and elements editable,
clear the appropriate checkboxes.

4. If desired, enter a comment that is saved to the central model.

5. Verify that Save local file before and after synchronizing with central is selected to ensure
your local file remains synchronized with central.

6. Click OK.

Re-assign an Element to a Different Workset

When working on a team project that is enabled for worksharing, you can move an element
from one workset to another.

1. In the drawing area, select an element.
2. On the Properties palette, locate the Workset parameter under Identity Data.
3. Click in the Value column for the parameter, and select a new workset.

In the Properties palette, the Workset parameter can be edited without first borrowing the
element.
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Identity Data sldent'rty Data
Image Image
Comments Comments
Mark Mark
Workset Levels and Grids Warkset Columns
Edited by Edited by Stru Eng

Add Elements to a Workset

When working on a team project that is enabled for worksharing, you can add elements to a
workset.

1. Select the workset from the Active Workset drop-down on the status bar or the
Collaborate tab > Manage Collaboration panel.

Note: You can select a non-editable workset as the active workset. If you place an element
in a non-editable workset, the element becomes non-editable after you synchronize with
central. If you add view-specific elements, such as detail lines or dimensions, they are added
to the workset of the active project view.

2. If you want all elements that were not created in the active workset to display as gray,
|
click Collaborate tab > Manage Collaboration panel * Cr (Gray Inactive Worksets).

3. Add the necessary elements to the drawing area.

Disable Worksharing
If needed, you can disable worksharing in a model that has been workshared.

1. Click File tab> Open.
2. Select a workshared model.
3. In the Open dialog, select Detach from Central.

4. Click Open.

e The default file name for the model is the original filename with "_detached"
appended. You can change the default name when you save the model.

5. In the task dialog, specify whether to preserve or discard worksets.

6. Save the model.
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Cloud Collaboration Platforms

Keep the team on-track with the latest drawings, documents, and models.

1. Controlled sharing of information across the entire team
Perform constructability reviews with 2D & 3D markups
Reduce rework risks through versioning and permissions
Manage contract documents and track project activity

PwnN

Workflow of Cloud platform for collaborations

e Getinformation published faster and organized logically with bulk upload, set creation, and
automatic separation of sheets from design files.

e Organize construction drawings and documents into sets and quickly review changes
between versions - in 2D or 3D.

e Maintain document control with five permission levels keeps the right information in the
right hands throughout the project.

e Structural Engineers can work with Draftsman / Modeller to update model and drawing
remotely on cloud and off-site anytime.
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